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Main Menu Area
The Main Menu area contains drop-down menus for managing projects, files, and settings. It also includes
Utility icons for common tasks and display options.

Figure 1: Main Menu Area

File Menu

Figure 2: File menu
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The File menu includes commands for managing your project, for managing the entities that make up
a project, for importing data, for exporting geometry data, for managing Replay Scripts, and to quit the
program.

Project Management Options

Entity Management Options

Import Options

Export Geometry

Replay Scripts

Exit

Project Management Options

Your Ansys ICEM CFD work is organized into Project files (*.prj). A project file contains the inform-
ation necessary to manage several data files associated with your project. The data files in a project
are a Geometry file (*.tin), Mesh file (*.uns), Blocking file (*.blk), Attributes files (*.fbc and
*.atr), and Parameters file (*.par).

Options for managing your project file include the following:

New Project

To initiate a project file, select the New Project option.

Figure 3: New Project Window

• Browse to the desired folder. This location becomes the working folder for all files associated
with your project.

• You must specify a File name.
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• The only available Save as type option is .prj for project files.

• Click Save.

Note:

• Existing project files in the current folder will be displayed.

• You may choose a File name from the existing files displayed or from a list of the
most recently opened project files using the drop-down list, although a new project
name is advised to prevent overwriting an existing project.

• If you already have a project open, this option will close the current project.

Open Project

To work on an existing project, select the Open Project option.

Navigate to the working folder and select the desired project from the Open Project window; or
select an existing project from the drop-down list in the File name field.

Note:

Ansys ICEM CFD supports native projects (.prj extension) or Ansys Workbench projects
(.wbpj extension).

Save Project

To update the project file (*.prj) on your disk, select the Save Project option.

If you are working in an existing project, this option will overwrite that project. If not, the applic-
ation prompts you for a File name and location.

This option also updates and saves the data files associated with the project. The files saved are
the Geometry file (*.tin), Mesh file (*.uns), Blocking file (*.blk), Parameters file (*.par) and
Attributes files (*.fbc and *.atr).

Save Project As

To create a new project file with existing work, select the Save Project As option.

The Save Project As dialog box opens, prompting you for a File name and location for your
project.

Close Project

To unload all project data and leave your ICEM CFD session open, select the Close Project option.

If the project has changed, the application prompts you to save your changes.
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Figure 4: Save Confirmation Window

Change Working Directory

To specify a default directory where the project and data files will be saved, select the Change
Working Directory option.

You can directly enter the path name or browse to the desired working directory for the project.

Figure 5: Change Working Directory Window

Entity Management Options

Your Ansys ICEM CFD project consists of several entities, each with its own data which may be managed
independently. Each option in this section opens a submenu to manage that entity’s data.

Geometry

Mesh

Blocking

Attributes

Parameters
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Cartesian

Geometry

The geometry file (*.tin) includes details of the shapes, names, material properties, and so on of
all component parts in the project. Options for managing the geometry file are shown in Figure 6: Geo-
metry Options (p. 5).

Figure 6: Geometry Options

Open Geometry

To load a geometry file into memory and display its graphical image, select the Geometry >
Open Geometry option.

Select the required geometry file (*.tin) in the Open window. You may have to browse to a
different working directory.

If a geometry is already loaded, the Geometry Exists window will open, prompting you to
either merge the new geometry with the existing geometry or replace the existing geometry.

Figure 7: Geometry Exists Window

Save Geometry

To update the .tin file with all your recent geometry work, select the Geometry > Save
Geometry option.

This option will overwrite an existing, open geometry file. If no geometry file is open, a Save
all geometry window will prompt you for a File name and location.
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Save Geometry As

To create a new .tin file with existing geometry data, select the Geometry > Save Geometry
As option.

The Save all geometry window opens where you are prompted for a File name and location.

Save Visible Geometry As

To create a new .tin file containing only displayed geometry entities, select the Geometry >
Save Visible Geometry As  option. This is typically done when you need to work with a subset
of all geometry in your project.

The Save only visible geometry window opens where you are prompted for a File name and
location.

Save Only Some Geometry Parts As

To create a new .tin file containing a subset of all geometry in your project, select the Geo-
metry > Save Only Some Geometry Parts As option.

The Save only some parts window opens where you are prompted for a File name and location,
followed by the Select parts dialog box for you to choose which parts are saved in the new
file.

Save Geometry As Version ...

To save the geometry in an earlier Ansys ICEM CFD format, select the Geometry > Save Geo-
metry As Version option. Options available are Version 4.3, Version 10.0, or Version 13.0.

Note:

• Options related to Mesh Type and Mesh Method introduced in Ansys ICEM CFD
11.0 will be ignored when saving a geometry file in the Ansys ICEM CFD 10.0 or
earlier format.

• The parameter related to curves and surfaces introduced in Ansys ICEM CFD 14.0
will be ignored when saving the geometry file in the Ansys ICEM CFD 13.0 or
earlier format.

This parameter is introduced because of changes to AutoVT in Ansys Workbench
and can be introduced when the model comes through Ansys Workbench, including
with the Workbench CAD interfaces.

Close Geometry

To remove the geometry information from the graphical display and close the loaded geometry
file, select the Geometry > Close Geometry option.

If the geometry has been modified, the Save Geometry window will open, asking if you want
to save the modified geometry.
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Figure 8: Save Geometry Window

Mesh

The mesh file includes details of the line, shell, and volume mesh elements of the project. Options
for managing the mesh file are shown in Figure 9: Mesh Options (p. 7).

Figure 9: Mesh Options

Open Mesh

To load a mesh file into your project and display its image, select the Mesh → Open Mesh
option. In addition to native unstructured mesh (*.uns) and multiblock, structured mesh
(*.multiblock), ICEM CFD can open Ansys Fluent Meshing (*.msh) files and Ansys Modeler
mesh (*.amm) files.

Select the required mesh file in the Open dialog box. You may have to browse to a different
working directory.

If a mesh file is already loaded in the project, the Mesh Exists window will open, prompting
you to either merge the new mesh with the existing mesh or replace the existing mesh (similar
to Figure 7: Geometry Exists Window (p. 5)).

Open Mesh Shells Only

To load only a shell (surface) mesh, select the Mesh > Open Mesh Shells Only option.

Select the required mesh file in the Open window. If a mesh file is already loaded in the project,
the Mesh Exists window will open, prompting you to either merge with, or replace, the existing
mesh.

7
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

File Menu



Load from Blocking

To load the mesh from the loaded blocking file, select the Mesh > Load from Blocking option.

The existing mesh will be converted from structured to unstructured mesh; and the meshing
entities in the display tree will be updated.

Save Mesh

To update your .uns file with all your recent mesh work, select the Mesh > Save Mesh option.

This option will overwrite an existing, open mesh file. If no mesh file is open, a Save all mesh
window prompts you for a File name and location.

Save Mesh As

To create a new .uns file with existing mesh data, select the Mesh > Save Mesh As option.

The Save all mesh window prompts you for a File name and location.

Save Visible Mesh As

To create a new .uns file containing only the displayed mesh entities, select the Mesh > Save
Visible Mesh As option. This is typically done when you need to work with a subset of all mesh
in your project.

The Save only visible mesh window prompts you for a File name and location.

Save Only Some Mesh As

To create a new .uns file containing a subset of your mesh data, select the Mesh > Save Only
Some Mesh As option.

The Save Some Mesh As dialog box opens where you select the mesh types and/or mesh parts
to be saved in the new file. See Figure 10: Save Some Mesh As Dialog (p. 9).
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Figure 10: Save Some Mesh As Dialog

Mesh file

The loaded Mesh file name will appear here. You may use the existing file name, type a
new Mesh file name, or browse for a file by clicking on the box to the right of the field.

Types

Select All to include all mesh types, or Select to choose the mesh elements to be saved.
The selected types will be highlighted.

Parts

Select All to include the mesh associated with all the existing parts, or Select to choose
the mesh parts to be saved. The selected parts will be highlighted.

Close Mesh

To remove the mesh information from the graphical display and close the loaded domain file
or mesh file, select the Mesh > Close Mesh  option.

If the mesh has been modified, the Save Mesh window will open, asking if you want to save
the modified mesh (similar to Figure 8: Save Geometry Window (p. 7)).

Blocking

The blocking file (*.blk) includes details of the underlying framework used to create a structured
hexahedral mesh in your project. Blocking files may also be loaded from or saved to unstructured
mesh. The options for managing the blocking file are shown in Figure 11: Blocking Options (p. 10).
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Figure 11: Blocking Options

Open Blocking

To load a blocking file into your project and display its image, use the Blocking > Open
Blocking option.

Select the desired blocking file from the Open dialog box. You may have to browse to different
working directory.

If a blocking file is already loaded in the project, the Blocking Exists window will open,
prompting you to either merge the new blocking with the existing blocking or replace the ex-
isting blocking (similar to Figure 7: Geometry Exists Window (p. 5)).

Create from Unstruct mesh

To create a hexa blocking file from an unstructured mesh composed entirely of hexa elements,
select the Blocking > Load from Unstruct mesh option. This option is useful to regenerate a
blocking file from a hexa mesh that was originally created from a blocking file, and is most robust
when used in this fashion. This option can also be used on unstructured meshes originally
written from external Multiblock formats such as Plot3D.

Note:

Allowed element types are NODE, LINE_2, QUAD_4, and HEXA_8. Element types TRI_3
and PENTA_6 will be ignored. All other element types will cause an error.

It is also useful to create complicated 2D blocking by first creating 2D elements. Each quad
element becomes a 2D hexa block. Complicated block structures can be made this way, which
may not be possible to do in a top-down method.

Create Pipe Blocking from File

To create pipe geometry and blocking from a text-based input file, select the Blocking > Create
Pipe Blocking from File option. After selecting a properly structured Pipe Input file, click
Apply to generate the pipe geometry and blocking.
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Figure 12: Create Pipe Blocking

Pipe Input file

Opens a dialog box to select your pipe data input file.

The input file can be created in a text editor or spreadsheet application. See Pipe Input file
Structure (p. 12) for file specifications.

Init Height

displays the surface height for the walls of the pipe (part CYL_SURFS), found in the input
file.

Ogrid Height

displays the Offset for the Ogrid Inflation layer.

Height Ratio

displays the surface height ratio and tetra height ratio for part CYL_SURFS.

Max Length

displays the largest edge length for the hexa mesh.
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Length Axial

displays the surface height for the inlets & outlets of the pipe (part CAP_SURFS).

Note:

Surface height ratio and tetra height ratio for part CAP_SURFS is always 1-1.

Hex cells in smallest cross section

displays the number of hexa cells to span the smallest cross section.

Target Mesh Size

displays the desired size for the hexa mesh cells.

Note:

• Hex cells in smallest cross section and Target Mesh Size must fit within
other meshing parameters otherwise they will be ignored.

• These two parameters will be used to calculate Init Height, Height Ratio, and
Max Length if any of the three values are set <= 0.0.

Single Topology

sets how the Blocking > Topology is shown in the Display Tree. If enabled, only the single,
merged topology is shown. If disabled, in addition to the merged topology (which will be
the one with the highest index number), you will see a topology for each segment.

Show Markers

adds markers for all Points in the pipe input file.

Pipe Input file Structure

The pipe input file contains the following data:

param init_height value

param ogrid_height value

param height_ratio value

param max_length value

param l_axial value

param n_across value

param target_size value

point point_ID x y z pipe_radius bend_radius
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Repeated as necessary, where point_ID are applied sequentially, x y z are the coordinates,
pipe_radius sets the pipe size at that point, and bend_radius sets the curvature if an elbow
segment.

pipe point_ID point_ID

Repeated as necessary, where point_IDs are the start and end Points of the individual pipe
segments.

For example, the simple input file listing will create the simple pipe structure.

Figure 13: Create Pipe Example

param init_height 0.85

param ogrid_height 0.5

param height_ratio 1.1

param max_length 0.5

param l_axial 0

param n_across 17

param target_size 333.0

point 1 90 0 38 4.0 1.0

point 2 90 20 38 4.0 1.0

point 3 75 20 38 4.0 1.0

pipe 1 2

pipe 2 3

Save Blocking

To update your .blk file with all your recent blocking work, select the Blocking > Save
Blocking option.
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If an existing blocking file, filename.blk is already open, then this option will rename the
existing blocking file to filename.blk0 (and then sequentially filename.blk1, file-
name.blk2, etc.) and save the current file to filename.blk.

Note:

The automatic indexing of blocking file names makes it easy to jump back to
an earlier step if you wish.

Note:

A key strength of Ansys ICEM CFD Hexa is the separate blocking layer file. This
blocking file sit on top of the geometry (*.tin file) and is associated with it, but
can be loaded with other topologically similar models and associated with them. In
this way a blocking structure can be used with a family of geometries to rapidly
create a series of high quality meshes or shared between colleagues working on
similar tasks.

Save Blocking As

To create a new .blk file with existing blocking data, select the Blocking > Save Blocking As
option.

The Save as window prompts you for a File name and location.

Save Blocking as 4.0 Format

To save the blocking file in the legacy Ansys ICEM CFD 4.0 format, select the Blocking > Save
Blocking – 4.0 format option.

Save Unstruct Mesh

To save the existing blocking pre-mesh in an unstructured hexa mesh format (*.uns file), select
the Blocking > Save Unstruct Mesh option.

The Save Mesh as dialog box prompts you for a File name and location. The unstructured mesh
is not loaded.

Save Multiblock Mesh

To save the current blocking data in the Multiblock structured format, select the Blocking >
Save Multiblock Mesh option.

A dialog box will open prompting you to choose which type of domains to convert.
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Figure 14: Convert Multiblock

Write Super Domain

To save the current blocking data in a merged, one-domain Multiblock mesh, select the
Blocking > Write Super Domain option. The intended solver must be compatible with the
Super Domain format.

Write Cartesian Grid

To save the current blocking data in a Cartesian grid format, select the Blocking > Write
Cartesian Grid option. This is useful as a starting point for the Body-Fitted Cartesian (BFCart)
meshing module (see the Cartesian file information on the  Body-Fitted Mesh Method  (p. 405)
page).

To use this option, start by creating a block from the geometry extents. You can modify the
vertex locations, but ensure the block remains aligned with a Cartesian coordinate system (right
angled corners). Control the Cartesian grid distribution and biasing with splits and edge para-
meters. Also, edge distributions should be "copied to parallel" to maintain a consistent Cartesian
distribution throughout the grid.

Close Blocking

To remove the blocking information from the graphical display and close the loaded blocking
file, select the Blocking > Close Blocking option.

If the blocking has been modified, the Save Blocking window will open, asking if you want to
save the modified blocking (similar to Figure 8: Save Geometry Window (p. 7)).

Attributes

The attributes files (extension *.fbc or *.atr) maintain the association of user-specified data for
parts, element properties, loads and constraints with nodes/elements of the mesh for a project.
The files are updated automatically to preserve consistency with the mesh, every time the project
is saved.

You can perform the following operations on an existing attributes file as shown in Figure 15: At-
tributes Options (p. 16).
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Figure 15: Attributes Options

Open Attributes

To load an attributes file (*.atr or *.fbc), select the Attributes > Open Attributes option.

Select the desired attributes file from the Open dialog box, or select an existing file from the
drop-down list in the File name field. You may have to browse to the working folder.

Save Attributes

To update your .fbc and .atr files with all your recent boundary conditions and attributes
work, select the Attributes > Save Attributes option.

This option will overwrite existing, open attributes files. If no attribute file is open, a Save as
window will prompt you for a File name and location.

Save Attributes As

To create new .fbc and .atr files with existing attributes data, select the Attributes > Save
Attributes As option.

The Save as window prompts you for a File name and location.

Close Attributes

To close the attributes files, select the Attributes > Close Attributes option.

Parameters

The parameters file (extension *.par) contains mesh-independent data such as material properties,
local coordinate systems, solver analysis set up and run parameters. The data in the parameters file
is cross-referred in the attributes file when a set of parameters is associated to the nodes/elements
of the mesh. The parameters file is also updated automatically along with the attributes files
whenever a project is saved.

You can perform the following operations on an existing parameters file as shown in Figure 16: Para-
meters Options (p. 16).

Figure 16: Parameters Options

Open Parameters

To load a parameters file (*.par), select the Parameters > Open Parameters option.
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Select the desired file from the Open dialog box; or select an existing file from the drop-down
list in the File name field. You may have to browse to the working folder.

Save Parameters

To update your .par file with all your recent parameters work, select the Parameters > Save
Parameters option.

This option will overwrite an existing, open parameters file. If no parameter file is open, a Save
as window will prompt you for a File name and location.

Save Parameters As

To create new .par file with existing parameters data, select the Parameters > Save Parameters
As option.

The Save as window prompts you for a File name and location.

Close Parameters

To close the parameters file, select the Parameters > Close Parameters option.

Note:

The data format for both the attributes and parameters files is unique for a solver. The
default format is Nastran. The conversion of Nastran files to Ansys & LS-DYNA files is
done automatically depending on the selected solver. The other solver-specific attributes
and parameters can be specified through the Edit Parameters and/or Edit Attributes
options available under Advanced Edit Options in the Write/View Input File DEZ. After
selecting this option, the Solver Parameters window will open and you can set the re-
quired parameters.

Cartesian

The Cartesian file (extension *.crt) contains information regarding the Cartesian grid for your
project, if one has been created. See Write Cartesian Grid under Blocking (p. 9).

You can perform the following operations on an existing Cartesian file as shown in Fig-
ure 17: Cartesian Options (p. 17).

Figure 17: Cartesian Options

Load Cartesian

To load a Cartesian grid file (*.crt), select the Cartesian > Load Cartesian option.

Select the desired file from the Open dialog box, or select an existing file from the drop-down
list in the File name field. You may have to browse to the working folder.
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Save Cartesian

To update your .crt file with all your recent Cartesian grid work, select the Cartesian > Save
Cartesian option.

This option will overwrite an existing, open Cartesian file. If no Cartesian file is open, a Save as
window will prompt you for a File name and location.

Save Cartesian As

To create a new .crt file with existing Cartesian grid data, select the Cartesian > Save
Cartesian As option.

The Save as window prompts you for a File name and location.

Close Cartesian

To close the Cartesian file, select the Cartesian > Close Cartesian option.

Import Options

Ansys ICEM CFD is capable of importing geometry and parts data from many popular CAD software
programs, as well as importing mesh data from many third party solvers.

The Import Model option uses available Workbench Readers to extend the third party options and
is recommended when importing from Ansys licensed products and most newer CAD software.

Import Geometry and Import Mesh options use direct interfaces.

Import Model

Import Geometry

Import Mesh

Note:

The special characters Ä, ä, Ç, Ö, ö, Ü, and ü are not supported in file names on Linux.

Import Model

The Import Model option allows you to use the Workbench Readers to import geometry or mesh
data into Ansys ICEM CFD.

The Ansys product file types that may be imported using Import Model are listed in the table.

Ansys licensed product file types that may be imported using Workbench Readers.

*.agdb, *.anf, *.cmdb, *.dsdb, *.mechdat, *.meshdat,
*.meshdb, *.mshdat, *.mshdb, *.wbpj

Ansys

*.bgdBladeGen

*.agdbDesignModeler

*.dbsGAMBIT
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*.scdocSpaceClaim

Third party CAD software formats supported by ICEM CFD using Workbench Readers are listed on
the Ansys, Inc. website (Support > Platform Support). See the Platform Support section of the Ansys
Website, download the CAD Support file, and refer to the Ansys Workbench Platform Reader/Plug-Ins
pages.

For information on how ICEM CFD interprets your CAD data, see File Format Support in the CAD
Integration documentation.

Note:

This option only appears if Ansys Workbench is installed along side Ansys ICEM CFD.
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Model Files from Workbench project

When the Workbench project (*.wbpj) file is read using the Import Model option, the existing
geometry and/or mesh files will be located. You can then select the specific data file to be im-
ported.

Selecting at the project level is more convenient than locating the particular Workbench geo-
metry or mesh files within the directory structure. However, the Model Files from Workbench
project option is particularly important if there are multiple files located.

Parts, Sizes

allows you to replace the default Workbench parameters with the parameters defined in an
existing tetin file to the imported geometry. The selected tetin file would transfer its global,
part, and entity based settings to the newly imported geometry. This results in rapid meshing
parameter setup for a modified geometry.

Import from Tetin File

When active, this allows you to choose which part mesh parameters are to imported from the
specified tetin file. This option is useful if you import a model file that contains the same part
names as the tetin file from which the parts and sizes should be imported because the curve
names and surface names may be different in both files.

Note:

Part mesh params, on Geometry Options (p. 96), must be enabled to select which
parameters are imported.

Import Geometry

allows you to import geometry. In general, the geometry import options available follow the
options available in Ansys Workbench Meshing. All the options under Geometry Preferences
will be active only when Import Geometry is enabled.

Use Associativity

Default is OFF. If checked ON, ICEM CFD will use a default part manager database to store
persistency data.

Note:

• Valid extensions are .prt .asm .prt* .asm* .par .psm .pwd .CATPart .CATProduct
.sldasm .sldprt .ipt and .iam. Otherwise you will get an error message about
an invalid file format.

• It is required that your ICEM CFD project exist to store the associated geometry
file.
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Use Reference Key

Typically this is left unchecked (default). Names of curves and surfaces are short, usually
persistent, and may be used in scripting.

For certain workflows, if parameter changes cause topology changes (example: splitting an
edge into multiple segments), the geometry entity names may not be persistent causing
scripting difficulties. Selecting this option causes geometry entity names to be derived from
reference keys in the geometry file, improving persistence but making them longer.

Note:

You can override the default value by selecting Always use Reference Key for
Import of Geometry in the Settings > Import Model Options menu.

Import Mesh

allows you to import meshes from *.meshdat. or *.mechdat files. Legacy formats such as *.cmdb
and *.dsdb are also supported. When only Import Mesh is enabled, all the Geometry Prefer-
ences options will be deactivated.

Geometry Preferences

allows you to set the following geometry preferences:

Named Selection Handling

allows you set the following preferences for Named Selections:

Named Selection Processing

If enabled, creates a named selection based on data generated in the CAD system. Default
is on.

Named Selections only

If enabled, only entities with Named Selections will be imported. This option refer-
ences the Named Selection Prefixes filter described below. Default is off.

Create Subset(s) from Named Selection

enables the creation of geometry subsets instead of parts, thereby allowing you to
decide the part to which the geometry entity (point/curve/surface) should be asso-
ciated. When this option is disabled each geometry entity (point/curve/surface) will
be assigned to only one part, thereby losing association with other Named Selections
(which are mapped to parts). This option is available only when the Import Mesh
option is disabled.

Create Entity and Part Names

uses attribute/entity names assigned in the CAD file to create entity and part
names in ICEM CFD.
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Named Selection Prefixes

allows you to set the named selection processing prefix key when Named Selection
Processing is enabled. If the filter is set to an empty string, all applicable entities
will be imported as named selections. You may enter multiple prefixes with each
prefix delimited by a semicolon.

Create Material Points

enables the automatic creation of material points during import.

Import Solid Bodies

enables the import of solid bodies.

Import Surface Bodies

enables the import of surface bodies.

Import Line Bodies

enables the import of line bodies.

Import Work Points

enables the import of work points.

CAD Attribute Transfer

allows import of CAD system attributes into Ansys ICEM CFD.

CAD Attribute Prefixes

allows you to set the CAD attribute prefix when CAD Attribute Transfer is enabled. By
default the filter is set to SDFEA;DDM. If the filter is set to an empty string, all applicable
entities will be imported as CAD system attributes. You may enter multiple prefixes with
each prefix delimited by a semicolon.

Import Local Coordinate Systems

allows you to import a coordinate system, which may be used as a LCS, with your CAD
model.

Enclosure and Symmetry Processing

enables the processing of enclosure and symmetry named selections. This option is enabled
by default.

Mixed Import Resolution

allows parts of mixed dimension to be imported as components of assemblies which have
parts of different dimension. By default, no bodies from a multibody part will be transferred
to Ansys ICEM CFD. You can select the appropriate combination of bodies to be transferred
to Ansys ICEM CFD using the following options:
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Solid

solid(s) from the selected geometry's multibody part(s) are imported into Ansys
ICEM CFD.

Surface

surface(s) from the selected geometry's multibody part(s) are imported into Ansys
ICEM CFD.

Line

line(s) from the selected geometry's multibody part(s) are imported into Ansys ICEM
CFD.

Point

point(s) from the selected geometry's multibody part(s) are imported into Ansys
ICEM CFD.

Note:

The Mixed Import Resolution options are valid only for "real" CAD files (Parasolid,
UniGraphics, CATIA, etc.). For Ansys Workbench (*.agdb) files, only the primary
options (Import Solid Bodies, Import Surface Bodies, Import Line Bodies) are
valid.

Convert Units

allows you to scale the imported geometry/mesh based on the units specified. Default retains
the units and size as set in the Import Model Options (p. 109) page.

Note:

When importing geometry from SpaceClaim you should explicitly select the ap-
propriate units.

Import Geometry

Figure 18: Import Geometry Options

The Import Geometry option allows you to import geometry directly from various sources, including
several faceted geometry formats (Nastran, Patran, STL, or VRML) or CAD drawing packages (CATIA
V4, GEMS, Plot3D, Rhino 3DM). When you select the CAD software format of the geometry file you
want to import; a corresponding window will pop up with further options.
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Options for importing geometry are shown in Figure 18: Import Geometry Options (p. 24).

For detailed CAD-related information specific to Ansys Workbench, see the CAD Integration section
of the product help.

Faceted

Legacy

Formatted Point Data

Reference Geometry

Faceted

The Faceted submenu gives several options for importing faceted geometry.

Figure 19: Import Faceted Geometry

Options for importing faceted geometry are shown in Figure 19: Import Faceted Geometry (p. 25).

ICEM CFD Mesh

Nastran

Patran

STL

VRML

ICEM CFD Mesh

The ICEM CFD Mesh option allows you to import unstructured mesh file as triangulated surface
data. The volume elements in the mesh file will be ignored. Surfaces and curves are segmented
by part.

Note:

You can convert loaded mesh to facets using the Mesh>Facets (p. 58) option (Edit
> Mesh>Facets).

Nastran

The Nastran option allows you to import a Nastran surface mesh file (*.dat, *.bdf ) as triangulated
surface data.

Patran

The Patran option allows you to import Patran files (*.pat).
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Transfer family information

Multiple

converts each Patran group (PID) into an ICEM CFD part.

Single

brings the Patran groups all in as one part.

STL

The STL option allows you to import a Stereolithography Part file (*.stl) as triangulated surface
data. Note that the parts defined in the STL file will also be imported. Select the format for the
part names and click Done to finish the operation.

Part names

Generate

generates part names of the format Filename.PartName, where PartName is the
part name defined in the STL file.

From file

retains the part names as defined in the STL file.

Note:

This option is valid only for STL files in ASCII format. For STL files in binary
format, part names of the format Filename.PartName will be generated
as described.
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VRML

The VRML option allows you to import a VRML file as triangulated surface data (*.wrl).

Note:

You can only import VRML files in ASCII format. The import of binary VRML files
in not supported in Ansys ICEM CFD.

Legacy

This option allows you to import geometry from legacy CAD formats CATIA V4, GEMS, Rhino 3DM,
and Plot3d. Select the format of the geometry file you want to import; a corresponding window
will open with further options.

Figure 20: Import Legacy Geometry

A complete list of legacy geometry formats supported by ICEM CFD is viewable via the Ansys,
Inc. website (Support > Platform Support). See the Platform Support section of the Ansys Website,
download the CAD Support file, and refer to the Ansys ICEM CFD Direct Interface Support page.

Note:

Several options are directly available only on Linux. On Windows, you need a supple-
mental install and to enable beta options.

Tip:

Many newer formats are supported in the Import Model option using Workbench
Readers. If your model fails to read with the Ansys ICEM CFD Legacy option, try the
Import Model option instead.

Options for importing geometry are shown in Figure 20: Import Legacy Geometry (p. 27).

ACIS (Linux only)

CATIA V4

DWG (Linux only)

GEMS

IDI (Linux only)

ParaSolid (Linux only)

Rhino 3DM

Plot3d
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STEP / IGES (Linux only)

ACIS (Linux only)

The ACIS option converts an ACIS file (*.sat) to a Geometry file (*.tin) and loads it.

Note:

This option is available only on Linux. On Windows, it requires a supplemental install
and you need to enable beta options.

Tip:

The Import Model (p. 18) option includes readers for the latest releases of supported
third-party products and may be a better route to import ACIS models.

Select an ACIS file in the file browser window, and click Open.

The Import Sizes From Tetin File window will open where you can select a previously setup
version of the model, if available, and transfer parts and mesh parameters to the newly imported
geometry. This saves time that would have been spent setting up the new model.

Model / Family mesh params

are used to set global mesh settings.

Surface families, mesh params

will put the imported surface entities into parts (same as the original) and assign surface
based mesh parameters.

Curve families, mesh params

will put the imported curve entities into parts (same as the original) and assign curve
based mesh parameters.

Point families / Material families

will put the imported point or material entities into parts (same as the original). Point
and material entities do not support mesh parameters.

Note:

These surface/curve/point entity options are based on the entity names matching
between the source file and the imported file.

CATIA V4

The CATIA V4 option converts a CATIA file (*.model) to a Geometry file (*.tin) and loads it. Select
a CATIA file in the file browser window, and click Open. This will open the Import Geometry
from Catia window.
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Figure 21: Import Geometry From Catia Window

Tetin file

Select the required path to store the Geometry file (*.tin) by clicking on the file browser
icon.
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In/Out Filters

CATIA Input

Four CATIA input filters are provided here. By default the SHOW area is converted
and the entities located in the NOSHOW area are ignored. Both PICK and NOPICK
are usually enabled.

File Output

Suppresses specific entity classes, which are of no further importance for Ansys
ICEM CFD. Often CATIA models contain a lot of points and curves, which slow
down the GUI and may even have to be deleted before meshing. Therefore, NO
POINTS and NO CURVES are enabled by default while NO SURFACES is disabled by
default.

Use CATIA Layer Filter

allows you to enter specific layer numbers to import. For instance specifying "17, 18"
for Filter args would only import entities in these two layers and leave out other layers
which may only contain construction geometry or the 2D drawing.

Other Options

The Preview option results in a roughly approximated conversion of the CATIA model
with a large Triangulation Tolerance. Although approximation slows down the conver-
sion, the resulting Tetin file is usually smaller and can be processed faster.

Sometimes trimming 2D boundary curves of CATIA faces exceeds the boundary of the
underlying surface a little. These faces are suppressed by default. These suppressions
are reported in the message window and if you want to force those faces to be con-
tained in the Tetin file then you need to enable the Ignore Range Errors option.

To extract all boundary curves into the Tetin file you should enable With Boundary
Curves.

Note:

This option conflicts with the No Curves option so the latter should be dis-
abled.

Note:

This option may require a longer time to complete.

If Loops instead of Faces is enabled, planar faces are written as loops instead of
Bspline surfaces in the Tetin file. Loops are easily meshed using the Shell Mesher.
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Create Bounding Box  will create a box around the converted model. The bounding
box is automatically assigned a special part name.

Note:

This option may require a longer time to complete.

If the faces of polyhedral solids in their original state are too complex to be represented
by an unstructured domain, then by default they are represented by planer Bspline
surfaces. If the Mesh polyhedral solids  option is enabled, the surface mesher is in-
voked to convert complex shaped faces of polyhedral solids into an unstructured do-
main entity.

Estimate Maximum Size  estimates the maximum size from the model dimension in-
stead of using an infinite large value.

Take Layer from Shell/Skin/Solid only imports entities from layers containing these
entity types. When enabled, it will not import entities from layers containing only
curves or points.

Transform to active Axis System transforms geometry to the active local coordinate
system.

Part Naming

You can select from the given four options:

Default

will directly transfer all the information of the CATIA model to the Tetin file.
It will make the whole model into one part.

Part by Layer

will write a Tetin file by the layers defined in the CATIA. Entities kept in the
same layers will be transferred into the same part.

Part by Color

will work the same way as layers. But it will translate the entities into part by
color type instead of layer.

CATIAMIF-Parts

is chosen if the CATIAMIF interface was used on the CATIA model. It will give
the name of the parts and mesh parameters set to the part defined by the
CATIAMIF interface.

Entity Naming

This option is useful for giving names to the entities and parts.
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Default

will write names as set in default.

CATIA-Names

will translate entities into Tetin files with the same names as defined in the
CATIA files.

CATIAMIF-Names

is applicable if the CATIAMIF interface was used on the CATIA model. It will
give the name of the parts as defined in the CATIAMIF interface.

Triangulation tolerance

sets up the global triangulation tolerance in Ansys ICEM CFD (Settings > Model). This
affects how the nurbs are rendered. It also affects mesh projection. Finer tri tolerance
means slower rendering but more accurate projection. (Refer to Figure 70: Examples
of Triangulation Tolerance (p. 95) for more information.)

DWG (Linux only)

Note:

This option is available only on Linux. On Windows, it requires a supplemental install
and you need to enable beta options.

The DWG option converts a DWG (AutoCAD Drawing) file to a Tetin file and loads it (Only 2D
geometries).

Selecting the DWG option pulls up a file browser. Select the DWG file (*.dwg, *.dxf ) to be im-
ported and click Open to start translator.

Another window will appear, where you have to specify path and name of the Tetin file which
is converted from DWG file. After supplying the name and path, click Open to end the process.

GEMS

The GEMS option converts a GEMS file to a Tetin file and loads it.

Select the GEMS file to be imported and click Open to open the window shown below.
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Figure 22: Import Geometry from GEMS window

Tetin File

select the required path to store the Tetin file by clicking on the icon.

Tri Tolerance

takes a default value of 0.001 if not otherwise specified.

Unitless

if enabled, the exact unit of Gems geometry is not transferred to the Tetin file.

IDI (Linux only)

Note:

This option is available only on Linux. On Windows, it requires a supplemental install
and you need to enable beta options.

The IDI option allows you to import IDI files. Select the IDI geometry file to import. The following
options are available for importing IDI geometry files.
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Figure 23: Import Geometry From IDI window

Single Tetin File

creates one Tetin file for the IDI file. If this IDI file is an assembly file, then the Tetin file will
contain all the parts.

Tetin File Per Part

creates one Tetin file for each part. If the IDI file is an assembly file, and Create/Load as-
sembly tetin is enabled, then the Tetin file is also created for the entire assembly and is
loaded into the GUI.

Part Naming

specifies whether part names or numbers are used.

Create/Load assembly tetin

if enabled, the assembly Tetin file will be created and loaded.

Merges multiple instances

if enabled, multiple instances of a part will be merged in one part file.

Import as faceted geometry

The IDEAS CAD data is high quality Bspline data. This is usually preferable, but this can add
up to a large amount of data for large models. If this option is enabled, it will convert it to
faceted data on import. This option is not recommended for use with patch based methods.
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Disable group to part mapping

disables group to part mapping in the Tetin file.

ParaSolid (Linux only)

Note:

This option is available only on Linux. On Windows, it requires a supplemental install
and you need to enable beta options.

The ParaSolid option converts a Parasolid model to a Geometry file (*.tin) and loads it.

The following options are available:

Figure 24: Import Geometry from Parasolid window

Parasolid File

specifies the Parasolid file.

Tetin File

specifies the output Tetin file.

Units

specifies the appropriate units of the geometry.
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Rhino 3DM

The Rhino 3DM option converts a Rhino file (*.3dm) to a Geometry file (*.tin) and loads it. The
following options for this conversion are available:

Geometry

By default all the entities in the Rhino file will be imported. If Selected Geometry is clicked,
then entities of different types can be specified for import:

• Points

• Curves

• Surfaces

• Solids

This refers to manifold Boundary Representation (B-rep) solids.

• Meshes

This refers to tessellated (STL-type) data.

Use Object Names for Parts

In Rhino, each object (point, curve, surface, etc.) may have a name associated with it. En-
abling this option will use the Rhino object name as the Part Name. By default the name
of the layer on which the object resides is used.
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Include Hidden Layers

Enabling this option will import objects on hidden layers. By default, objects on hidden
layers will not be imported.

Split Composite Curves

If enabled, composite curves will be split into their component curves and imported, instead
of as a single curve.

Include B-rep Surface Trim Curves

If enabled, the 3D spatial curves associated with the 2D parametric trim curves or a surface
will be generated and imported, otherwise only the trimmed surface is imported.

Plot3d

The Plot3d option converts a Plot3d file to a Geometry file (*.tin) and loads it.

Figure 25: Import Geometry from Plot3d window

Describe Plot3D File Content

User Input allows you to specify file parameters.

Input type

Specify the input type. Windows_unformatted type refers to unformatted Plot3d meshes
created on Windows. This option allows Unix platforms to read these files as well.

Number of blocks

Specify whether there is a single block or multiple blocks.

Precision

Specify either single or double precision.
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Data layout

Specify whether data layout is in planes or not.

Include IBLANK array

Specify whether to include or omit IBLANK array.

Swap byte order

To toggle compatibility between platforms with little-endian or big-endian data storage.

STEP / IGES (Linux only)

Note:

This option is available only on Linux. On Windows, it requires a supplemental install
and you need to enable beta options.

The STEP/IGES option converts a STEP/IGES file to a Geometry file (*.tin) and loads it.

The following options are available for importing STEP/IGES geometry.

Figure 26: Import Geometry from Step or IGES window

Tetin File

specifies the required path to save the Tetin file by clicking on the icon.

Use Version 5.1 Step Translator

allows you to translate the file using Ansys ICEM CFD 5.1 parameters.

Create part name from STEP/IGES file

If multiple STEP/IGES files are opened at once, this option will create the part names
in the converted geometry file from the STEP/IGES files.
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Merge geometry files after conversion

If multiple STEP/IGES files are opened at once, this option will merge the multiple
geometry files after conversion.

Ignore units

if enabled, the units specified in the import file will be disregarded and meters are
assumed to be the length unit.

Use healing

if enabled, the Parasolid Kernel attempts healing on the IGES geometry (bodies, surfaces,
and loops) before sending it to the IGES translator.

Formatted Point Data

The Formatted point data option is used to create an Ansys ICEM CFD geometry surface from
a file containing Bspline data.

The Import Formatted INPUT point data DEZ is shown, where you can open the Select File
window and provide names for the geometry parts created.

Figure 27: Import Geometry from Formatted Point Data window

The syntax for each surface's data is presented in the following example. The first line contains
two numbers - the number of points for each curve and the number of curves for each surface.
The remaining lines are the coordinates for the points that define the surface, one point per line.

6 5

0.0000000 0.009060410 -0.5980142

0.1037449 0.08676791 -0.5980142
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0.2252334 0.1319692 -0.5980142

0.3546632 0.1250788 -0.5980142

… for thirty total points.

The surface created by this example point data is shown.

Reference Geometry

The Reference Geometry option allows you to use an existing Tetin file as a reference to map
the mesh setup and other parameters to the loaded geometry file. This is important in parametric
modeling, as the setup that is done for one Tetin file can be reused for subsequent design changes.

The parameters that will be read from the reference geometry file include:

• Global Meshing parameters

• Entity meshing parameters

• Prism meshing parameters

• Part names of entities

• Dormant curves and points

• Density regions

• Connector definitions

• Geometry subsets

• Periodicity
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Import Mesh

Figure 28: Import Mesh options

The Import Mesh menu allows you to import mesh from the following formats:

From Ansys

From Abaqus

From CFX

From CGNS

From Fluent

From LS-DYNA

From Nastran

From Patran

From Plot3d

From Starcd

From STL

From TecPlot

From UGrid

From Vectis

From Ansys

The From Ansys option allows you to import an Ansys mesh file into Ansys ICEM CFD. Select a
*.cdb file to import.

From Abaqus

The From Abaqus option allows you to import an Abaqus mesh file into Ansys ICEM CFD.

From CFX

The From CFX option allows you to import a CFX5 mesh file into Ansys ICEM CFD.
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After selecting the CFX5 *.def file, you need to choose the translation option shown below.

Figure 29: Import CFX Options

Set Face Parts from

BC Patches

creates a Part for each different boundary condition (inlet, outlet, wall, Domain-Interface-
1-side-1, etc.) as shown in Figure 30: Set Face Parts from BC Patches Option (p. 42).

Figure 30: Set Face Parts from BC Patches Option

Surfaces

creates a part from each surface (surface 1, surface 2, etc.) as shown in Figure 31: Set Face
Parts from Surfaces Option (p. 43).
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Figure 31: Set Face Parts from Surfaces Option

Click Done to complete the process.

Note:

CFX5 mesh import disallows duplicate nodes and faces. Internal walls should not be
split, because this introduces duplicate nodes and faces and the connectivity between
the faces may be incorrect. Use Reorient Mesh > Reorient Consistent on all thin surfaces
prior to export to avoid inconsistencies in the orientation of face elements.

From CGNS

The From CGNS option allows you to import a CGNS mesh file into Ansys ICEM CFD. You need
to specify whether the input mesh file is structured or unstructured mesh.

From Fluent

The From Fluent option allows you to import a Fluent mesh file into Ansys ICEM CFD. Select a
*.cas or *.msh file to import.

Recognized element types include linear or quadratic hexas, prisms, tetras, quads, tris, or bars.
Other element types, such as polyhedra, are not recognized.

From LS-DYNA

The From LS-DYNA option allows you to import an LS-DYNA mesh file into Ansys ICEM CFD.
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Figure 32: Import LS-DYNA Options

Import include files as

INCLUDE files can be read in as links or as actual data.

Note:

If the INCLUDE files are read in as data, they will be written to the assembly
file and the original file structure will not be preserved.

Note:

Any unsupported LS-DYNA cards will be written to a temp file named "unsuppor-
ted.k" in the working directory, and will be appended to the input file of this
project if it is written out.

From Nastran

The From Nastran option allows you to import a Nastran mesh file into Ansys ICEM CFD.

Figure 33: Import Mesh from Nastran Options

From Patran

The From Patran option allows you to import a Patran mesh file into Ansys ICEM CFD.
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Figure 34: Import Mesh from Patran Options

Transfer family information

Multiple

converts each Patran group (PID) into an ICEM CFD part.

Single

brings the Patran groups all in as one part.

From Plot3d

The From Plot3d option allows you to import a Plot3d mesh file into Ansys ICEM CFD.

Plot3d files do not provide a topology, so Ansys ICEM CFD will recompute a topology. Mesh will
be converted to an unstructured mesh by default. The subfaces, edges, and vertices belonging
to the recomputed topology will added to separate parts.

From Starcd

The From Starcd option allows you to import a STAR-CD mesh file into Ansys ICEM CFD. Select
any one of the *.cel, *.vrt, or *.inp files with the same file name.

From STL

The From STL option allows you to import an STL mesh file into Ansys ICEM CFD. Note that the
parts defined in the STL file will also be imported. Select the format for the part names and click
Done to finish the operation.

Part names

Generate

generates part names of the format Filename.PartName, where PartName is the
part name defined in the STL file.
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From file

retains the part names as defined in the STL file.

Note:

This option is valid only for STL files in ASCII format. For STL files in binary
format, the part names of the format Filename.PartName will be generated
as described.

From TecPlot

The From TecPlot import filter allows you to read CFX files and convert the mesh data to Ansys
ICEM CFD unstructured mesh.

From UGrid

The From UGrid import filter allows you to read *.ugrid files in ASCII format and convert the
mesh data to Ansys ICEM CFD unstructured mesh.

From Vectis

The From Vectis option allows you to import a Vectis mesh file (*.sdf ) into Ansys ICEM CFD.

Note:

This option is available only on Linux systems.

Export Geometry

Figure 35: Export Geometry Options

The Export Geometry option allows you to export geometry in the following formats.

To IGES

To Parasolid

To Rhino 3DM

To STL

To IGES

The To IGES option allows you to export geometry in IGES format. After selecting To IGES, select
the geometry file (*.tin) that you want to export in the Select tetin file window.
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Figure 36: Export to IGES File

After selecting the geometry file, supply the name and the path of for the IGES file and click Save
in the Select iges file window to complete the export process.

Note:

Faceted data cannot be exported to an IGES file. If faceted data is found in the geometry
file, it will not be translated.

To Parasolid

The To Parasolid option converts geometry in Ansys ICEM CFD to a Parasolid file.

Select To Parasolid and then select the tetin file to export in the Select tetin file window. After
selecting the geometry file, supply the name and the path of for the Parasolid file and click Save
in the Select ps file window to complete the export process.

Files with an asterisk (*) indicates these files are OK to select.

Note:

Faceted data cannot be exported to a Parasolid file. If faceted data is found in the geo-
metry file, it will not be translated.
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To Rhino 3DM

The To Rhino 3DM option converts geometry in Ansys ICEM CFD to a Rhino 3DM file format
(*.3dm). Select the geometry file (*.tin) to be exported. The following options are available.

Geometry

By default all the entities in the geometry file will be exported. If Selected Geometry is clicked,
then entities of different types can be specified for export:

• Points

• Curves

• Surfaces

• Meshes

Units

Specify the units of measurement of the file.

Tolerance

This is the absolute tolerance value passed to the Rhino file. It is used in Rhino for operations
such as trimming and intersecting.
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Include Dormant Entities

By default, any dormant entities (typically points and curves) created will not be exported to
Rhino. If this option is enabled, the dormant entities will also be exported.

Do Not Trim Surfaces

If this option is enabled, any trim curves are removed, so that trimmed surfaces will be exported
to Rhino as untrimmed.

Rebuild Coedges

If enabled, the coedges (3D spatial curves) will be rebuilt from the 2D parametric curves (pcurves)
by projection prior to exporting. This sometimes improves the quality of the exported 3DM file,
particularly when the Tetin file has relatively large tolerances.

Version 2 Compatibility

The default will export the data to a Version 3 3DM (Rhino) file, which cannot be read by Rhino
Version 2.xx. If this option is enabled, then the 3DM file will be version 2 compatible.

To STL

The To STL option converts geometry in Ansys ICEM CFD to the STL format. Select the appropriate
file format and click Done to finish the operation.

File format

specifies the format for the STL file.

Ascii

exports the STL file in ASCII format.

Binary

exports the STL file in binary format.

Replay Scripts

Ansys ICEM CFD makes it possible for you to write your own specialized scripts to customize Ansys
ICEM CFD or run complex operations in batch mode. ICEM CFD scripts are based on a variation of
the Tcl/Tk language. Details of commands specific to ICEM CFD plus basic scripting information can
be found in Ansys ICEM CFD Programmer's Guide.

The Replay Scripts menu item opens a submenu of options as shown in Figure 37: Replay Op-
tions (p. 50).
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Figure 37: Replay Options

Replay Control

This option helps you create script files by performing operations in Ansys ICEM CFD and recording
the equivalent Tcl/Tk commands in a Replay file. You can modify or run this Replay file as a script
file. This gives users unacquainted with Tcl/Tk an option to also use scripting.

The Replay control window can be minimized at any time.

Note:

If you are using Ansys ICEM CFD in Workbench and want to step through Workbench
Input Parameters you have created, you must open the Workbench Replay Control
from the One-click menu. For more information, see Interface Differences in the Data-
Integrated ICEM CFD in the Workbench User's Guide.

Record (after current)

Toggles between Record mode and Edit mode.

Record mode

Commands will be sequentially numbered and appended to the list in the Replay Control
dialog box.

The example shown in Figure 38: Replay Control Window - Record Mode (p. 51) contains
the script commands recorded while performing the following operations in Ansys ICEM
CFD.

With no geometry loaded, perform

Geometry → Create Point → Screen Select

New part name is GEOM.

Screen select a location.

Screen select a second location.

Screen select a third location.

Click Apply.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.50

Main Menu Area



Figure 38: Replay Control Window - Record Mode

Edit mode

Line numbers are turned off and the Replay Control dialog box becomes a simple text
editor. You can load or save a script file; undo or redo changes; and cut, copy, and paste
command lines using the icons or menus. The Edit menu also contains Search and Replace
commands.

The ICEM CFD window and the Do one / Do all / Do range / Skip controls remain active
so you can verify the script commands as you edit.

When you switch back to Record mode, all commands will be renumbered sequentially.
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Figure 39: Replay Control Window - Edit Mode

Yellow highlighting indicates the current line being edited, as well as the location from
where the replay would start if using Do one as described below.

Edit mode (Line: nn) indicates the line in the replay that is highlighed. If you click text
in another line, the new line will be highlighted and the new line number will be indicated.
This could be used with Do range as described below.

All commands

To record all the commands that you or Ansys ICEM CFD performs, toggle this option ON.

Do one

While running the script, clicking this button will perform only one step, or one line of the
Replay file.

Do all

Ansys ICEM CFD will run the whole Replay file when this option is selected.
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Do Range

To run a specific subset of the commands in the Replay file, select this option. The Replay
Range window opens where you select the Start line and End line numbers, as shown in Fig-
ure 40: Replay Range window (p. 53).

Figure 40: Replay Range window

Skip

To ignore the command line where the cursor lies, select this option. The cursor will move to
the next line.

Load

To open a previously stored Replay file (*.rpl) in the Replay Control window, select this
option. The File Selection window opens where you choose the Replay file to be loaded.

Save

Saves the Replay file in a location specified in the File selection window.

Edit

Opens a text editor window where you can modify the existing Replay script. The application
prompts you to save your work when you close the editor.

The choice of editor is determined in the General (p. 75) dialog box. If you use the internal
editor,

• It will open at the current line in the Replay control dialog box.

• Any changes, including line numbers, are synchronized between the editor window and
the Replay control dialog box.

• Saving the file in the editor will also renumber and update the contents of the Replay
control dialog box.

• The editor window can be minimized, allowing you to work in ICEM CFD. Clicking Edit will
bring the editor window back to the foreground and jump to the current line.

Insert

Inserts one line in the script so that you can enter comments or commands.
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Delete one

Removes the selected line of command from the Replay file.

Delete all

Clears all the commands from the Replay Control window.

Delete range

Deletes a specific range of commands from the Replay file.

Renumber

If you have added or deleted commands manually, this button re-sequences the command
line numbers.

Always update

Updates the model after each step. When this is disabled, the replay script will be run in batch
mode and the model will be updated at the end. You can enable this option to see the step
by step updates, however, you can disable it to more rapidly generate the model.

Ignore errors

When disabled (default), the replay control will stop executing the replay script when an erro-
neous command is reached. When enabled, the replay control will skip the erroneous command
and continue to execute the subsequent commands in the replay script.

Stop

Halts an ongoing Replay of your script file.

Clean

This option simplifies a replay recording by deleting unnecessary lines. The determination of
which lines are unnecessary is performed by the Edit Filter. You should Renumber after
Clean. See Figure 41: Replay Control window After Clean (p. 55) where two lines have been
removed, including line number 3.

Tip:

• You can right-click in the Replay Control window and select Undo Clean to
reverse the latest clean action.

• You can right-click in the Replay Control window and select Edit Filter to add
to, or remove from, the list of commands deleted by Clean. Right-click a second
time to return to the normal replay scripting window.
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Figure 41: Replay Control window After Clean

Note:

If an Undo action was performed while recording the Replay file, then you need
to manually remove the appropriate lines from the script (starting with
undo_begin and ending with the undo_end command). The Clean filter does
not take care of this.

Done

Closes the Replay Control window. The application prompts you to save the Replay file before
closing the window if it is not saved.

Load script file

The Load script file option opens a dialog box where you select a replay script file (*.rpl) to
display in the Replay Control window.

Run from script file

The Run from script file option opens a dialog box where you select a previously written script
and initiate automatic replay.

Note:

The set of functions that begin with the letters ic_, as documented in the Programmer’s
Guide, are used to perform all the operations in ICEM CFD.

Note:

Reading through the tcl files in $ICEM_ACN/bin/med and using undocumented functions
is not recommended because they might change at any time.
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Recording scripts

This option performs the same function as the Record (after current) check box.

Exit

The Exit option closes the Ansys ICEM CFD application. The application prompts you to save any
new work in your project.

Edit Menu

Figure 42: Edit menu

The Edit menu has the following options:

Undo

Redo

Clear Undo

Shell

Facets > Mesh

Mesh > Facets

Struct Mesh > CAD Surfaces

Struct Mesh > Unstruct Mesh

Struct Mesh > Super Domain

Shrink Tetin File
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Undo

The Undo option undoes the last operation. For a few operations like smoothing, refinement,
coarsening, conversion, etc., where the whole mesh is changing, only one Undo operation is possible.

Note:

Operations related to display cannot typically be undone.

Note:

When using Undo for blocking operations, the index control may be affected because the
active state of the index control may be modified by the Undo operation.

Redo

The Redo option redoes the previous Undo operation. You can only redo operations that have been
undone.

Note:

Once a new command is performed; all operations undone are lost from the undo/redo
history.

Clear Undo

The Clear Undo option clears up the memory used by the Undo history. This option is most useful
after performing an operation (such as "Add to Part", "Change Type", or "Split/Redistribute Prisms")
on a large number of elements because the Undo needs to store the state both before and after the
operation in memory.

Note:

The Clear Undo option frees up the memory for further operations, but you will not
be able to undo the particular operation any more.

Shell

The Shell option opens a new terminal in the current working directory.

Facets > Mesh

The Facets > Mesh option will convert the faceted geometry data into unstructured mesh format.
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Mesh > Facets

The Mesh > Facets option will convert unstructured mesh format into faceted geometry data.

Struct Mesh > CAD Surfaces

The Struct Mesh > CAD Surfaces option will convert structured mesh format into CAD surfaces.

Struct Mesh > Unstruct Mesh

The Struct Mesh > Unstruct Mesh option will convert structured mesh format into unstructured
mesh format.

Struct Mesh > Super Domain

The Struct Mesh > Super Domain option will convert structured mesh format into a superdomain
file. In the popup window that appears, highlight the domains with the specified project prefix that
are to be converted to a superdomain.

Shrink Tetin File

The Shrink tetin file option removes header lines, comment lines, and unnecessary definitions in the
Tetin files, which can reduce the size of the Tetin file significantly. The comment lines include the
date and software version of the last modification.

Selecting this option will automatically open a browser window. Select the desired Tetin file. The
number of lines removed will appear in the message window. From the browser window, you can
either save the file with a new name or overwrite the original file.

View Menu

The View menu contains options for choosing different orientations of the model in the graphics display.

Figure 43: View Options
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The different options are shown in Figure 43: View Options (p. 58).

Fit

Box Zoom

Top

Bottom

Left

Right

Front

Back

Isometric

View Control

Save Picture

Mirror and Replicates

Annotation

Add Marker

Clear Markers

Mesh Cut Plane

Fit

The Fit option scales the model so that it fits in the graphics window.

Box Zoom

The Box Zoom option will prompt you to click and drag a rectangular region which is then zoomed
in to fill the graphics window.

Top

The Top option orients the model so that you see it parallel to the XZ-plane, looking from the positive
Y-axis.

Bottom

The Bottom option orients the model so that you see it parallel to the XZ-plane, looking from the
negative Y-axis.

Left

The Left option orients the model so that you see it parallel to the YZ-plane, looking from the negative
X-axis.
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Right

The Right option orients the model so that you see it parallel to the YZ-plane, looking from the
positive X-axis.

Front

The Front option orients the model so that you see it parallel to the XY-plane, looking from the
positive Z-axis.

Back

The Back option orients the model so that you see it parallel to the XY-plane, looking from the neg-
ative Z-axis.

Isometric

The Isometric option orients the model so that you see a 3D pictorial representation of the model
is shown.

Tip:

One of the six orthographic views or the isometric view may be easily selected by clicking
on one of the points of the Display Triad in the graphics window.

View Control

The View Control options allow you to save or edit the current view.

Figure 44: View Control Options

Save Current View

allows you to save the current view.

Edit/Load/Save Views

allows you to edit and save different views. You can save the views to an external file for use with
any project. The views can also be saved with the current project file when the Automatically
Save Views to Project option in the Settings - General DEZ is enabled (see the General (p. 75)
section). The View Control appears in the bottom-right corner of the screen.

Save Picture

The Save Picture option allows you to save different views of the model in different picture formats.
The format can be selected from the Save Picture DEZ shown in Figure 45: Save Picture DEZ (p. 61).
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Figure 45: Save Picture DEZ

Output Prefix

specifies the name of the picture file you want to save in the current directory (where project file
exists). Alternatively, you can browse to any other directory by clicking on the icon.

Generate new file names

toggles the generation of output files with new names each time the function is used.

Format

specifies the picture format. You can select any of the following picture formats: PostScript, PS
from screen, PPM, X11, TIFF, GIF, JPEG, and VRML.

The following options are available for the PS from screen, PPM, X11, TIFF, GIF, and VRML formats:

Invert black and white

controls the foreground/background color. When enabled, the background color in the saved
image will be changed from black to white.

Landscape mode

controls the orientation of the saved image. When enabled, the image will be saved in land-
scape mode; else the image will be saved in portrait mode.

Scale Factor

scales the image taken with respect to the actual size appearing in the graphics window. Ex-
ample: A Scale Factor of 2 doubles the size of the picture taken.

Quality (for JPEG format only)

specifies the quality level, which will determine the file size.
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Figure 46: PostScript Format Options

The following options are available for the PostScript format:

PS Type

specifies the PS type. The PS format is suitable for operating systems other than Windows,
like UNIX. The EPS format is suitable for the Windows operating system.

PS Mode

specifies the color mode for the image saved. Color maintains the actual colors of the picture.
Gray converts all the colors to gray scale. Mono converts the picture to black and white.

Include Frame

shows the border of the picture in a different color than the background.

Title (top)

specifies the title for the image. This can be viewed at the top of the postscript file.

Label (bottom)

specifies the label which will appear at the bottom of the postscript file.

Send to printer

allows you to print the picture after saving.
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Mirror and Replicates

The Mirrors and Replicates DEZ contains options that allow you to create a mirror image of a model.

Note:

Mirrors and replicates are not real objects. They are only for display purposes and therefore
cannot be selected or have operations performed on them.

Figure 47: Mirrors and Replicates DEZ

X, Y, Z Mirror

contains options for defining the mirror plane. You can use the standard defined mirror planes
(normal or outward in the X, Y, or Z directions) or define a specific plane in the required direction
using the Modify specific mirror dialog (seeFigure 48:Modify specific mirror Dialog (p. 63)).

Figure 48: Modify specific mirror Dialog

Replicate by rotating with

enables the creation of replicates by rotation. Specify the Center, Axis, and Angle of rotation to
create the replicates.
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Replicate by translating

enables the creation of replicates by translation. Specify the distances in the X, Y, and Z directions
for the translation.

Times

indicates the number of replicates.

Annotation

Annotations are graphical objects (such as thumbnail pictures or some explanatory text) that are
defined independently of the data being displayed, and are generally fixed in position in the window.

Figure 49: Annotations Options

The available annotation options are as follows:

Add in the current window

Modify by selecting

Pick and move

Pick and remove

Reset mouse

Add in the current window

The Add in the current window option allows you to add annotations to the displayed data.

Figure 50: Create/Modify Annotation window
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Create

allows you to create the following types of annotations:

• Text

• Utf Text

• Lines

• Box

• Circle

• Polygon

• Marks

• Image

• Colormap Bar

The options available are:

Text font

specifies the font size to use for text annotations.

Line width

specifies the line width, in pixels, used for drawing line, circle, box, and polygon annota-
tions.

Arrow type

determines whether an arrow will be drawn at the start and/or end points of the line.

Symbol type

specifies the type of symbols used in mark annotation.

Symbol size

specifies the size of marker annotations.

Color

specifies the color of the annotation.

Fill

enables the filling of box, circle, polygon, and mark annotations.
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Modify by selecting

The Modify by selecting option allows you to modify features of specific annotations, such as size,
text, color, and font.

Pick and move

The Pick and move option allows you to pick and move specific annotations.

Pick and remove

The Pick and remove option allows you to pick and remove specific annotations.

Reset mouse

The Reset mouse option allows you to reset the mouse.

Add Marker

The Add Marker option allows you to display text in the GUI using the Add marker dialog (see Fig-
ure 51: Add Marker Dialog (p. 66)).

Figure 51: Add Marker Dialog

Position

specifies the coordinates for the position of the marker.

Select

allows you to select the position of the marker from the existing geometric information.

Text

specifies the text to be displayed as a marker.

Accept

creates given text at a given location as a marker.

Reset

resets the position and text to the previously created marker.
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Cancel

cancels the command and closes the Add Marker dialog.

Help

launches the Help manual.

Clear Markers

The Clear Marker option allows you to clear all the created markers from the GUI.

Mesh Cut Plane

A cut plane is used to visualize results on a plane cut through the three dimensional model. Results
are viewed on the cut plane as well as on the 2D Dynamic window. The cut plane may be defined in
several ways depending on the application. These options are described here in detail.

Figure 52: Manage Cut Planes DEZ
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Show Cut Plane

enables the display of the cut plane.

Show whole elements

If enabled (default), the cut plane is shown as complete elements. If disabled, the cut plane is
shown as a zero-thickness slice.

Reset Cut Plane

recalculates the extent of the visible mesh and recreates the cut plane. Use this button to ensure
the cut plane can be swept through the entire visible mesh if part visibility is enabled or disabled
when the cut plane is active.

Method

contains options for defining the cut plane.

By Coefficients

defines the cut plane by the equation of the normal vector. The equation is of the form: Ax
+ By + Cz + D = 0. Specify the coefficients A, B, C, and D in the fields Ax , By, Bz, and D.

By Point and Normal

defines the cut plane by a point and the normal. Specify the Global Cartesian coordinates in
the X, Y, and Z direction for the point (Pn ) and the X, Y, and Z components of a unit vector
normal to the desired cut plane (NX, NY, and NZ).

By Corner Points

creates a cut plane passing through the three specified points. You can enter the Cartesian
coordinates for Pt1, Pt2, and Pt3.

By 3 Points

creates a cut plane passing through the three locations selected.

Move or Rotate

allows you to interactively move and/or rotate a previously defined cut plane. Use the left
mouse button to rotate the cut plane about the normal axis and the middle mouse button
to move the cut plane. Click the right mouse button to end the interactive movement of the
cut plane.

Middle X plane

positions the cut plane at the middle of the geometry in the X-direction.

Middle Y plane

positions the cut plane at the middle of the geometry in the Y-direction.
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Middle Z plane

positions the cut plane at the middle of the geometry in the Z-direction.

Fraction Value

specifies the location of the plane.

Display back plane

enables the display of the back plane.

Draw plane normal

enables the display of the normal direction of the plane.

Draw plane border

enables the display of the border of the back plane.

Color

specifies the color of the back plane. To select a different color, click the color bar and select a
color from the menu that appears.

Create mesh subset

creates a mesh subset of cut plane elements.

Info Menu

The Info menu provides useful information related to the model like curve length, node information,
distance between two points, etc.

Figure 53: Info Options

The options available are as follows:

Geometry Info

Surface Area
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Frontal Area

Curve Length

Curve Direction

Mesh Info

Mesh Area/Volume

Element Info

Node Info

Element Type/ Property Info

Toolbox

Project File

Domain File

Mesh Report

Geometry Info

The Geometry Info option prints the dimensional units along with the number of surfaces, curves,
geometry points, solids, and parts that exist in the model, in the message window.

Surface Area

The Surface Area option prints information (like surface names, total area, etc.) for the selected surfaces
in the message window.

Frontal Area

The Frontal Area option prints information about the area of the model in front of the screen in the
message window.

Curve Length

The Curve Length option prints information (like curve name, curve length, etc.) for the selected
curves in the message window.

Curve Direction

The Curve Direction option will prompt you to select curves. The curve direction will be displayed
for each selected curve. The curve direction is the direction of increasing curve parameter, from 0 to
1.

Note:

The curve direction can be reversed using the Reverse Direction option in the
Modify Curve(s) DEZ. Curve direction may affect some meshing and geometry func-
tions that utilize curve end locations.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.70

Main Menu Area



Mesh Info

The Mesh Info option prints the following information about the mesh in the message window:

• Total number of elements

• Total number of nodes

• The minimum (Min) and maximum (Max) coordinates of the bounding box

• Number of elements by type

• Number of elements by parts

• Maximum edge sides

This is the maximum edge distance between nodes of the mesh. The nodes will be placed in the
subset that is listed.

• Minimum edge sides

This is the minimum edge distance between nodes of the mesh. The nodes will be placed in the
subset that is listed.

Mesh Area/Volume

The Mesh Area/Volume option prints the area and volume of the mesh elements by type, and the
total area and volume in the message window. For example:

Area of 5534 TRI_3 is 6
Total Area is 6.0
Volume of 10442 TETRA_4 is 0.358048
Volume of 4040 PENTA_6 is 0.590489
Volume of 314 PYRA_5 is 0.051463
Total Volume is 1.0

Note:

Ansys ICEM CFD is essentially unitless. The area and volume values reported in the message
window are the square and cube, respectively of the length units in Ansys ICEM CFD. For
example, if the length units are in meters, the values represent square meters for area and
cubic meters for volume.

The length units can be set in the Model/Units  (p. 93) DEZ.

Element Info

The Element Info option prints the following information for the selected elements in the message
window:

• Number of elements selected

• Element type
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• Element part

• Node numbers

• Element Thickness (for surface elements)

• Mesh Quality (for mesh elements, if Quality metrics are selected under Settings > Meshing >
Quality Info)

If more than one element is selected, the information for each element is printed out in the message
window.

Node Info

The Node Info option prints the following information for the selected nodes in the message window:

• Number of nodes selected

• Node number

• Node dimension

• Node coordinates

• Thickness at node (for surface elements)

• Mesh Quality (for mesh elements, if Quality metrics are selected under Settings > Meshing >
Quality Info)

If more than one node is selected, the information for each node is printed out in the message window.

Element Type/ Property Info

The Element Type / Property Info option prints information about element types and defined ma-
terial properties in the message window.

Toolbox

The Toolbox option will open a window in the lower right hand corner of the GUI that includes a
calculator, notepad, unit conversion tables, and a variables/parameters window.

Note:

Variables may be used instead of numerical values in scripts and geometry creation
functions.

Project File

The Project File option prints information regarding the project file in the message window.
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Domain File

The Domain File option prints information about the domain file in the message window.

Mesh Report

The Mesh Report option allows you to generate a mesh quality report using the options in the Mesh
Quality Report DEZ.

Figure 54: Mesh Quality Report DEZ

Mesh report file name

specifies the name of the mesh report file.

Title

specifies title of the mesh report project.

Author

specifies the author of the project.

73
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Info Menu



Write summary

enables the writing of the summary for the mesh.

Mesh types

contains options to report available mesh statistics for all or selected element types.

All

reports available mesh statistics for all available element types.

Select

limits the mesh statistics report to only check the selected element types.

Quality

Write quality

enables the writing of the quality for the mesh.

All existing quality types

enables the writing of the quality report for all existing quality types for the mesh. The list of
quality measures reported is dependent on the loaded mesh. This option is disabled by default.
When disabled (default), the mesh report will include the quality report for only the Quality,
Determinant, Aspect Ratio, Min angle, Max ortho, Max warp, Max warpgls, and Skew
measures.

Write diagnostics

enables the writing of the diagnostics for the mesh.

Settings Menu

The Settings menu contains options that allow you to change the default settings of display, memory,
speed, etc.
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Figure 55: Settings Options

The options available are as follows:

General

Ansys ICEM CFD Tools

Display

Speed

Memory

Lighting

Background Style

Mouse Bindings/Spaceball

Selection

Remote

Model/Units

Geometry Options

Meshing Options

Import Model Options

Solver

Reset

General

The File → Settings → General menu allow you to change the default settings regarding files,
number of processors, text editor, and so on for Ansys ICEM CFD.

75
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Settings Menu



Figure 56: Settings-General DEZ

Number of Processors

specifies the number of processors. Some operations such as tetra meshing, hexa meshing, and
smoothing can use multiple processors if they are available. Specifying multiple processors will
enhance the performance of these operations. You can specify a value from 0 to 256. The default
is 1. If the Number of Processors is set to 0, the number of processors will be set automatically
to the maximum number of processors available.

Text Editor

defines the default external text editor that will be used by Ansys ICEM CFD. Typically this would
be Notepad for Windows and vi for UNIX systems.

Use internal editor for Replay Control

enables the use of the internal, interactive text editor when managing Replay script files. ICEM
CFD is not locked when editing a replay script using the internal editor.

To use the external Text Editor, uncheck this option. ICEM CFD is locked when editing a replay
script using the external editor.

You must restart ICEM CFD for the change to take effect.
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Temporary Directory

defines a temporary directory where ICEM CFD data files are written. To define the location, list
the path of an existing directory using UNIX notation (for example, c:/users/temp instead of
c:\users\temp). If the directory does not exist, ICEM CFD will not create it.

Save Emergency Mesh on Crash

enables the saving of the mesh file in the event of a program crash.

Save Emergency Tetin on Crash

enables the saving of the Tetin file in the event of a program crash.

Save Emergency Blocking on Crash

enables the saving of the blocking file in the event of a program crash.

Clean up Temporary Files

enables the cleaning up of temporary files, if any, inside the project directory.

Record Journal File

creates a journal file (*.jrf ) of the Tcl/Tk commands representing all the operations in an entire
session. This is similar to replay scripts, except that the journal file is saved in the working directory.
The journal files can be accessed using the same options used for Replay Scripts (p. 49).

Note:

Journal files are useful for debugging purposes. Technical Support may utilize
these files when diagnosing a problem.

Keep existing file names

enables the use of the existing mesh, geometry, and other file names when saving a project instead
of creating new file names to match the project name. These file names are stored with the project
and loading the project file will automatically load these files too. This feature is useful when
working with large files. If this option is disabled (default), saving the project with a new name
will create new files with matching names for geometry, mesh, attributes, etc.

Clear undo after saving project or geometry

enables the clearing of the Undo history after saving the project or geometry. If this option is
disabled, you will be able to undo operations even after the project has been saved.

Automatically check/fix surface orientations after Open Mesh

checks and fixes surface orientation errors when a mesh file is loaded. The option is enabled by
default.

Disable this option to find surface orientation errors manually using Edit Mesh → Check Mesh,
if required.

77
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Settings Menu



Automatically Save Views to Project

enables the saved views to be saved with the project file. This option is enabled by default.

Note:

You can use the View → View Control → Edit/Load/Save Views option (see the View
Control (p. 60) section) to edit the views saved with the project file. The View Control
appears in the bottom-right corner of the screen.

Enable Idle

If disabled (default), the checked-out license remains associated with the application for your
entire session.

Enable this option to allow the license server to check-in licences, allowing other applications to
use them, in case your instance of the application is inactive for the set timeout period. If your
application goes into the idle state, a button is provided to recheck-out the needed licenses to
resume the application activity.

Ansys ICEM CFD Tools

The Tools group allows you to select which Ansys ICEM CFD components are available. The GUI Style
group allows you to select the color scheme for the Ansys ICEM CFD environment.

Figure 57: Tools Options DEZ
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Tools

Use the check boxes to specify which tabs are visible in the Ansys ICEM CFD environment.

Geometry

enables the Geometry tab with its associated geometry editing tools.

Mesh

enables the Mesh tab with its associated mesh computing tools.

Blocking

enables the Blocking tab with its associated blocking and structured hexa-mesh creation tools.

Edit Mesh

enables the Edit Mesh tab with its associated mesh editing tools.

Mechanical Preprocessing

enables the Properties, Constraints, Loads, and FEA Solve Options tabs. Use these tools to
create and assign material properties; define constraints and displacements; apply force, pressure
or thermal loads on the model; and choose a structural analysis solver format.

Solver Output

enables the Output Mesh tab. Use these tools to choose a CFD solver format; set advanced
boundary conditions or other parameters; and write the solver input file.

Beta Options

enables beta options within Ansys ICEM CFD to be made available. These options are new features
that are pending more extensive testing and documentation before being added to the standard
release.

GUI Style

You can select either the Workbench style or the traditional ICEM CFD style.

The Workbench style has the display tree on the upper-left and the DEZ on the lower-left of the in-
terface. The background colors are set up to match those in Ansys Workbench and the Ansys logo is
displayed in the upper-right corner of the graphics window. The message window is wider and spans
the entire window when there is no histogram, scan, index, or interrupt window present. This is the
default setting for Ansys ICEM CFD.
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The ICEM CFD style has the positions of the display tree and the DEZ swapped, with a solid background
color.

Note:

This is not the same as the option to use the old GUI.

Important:

After Applying any changes to selected Tools or GUI Style, you must quit and restart the
software to see the changes.

Display

The Display options allow you to change the display settings for Ansys ICEM CFD using the options
in the Settings-Display DEZ. Some changes in settings will be effective only after restarting Ansys
ICEM CFD.
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Figure 58: Display Settings window
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Use Native Display List

enables the use of OpenGL or another accelerated graphics library when possible. The final color
including the lighting effects are fixed until the surfaces are refreshed. This option is recommended,
because the color and lighting effects are updated for every redraw. Depending on the system
and machine, this option may result in slower display redraws. Some nVidia graphics cards may
show slower performance when this option is enabled.

Note:

If you encounter graphics performance problems, disable the Use Native Display List
option and click Apply. You do not need to restart Ansys ICEM CFD for this change to
take effect.

Use OpenGL Feedback

enables the use of OpenGL's feedback mechanism to detect the 3D coordinates of the location
on the model that the mouse is pointing to. This option is recommended when the option Use
Native Display List is enabled, since it allows the program to release the memory holding the
model's geometry data once it has been used to create the display list.

Disable Overlays

disables the use of overlays in drawing a selection box since some graphical cards perform slower
with this option.

Enable Smooth Movement

Enable Smooth Movement improves display performance, allowing you to rotate very large
models smoothly. With this option enabled, you will need to double-click to change the model’s
center of rotation, in Dynamic Mode. See The Ansys ICEM CFD GUI in the User’s Manual and
Mouse Bindings/Spaceball (p. 89) in the Help manual.

Simplify Geometries

contains options for simplifying the geometry rendering.

Auto Simplify

simplifies geometry rendering as the model is zoomed out. This option can speed up rendering
of large assemblies or models containing a large number of surfaces. The Simplification level
(pixels) option sets the threshold for simplification.

Simplification level (pixels)

sets the threshold for simplifying geometry rendering. As the model is zoomed out, surfaces
of less than the specified number of pixels across are displayed in a more simplified way in
order to speed up graphics performance. The default is 10 pixels, meaning that as the model
is zoomed out and each surface becomes less than 10 pixels across, its display is simplified.

Figure 59: Simplifying Geometry Rendering (p. 83) shows a jet with surfaces shown as Wireframe
with Show Full enabled, and Simplification level set to 50 pixels. As the model is zoomed out,
the smaller surfaces fall below the 50 pixel threshold, and the display is simplified.
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Figure 59: Simplifying Geometry Rendering

Select Icon Size

specifies the icon size. You can select Normal, Large, or Huge, as required. The software must
be restarted before any change will take effect. If your screen resolution is very high, you may
prefer the Huge setting.

ICON SIZES

DEZ (Data Entry
Zone)

Tab

3524Normal

3535Large

4835Huge
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The font size will also change depending on the icon size set and the screen resolution.

View Fit Percentage

determines the percentage of the screen on which the model will be displayed when the  Fit to
Screen option is used. For example, if set to 90, when Fit to Screen is selected, the model will
displayed on 90 percent of the total height and width of the screen display. The default of 95%
is usually sufficient to prevent the on-screen prompts from obscuring a portion of the model.

Warn if Elements Displayed

sets the threshold number of elements that will be displayed without a warning. These elements
are displayed according to the Tree Mesh Display settings after the mesh is loaded. The default
value is 1000000, and the value 0 will disable the warning completely.

In the case of Tetra Octree mesh, this warning is displayed before the in-process smoothing. If
the specified number is exceeded, a popup window will tell you the number of elements about
to be displayed and ask if you want them to be displayed.

Figure 60: Example of Display Elements Window

Note:

If you are generating large numbers of shell elements and do not want to display
them, disable them under Tree Mesh Display.

Float Display Precision

sets the number of decimal places displayed.

Quadratic Accuracy

makes the Bspline display a smoother curve.

Show External Node/Element Numbers

displays the external Node or Element information. Internally, these numbers may be different in
order to optimize the meshing routines, but most users prefer to interact with the external numbers
as they were before being imported into Ansys ICEM CFD or as they will appear after export.
This affects the behavior of node and element number display, as well as features such as creating
a subset from node numbers.
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Show Origin Marker

displays the origin marker on the screen.

Show XYZ Axes

displays the XYZ axes in the bottom right corner. This triad is interactive and clicking on it will
orient the display.

Fast Box Selection

enables the "-overlay" option for the selection box. This can increase performance when there
are millions of selected items. Since the memory or accuracy penalty is small, it is recommended
that it is enabled for all models.

Tree Mesh Display

allows you to select the default elements which are displayed when a geometry or mesh is loaded.
You can enable the display of points, lines, shell elements (triangles and quads), and volume
elements (hexahedra, tetrahedra, prisms, and pyramids) as required. On a large model, displaying
all the Shells by default may take too long, so you may want to disable the shell elements. When
computing a large tetra mesh, disabling Show Triangles would prevent the time consuming
display of these elements before and during the in-process smoothing steps.

Speed

The Speed options allow you to modify display modes related to geometry and mesh.

Figure 61: Speed Options window

Fast Dynamics - Geometry

enables a point display mode for the geometry to improve rotational performance.

Fast Dynamics - Mesh

enables a point display mode for the mesh to improve rotational performance.

Threshold (ms)

specifies the length of time between the last input and the time when the display refreshes.
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Memory

The Memory options contain features related to the program’s maximum memory parameters.

Figure 62: Memory Related Features

Max Display List Size (MB)

specifies how much memory is dedicated to making redraws faster.

Max Binary Tetin Size (MB)

specifies the maximum amount of memory that a binary Tetin file can take up. A value of 0 means
no limit.

Max Geometry Memory (MB)

specifies the amount of memory for use by the geometry. A value of 0 is the recommended value
since if this space is exceeded it will not load anything.

Max Mesh Memory (MB)

specifies the amount of memory for use by the mesh. 0 is the recommended value since if this
space is exceeded it will not load anything.

Max Memory for Undo (MB)

specifies the maximum amount of memory that the undo option will take up. A value of 0 means
no limit.

Enable Undo/Redo logging

specifies whether or not to reserve memory for the availability of undo for log messages.
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Enable Undo/Redo for Large Operations

specifies whether or not to reserve memory for the availability of undo for larger operations.

Note:

Disabling this option also allows a more efficient algorithm (reduced memory usage)
for Linear to Quadratic conversion.

Lighting

The Lighting options allow you to interactively set the direction and different components of the
lighting on entities displayed in solid view.

Figure 63: Settings-Lighting DEZ

Ambient

specifies the ambient light setting. The Ambient setting has a range of 0 to 1.

Diffuse

specifies the diffuse light setting. The Diffuse setting has a range of 0 to 1.

Specular

specifies the specular setting. The Specular setting has a range of 0 to 1. For more uniform
shading, lower the specular component.

Shininess

specifies the shininess setting. The Shininess setting has a range of 1 to 10.

Direction

specifies the direction of the lighting as a vector.
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Use Two Opposite Lights

enables the use of two opposite lights. For faceted data, the default lighting settings may
not be ideal due to the differing orientations of the surface facets. In such a case, utilizing
the Use Two Opposite Lights option, and lowering the specular component to zero will
remove the contrast and provide more uniform shading.

Restore defaults

restores all lighting settings to their default values.

Background Style

The Background Style options allow you to select the background style and colors.

Figure 64: Settings-Background DEZ

Background Style

allows you to select a solid background, or one of the following gradients: Top-Bottom, Left-Right,
or Diagonal.

Background Color

specifies the background color selected from the menu of colors. Click the palette icon to open
a separate window with a color map. To select a color from the colormap, move the cross-hairs
to the desired color, and use the sliding arrow on the right to select the desired shade. Click a
blank square under User colors to make the specified color an option. Click the desired color
square and click Apply to select it as the background color.

Background Color2

specifies the second background color selected to form gradients along with the first Background
Color.

Show Ansys Logo

enables the use of the Ansys logo in the graphics window.
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Mouse Bindings/Spaceball

The default functions for the mouse buttons and space ball are shown in Figure 65: Default Spaceball
and Mouse Bindings (p. 89). and Table 1: Default Mouse Bindings (p. 89)

Figure 65: Default Spaceball and Mouse Bindings

Table 1: Default Mouse Bindings

Selection Mode functionDynamic Mode
function

Button

Select / DESELECT (with Shift
Key)

3D RotateLeft Button

Done selectionPanMiddle
Button

Backup / CancelZoom / RotateRight
Button

ZoomScroll Wheel

The Settings>Mouse Bindings/Spaceball DEZ allows you to redefine the dynamic and selection
operations of the mouse buttons.
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Figure 66: Settings-Mouse Bindings/Spaceball DEZ

The left, middle, and right mouse buttons all must have different settings.

Wheel Sensitivity

controls the mouse wheel sensitivity.

Mouse wheel for cutplane

enables the manipulation of the cut plane slider with the mouse wheel when a mesh cut plane
is enabled. You may disable this option when working with large meshes, so that accidental
scrolling does not cause the entire volume mesh to be re-rendered.

Zoom in as Moving

allows you to zoom in as you scroll up or down.

The Spaceball option allows you to control the Spaceball check during the Ansys ICEM CFD startup.

Start Spaceball at startup

This option is enabled by default. If you do not have a Spaceball, disable this option for a quicker
startup.

A Spaceball (http://www.3dconnexion.com/) is a 3D mouse that lets you Pan, Zoom and Rotate as if
you are holding the model in your hand, while you use your traditional mouse with your other hand
to Select, Edit, etc. This effectively allows simultaneous Dynamic and Selection Mode which can lead
to productivity gains, particularly for new users who will find the Spaceball movement to be more
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intuitive and consistent across tools. See the Platform Support section of the Ansys Website for a
complete list of 3Dconnexion products certified with the current release of Ansys ICEM CFD.

Note:

Fit & View button features not currently supported.

Selection

The Selection options allow you to change the default settings related to selection of geometry,
mesh, and blocking.

Figure 67: Settings – Selection DEZ

Auto Pick Mode

• initiates the selection process automatically when it is logical to do so.

• activates continuation mode for the middle mouse button (behaves like Apply plus reiterates
the command or proceeds to the next logical selection step.)

Allow Plane Selection

allows the selection tool to snap to planes. When selecting a location on the screen, there is an
entity type-based selection hierarchy within a certain proximity of the cursor. The select location
tool will snap to a point first, then curve, then surface. If no entity types are within a few pixels
of the cursor, and Allow Plane Selection is enabled, it will also snap to the X, Y or Z = 0 planes.
This option can also be activated during selection using the Select location toolbar and enabling
Allow any plane selection.
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Allow Preview Name

enables the displaying of the entity name while previewing selection in geometry selection oper-
ations. For example, if in curve select mode, preview selection will highlight the curve as well as
the curve name.

Minimum Aspect Ratio

sets the lowest quality that elements are allowed to reach during interactive node movement
operations.

Wait for Edit Confirmation

requires the confirmation of selected entities using the middle mouse button after all selections
have been made for operations that require a fixed number of selections. If this option is disabled,
then the operations will be carried out and finished once all selections are available.

Cut Delay Threshold

specifies the threshold value for updating the cut plane. If the redraw speed takes longer than
the specified number of milliseconds, the unstructured cut plane will update only when the mouse
is released and not at every stage along its movement.

Flood Select Angle

controls the selection of elements. You can change the angle if you want to select neighboring
elements with the selection.

Remote

The Remote option allows you to run the program on a remote machine. For this, you need to map
the remote machine with the proper settings in the Settings-Remote DEZ.

Figure 68: Settings—Remote DEZ

Remote Host

specifies the hostname of the remote machine.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.92

Main Menu Area



Remote User

specifies the username on the remote machine.

Remote Directory

specifies the directory on the remote machine in which the operation is to be run.

Remote ICEM_ACN

specifies the directory on the remote machine where Ansys ICEM CFD is installed.

Remote Shell

specifies the type of shell on the remote machine from which the operation will be run.

Model/Units

The Model/Units option allows you to set dimensional preferences.
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Figure 69: Model/Units Setting Options

Topo Tolerance

specifies the tolerance used in operations where topology is automatically calculated.

Restore

resets the topology tolerance to the default value. The default topology tolerance will be set to
the smaller of:

• 0.05% of the bounding box diagonal.

• The value so that no more than 5% of the curves in the model have a length less than 2
* the Topo Tolerance value.
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Triangulation Tolerance

is the distance allowed between the triangle edge and the actual surface edges. Ansys ICEM CFD
triangulates Bspline surfaces and curves when it reads Tetin files. A very low tolerance will give
a good representation of the geometry but will require more memory and longer processing time.
A higher tolerance will give good performance and less memory usage but a coarser representation
of the geometry.

A coarser geometry representation may be a better choice for a large model that will be coarsely
meshed. For example, a bigger triangulation tolerance would be reasonable for a full engine as-
sembly model that is going to be shrinkwrapped. If fine precision is required, you may choose a
finer triangulation tolerance. For example, some geometry operations, such as trimming a curve
with a curved surface will be affected. Also, users who generate very thin boundary layers on
curved surfaces may have issues if their surface curvature is not being adequately represented.

An optimal value for most models is 0.001. This setting is independent of the mesh element size.

Note:

Triangulation tolerance does not affect faceted geometry.

In the examples below, note that for every 1/10th reduction in the Tri Tolerance, each square of
the surface representation is further divided into 12-16 squares.

Figure 70: Examples of Triangulation Tolerance

Tri Tolerance = 0.1 

Tri Tolerance = 0.01 
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Tri Tolerance = 0.001 (default) 

Unitless tolerance

is a factor of the minimum edge length of a given surface or curve. If enabled, the triangulation
tolerance is calculated using this factor for each surface. If disabled, the triangulation tolerance
is in actual units.

Length Units

allows you to select the appropriate units of length for your model. The default selection is
Unitless, where you need to ensure that the intended proportions are reasonable. In this case,

you can use the Measure Distance ( ) tool to make sure the model appears to be of the right
scale.

Note:

Selected units information will be saved to the Tetin file.

Scale to selected unit

allows you to draw the entire geometry and blocking to scale based on the selected Length
Units. Click Apply to scale the model. This options has no effect if Unitless is selected.

Also scale mesh sizes

allows you to include mesh sizes when drawing to scale based on the selected Length Units.
Default is off. This option requires Scale to selected unit to be enabled.

Geometry Options

The Geometry Options allow you to set geometry preferences.
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Figure 71: Geometry Options

Name new geometry

enables the display of entity names and modification of entity names when creating geometry
entities. If disabled, the entity names will not be visible and the default naming convention will
be followed.

Default Naming Convention

If the last two characters of an entity name are digits, then the numbers will be incremented for
each new entity created. If the last two characters are not digits, then new entity names will be
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generated by adding "00" to the name and successively incrementing the number. Examples are
shown below.

Next Entity Name (Automatically Generated)Entity
name

abc01abc00

abc.54abc.53

abc.00abc.1

abc000abc0.1

Note:

Part names and entity names should be less than 64 alphanumeric characters.
Names should start with a letter, not a digit. Evaluators ( +, -, /, and * ) should not
be used in names because they can be misinterpreted as expressions or as denoting
an assembly. Part names are written with all upper-case characters. Entity names
are case sensitive.

Replace same name item

enables replacing the previously existing entity when an existing name is used for an entity. If
disabled, then the new entity will automatically be named according to the default naming con-
vention and the next incremented name will appear in the Name field.

Inherit part name

controls the default behavior of new geometry entities that are created.

• Inherited

specifies that all applicable geometry operations will take the part name from the first object
selected. This inherited part name will be used for the new objects that are created.

• Create New

specifies that new geometry objects will be created in the working part name (the part name
defined in the Point, Curve, Surface, Faceted Data, or Repair forms). Some operations, such as
Create Point From Screen, requires a specified working part, so it will take on the working part
name even if the Inherited option is used.

Default Part Name

specifies the default working part for any new geometry created in Point, Curve, Surface, Faceted
Data, or Repair forms. The working part name for a particular project can be changed independent
of this default name.

Create auxiliary points

retains the points used in the creation of geometry.
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Create surface topology

creates and maintains the topological connections when geometry is created.

Note:

This is currently only used for Create/Modify Surface functions.

Import Parameters from Tetin file

allows you to select which type of mesh parameter(s) to import with the model. By default, all
mesh parameters are imported. ICEM CFD attempts to match parameters to the geometry by
element name.

Global mesh params

will change the global mesh parameters.

Part mesh params

will change the part mesh parameters as selected under Import Model (p. 18).

Point parts

will change the part assignment and also import dormant points.

Curve parts

will change the part assignment and also import dormant curves. Mesh parameters are unaf-
fected.

Curve mesh params

will change only the mesh parameters. Part assignments and dormancy are unaffected.

Surface parts

will change only the part assignment.

Surface mesh params

will change only the mesh parameters.

Thincuts

will clear existing thincuts and import all thincuts from the tetin file.

Densities volume

will clear existing densities and import all densities from the tetin file.

Subsets

will clear existing subsets and import all subsets from the tetin file.
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Material points

imports bodies and material points.

Note:

This option should be disabled if both Always Import Parts, Sizes from Tetin File
and Always Create Material Points are enabled (under Settings → Import Model
Options), which creates a new material point during model import.

Part Table Data

These options apply to the Part Mesh Setup and Edit Attributes tables, with are accessed by
right-clicking on the Parts Display Tree.

Mesh Setup

opens the Mesh Setup Data dialog with the various options available for the Part Mesh Setup
table. All options are enabled by default.

Attributes

opens the Attributes Data dialog with the various options available for the Edit Attributes
table. All options are enabled by default.

Meshing Options

Meshing Options allow you to set the preferences for mesh generation. The different meshing setting
options are described in the following sections.

Hexa Meshing

Quality/Histogram Info

Edge Info

Hexa Meshing

The Hexa Meshing option allows you to specify settings for hexa meshes.
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Figure 72: Hexa Meshing Options

Multigrid level

allows you to create a linear multigrid mesh with a specified number of levels. The node count
is altered so that the number of elements on an edge is divisible by 2^M, where M is the
number of multigrid levels. Thus, the new number of nodes will be:
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where N is the current number of nodes.

You must select Blocking > Pre-Mesh Params > Update Sizes (p. 514) to for the change to take
effect on a blocking with existing node distributions, or set this parameter before prescribing
node counts or element sizes.

Check multigrid level

edges will be highlighted (red) if changing the multigrid level will change their number
of nodes.

Projection limit

controls the projection of nodes. If the Projection limit is set to a non-zero value, P, the nodes
along an edge within distance P of the end of the edge will not be projected. Instead, they will
be linearly interpolated between the first point farther than P and the end. Nodes on the interior
of a face within distance P of the edge of the face will not be projected. Instead, they will be
linearly interpolated from the interior of the face. If the Projection limit is set to 0, all nodes will
be projected.

The Projection limit is set to a non-zero value in cases where you want to keep the nodes on
the edges and avoid projection to the underlying surfaces. This option is typically used for
Navier-Stokes grids where the grid spacing is small relative to the geometry tolerance. Allowing
nodes within a gap in the geometry to project would skew the elements. With a value P set to
slightly larger than the gap, the nodes would instead be interpolated. The value may have to
be set by trial and error depending on skewness or negative determinants being reported by
pre-mesh quality checks.

Default meshing law

specifies the default meshing law used for node distributions for edges. Edges which have a
meshing law set will retain their current law unless Blocking > Pre-Mesh Params > Update
Sizes (p. 514) is applied.

Default bunching ratio

specifies the default node expansion ratio along an edge from either end of the edge.

Note:

Though the settings are saved in the .aienv_options file, some settings such as
the bunching ratio and the meshing law may also be saved in the blocking file. If a
blocking file is loaded, it will override the settings saved in the settings file.

Find worst blocks (range)

specifies the range of Worst Blocks displayed by the Find Worst blocks (p. 193) option.
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Ogrid Smooth Transition

provides a smooth transition from the offset layer to interior layers. This option uses transfinite
interpolation to prevent intermediate unprojected Ogrid splits from adversely affecting the
smoothness of the mesh.

In the following figure, the cyan-colored Ogrid edge split, between the outer perimeter and
the inner square, is not shaped for optimal mesh quality.

Figure 73: Ogrid Not Interpolated

This second figure shows the central Hgrid portion and the Ogrid split has been interpolated
(shaped) to more smoothly transition the mesh across the model.

Figure 74: Ogrid, interpolated

Floating grid

is used when grid distribution on faces is independent of the sub-edge structure. It also helps
to turn on this option if a series of block splits have been made where the splits do not extend
through the whole topology. With this option, subsequent splits would not "connect" to previous
non-extended splits.

Project to Bsplines

projects the mesh to the true Bspline geometry rather than the faceted representation, which
is the internal triangulated representation of surface data as defined by Settings > Model >
Triangulation Tolerance (p. 93). This can be used instead of decreasing the tri-tolerance or using
projection limit, where small gaps in the faceted representation create skewed elements on a
Navier-Stokes grid. This, however, takes longer and more memory to compute the pre-mesh.

Check/Fix Blocks

checks the internal block data structures for inconsistencies and fixes them if possible.

103
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Settings Menu



Check/Fix Inverted Blocks

checks for all the inverted (left-handed) blocks and redefines the block by reordering the vertices
to make it right-handed.

Write 7-node-hexas as pyramids

when enabled (by default this option is disabled), converts degenerate 7-noded-hexas (2 nodes
merged along an edge) into two pyramids when you select the Convert to Unstruct Mesh
option under Blocking > Pre-Mesh in the Model tree or when using the File > Blocking >
Save Unstructured Mesh option.

Project to topo

when enabled, allows a hexa face to be projected to an underlying surface. Default is off
meaning the hexa face will be projected to a face family.

When two surfaces are very close to each other and highly curved, family based projection may
cause the nodes to jump between surfaces.

Verbose mode

displays additional minor warning messages that are intended to aid development or support
in diagnosing possible problems that may occur. This option is disabled by default, but warnings
intended to help the user with errors or problems are always displayed.

Update options from current blocking

when enabled, this option allows the previously saved hexa settings to be overwritten by the
settings from the loaded blocking file. When disabled, the previously saved hexa settings will
be retained and the settings in the loaded file will be ignored. This option is enabled by default.

Transfinite degree

Transfinite interpolation is used for face interpolation when computing a mesh. The default is
linear but quadratic is better for maintaining initial element heights. The drawback is that it
can produce inverted elements in bowtie-shaped blocks where linear would work fine.

Reference topology

specifies the name of another blocking topology that you can use to test different smooth mesh
options. The next time you re-compute the premesh, node positions will be matched to those
in the reference topology.

For example, you set a reference topology based on a smoothed Euler mesh. If you now
modify the mesh to have Navier Stokes spacing while maintaining the blocking topology, the
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node positions in the NS elements will match those in the smoothed Euler elements, giving
you a smooth mesh but with the NS spacing.

Note:

The current topology must match the reference topology exactly.

Tip:

A reference topology (the basis for the smoothed mesh) can be created easily by
right-clicking on Blocking → Topology and selecting Create sub-topo in the Display
tree. Select all visible blocks and apply an appropriate name. Node locations do not
get saved to the blocking file so this is available only in the current session.

Free face mesh type

specifies the default mesh type that will be used for meshing unstructured 2D surface blocking.
The following options are available:

• Quad w/one Tri

• Tri (STL like)

• All Tri

• All Quad

• Quad Dominant

Free face mesh method

specifies the method that will be used for meshing unstructured 2D surface blocking. The fol-
lowing options are available:

• ICEM CFD Quad

• GAMBIT Pave

• Auto

What to Mesh

specifies the entities or blocks to mesh for Blocking Tree > Pre-Mesh. Used typically for blocks
with a mixture of mapped (structured), swept, and free (fully unstructured) 3D blocks as en-
countered using Multizone techniques.

Vertices

not used.

Edges

will mesh only edges to create line elements.
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Faces

will mesh only faces and edges to create surface mesh.

Struct & Swept Blocks

will mesh mapped (structured) and swept blocks, but not free (unstructured) blocks.

Note:

This option can be used with multizone blocking to more efficiently iterate
and improve the surface mesh and boundary layers. The All Blocks option
can then be used to mesh the unstructured regions also.

All Blocks

will mesh all blocks. This is the default. Any unstructured (free) blocks will be filled with
tetras using the Delaunay algorithm which could take some time for large volumes such as
in external flow models.

Number of Tetra Smoothing steps

specifies the number of Tetra smoothing steps for Multizone unstructured blocks. You may
want to lower this during early iterations of Multizone blocks in order to save time.

Restore Hexa Defaults

restores the hexa meshing settings to the defaults.

Quality/Histogram Info

The Quality/Histogram Info option allows you to specify settings for displaying information regard-
ing quality criteria that will be reported for Element Info under the Info menu. You can also set
the default settings for the histogram display that will be used by the Pre-Mesh Quality histo-
gram (p. 539) and the Quality Metric histogram (p. 591).
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Figure 75: Settings-Quality

Check Quality

allows you to select the quality metrics that will be reported for Element Info under the Info
menu. The default is set to report the Quality metric only. For the descriptions of the quality
metrics, see Edit Mesh > Display Mesh Quality (p. 573).
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Histogram Defaults

allows you to select the settings for the histogram display.

Note:

You can also change the histogram display settings (and ranges) by right-clicking in
the histogram window.

Show

displays the elements within the selected (highlighted) histogram bars.

Solid

displays all selected elements in solid view.

Note:

This option may slow down the display speed.

Color by Quality

displays the histogram by colors that corresponds to the quality range. The color contour
bar will display the range of quality by color.

Evaluation at

specifies the nodes for which the determinants and distortion will be evaluated for hexa and
quad elements. This is used for linear as well as quadratic elements.

• Corner Nodes

The Jacobian determinants of a volume element will be calculated at r = -1, 0, 1; s = -1,
0, 1; t = -1, 0, 1 (natural coordinate system).

• Gauss Points

The determinants will be calculated at the Gauss points of the selected order.

Edge Info

The Edge Info option allows you to specify settings for displaying information regarding edges.

Figure 76: Settings-Edge Info
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Calculate min / max mesh edge sides

enables the calculation and display of maximum and minimum distances between nodes of a
mesh in the information given for Info > Mesh Info (p. 71).

Import Model Options

Use the Import Model Options for global settings affecting geometry refresh and scaling.

Figure 77: Settings-Import Model Options

Always Update Geometry from Source

If enabled, the geometry will always be refreshed, even if nothing is changed. Default is disabled.

Always Import Parts, Sizes from Tetin File

If enabled, the model parts and size information will be extracted from the geometry file. This
can help to speed meshing parameter setup for a modified geometry. You can choose which in-
formation is imported using the Import Parameter from Tetin file list under Geometry Op-
tions (p. 96).

Default is version dependent:

• Off for the stand-alone version.

• On for the data-integrated (Workbench add-in) version.

You can override this setting in the Import Model (p. 18) DEZ.

Always Create Material Points

If enabled, the software will calculate a material point from the imported geometry. Default is
enabled.
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You can override this setting in the Import Model (p. 18) DEZ.

Note:

When using this option along with Always Import Parts, Sizes from Tetin File, you
should be disable Material points, under Settings → Geometry Options, to avoid
creating a material point that will not be scaled with imported sizes.

Always use Reference Key for Import of Geometry

If enabled, geometry entity names will be derived from reference keys in the geometry file, im-
proving persistence and making them longer. Default is disabled.

Typically, names of curves and surfaces are short and usually persistent. For certain workflows,
parameter changes may cause topology changes (example: splitting an edge into multiple seg-
ments), which may affect the geometry entity names causing scripting difficulties.

Always Import Mesh if Model File contains blocking

If enabled, the SpaceClaim geometry will not be converted to a tetin file. Instead, the software
will load the existing tetin file from the SpaceClaim file, together with the blocking file, and
automatically convert the existing pre-mesh to unstructured mesh.

Note:

This option applies only to SpaceClaim files that contain a blocking.

Import Named Selections only

Used to automatically set a preferred state for the Named Selections only check box in the Import
Model (p. 18) DEZ. Default is off.

Always Convert Geometry to Unit

If enabled, the geometry will be converted and scaled to the Unit selected. Default is disabled -
units will be read from the imported model file.

You can override this setting in the Import Model (p. 18) DEZ.

Solver

The Solver option opens a DEZ to select a default Solver or mesh file format for creating the input
file to your analysis software.
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Figure 78: Solver Setup Defaults DEZ

Output Solver

Use this list to select a default solver suitable for CFD analysis, or a mesh file format.

Additional setup for your specific project is done from the Output Mesh tab.

Common Structural Solver

Use this list to select a default solver suitable for structural analysis.

Additional setup for your specific project is done from the FEA Solve Options tab.

Note:

More information about the Ansys ICEM CFD Output Interfaces is available from the Help
menu. Select the Output Interfaces option to open a browser window containing the
Ansys ICEM CFD Output Interfaces information. Select the name of an interface in the Table
of Supported Solvers for more detail about that specific interface.

Reset

The Reset option allows you to reset the project settings to the defaults. Click Yes  in the Settings
dialog to reset Project settings to the default. This will overwrite any user settings done in the project.

Figure 79: Reset Options Dialog
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Help Menu

The Help menu provides access to different sections of the Ansys ICEM CFD Documentation. On selecting
the desired option, the Help will open at the first page of the selected document.

Help Topics

Tutorial Manual

User’s Manual

Programmer’s Guide

Output Interfaces

Installation & Licensing Guide

What's New

Show Customer Number

About Ansys ICEM CFD

Figure 80: Help Options

Help Topics

The Help Topics option opens the Ansys ICEM CFD Help Manual, which contains descriptions of all
the features available in Ansys ICEM CFD.

Tutorial Manual

The Tutorial Manual option opens the Ansys ICEM CFD Tutorial Manual, which contains several text-
based tutorial examples.

Additional tutorials and other supporting documents are available on the Ansys customer site. To
access tutorials and their input files, go to the tutorials area of the customer site. You will be required
to Show Customer Number (p. 113) to access the customer site.

User’s Manual

The User’s Manual option opens the Ansys ICEM CFD User's Manual, which offers a more technical
description of many of the features available in Ansys ICEM CFD.
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Programmer’s Guide

The Programmer's Guide option takes you to the Ansys ICEM CFD Programmer's Guide Table of
Contents.

Ansys ICEM CFD is fully scriptable (in Tcl/Tk) and taking advantage of this is an excellent way to
compress your process and use the tools more efficiently. The Programmer's Guide includes:

• Ansys ICEM CFD scripting basics

• Form creation functions for manipulating the GUI

• External commands for running external programs or performing operations at the OS level

• Scripting commands for use in Ansys ICEM CFD

• Blocking commands for use in Ansys ICEM CFD Hexa blocking

• Meshing Directives providing additional scripting commands for use with Ansys ICEM CFD
Meshing, Editing, etc.

Output Interfaces

The Output Interfaces option opens the Ansys ICEM CFD Output Interfaces information in a browser.
For information about a specific interface, refer to the Table of Supported Solvers and click the name
of the interface.

Installation & Licensing Guide

The Installation & Licensing Guide option describes Installation processes and Licensing requirements
for Ansys ICEM CFD.

What's New

The What's New option opens the list of additions and improvements to the current release of Ansys
ICEM CFD.

Show Customer Number

The Show Customer Number option shows your Customer Number that is included in the license
file. The Customer Number is needed to access the customer site.

Note:

Reference the Customer Number when contacting Ansys ICEM CFD Technical Support
by phone (1-800-937-3321) or by email (techsupp@Ansys.com).
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About Ansys ICEM CFD

The About Ansys ICEM CFD option gives information about the version and release date of Ansys
ICEM CFD.

Graphical Main Menu, Utilities and Display Options

Some of the most frequently used functions are made available for quick access in the Figure 81: Graph-
ical Main Menu (p. 114).

Figure 81: Graphical Main Menu

The Main Menu icons include options to manage your Project, Geometry, Mesh or Blocking files.
They function exactly as the equivalent text based menus.

Utilities for taking measurements of your project’s features or defining a Local Coordinate system are
available along with Undo and Redo.

Display management options include sizing, zooming, and drawing style.

Main Menu Icons

Utilities Icons

Display Management Icons

Main Menu Icons

The Main Menu icons include options to manage your Project, Geometry, Mesh or Blocking files.
They function exactly as the equivalent text based menus.

Figure 82: Main Menu Icons

Open Project

To work on an existing project, select the Open Project option.

Navigate to the working folder and select the desired project from the Open Project window; or
select an existing project from the drop-down list in the File name field.

Save Project

To update the project file (*.prj) on your disk, select the Save Project option.
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This option also updates and saves the data files associated with the project. The files saved are
the Geometry file (*.tin), Mesh file (*.uns), Blocking file (*.blk), Parameters file (*.par) and
Attributes files (*.fbc and *.atr).

Geometry Menu

The Geometry drop-down menu contains options to Open, Save, and Close your Geometry file:

Open Geometry

To load a geometry file into memory and display its graphical image, select the Open
Geometry icon.

Save Geometry

To update the geometry file with all your recent work, select the Save Geometry icon.

Close Geometry

To remove the geometry information from the graphical display and close the loaded
geometry file, select the Close Geometry icon. If the file has been modified, you will be asked
whether you want to save the file.

Mesh Menu

The Mesh drop-down menu contains options to Open, Save, and Close your Mesh file:

Open Mesh

To load a mesh file into memory and display its graphical image, select the Open Mesh
icon.

Save Mesh

To update the mesh file with all your recent work, select the Save Mesh icon.
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Close Mesh

To remove the mesh information from the graphical display and close the loaded mesh
file, select the Close Mesh icon. If the file has been modified, you will be asked whether you
want to save the file.

Blocking Menu

The Blocking drop-down menu contains options to Open, Save, and Close your Blocking file:

Open Blocking

To load a blocking file into memory and display its graphical image, select the Open
Blocking icon.

Save Blocking

To update the blocking file with all your recent work, select the Save Blocking icon.

Close Blocking

To remove the blocking information from the graphical display and close the loaded
blocking file, select the Close Blocking icon. If the file has been modified, you will be asked
whether you want to save the file.

Utilities Icons

Utilities for taking measurements of your project’s features or defining a Local Coordinate system
are available along with Undo and Redo.

Measurement Menu

The Measurement drop-down menu contains options to measure distance or angle, or to find
the xyz coordinates of a location in the graphical display:
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Measure Distance

To measure the distance between two points in the graphical display, use the Measure
Distance option. Select the locations with the left mouse button. The distance between the
two points will be displayed in the message window.

Measure Angle

To measure the angle between two intersecting vectors, use the Measure Angle option.
Select three points in the graphical display. The first location is at the point of intersection,
and the second and third locations define the two different vectors as shown in Figure 83: Pixel
Sequence to Measure Angle (p. 117). The angle between these two vectors will be reported
in the message window.

Figure 83: Pixel Sequence to Measure Angle

Find Location

To find the xyz coordinates of a point in the graphical display, use the Find Location
option. Select a pixel with the left mouse button. The location of the point in space will be
displayed in the message window and in the GUI.

Local Coordinate Systems

You can define local coordinate systems (LCS) for use in geometry, mesh, blocking or
boundary condition manipulation. The default coordinate system located at the origin is called
Global.

Note:

LCS information is saved in both geometry (.tin) and parameter (.par) files. If
the geometry is closed, the LCS data will also be closed if only the geometry was
loaded. However, if mesh, blocking, boundary conditions, or loads are also loaded,
the LCS data will not be removed when the geometry is closed and/or replaced.
This will ensure that the LCS info remains in the case that other entities such as
mesh, blocking, boundary conditions, or loads are defined in relation to the LCS.
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Figure 84: Define Local Coordinate System DEZ

Name

specifies the name for the local coordinate system (LCS). You can define as many systems as
you wish.

Number

is used by output interfaces to signify a solver's LCS number.

Reference

specifies the reference coordinate system which is the basis for the new coordinate system.

Type

specifies the coordinate system type. The LCS Type can be Rectangular (Cartesian), Cylindrical,
or Spherical. A Rectangular LCS has X, Y, and Z axes. A Cylindrical LCS has R, θ, and Z coordin-
ates. A Spherical LCS has R, θ, and Φ coordinates.

Defined by

specifies the method used to define the LCS. The following methods are available:

Defined by 3 points

In this method, the first point defines the origin of the LCS. The second point defines
the positive Z axis relative to the origin for rectangular and cylindrical coordinate
systems, and the θ axis (Φ = 0) for spherical coordinate systems. The third point defines
positive X for Cartesian coordinate systems, and θ = 0 for cylindrical and spherical
coordinate systems. This vector is ortho-normalized if the selected third point is not
90 degrees relative to the first two. Points can be selected by clicking on a graphic
location, or by clicking on a prescribed (pre-existing) point.

Defined by 1 point

The current screen view plane defines the orientation. The selected point defines the
origin. The vector normal out of the screen defines the positive Z axis (Cartesian and
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cylindrical) or Φ = 0 (spherical). The horizontal direction to the right defines the pos-
itive X axis (Cartesian) or θ = 0 (cylindrical and spherical). The vertical direction upward
describes the positive Y axis (Cartesian) or θ = 90 (cylindrical and spherical). Points
can be selected by clicking on a graphic location, or by clicking on a prescribed (pre-
existing) point.

Click Apply to create and activate the LCS. A triad showing the coordinate system axes will be
displayed in the screen at the point of origin. The Global coordinate system is always displayed
in the lower right hand corner (not at the origin). The defined LCS will also appear in the Display
Tree.

For more information on options to modify Local Coordinate Systems using the Display Tree, see
Display Tree > Local Coordinate Systems (p. 204).

Refresh / Recompute

The Refresh/Recompute drop-down menu contains two options:

Refresh

The Refresh option allows you to refresh the screen. Use this option to unfreeze the screen
after a failed selection or other failed operation.

Recompute Premesh

The Recompute Premesh option allows you to recompute the mesh.

Undo

The Undo option reverses (undoes) the most recently performed operation.

Redo

The Redo option repeats the previously reversed operation.

Display Management Icons

Display management options include sizing, zooming, and drawing style.
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WireFrame Display Options

The WireFrame Display Options drop-down menu contains the following options:

WireFrame Simple Display

The WireFrame Simple Display  option allows you to display wireframe representation
of CAD data or a "Hard Feature" representation of triangulated surface data, including surface
boundaries as hard features.

WireFrame Full Display

The WireFrame Full Display option allows you to display a more detailed representation
of the CAD data, showing more isobars than in the simple representation. For triangulated
surface data, a detailed representation will show all the surface triangles.

SolidFrame Display Options

The SolidFrame Display Options drop-down menu contains the following options:

Solid Simple Display

The Solid Simple Display option allows you to display a smooth or flat shaded represent-
ation of surfaces, which is simplified for parametric surfaces.

Solid Full Display

The Solid Full Display option allows you to display a smooth shaded representation of
surfaces which are triangulated in details.

Solid Full Flat Display

The Solid Full Flat Display option allows you to display a flat shaded representation of
surfaces which are triangulated in details.
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Solid/Wire Full Display

The Solid/Wire Full Display option allows you to display a wireframe over a smooth or
flat shaded representation of surfaces which are triangulated in details.

Fit Window

The Fit Window option scales the model so that it fits in the GUI.

Box Zoom

The Box Zoom option prompts you to select a region on GUI to zoom in to.
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Selecting Entities, Keyboard and Mouse Functions
Ansys ICEM CFD offers several ways of interacting with your model, including context-sensitive hotkeys
and mouse functions.

Selection options, hotkeys, and mouse functions that are appropriate for a given mode (Selection or
Dynamic) and Function tab are presented in this chapter.

Selection Options

Hotkeys

Spaceball and Mouse Binding

Selection Options

In ICEM CFD, you may select locations or graphical entities (geometry, mesh, blocking, nodes, and so
on) in multiple ways. Common methods are point/click, drawing a surrounding figure, or selecting from
a list (name or other identifier). Most selection options are shown in the Selection Mode Keymap
graphic and supporting table.

Not all selection options are available in all contexts. Available Selection options for each context are
presented in a toolbar in that context. Some selection options appear on the toolbar for only one spe-
cific context, although many appear in multiple contexts. Descriptions of the various Selection toolbars
follow.

Selection Mode Keymap

Location Selection Toolbar

Geometry Selection Toolbar

Mesh Selection Toolbar

Blocking Selection Toolbars

Density Selection Toolbar

Selection Mode Keymap

Figure 85: Selection Mode Hotkeys (p. 124) and its associated table lists most of the Selection mode
functions in ICEM CFD. In any given context, a subset of these will be available, and will be indicated
in a Selection toolbar.
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Figure 85: Selection Mode Hotkeys

SHIFT + Hotkey functionHotkey function

 Select all appropriate objects

a Objects may be visible or blanked

Useful for selecting a large number
of objects

 Select all appropriate blanked objectsb

Select items in a circular region

c Click (center point) and drag
(radius) to define the selection
region.

Toggle select diagonal corner vertices

d
In certain Blocking selection
contexts, this allows you to select
multiple, contiguous blocks by
clicking two diagonally opposite
vertices.

Select elements by numbers

e In certain Mesh selection contexts,
this opens a dialog box to specify
a range of ID numbers.
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SHIFT + Hotkey functionHotkey function

 Set feature angle for flood fill

g

Opens a dialog box to set the
maximum angle at which attached
items are selected. This applies to
certain selection functions that
allow you to start with one item,
and quickly select all attached.

If feature angle is set to zero, all
attached, appropriate items will be
selected.

Toggle between all edges and
highlighted edges

h Highlighting of Specific edges may
be determined in many ways. For
example, selecting Show Single in
the Curves Display tree.

Split two edges and flood fill in
between them

 Select a path in between two selected
nodes

i This is useful if the edge section
you want to select is not clearly
delineated into facets.

Preselect two or more,
non-contiguous, faceted edges on
a faceted surface, and then use this
option to select all the edges
between them.

 or  Select one attached layer

k Selects items immediately adjacent
to the current selection, within the
feature angle limit.

 or  Select all items attached to
current selection

l

Selects all attached items, within
the feature angle limit.

Select items by MaterialToggle between full and partial
enclosure

m
Used in mesh selection contexts,
Materials must be defined and
associated with parts.

Partial enclosure is used to select
a body’s material point without
selecting attached surfaces, if any
exist.
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SHIFT + Hotkey functionHotkey function

In edge selection contexts, partial
enclosure requires at least one
enclosed vertex. All visible edges
connected to any enclosed vertex
will be selected. An edge split
behaves like an invisible vertex.

Select by numbers Select the next item picked

n

In certain Blocking selection
contexts, a dialog box is opened to
accept a numeric identifier.

Cyclically steps through all
appropriate objects. Accept with
middle mouse button.

OROR

Select by name Select next edge segment

In Geometry and Density selection
contexts, a dialog box is opened to
accept an alphanumeric identifier.

In certain Blocking edge selection
contexts, this helps to select a
piecewise continuous edge, rather
than clicking on individual
segments.

Toggle boundary type

o

Active only in (Geometry) Surface
or (Blocking) Face selection
contexts.

Toggles between ON: selecting all
surfaces, or faces, regardless of the
boundary (inner and outer), and
OFF: only the outer boundary
surfaces, or faces, will be selected.

ON/OFF status is applicable to any
surface, or face, selection tool.

Select items in a part Select items in a polygonal region

p

A dialog box is opened listing all
appropriate parts

Use the left mouse button to select
multiple points until the polygon
is created. Check the box to select a part.
Middle button completes the
selection and closes the polygon.

Right button cancels points.

After selection, entities may be
individually de-selected from the
list.
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SHIFT + Hotkey functionHotkey function

Select elements by Property Select all items attached to current
selection, up to a curve

r
Used in mesh selection contexts,
Properties must be defined and
associated with parts.

In surface mesh selection context,
all attached elements within the
feature angle limit and constrained
by the nearest curve are selected.

Select items in a subset

s A dialog box opens listing all
appropriate subsets from which to
choose.

 Select mesh attached to geometry

t
Selects the mesh associated with
the selected geometry.

Select block by vertex Select all appropriate visible objects

v
Enter vertex numbers in the dialog
box.

 Cancel selection mode.x

 Select all node elements0

 Select all line elements1

Select all surface elements

2
A drop-down list offers the opportunity to choose which surface element types.

 Select all volume elements

3

A drop-down list offers the opportunity to choose which volume element types.

Undo selection. This is the same as clicking the right mouse button.[

Accept selection. This is the same as clicking the middle mouse button.]
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SHIFT + Hotkey functionHotkey function

Toggle Dynamics

F9 Switch to Dynamic mode to reorient the model in the Graphics window, back to
Selection mode to complete your selection.

The same response is achieved by holding down the Ctrl key.

Print hotkey list (message window)?

Location Selection Toolbar

When in Select Location mode the toolbar shown in Figure 86: Select Location Toolbar (p. 128) pops
up showing the Select location options.

Figure 86: Select Location Toolbar

The first two icons are selection mode functions as described in Selection Mode Keymap (p. 123):

• Toggle Dynamics

• Cancel selection

In addition to the common functions, there are several functions specific to the Select location
context:

• Toggle allow any plane selection (key = 1)

If toggled ON, a location on any plane can be selected.

• Toggle allow on XY plane selection (key = 2)

If toggled ON, it allows you to select a location on the XY plane.

• Toggle allow on XZ plane selection (key = 3)

If toggled ON, it allows you to select a location on the XZ plane.

• Toggle allow on YZ plane selection (key = 4)

If toggled ON, it allows you to select a location on the YZ plane.

• Toggle allow on Mesh/Block selection (key = 5)
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Toggles between allowing you to select a location on Mesh elements or a location on Blocking.

Note:

It may be easier to select mesh nodes if you disable Toggle allow any plane selection.

• Toggle show location (key = 6)

Toggles the display of the selection location coordinates.

• Toggle show entity name (key = 7)

Toggles the display of the selected entity's name.

• Toggle highlight entity (key = 8)

Toggles the highlighting of the selected entity.

Geometry Selection Toolbar

When in Select geometry mode the toolbar shown in Figure 87: Select Geometry Toolbar (p. 129)
pops up showing the Select geometry options.

Figure 87: Select Geometry Toolbar

Many of these icons invoke selection mode functions as described in Selection Mode Keymap (p. 123):

• Toggle Dynamics

• Select items in a polygonal region

• Select all appropriate objects

• Select all appropriate visible objects

• Select all appropriate blanked objects

• Cancel selection

• Toggle between full and partial enclosure

• Select the next item picked
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• Toggle between all edges and highlighted edges

• Select all items attached to current selection

• Select one attached layer

• Set feature angle for flood fill

• Toggle boundary type

• Select items in a subset

• Select items in a part

• Select by name

In addition to the common functions, there are several functions specific to the Select geometry
context:

• Toggle preselect highlight and name

Allows geometry entities to be highlighted and their names to display before you select them.
Enable Preview Name must be enabled in the Selection menu to see the name.

• Toggle selection of points

If toggled ON, points can be selected.

• Toggle selection of curves

If toggled ON, curves can be selected.

• Toggle selection of surfaces

If toggled ON, surfaces can be selected.

• Toggle selection of bodies

If toggled ON, bodies can be selected.

• Toggle selection of mesh

If toggled ON, the mesh selection toolbar will appear and mesh elements can be selected.
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Segment Selection Toolbar

The Select segments toolbar appears when the context requires selection of faceted edges. The Select
segments options are described below.

Figure 88: Select Segments Toolbar

All of the icons invoke selection mode functions as described in Selection Mode Keymap (p. 123):

• Toggle Dynamics

• Select items in a polygonal region

• Cancel selection

• Toggle between full and partial enclosure

• Select all items attached to current selection

• Select one attached layer

• Select a path in between two selected nodes

• Split two edges and flood fill in between them

• Set feature angle for flood fill

Mesh Selection Toolbar

When in Select mesh elements mode the toolbar shown in Figure 89: Select Mesh Toolbar (p. 131)
pops up showing the Select mesh elements options.

Figure 89: Select Mesh Toolbar

All except the last of these icons invoke selection mode functions as described in Selection Mode
Keymap (p. 123):

• Toggle Dynamics

• Select items in a polygonal region

131
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Selection Options



• Select items in a circular region

• Select all appropriate objects

• Select all appropriate visible objects

• Select all appropriate blanked objects

• Cancel selection

• Toggle between full and partial enclosure

• Select all items attached to current selection

• Select all items attached to current selection, up to a curve

• Select one attached layer

• Set feature angle for flood fill

• Select items in a subset

• Select items in a part

• Select elements by numbers

• Select items by Material

• Select items by Property

• Select mesh attached to geometry

• Select all node elements

• Select all line elements

• Select all surface elements

• Select all volume elements

In addition to the common functions, the last icon invokes a function specific to the Select mesh
elements context:

• Toggle selection of geometry
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If toggled ON, the geometry selection toolbar will appear and geometry entities can be selected.
This option is available when geometry or mesh selection would be applicable.

Blocking Selection Toolbars

When selecting blocking, you may be required to select Blocks, Faces, Edges, Compcurves, or Vertices.
Each of these has its own toolbar with its specific selection options.

Select Blocking - block

Figure 90: Select Blocking Block Toolbar

All of these icons invoke selection mode functions as described in Selection Mode Keymap (p. 123):

• Toggle Dynamics

• Select items in a polygonal region

• Select items in a circular region

• Select all appropriate visible objects

• Select all appropriate blanked objects

• Cancel selection

• Toggle between full and partial enclosure

• Select block by vertex

• Select items in a subset

• Select items in a part

• Select by numbers

• Toggle select diagonal corner vertices

133
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Selection Options



Select Blocking - face

Figure 91: Select Blocking Face Toolbar

All of these icons invoke selection mode functions as described in Selection Mode Keymap (p. 123):

• Toggle Dynamics

• Select items in a polygonal region

• Select items in a circular region

• Select all appropriate visible objects

• Cancel selection

• Toggle between full and partial enclosure

• Toggle between all faces and boundary faces

• Select items in a subset

• Select items in a part

• Toggle select diagonal corner vertices

Select Blocking - edge

Figure 92: Select Blocking Edge Toolbar

All of these icons invoke selection mode functions as described in Selection Mode Keymap (p. 123):

• Toggle Dynamics

• Select items in a polygonal region

• Select items in a circular region

• Select all appropriate visible objects
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• Cancel selection

• Toggle between full and partial enclosure

• Select next edge segment

• Select items in a subset

• Select items in a part

Select Blocking - compcurve

Figure 93: Select Blocking Compcurve Toolbar

All of these icons invoke selection mode functions as described in Selection Mode Keymap (p. 123):

• Toggle Dynamics

• Select items in a polygonal region

• Select items in a circular region

• Select all appropriate visible objects

• Cancel selection

• Toggle between full and partial enclosure

• Select items in a subset

• Select items in a part

• Select by numbers

Select Blocking - vertex

Figure 94: Select Blocking Vertex Toolbar
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All of these icons invoke selection mode functions as described in Selection Mode Keymap (p. 123):

• Toggle Dynamics

• Select items in a polygonal region

• Select items in a circular region

• Select all appropriate visible objects

• Cancel selection

• Toggle between full and partial enclosure

• Select items in a subset

• Select items in a part

• Select by numbers

Density Selection Toolbar

When working with Density regions, the toolbar shown in Figure 95: Select Densities Toolbar (p. 136)
pops up showing the Select densities options.

Figure 95: Select Densities Toolbar

Note:

The Select densities toolbar has fewer options than other entity selections. For example,

the Enclosure toggle ( ) is not available because only the partial enclosure mode is
available.

All of these icons invoke selection mode functions as described in Selection Mode Keymap (p. 123):

• Toggle Dynamics

• Select items in a polygonal region

• Select all appropriate objects
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• Select all appropriate visible objects

• Select all appropriate blanked objects

• Cancel selection

• Select the next item picked

• Select by name

Hotkeys

Many of the most frequently used commands in Ansys ICEM CFD are accessible via single or combination
keystrokes. Many of these hotkeys are common across all contexts while others are specific to the active
function group – Geometry, Blocking, or Edit Mesh. To access any hotkeys related to geometry, mesh,
blocking operations, you must first go to the respective tab.

Note:

Make sure that the Caps Lock is not toggled ON when using hotkeys.

Hotkeys work only when the cursor is in the graphics display area.

Hotkeys which are available in any context are shown in the following image and table.

Figure 96: Common Hotkeys

Open online helpF1

Emergency ResetF4

Note:

Emergency Reset is useful if a series of random keystrokes accidentally locks the
keyboard. If a user clicks too fast or bumps multiple keys at a time the keyboard
may lock up. The Emergency reset attempts to fix this problem and unlock the
keyboard.

Set wireframe offsetF5

Set wireframe offset to 0F6

Increment wireframe offsetF7
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Decrement wireframe offsetF8

Note:

The Wireframe Offset Display controls allow you to optimize the wireframe display
for solid and wireframe modes. This can be useful when the wireframe display is
difficult to see in contrast to the solid display. For example, if the wireframe offset
is set too high you can see overlapping lines, if it is set too low, the wireframe
lines look dim. This can happen when adjusting the zoom, or if the model
dimensions make the wireframe offset difficult to compute automatically. When
generating images of the mesh it is recommended that the wireframe offset be
increased slightly to ensure better crispness of solid/wireframe mesh display.
Increasing the wireframe display makes the wireframe lines larger and clearer, but
it can also bring lines in the background to the foreground. The default Wireframe
offset (Z-offset) tries to automatically set the wireframe value based on the model
dimensions.

Save ProjectF10

Emergency ResetF11

Save hardcopyF12

Apply

Note:

Pressing the Enter key after typing in a field in the GUI is the same as
clicking on the Apply button.

Enter

Geometry

In addition to the common hotkeys listed above, the hotkeys shown in the following image and table
are available only when working with the Geometry tab functions.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.138

Selecting Entities, Keyboard and Mouse Functions



Figure 97: Geometry Hotkeys

SHIFT + Hotkey functionCtrl + Hotkey functionHotkey function

Merge surfacesa

Build diagnostic topologyb

Create surfaceCreate curvec

Delete geometry permanentlyDelete geometry entitiesd

Stitch/match edgesCreate curtain surfaceExtend surfacee

Move facets to newFaceted toolsf

Concatenate curvesg

Home positionh

Isometric viewi

Toggle solid displayj

Copy geometryMove geometrym

Offset surfaceo

Project point to surfaceProject curve to surfaceProject points to curvesp

Reverse viewr

Extend splitSplit curves

View in x-direction (right
side)

Scale to fit
x

View in y-direction (top
view)

Redo last undone operation
y

View in z-direction (front
view)

Undo last operationZoom in
z

Print hotkey list (message
window)

?
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Blocking

In addition to the common hotkeys listed above, the hotkeys shown in the following image and table
are available only when working with the Blocking tab functions.

Figure 98: Blocking Hotkeys

SHIFT + Hotkey functionCtrl + Hotkey functionHotkey function

Merge blocksMerge vertices with
propogation

Merge vertices
a

Create blocks from
vertices

Initialize blocks
c

Delete blocks permanentlyDelete blocksd

Unsplit edgeSplit edgee

Fix inverted blocksAssociate face to surfacef

Ungroup curvesGroup curvesg

Home positionh

Isometric viewRestrict blocks – cornersIndex controli

Toggle solid displayj

Change block IJKk

Set edge lengthSet vertex locationAlign verticesl

Merge FacesMove multiple verticesMove vertexm

Scale sizesMatch edges for node
distribution

Set edge mesh parameters
n

Rescale OgridCreate Ogrido

Project vertex to pointProject edge to surfaceProject edge to curvep

Check Quality – angleCheck Quality – aspect ratioCheck Quality – determinantq

Reverse viewReset index controlRecompute pre-meshr
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SHIFT + Hotkey functionCtrl + Hotkey functionHotkey function

Extend splitSplit blocks

Update Mesh sizesu

Snap visible verticesSnap selected verticesv

View in x-direction (right
side)

Scale to fit
x

View in y-direction (top
view)

Redo last undone operation
y

View in z-direction (front
view)

Undo last operationZoom in
z

Print hotkey list (message
window)

?

Edit Mesh

In addition to the common hotkeys listed above, the hotkeys shown in the following image and table
are available only when working with the Edit Mesh tab functions.

Figure 99: Edit Mesh Hotkeys

SHIFT + Hotkey functionCtrl + Hotkey functionHotkey function

Merge nodes with
propogation

Merge nodes without
propogation

a

Build mesh topologyb

Create elementc

Mesh diagnosticsDelete mesh elementsd

Mesh from edgese

Home positionh
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SHIFT + Hotkey functionCtrl + Hotkey functionHotkey function

Isometric viewi

Toggle solid displayj

Move multiple nodesMove nodem

Project node to pointProject node to surfaceProject node to curvep

Smooth mesh globallyQuality metrics, custom
quality

q

Reverse viewRemesh bad elementsRemesh elementsr

Split edges with propogationSplit edges without
propogation

s

Convert Tri to Quad,
quadrization on (refine)

Convert Quad to TriConvert Tri to Quad,
quadrization OFF

t

Snap by current projectionv

Swap edgesw

View in x-direction (right
side)

Scale to fit
x

View in y-direction (top
view)

Redo last undone operation
y

View in z-direction (front
view)

Undo last operationZoom in
z

Print hotkey list (message
window)

?

Spaceball and Mouse Binding

Ansys ICEM CFD allows simultaneous connection of both a Spaceball and a 3-button mouse. The default
actions for these is shown in Figure 100: Default Spaceball and Mouse Bindings (p. 143). For additional
information on managing your spaceball and mouse, see Mouse Bindings/Spaceball (p. 89).
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Figure 100: Default Spaceball and Mouse Bindings
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Display Tree
Use the Display Tree, which is located on the left of the GUI window, to manage what is displayed,
and how it is displayed, in the graphics window. Ansys ICEM CFD offers a great deal of control in the
mesh generation process. The ability to manage the mesh generation is enhanced if you become famil-
iar with the functions within the Display Tree.

The Display Tree has branches for the four most common types of entities that exist in most projects:
Geometry, Mesh, Blocking, and Parts/Subsets. Other branches will appear as various properties, loads,
constraints, etc. are applied to the model.

Figure 101: Display Tree

Mouse Usage

DescriptionMouse Operation

Displays Options menu of the selected Display Tree item.Right button

To automatically select all the items listed in between two
selected (highlighted) items.

Shift + Left button

To select items in addition to, or deselect items from, a
set of previously selected (highlighted) items.

Control + Left button

Toggles entity visibility.Left button on check box

Toggles entity visibility.Double-click the Display Tree item with
check box
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Opens the Modify options of the selected item.Double-click the Display Tree item
without check box

Model

Right-click Model in the Display tree to see the Model display options available, as shown below.

Create All Nodes

Displays all branches available in the Display tree. The default behavior is to display a branch only
if entities of that type exist in the model.

Geometry Units

Opens a DEZ in which you can specify a global unit of length to be used in your model.

Choose the appropriate units, and then click Apply (DEZ is preserved) or OK (DEZ is closed).

Geometry

Click the right mouse button on Geometry in the Display tree to see the Geometry display options
available, as shown below. The geometry options work only if a Geometry file is loaded.

Figure 102: Geometry Tree Display Options

Show All

Displays the whole geometry.

Hide All

Hides the whole geometry.

Blank Entities

Makes selected entities invisible.

Unblank All Entities

Restores blanked entities.

Rename Entity

Opens a Rename Geometry DEZ where you assign a new name to the selected entity.
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New Name

Enter the desired name.

Type

Choose the type of geometry from the drop-down list to constrain the selection options.

POINT/CURVE/SURFACE/DENSITY/ENTITY

Click the Select ... icon, and then choose an appropriate geometry from the GUI window.

The following sections describe the subparts of the Geometry Tree.

Geometry Subsets Options

Modify Geometry Subset Options

Geometry Points Options

Geometry Curves Options

Geometry Surfaces Options

Geometry Bodies Options

Geometry Densities Options

Geometry Subsets Options

Elements can be grouped into Subsets, which have display options that can be controlled independ-
ently. For a description of how to control visibility of a subset, see Mesh Subsets (p. 167).

Right-click Subsets under Geometry to view the display options as shown below.

Figure 103: Subsets Display Options

Create

Creates subsets by the following methods.

Figure 104: Create Subset by Selection Window
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Create Subset by Selection

 Select geometry or mesh entities to add to the subset, then click Apply. If there are no
valid selections and Apply is clicked, then an empty subset will be created.

Note:

When entities are selected, the type of entity followed by the entity name
appears in the field. For example, the selection of a surface of the entity
"box.00" will appear as "surface box.00". When manually entering an entity,
the same format must be used.

Break Part into Subsets by Surface Connectivity

 Creates subsets of connected surfaces filtered by the angle of connectivity or surface
curvature.

Note:

Build Topology must be completed before using this feature.

This feature starts with one of the selected surfaces and returns the connected surfaces that
are connected at an angle less than the defined value, or has a curvature less than the defined
value. Then it moves on to the next surface. If none of the attached surfaces meet the defined
criteria it is placed in its own group.

Surfaces

Select the surfaces to be broken into subsets.

Angle

If the angle between the connected surfaces is less than the defined angle, then it
will be added to the same group. An angle of 180 would mean that all connected
surfaces would be in the same group. An angle of 0 would mean that all angles would
stop surface grouping, so each surface would be in its own group. Parallel surfaces
meet at an angle of 0.

Curvature

If the curvature of a surface is less than the defined curvature value, than it will be
added to the group. A curvature value of 360 means that no surfaces would be ex-
cluded based on curvature, and a value of 0 means that all surfaces would become
their own group.

If the default values of angle = 180 and curvature = 360 are used, the selected surfaces will
be broken into groups by connectivity. After the groups are created, the subsets are ordered
by surface area, where the largest groups are listed first.
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Create Subset by Attributes

 Create subsets of geometry or mesh entities filtered by specified attributes. Toggle ON
the desired type of attribute, and enter the criteria in the field. More than one criteria can be
used, for example, entities with mesh maximum sizes between 50 and 100 can be defined by
entering "< 100 > 50".

Mesh Maximum Size

To create a subset of surfaces and curves filtered by the Maximum element size set
for the surfaces or curves.

Curve Length

To create a subset of curves filtered by curve length.

Surface Area

To create a subset of surfaces filtered by surface area.

Preview Subset

Click to highlight the entities that have the defined attributes. To create the subset
of these entities, click Apply.

Show All

Displays all created subsets.

Hide All

Hides all created subsets.

Create Part

Creates parts from selected subsets.

Note:

Subsets should not overlap since parts are "exclusive groups".

Modify Geometry Subset Options

Right-click an existing subset name and the following options will be shown.
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Figure 105: Modify Subset Options

Info

Gives information about the subset.

Modify

You can modify Subsets with the following options.

Figure 106: Add to Subset by Selection Window

Add to Subset by Selection

 Select the geometric entities to add to the subset.

Remove from Subset by Selection

 Select the geometric entities to remove from the subset.

Add Layer(s) to Subset

You can add layers to a subset using different methods of the Flood Fill option as
shown below.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.150

Display Tree



Figure 107: Modify Subset – Add Layer Method

• Add Layer Method

Enter the number of layers attached to the selected entity to be added to the subset.

• All Attached Method

This will make a subset of all the attached items of the selected item.

• To Angle

The items that are attached to the selected entity at this angle or less will be added to the
subset. Enter the required angle (degrees) as shown below.

Figure 108: Modify Subset – To Angle Method

• At one side

If an entity is selected, all the surfaces attached to that entity will be highlighted. Select
any of the highlighted surfaces with the left mouse button and click the middle mouse
button or press Apply to add that surface to the subset.
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Delete

Deletes the subset.

Rename

To rename the subset.

Copy

Makes a copy of the subset.

Clear

Clears the subset contents.

Add

To add elements to the subset.

Remove

To remove elements from the subset.

Geometry Points Options

The display options for Points are shown below.

Figure 109: Points Display Options

Show Large

Shows the visible points as large points.

Show Dormant

Shows all the dormant points which are not permanently deleted.
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Show Protected

If enabled, soft protected points will be displayed with a yellow sphere; hard protected points
will be displayed with a red sphere.

Note:

Protected points come from Workbench Meshing. If you are not using Workbench
Meshing, you may disregard this option.

Show Point Names

Displays the point names of the visible points.

Show Point Info

Gives information about a selected point, including the point name, part name, and geometric
location.

To employ this option, select Points > Show Point Info. Proceed to select a point with the left
mouse button and accept the selection with the middle mouse button. Information on the point(s)
will be listed in the Messages window.

Blank Points

Blanks selected points.

Unblank All Points

Restores blanked points.

Show Only Points

Displays only the selected points and makes everything else invisible.

Show Attached Curves

Displays the curves which are attached to the selected point.

Show Attached Surfaces

Displays the surfaces which are attached to the selected point.

Rename Point

To rename selected points.

Geometry Curves Options

The display options for Curves are shown below.
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Figure 110: Curves Display Options

Show Unattached

Shows the curves that are not attached to any of the geometry.

Show Single

Shows all the curves that are attached to only one surface.

Show Double

Shows all the curves that are shared by two surfaces.

Show Multiple

Shows all the curves that are shared by more than two surfaces.

Show Wide

Displays line data with thicker lines, to help distinguish between geometry and mesh.

Show Dormant

Shows all the dormant curves which are not permanently deleted.
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Show Protected

If enabled, soft protected curves will be displayed as a dotted line; hard protected curves will be
displayed as a bold dashed line.

Note:

Protected curves come from Workbench Meshing. If you are not using Workbench
Meshing, you may disregard this option.

Show Hard Sized

If enabled, hard sized curves will be displayed as a non-bold, dashed line.

Note:

Hard sized curves come from Workbench Meshing. If you are not using Workbench
Meshing, you may disregard this option.

Color by Count

Colors curves by the number of surfaces the curve is associated with. This option works only after
CAD repair. See Repair Geometry (p. 283).

• Green

Not associated with any surfaces

• Yellow

Associated with only one surface edge

• Red

Associated with two surface edges

• Blue

Associated with more than two surface edges

Show Composite

Displays the existing composite curves with different colors. Blocking must be loaded for this
option. Composite curves are curves that are grouped together for the purpose of edge association.
See Blocking > Associate > Group/Ungroup curves (p. 500).

Curve Node Spacing

Displays a preview of the node spacing on curves.

Curve Element Count

Displays the number of elements prescribed on each curve.
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Curve Tetra Sizes

Displays a tetra icon sized to indicate the tetra sizes that are set (if any) on each visible curve.

Curve Hexa Sizes

Displays a hexa icon sized to indicate the hexa sizes that are set (if any) on each visible curve.

Show Curves Names

Displays the names of the visible curves.

Show Curve Info

Gives information about a selected curve, including the curve and part names.

To employ this option, select Curves > Show Curve Info. Proceed to select a curve with the left
mouse button and accept the selection with the middle mouse button. Information on the curve(s)
will be listed in the Messages window.

Blank Curves

Blanks all the selected curves.

Unblank All Curves

Restores blanked curves.

Show Only Curves by Selection

Shows only selected curves on the screen and keeps others invisible.

Show Only Curves by Sharp Angle

Shows only curve pairs with angle of intersection less than specified limit.

Show Attached Points

Shows all the points which are attached to the selected curve.

Show Attached Surfaces

Shows the surfaces which are attached to the selected curve.

Rename Curve

You can rename the selected curves.

Geometry Surfaces Options

The display options for Surfaces are shown below.
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Figure 111: Surfaces Display Options

Show Full

A more detailed representation of the CAD data, showing more isobars than in the Simple repres-
entation. For triangulated surface data, a detailed representation will show all the surface triangles.

Show Simple

A wireframe representation of CAD data or a "Hard Feature" representation of triangulated surface
data, including surface boundaries as hard features.

Show Simpler

This wireframe representation requires less memory than the Simple option. This option is bene-
ficial for simplifying more complicated models, and making them easier to translate or rotate.

Show Simplest

This representation uses the least memory. This option is recommended for simplifying models
that are extremely complicated.

Wire Frame

The surfaces are drawn using lines, in either simple or detailed formats.

Solid

A solid or shaded representation of the surface data, which can be either simple or detailed.

Solid & Wire

A combination of the Solid and Wireframe representations of the surface data.
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Grey Scale

This will convert the color geometry into grey scale.

Transparent

This will show the surface as transparent.

Show Surface Normals

When enabled, arrows indicating the positive normal direction of each visible surface will be dis-
played.

Color by Normal

When enabled, the part color is used to indicate the positive normal side of each visible surface.
The reverse side of each surface is colored gray.

Note:

This option works only with Solid or Solid & Wire display.

Show Surface Thickness

This will show the thickness assigned for the surface.

Tetra Sizes

Selecting this option will display the reference tetra mesh sizes upon the selected visible surfaces.

Hexa Sizes

Selecting this option will display reference hexa sizes upon the selected visible surfaces.

Show Surface Names

Displays the names of the visible surfaces.

Show Surface Info

Gives information about a selected surface, including the surface and part names.

To employ this option, select Surfaces>Show Surface Info. Proceed to select a surface with the
left mouse button and accept the selection with the middle mouse button. Information on the
surface or surfaces will be listed in the Messages window.

Blank Surfaces

Blanks the selected surfaces.

Unblank All Surfaces

Restores blanked surfaces.
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Show Only Surfaces

Displays the selected surfaces only.

Show Attached Points

Displays points that are attached to the selected surface.

Show Attached Curves

Displays curves that are attached to the selected surface.

Rename Surface

To rename the selected surfaces.

Geometry Bodies Options

The display options for Bodies are shown below.

Figure 112: Bodies Display Options

Show Bounding Surfaces

Shows the attached boundary surfaces of the visible body, if any exist.

Show Body Names

Displays the names of the visible bodies.

Show Body Info

Displays information about a selected body in the Messages window, including the body and
part names.

Screen Move

Allows interactive movement of the selected material point(s) in the plane of the screen.

Note:

When using the box selection method, partial enclosure should be used to select a body’s
material point without selecting attached surfaces, if any exist.
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Geometry Densities Options

Figure 113: Density Options Window

Create Density

Opens the Create Density Window which is explained in Create Mesh Density (p. 386).

Modify Density

Allows you to modify a previously created density region. The following options are available:

Size

Specifies the local maximum mesh size specified for the density region. This will be multiplied
by the Global Scale Factor.

Ratio

Specifies the tetra growth ratio away from the density region.

Width

For a density region, this specifies the number of layers (N) of the specified element size away
from the boundary of the density region that should have a constant expansion ratio. The
layer N + 1 will have a tetra size of the Size value multiplied by the Ratio.

For line and point densities, the Size value multiplied by the Width is the radius of the region
that the density region influences.
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Density Location

Contains options for modifying the bounding nodes of the density region.

Modify Location

Allows you to select a new location for an existing bounding node. Select the node to be
moved and its new location.

Add Location

Allows you to add new bounding node(s) to the existing density region definition. Select
the location(s) to be added to the density region extents and confirm the selection using
the middle-mouse button.

Delete Location

Allows you to delete existing bounding node(s) from the density region definition.

Delete Density

Allows you to select the density region(s) to be deleted.

Wide Density Lines

Displays wider density region lines.

Note:

This option is often useful when taking images of the mesh setup.

Density Tetra Sizes

Shows the reference tetra size for the density region(s).

Density Color

Allows you to display the density region(s) in the color of your choice.

Show Density Names

Shows the names of the density region(s) on the screen.

Show Density Info

Reports information about the selected density region(s) in the message window.

Blank Densities

Blanks the selected density region(s).

Unblank All Densities

Restores blanked density region(s).
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Rename Density

Allows you to rename the selected density region.

Mesh

The Mesh branch of the Display tree allows you to display all or part of the mesh by element type.

Figure 114: Mesh Tree

Mesh Display Options

Right-click Mesh in the Display tree to see the options available for displaying the mesh, shells or
volumes, as shown below.

Figure 115: Mesh Display Options
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Cut Plane

• Manage Cut Plane

Opens the Manage Cut Plane DEZ as shown below. This option is described in Mesh Cut
Plane (p. 67) in the Main Menu chapter.

Figure 116: Manage Cut Plane Window

• Show Cut Plane

If toggled ON, the Cut Plane will be displayed.

Element Numbers

Displays the numbers of the visible elements.
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Color by Quality

Displays the elements according to the quality color setup. The color contour bar displays the
range of colors by quality.

Figure 117: Example of Color by Quality for Quality Quad Angle

Shrink 10%

Displays each element shrunk by 10% of its original size.

Shrink 50%

Displays each element shrunk by 50% of its original size.

Shrink Node Pos

Works in collaboration with the Shrink features that were previously described to redraw the
nodes, depending on whether or not the elements were shrunk.

Dot Nodes

Displays nodes as dots. If the display background color is dark, the dot nodes will be displayed
as white, and if the background color is light, the dot nodes will be displayed as black.

Node Numbers

Displays the numbers of the visible nodes.

Node Coords

Displays the coordinates of all the visible nodes.

Elem Verts

Displays the node order numbers of the visible elements. Works best if a shrink factor is also dis-
played. The element vertex numbers can help you see how an element is defined, and thereby
see the orientation of the element. For example, a tri element is defined by three nodes in a
particular order (0, 1, 2). This defines the orientation of the element.

Elem Triads

Displays the orientation triad of each visible element, with the I, J, and K directions.
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No Inner Elems

Shows only the outer volume elements and hides the inner volume elements.

Periodicity

Identifies the periodicity of the nodes, either translational or rotational.

Note:

Periodicity applies only to Volume (Tetra and Hexa) Meshing, as well as Patch In-
dependent Meshing.

Quadratic Shape

Displays the correct curvature of edges with midside nodes.

Wide Lines

Displays wider lines for elements.

Couplings

Displays couplings. Couplings consists of defined hanging nodes and arbitrary interfaces.

Locked Elements

Displays any locked elements.

Distributed attribute

Makes the element with a distributed attribute visible. For example, if a model has distributed
boundary conditions, selecting this option allows you to view and edit the BC at an element or
node basis. This option is also available as an icon on the Edit Mesh toolbar.

Diagnostics
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This option allows you to utilize shell mesh diagnostics. The mesh diagnostic options can also be
accessed through Edit Mesh > Check Mesh (p. 569). The difference is that the diagnostic options
in the Mesh Display Tree does not add problematic mesh to mesh subsets.

Single Edges

Displays any single edges of surface mesh elements that are visible. A single edge would
represent a hanging edge, and the element would be an internal baffle. These may or may
not be legitimate. Legitimate single edges would exist where the geometry has a zero thickness
baffle with a free or hanging edge.

Multiple Edges

Displays any edge that is shared among three or more surface elements. Legitimate multiple
edges would be found at a "T" junction, where more than two geometry surfaces meet. These
elements are a subset of the single and multiple edge checks.

Overlapping elements

Displays surface elements that occupy part of the same surface area, but do not have the
same nodes. This could be surface mesh that folds on to itself.

Non-manifold elements

Displays surface elements with non-manifold vertices. Non-manifold vertices are those where
the outer edges of their adjacent elements do not form a closed loop. Usually indicates ele-
ments that jump from one surface to another, forming a "tent like" structure. This would
usually pose no problem for mesh quality but will represent a barrier in the mesh that probably
should not be there.

Triangle boxes

Groups of four triangles that form a tetrahedron with no volume element inside.

Show

Edges

Displays only the edges of the surface mesh that are found by the selected diagnostic
options. Single edges will be displayed in yellow, and multiple edges in blue.

Edges and Faces

Displays the edges and one layer of attached faces.

Edges and 2 layers of Faces

Displays the edges and two layers of attached faces.

Show only problems

Displays only the elements found by the diagnostic options and turns off the rest of the mesh.
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Mesh Subsets

Elements can be grouped into Subsets, which have display options that can be controlled independ-
ently.

Note:

To view the contents of a single subset, select the subset and deselect all other subsets.

Subsets work independently of the active elements under parts and types. You can switch
between displaying entities by part, type, or by a defined grouping in a subset. Parts and
Subsets are Boolean with the geometry, but they are not Boolean with each other, meaning,
by turning a subset off, it does not turn those entities off unless they are off in the part
as well. To access specific entities of geometry, mesh, or blocking, you can place the entities
into a subset. By turning off the Parts, and displaying the subset, you can choose to view
only the entities in the subset.

Parts are exclusively defined, so that an entity can only be in one part. But one entity can
be part of multiple subsets.

Clicking the right mouse button on Subsets in the Mesh Tree will give the options below.

Figure 118: Mesh Subsets Display Options

Create

To create a new subset of active parts and types. There are different options for creating subsets
as shown below.

Figure 119: Create Subset Window
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Create Subset by Selection

 Create a subset by entering a name and selecting either geometric or mesh entities.

Create Subset near Position

 Create a subset near a certain position by entering the XYZ coordinates as shown below.

Figure 120: Create Subset Near Position Window

• Nodes

Toggle this ON if nodes are to be selected.

• 1d elems

Toggle this ON if 1d elements (lines and curves) are to be selected.

• 2d elems

Toggle this ON if 2d elements (surfaces) are to be selected.

• 3d elems

Toggle this ON if 3d elements (volumes) are to be selected.

• Toggle OFF the options that you do not wish to select.

Create Subset by Element Number

 Create a subset by entering the elements numbers of the elements you want to include.
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Create Subset in Region

 Create a subset in a specified region as shown below.

Figure 121: Create Subset in Region Window

• Min and Max Coordinates

Enter the minimum and maximum coordinates that represents the region.

• Include partially enclosed

Includes elements partially enclosed in the region specified by the coordinates.

• Nodes

Toggle this ON if nodes are to be selected.

• 1d elems

Toggle this ON if 1d elements (lines and curves) are to be selected.

• 2d elems

Toggle this ON if 2d elements (surfaces) are to be selected.

• 3d elems

Toggle this ON if 3d elements (volumes) are to be selected.
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• Toggle OFF the options that you do not wish to select.

Find Worst

Creates a subset of the elements with the worst quality found using the "Quality" criterion.

Show All

Displays all subsets.

Hide All

Hides all subsets.

Shadings

allows you to set the shading for the subset independent of the shading used for the mesh. This
allows for better visibility as the subsets can be distinguished from the surrounding mesh. By
default, the shading of the subset is Inherited from the shading used for the mesh. You can also
select the Wire Frame, Solid, or Solid & Wire rendering.

Note:

Subsets created from the Quality Metric Histogram (p. 591) will retain their Color by
Quality based color and shading independent of this setting.

Tip:

• To display other subsets with Color by Quality, combine the Solid or Solid & Wire
subset shading with the Color by Quality mesh display option.

• To display the elements of a DIAGNOSTIC subset without the Color by Quality
shading, you can copy it to a new subset and disable the DIAGNOSTIC subset (Mesh
> Subsets > DIAGNOSTIC).

Modify Mesh Subsets

Right clicking on an existing mesh subset displays the options shown below.
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Figure 122: Modify Mesh Subset Options

Info

Gives information about the subset.

Modify

Subsets can be modified by the options in the window shown below.

Figure 123: Modify Subset Window
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The following options are common to all of the Modify Subset options.

• Clear

Clears all the entities in the subset.

• Reset to Active Parts and Types

Resets the subset to contain all active (visible) parts and types.

• Remove Inactive Parts and Types

Removes the inactive (not visible) parts and types from the subset.

The different Modify Subset options are described below.

Add to Subset by Selection

 Select mesh entities to add to a subset.

Add to Subset near Position

 Enter the node numbers or XYZ coordinates of entities to add to a subset.

Add by Element Number

 Enter element numbers to add to a subset.

Add Contents of Subset

 Add contents of an existing subset to the current subset.

Add to Subset in Region

 Choose a subset with a specified region to modify.
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Figure 124: Add to Subset in Region Window

• Min and Max Coordinates

Enter the minimum and maximum coordinates that represent the region.

• Include partially enclosed

Includes elements partially enclosed in the region specified by the coordinates.

Restrict to subset by selection

 Allows you to restrict a subset to the entities that are selected.

Remove from subset by selection

 Removes the selected entities from the subset.
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Add Layer(s) to Subset

You can add layers to a subset using different methods of the Flood Fill option as de-
scribed below.

Figure 125: Add Layer(s) to Subset Window

• Add Layer Method

Enter the number of layers attached to the selected entity to be added to the subset.

• All Attached Method

This will add all the attached items of the selected entity to the subset.

• Same Part

Adds all entities in the same part.

• To Curve

Adds all entities up to the nearest boundary curve.

• To Angle

Enter the threshold Angle (degrees). Any items that are attached to the selected entity at
this angle or less will be added to the subset.
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You can also use the check boxes to filter visible and volume elements.

• Only visible elements

Toggle ON to add visible entities only.

• Also volume elements

Toggle ON to add volume elements.

Remove Layer(s) from Subset

You can remove layers from a subset using different methods as described below.

• Num Layers

Enter the number of layers to be removed.

• Only visible

To remove visible entities only.

Make scan plane

 Creates a subset of scan plane elements. This option is for advanced users.
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Figure 126: Make Scan Plane Window

Delete

Deletes an existing subset.

Rename

To rename a subset.

Copy

Copies a subset.

Clear

Clears the contents of a subset.

Add 1 layer

Adds the adjacent layer of entities to the subset.
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Add

To select entities to be added to the subset.

Remove

To select entities to be removed from the subset.

Make Element set

To define a subset as an element set.

Make Node set

To define a subset as a node set.

Break by Parts

If the mesh subset contains elements in two or more parts, the subset will be separated into
smaller subsets along the part boundaries, with names derived from the corresponding part name.

Break by Connectivity

If the mesh subset contains elements from two or more intra-connected regions (elements are
connected within the region), the subset will be separated into smaller subsets corresponding to
each region

Mesh Points

Click Points in the Mesh Tree to turn nodes ON or OFF from the display.

Mesh Lines

Click Lines in the Mesh Tree to turn bar elements ON or OFF from the display.

Right-clicking Lines in the Mesh Tree gives the display option Direction. Toggling ON this option
displays an arrow showing the relationship between the first and second nodes along the line element.
This can be useful to display the dependency for 1D line element properties. The direction of the line
element can be changed using Edit Mesh > Reorient Mesh > Reverse Line Element Direction.

Mesh Shells

The display options for Shells  are shown below.
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Figure 127: Shells Display Options

Wire Frame

Displays the mesh with a wire frame outline, colored part by part.

Solid

Displays the mesh as a solid mesh.

Solid & Wire

Displays the mesh as a solid mesh with a wire frame outline. The wire frame is drawn in the color
of the background.

By dimension

Displays shell elements only as solid mesh.

Hidden Line

Displays a wire frame mesh with the backside of the model hidden.

Color by Quality

Displays the shell elements according to the quality color setup. The color contour bar displays
the range of colors by quality.

Figure 128: Examples of Color by Quality—Aspect Ratio

Tri elements
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Tetra elements
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Dual Mesh

Allows you to view the mesh dual. When enabled, it draws the wire-frame between the centroid
of each cell to better show the node centered volumes. An example of the mesh dual for a tetra-
prism mesh is shown in Figure 129: Mesh Dual for a Tetra-Prism Mesh (p. 180).

Figure 129: Mesh Dual for a Tetra-Prism Mesh
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This option is just a visual aid and can be used only for surface meshes.

Note:

The mesh dual of a hexa mesh is still a hexa mesh.

Shell Thickness

Displays the surface mesh thickness.

Normals Using Arrow

When enabled, arrows indicating the positive normal direction of each visible unstructured surface
element will be displayed.

Normals Using Color

When enabled, the part color is used to indicate the positive normal side of each visible unstruc-
tured surface element. The reverse side of each element is a darker color.

Note:

This option works only with Solid or Solid & Wire display.

Face Icons

Adds part colored face icons to the wireframe display. The icons appear similar to Shrink 75%.

Diagnostics

This option allows you to utilize shell mesh diagnostics. The mesh diagnostic options can also be
accessed through Edit Mesh > Check Mesh (p. 569). The difference is that the diagnostic options
in the Mesh Display Tree does not add problematic mesh to mesh subsets.

Single Edges

Displays any single edges of surface mesh elements that are visible. A single edge would
represent a hanging edge, and the element would be an internal baffle. These may or may
not be legitimate. Legitimate single edges would exist where the geometry has a zero thickness
baffle with a free or hanging edge.

Multiple Edges

Displays any edge that is shared among three or more surface elements. Legitimate multiple
edges would be found at a "T" junction, where more than two geometry surfaces meet. These
elements are a subset of the single and multiple edge checks.

Overlapping elements

Displays surface elements that occupy part of the same surface area, but do not have the
same nodes. This could be surface mesh that folds on to itself.
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Non-manifold elements

Displays surface elements with non-manifold vertices. Non-manifold vertices are those where
the outer edges of their adjacent elements do not form a closed loop. Usually indicates ele-
ments that jump from one surface to another, forming a "tent like" structure. This would
usually pose no problem for mesh quality but will represent a barrier in the mesh that probably
should not be there.

Triangle boxes

Groups of four triangles that form a tetrahedron with no volume element inside.

Show

Edges

Displays only the edges of the surface mesh that are found by the selected diagnostic
options. Single edges will be displayed in yellow, and multiple edges in blue.

Edges and Faces

Displays the edges and one layer of attached faces.

Edges and 2 layers of Faces

Displays the edges and two layers of attached faces.

Show only problems

Displays only the elements found by the diagnostic options and turns off the rest of the mesh.

Surface Bounds

Displays the surface boundary region and all elements attached to that region. Useful in visualizing
curve boundary regions.

Mesh Volumes

Volume display options are shown below.

Figure 130: Volume display options

Wire Frame

Displays the elements with a wire frame mesh on it.
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Solid

Displays the elements as a solid mesh.

Solid & Wire

Displays the mesh as a solid mesh with a wire frame outline. The wire frame is drawn in the color
of the background.

Hidden Line

Displays a wire frame mesh with the backside of the model hidden.

Volume Bounds

Displays the volumetric boundary region and all elements attached to that region. Useful in
visualizing the surface boundary regions.

Blocking

Click the right mouse button on Blocking in the Display tree to see the options available.

Blocking Options

Right-click the Blocking branch in the Display tree to view the Blocking display options. When the
blocking tab is active, the hot key (p. 140) "i" will initialize the index control. The Blocking display options
are as follows:

Figure 131: Blocking Display Options

183
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Blocking



Index Control

Figure 132: Index Control Window

Select corners

Allows you to select boundary node vertices and adjusts the index range accordingly.

Reset

Resets the values to the minimum and maximum values, so that the entire blocking is displayed.

Query Edge

Allows you to select an edge. The system will then center the Index control on the dimension
corresponding to the edge selected

When an Ogrid is created, a new index direction will be added to the Index control and a
message will be printed with the corresponding dimension. Ogrid dimensions are named On

where n begins with a value of 3. The reason for this is that dimensions 0, 1, and 2 already
correspond to the I, J, and K indices.

The index range is not taken into account when the mesh is saved.

Index Sets

Contains options for saving and managing index sets based on the index control values.

Show

shows the list of the saved index sets in the Saved Index Sets dialog.

You can select the index set to restore from the list and the blocking display will be reset
corresponding to the saved index values.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.184

Display Tree



Add

saves the current set of index values. The saved index sets are numbered sequentially (1,
2, etc.).

Clear

clears all the saved index sets from the Saved Index Sets list.

Load

allows you to load previously saved index sets from an index control (*.ictrl) file.

Save

allows you to write the saved index sets to an index control (*.ictrl) file.

Done

Closes the window.

Set Line Width

Sets the width of Block edge lines.

Init output blocks

Initializes the number of Output Blocks to be equal to the number of regular topology blocks.
See Pre-Mesh (p. 196).

Blocking info

Provides information in the message window about the blocking (number/type of blocks, topology
info, index info) and pre-mesh (number of nodes, elements). Information about shared walls (if
defined) will also be reported.

Blocking Subset Options

Right-click Subsets in the Blocking tree to view options as shown below.

Figure 133: Blocking Subset Display Options

Create

Opens a dialog box to input a name, choose a type, and select entities for a new Blocking Subset.

Note:

The subset name cannot be already in use as a part name.
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You can use the Type drop-down list to choose whether to create a DISPLAY subset or a
NAMED_SELECTION subset.

• A DISPLAY subset allows you to control the visibility of the subset independently. You may
add only Blocks to a display subset.

For a description of how to control visibility of a DISPLAY subset, see Mesh Subsets (p. 167).

Figure 134: Create Display Subset Window

• A NAMED_SELECTION subset adds blocking entities into a topologically related group. The
subset information is included in the Blocking file (*.blk) when the project is saved. You may
add Faces, Edges, and/or Vertices to a named selection subset.

Figure 135: Create Named Selection Subset Window

After the subset is created, it will be displayed in the Display Tree under Blocking → Subsets as
shown below.
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Figure 136: Blocking Subset Tree

Modify Subsets Options

Right-click a created subset to view the options available.

Figure 137: Modify Subset Options

Info

The subset Name, Type, and block entities it contains are printed in the message window.

Modify

Change the entities contained within the subset. If it is a Display subset, you may add or remove
Blocks only. If it is a Named Selection subset, you may add and remove Faces, Edges and Ver-
tices.

Figure 138: Modify Subset window
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Add to Subset by Selection

 Select the entities to add to the subset.

Remove from Subset by Selection

 Select the entities to remove from the subset.

Delete

Deletes the subset.

Rename

Renames the subset.

Vertices

The display options for Vertices are shown below.

Figure 139: Vertices Display Options

On surfaces

To turn the display of vertices on surfaces ON  or OFF.

Periodic

To turn the display of vertices that are marked as periodic ON  or OFF.

Names

Displays the names of the vertices.

Proj type

Vertices will be tagged according to type:

• p: Associated to a prescribed point (red).

• c: Associated to a curve (green).
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• s: Associated to a surface (white).

• v: Associated to an interior, volume, or vertex (blue).

Indices

Displays the block indices at each vertex location.

Numbers

Vertices will be displayed with unique numbers assigned to them during creation of the blocks.

Show Hidden

Toggles the display of hidden vertices using the same format (type, indices, or numbers) as visible
vertices.

When creating block topology, some splits may not be propagated through the entire extent of
the blocking. To maintain structured mesh, hidden vertices are placed at locations where splits
would occur if fully propagated.

Note:

Hidden vertices are not selectable for merging, moving, showing info, or any such action
in which you are required to select a vertex.

Tip:

You can also identify the presence of hidden vertices using the Show Edge Info
command. See Edges (p. 189).

Show Vertex Info

Vertex number, corresponding block indices, and location are displayed in the message window.

Edges

The display options for Edges are shown below.
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Figure 140: Edges Display Options

Internal edges

To turn the display of internal edges in a volume ON  or OFF.

Show associations

Shows the associations of different edges to curves.

Bunching

Displays the node distribution on edges.

Counts

Displays the number of elements of the edges.

Projected Edge Shape

Displays the edges after mesh calculation with the current node distribution.

Projected Mesh Shape

Displays the mesh after calculation with the current edge distribution.

Meshing set

Displays the special meshing sets.

Shape source

Turns the linked edges ON or OFF. All the arrows will point from the source edge to the target
edge.

Simple

Shows edges in simple form.
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Color by Count

The edge color indicates the number of block faces to which it is connected - yellow means
connected to one block face; red means connected to two block faces; blue means connected to
three or more block faces.

Show Edge Info

Gives information about the selected edge. The edge vertices (by number), node spacing, spacing
ratio, constraints, edge dimension, index, number of nodes, mesh law, and edge length are reported
in the message window.

Note:

If the edge includes hidden vertices, the format for vertex display is Edge (hidden)
vertices = n1 (n2) n3. In this situation, you use the first two vertex numbers,
n1 and n2, in any blocking command that uses the edge as an input parameter. The
command will be applied to the entire edge.

Faces

The display options for Faces are shown below.

Figure 141: Faces Display Options

Solid

If enabled, mapped faces are displayed in solid red color and free faces are displayed as wide
blue outline.

Periodic Faces

Allows you to turn the display of periodic faces ON or OFF. Periodic faces are established when
all associated vertices have been set to periodic using the Periodic Vertices (p. 481) option in the
Blocking tab. Vertex periodicity can also be displayed by enabling Periodic (p. 188) for Vertices
in the tree. Further splits across periodic faces create new edges and vertices which are automat-
ically set to periodic.
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Face Projection

Toggles ON or OFF the display of faces associated with surfaces (see Associate Face to Sur-
face (p. 493)).

The projected faces will be displayed depending on their association as follows:

DisplayFace Association

Part Color along with Part NameFace→Part

White or Black (depending on the
background color)

Face→Link Shapes

PurpleFace→Selected Surface

GreenFace→Interpolate

YellowFace→Reference Mesh

Note:

Only one of Solid, Periodic Faces, or Face Projection may be selected at one time.

Boundary

Displays only the faces that lie on the outer surfaces.

Volume

Displays only the faces that are internal to the volume.

Note:

Only one of Boundary or Volume may be selected at one time.

Blanking

This option gets enabled when you use Blank Free Faces. To turn blanked faces back on, disable
Blanking.

Blank Free Faces

Use this option to hide selected free face(s) from the screen, as well as remove them from addi-
tional selection and being affected by subsequent operations.

Note:

• Only Free Block faces can be hidden. For other block types, hiding a block face will
also hide the attached block volume.

• This works for 3D blocking only.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.192

Display Tree



Shared Wall Info

Reports information about the defined shared wall configurations in the message window. The
volumes having a shared wall between them and the shared surface will be reported.

Show Face Info

Gives information about the faces. The face vertices, face elements, and the projection type will
be reported in the message window.

Note:

In blocking topologies that include hidden vertices, the reported vertex numbers may
not match the visible vertex numbers and the number of elements will be greater than
one. See Vertices (p. 188) and Edges (p. 189).

Blocks

The display options for Blocks are shown below.

Figure 142: Blocks Display Options

Note:

The Blocks display is an approximation using vertices only and does not represent any
detail, especially regarding holes.

Solid

Displays blocks in solid color.
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Whole blocks

Changes how blocks are displayed, depending on the type.

Whole Blocks is DisabledWhole blocks is EnabledType of block

Blocks are displayed as smaller,
unmerged sub-blocks.

Blocks are displayed full size.
Merged blocks are displayed as a

Mapped

single block. Block id number is
shown.

Blocks are displayed as six block
sides.

Blocks are displayed full size. Block
id is shown along with type
(free).

Free

Blocks are displayed as four
mapped sides.

Blocks are displayed nearly full size.
Block id is shown along with type
(swept).

Swept

No shrink

If toggled ON, blocks are displayed at full size regardless of the block type.

Note:

Whole Blocks must be disabled.

Find Worst

This option calculates the determinant value for each block and highlights the block(s) with the
worst value or values. A bad determinant block usually results in a bad determinant grid. Moving
the vertices can help improve the determinant values. The worst blocks are listed in the message
window by their determinant values and are shown in red in the model.

You can set the number of worst blocks to display by selecting Settings → Meshing Options →
Hexa Meshing, then setting a numerical value for Find Worst. The default range is 1–3, but you
can set the range to any desired level (for example, 3–5 or 2–8).

IJK

Displays the IJK grid orientation for mapped blocks.

Refinement

Allows the display of only those blocks that are affected by the Refinement command. See Pre-
Mesh Params (p. 513). Disable to allow the display of all blocks.
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Classes

Displays the blocks along with their respective axis and index numbers. For each block the three
axial directions are indicated by 1, 2, and 3, and Ogrids are represented by 0.

Note:

Whole Blocks must be disabled.

Show Mapped

Enable or disable the display of structured blocks.

Show Swept

Enable or disable the display of swept blocks in the geometry.

Show Free

Enable or disable the display of unstructured blocks.

Show Inverted

Displays inverted blocks.

Blanking

This option gets enabled when you use Blank Blocks. To turn blanked blocks back on, disable
Blanking.

Blank Blocks

Blanking blocks not only hides blocks from the screen, it also removes them from selection and
being affected by subsequent operations. This option opens a submenu to let you choose which
blocks to blank.

Select

Allows you to choose blocks manually.

Press the Shift key when clicking to deselect blocks.

All Mapped

Blanks all structured blocks.

All Swept

Blanks all swept blocks.

All Free

Blanks all free blocks.
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Block Types

Outputs statistics for the count of each block type, in the message window.

Show Block Info

Gives information about the selected block in the message window.

Note:

In blocking topologies that include hidden vertices, the reported number of elements
in one or more dimensions will be greater than one. See Vertices (p. 188).

Pre-Mesh

The display options for Pre-Mesh are shown below.

Figure 143: Pre-Mesh Display Options

Wireframe

Displays the model in the wireframe mode.

Solid

Displays the model in the solid mode.

No projection

When the mesh is generated, it will conform to the blocking without being projected to the actual
CAD geometry.
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Project vertices

When the mesh is generated, the vertices/points on the edges of the blocks will be projected to
the curves or surfaces to which they are associated. No other projection will take place.

Project edges

When the mesh is generated, the nodes on the edges of the blocks will be projected to the curves
or surfaces to which they are associated. The face nodes will not be projected to the surfaces,
but rather interpolated between the edges. This option is generally used for two-dimensional
models. Project edges may be used for three-dimensional models as well, as a method to quickly
confirm a correct mesh before employing the Project faces operation.

Project faces

When the mesh is generated, all face nodes and edge nodes will be projected to their associated
curves and surfaces. This option is generally used for three-dimensional models.

Active Parts

Allows you to select surface parts to be considered for projection when the mesh is generated.
All surface parts highlighted in the selection list will be projected to during the mesh generation.

When you compute the pre-mesh, a message will appear indicating the part(s) to which projection
has been disabled.

Recompute

Recomputes the mesh.

Pre-mesh Info

Reports the number of nodes and elements, by type, in the message window.

Find Worst elements

Displays those elements of the pre-mesh that have the worst value of the selected criterion in
the graphics window.
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Figure 144: Pre-Mesh: Find worst elements

Criterion

Specifies the Criterion for finding the worst elements. For descriptions of the criteria, see Pre
Mesh Quality Options (p. 531).

Select the criterion and click Apply.

The Number of elements, Current element, Element ratio, and Element type are updated
automatically. The number of elements and the range are also reported in the message window.
The display shows the current worst element, identified by a point in the display.

Clear

Clears the worst element details.

Show elements

Enables you to view the elements identified. Click Next or Previous to step through the
identified elements one by one.

Note:

• The software automatically finds a range of bad elements including the worst element
and those near it. The range of elements must be less than 500 elements or the
function will be skipped. If only 1 element is found, the Next/Previous buttons will
be greyed out.

• This option is disabled if the Pre-Mesh Quality histogram is displayed.
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• This option is intended for a 3D blocking. If you have a 2D blocking and the selected
criterion do not exist, you will get an error message.

Convert to Unstruct Mesh

Converts the blocking to an unstructured mesh.

Convert to MultiBlock Mesh

Writes out the multiblock mesh for the current blocking.

Reference MultiBlock Mesh

Matches node positions of the loaded multiblock mesh to those in the referenced multiblock
mesh file in the current directory. By matching the current premesh to a previously smoothed
mesh, you can experiment with different smooth mesh options.

Note:

• Only one multiblock mesh file should exist in the current directory.

• The topology of the loaded blocking and the topology of the multiblock mesh
must match.

Scan planes

Scan planes are used to view the volume grid. The following Scan plane control window will be
displayed.

Figure 145: Scan Planes Window

• There are a number of selection fields for displaying scan planes across each of the principal
directions (i, j, k, o3, o4, etc.). #0 corresponds to the first scan plane across i, #1 corresponds to
the second, across j, etc. Higher scan planes, such as #3 or #4, scan across the first and second
Ogrid indices, respectively.

• There is a Block and a Grid index for each scan plane. The Block index is the block number in
which the scan plane is displayed. The lowest and highest block are typically in the VORFN region
and may not be displayed. The Grid index is the node number within the block.

• The up/down arrow buttons allow you to increase/decrease the Block or Grid index by one,
respectively. If you click and hold down the up/down arrow button, you will be able to scroll
through the Block/Grid index (you need not click the button repeatedly).
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• By default, the scan plane is in the color of the volume parts it passes through. However, the
Color buttons allow you to specify a color for each scan plane (see Figure 146: Selecting the
Scan Plane Color (p. 200)).

Figure 146: Selecting the Scan Plane Color

• The Select button allows you to select an edge in the model. The scan plane perpendicular to
this edge is then displayed. This is the easiest way to place a scan plane in the model.

• The Solid check box controls whether the mesh will be displayed in solid or wire-frame form.

Tip:

Scan planes are very useful for diagnosing blocking issues. Running a scan plane
through the problem area is often the best way to gain understanding of what is
happening in the volume. Typically the scan plane will reveal issues with projection or
edge distribution. Fixing these will improve the quality. Enabling the display of edge
association and edge bunching can also help identify the problem.

Cut Planes

A cut plane is used to visualize results on a plane cut through the three dimensional model. Results
are viewed on the cut plane as well as on the 2D Dynamic window. The cut plane may be defined
in several ways depending on the application.
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Figure 147: Pre-Mesh Cut Plane

Method

• By Coefficients

Defines the cut plane by the equation of the normal vector. The equation is of the form:
Ax + By + Cz + D = 0. Enter the coefficients A, B, C, D of the equation.

• By Point and Normal

pt

Enter the Global Cartesian coordinates in the X, Y, and Z direction.

NX

Enter the X component of a unit vector normal to the desired cut plane.

NY

Enter the Y component of a unit vector normal to the desired cut plane.

NZ

Enter the Z component of a unit vector normal to the desired cut plane.

• By Corner Points

Creates a cut plane passing through the given three points. You can enter the Cartesian
coordinates of Pt1, Pt2, and Pt3 points.

• By 3 Points

You can select any three points in the GUI using the left mouse button to define a cut
plane.
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• Move or Rotate

You can interactively move a previously defined cut plane while holding the left mouse
button down. Once you get to the desired location, release the mouse button. Use the
middle mouse button to rotate the cut plane about the normal axis. When you get the
desired orientation, release the mouse button. To end the interactive movement of the cut
plane, click the right mouse.

• Middle X plane

This will put the cut plane at the middle of the geometry in the X-direction.

• Middle Y plane

This will put the cut plane at the middle of the geometry in the Y-direction.

• Middle Z plane

This will put the cut plane at the middle of the geometry in the Z-direction.

Fraction value

Select the location of the plane by changing the fraction value either by moving the sliding
bar or entering a value.

Solid Mode

To display the cut plane in solid mode.

Shrink elements

To shrink elements in the display.

Note:

Cut planes show the grid lines relative to planes in 3D space. Scan planes show grid
lines relative to grid planes. Either method may be used. For unstructured blocking, it
is recommended that cut planes be used.

Note:

The cut planes for Pre-Mesh can be viewed before writing out the mesh. This allows
for mesh quality inspection and block editing before writing out the final mesh.

Output Blocks

Toggles between Output Block topology and regular blocking topology.

ICEM CFD supports two levels of block decomposition. The first and typical level is what you see
by default and what is used to mesh the model. The second level, called Output Blocks, is used
to group blocks together resulting a smaller number of meshing files for the solver.

The following tools are used with Output Blocks:
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Init output blocks

Makes your Output Block topology the same as your regular block topology. See Blocking
Options (p. 183).

Output Blocks

Toggles Output Block topology for block editing and writing of multi-block structured
mesh files.

When enabled, you can edit the Output Block topology with operations such as Merge
Blocks, Extend Split, Merge Face, and Renumber Blocks. Regular block topology that is
used to mesh the model remains unchanged. Merging blocks, for example, can reduce
the number of structured mesh files written for the solver.

Transfer Blocks

Allows you to bring blocks from the regular block topology into the Output Blocks. Use
this option when you have already completed most of the output blocks definition and
need to add a regular block(s) to the output blocks. See Transfer Blocks (p. 489).

Note:

Face selection operations for Output Blocks are not fully supported.

Topology

The display option for Topology is shown below.

Figure 148: Topology Display Options

Create sub-topo

A portion of the current (root) block topology may be extracted to create a new topology. Each
sub-topology has the following display options.

Figure 149: Sub-topo Display Options

• Copy

Makes a copy of a sub-topology.

• Merge

Merges selected sub-topologies.
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• Rename

To rename the sub-topology.

• Delete

Deletes the sub-topology.

• Save

Saves the sub-topology.

Local Coordinate Systems

You can define local coordinate systems (LCS) for use in geometry, mesh, blocking or boundary condition
manipulation using the LCS icon in the main menu. The default coordinate system located at the origin
is called Global.

When a LCS is defined, its name will appear in the display tree as shown below. Deactivating all Local
Coordinate Systems in the Display tree will activate the Global coordinate system. You can view only
one LCS at a time.

Figure 150: Local Coordinate Systems Tree

Right-click a defined coordinate system in the Display Tree for the following options.

Delete

Removes the LCS from the display tree and its data from the geometry and parameter files.

Modify

Opens the Define Local Coordinate System DEZ to allow you to modify the coordinate system.

See Local Coordinate Systems (p. 117) in the Main Menu chapter for the description of all the options.
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Rename

Opens a dialog box where you may give the LCS a new name.

Flip Axis

Cycles the LCS axes through the sequence X-Y-Z, to Z-X-Y, to Y-Z-X, back to X-Y-Z relative to the
original LCS. For non-rectangular coordinate systems the transformation is the same, except using
the R, θ, and Z axes, or the R, θ, and Φ axes.

This approach is useful to transform a Z-dominant coordinate system to an X-dominant or Y-dom-
inant coordinate system. For example, if you want to change the orientation for the 1-point definition
method or have the first two points of the 3-point method define something other than Z-direction,
it might be best to define the LCS in the easiest method possible and Flip Axis to get the appropriate
LCS.

Element Properties

If the model contains different defined Elements, such as 0D, 1D, 2D (TRI/QUAD) or 3D elements
(TETRA/HEXA), they will be under Points, Lines, Surfaces and Volumes respectively. The Element Properties
Tree will appear as shown below.

Figure 151: Element Properties Tree

Points contain all the 0D element properties and Lines contains 1D element properties, etc. When element
properties are defined, they will appear in both the Element Properties tree as well as the part display
tree to which they belong. To edit any of these definitions, double-click the defined properties.

Right clicking on Element Properties in the Display tree will give you the options to Delete Empty
Properties. This option removes empty element properties from the display tree and refreshes the
Element Properties branch. This option can be run whenever needed after modifications are made to
Element Properties

Connectors

If connectors are defined for a model, they will be listed under the Connectors Tree.

Right clicking on the Connectors Tree will give you the following options.

Figure 152: Modify Connectors Options
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Create

Opens the Define Connectors window. See Mesh > Define Connectors  (p. 388) for more information.

Make All Active

Makes all connectors active.

Make All Inactive

Makes all connectors inactive.

Delete All

Deletes all connectors defined in the model.

Constrained Nodes

Node constraints may be set using the Define Constrained Node sets option on the Constraints tab,
or by right-clicking Constrained nodes in the display tree. See the Define Constrained Node Sets (p. 705)
page for information on the node constraint options.

If constrained node sets are defined, they will be listed under Constrained nodes in the display tree.
Right-clicking on the name of a Constrained Node set, will give you the following options:

Delete

Removes the selected constrained node set.

Rename

Opens a dialog box to specify a new name for the constrained node set.

Modify

Opens the Modify Constrained Nodes DEZ where you can change the parameters of the node set.
For more information regarding the options available, see the Define Constrained Node Sets (p. 705)
page.
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Contacts

Contact boundary conditions may be set using the Define Contact option on the Constraints tab, or
by right-clicking Contacts in the display tree. See the Define Contact (p. 706) page for information on
the contact constraint options.

When you turn on the display for a contact set, the contact area will be drawn as white and the target
set as red. This display is useful for Automatic Contact Setup to see the elements that are marked de-
pending on the defined contact proximity factor.

Figure 153: Contacts Tree

To edit a contact boundary condition, right-click the defined contact boundary condition set to choose
from the following options.

Figure 154: Modify Contacts Options

Modify

Opens the Modify Surface-to-Surface Contact Parameters DEZ. For more information on the options
available, see the Define Contact (p. 706) page.

Switch contact/target

To switch the target set and the contact set for the given contact region.
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Delete

Deletes the selected contact.

Rename

To rename the selected contact.

Displacements

Multipoint Constraint Equations may be set using the Create Constraint Equation option on the
Constraints tab. See the Create Constraint Equation (p. 705) page for information on multipoint constraint
options.

Multipoint Constraint Equations that are defined on points, curves and surfaces will appear in the Display
tree as shown below.

Figure 155: Displacements Tree

To edit any constraints, right-click the constraint name in the display tree and choose from the following
options.

Figure 156: Modify Displacement Options

Delete

Removes the selected displacement.

Rename

Opens a dialog box to specify a new name for the displacement.

Modify

Opens the Modify Constraint Equation DEZ where you can change the parameters of the multipoint
constraint equation (displacement). For more information regarding the options available, see the
Create Constraint Equation (p. 705) page.

Right-click Displacements in the Display Tree to choose from the following options.

Figure 157: Displacement Display Options
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Show All

Displays all the defined displacement.

Hide All

Hides all the displacement.

Loads

Loads that are defined on points, curves and surfaces will appear in the Display tree as shown below.
In this context, ‘Loads’ may be of force or pressure type.

Figure 158: Loads Display Tree

Right-click a defined load to choose from the following options.

Delete

Deletes the selected load.

Rename

Opens a dialog box to specify a new name for the selected load.

Modify

Opens a Modify Force (or Modify Pressure, as appropriate) DEZ which allows you to adjust the
parameters of the load.

For full information on the options available, see Create Force (p. 713) (or Place Pressure (p. 716)) in
the Help.

Right-click Loads in the Display Tree to choose from the following options.

Show All

Displays all the defined loads.

Hide All

Hides all the loads.
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Material Properties

Material Properties that are defined are located in the Display tree as shown below.

Figure 159: Material Properties Display Tree

To edit the material properties of an element, you can double click the left mouse button on the defined
material name in the Display Tree to open the Define Material Property DEZ.

Right clicking on a defined material name in the Display Tree will give you the following options.

Figure 160: Modify Material Properties Options

Delete

Removes the Material Property definition.

Rename

Opens a dialog box to assign a new name to the selected material property.

Modify

Opens the Define Material Property DEZ to allow to modify the material properties.

For more information on the options available, see Create Material Property (p. 681) in the Help.

Copy

Opens a dialog box to assign a distinct name to the new material being defined. The new material
properties may then be modified as necessary.

Rigid Walls

Rigid Wall boundary conditions may be set using the Define Planar Rigid Wall option on the Constraints
tab, or by right-clicking Rigid walls in the Display tree. See the Define Planar Rigid Wall (p. 710) page
for information on the Rigid Wall boundary condition options.

When set, Rigid Wall boundary conditions will appear in the Display Tree as shown below.

Figure 161: Rigid Walls Tree
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Right-clicking on the name of a Rigid wall, will give you the following options.

Delete

Removes the selected rigid wall boundary condition.

Rename

Opens a dialog box to specify a new name for the rigid wall boundary condition.

Modify

Opens the Modify Planar Rigid Wall DEZ where you can change the parameters. For more information
regarding the options available, see the Define Planar Rigid Wall (p. 710) page.

Single Surface Contacts

Single Surface Contact constraints are available only for the LS-DYNA solver.

You may set Single Surface Contact constraints using the Define Single Surface Contact option on
the Constraints tab, or by right-clicking Single Surface Contacts in the Display tree. See the Define
Single Surface Contact (p. 709) page for information on the Single Surface Contact options.

Right-clicking on the name of a Single Surface Contact in the Display tree, will give you the following
options.

Delete

Removes the selected single surface contact.

Rename

Opens a dialog box to specify a new name for the single surface contact.

Modify

Opens the Modify Single Surface Contact DEZ where you can change the parameters. For more
information regarding the options available, see the Define Single Surface Contact (p. 709) page.

Temperatures

Temperature boundary conditions defined on points, curves or surfaces will appear in the Display Tree
as shown below.
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Figure 162: Temperatures Tree

Right-click a defined temperature to choose from the following options.

Delete

Deletes the selected temperature boundary condition.

Rename

Opens a dialog box to specify a new name for the selected temperature boundary condition.

Modify

Opens a Modify Temperature Boundary Condition DEZ which allows you to adjust the parameters
of the boundary condition.

For full information on the options available, see Create Temperature Boundary Condition (p. 718)
in the Help.

Right-click Temperatures in the Display Tree to choose from the following options.

Show All

Displays all the defined temperature boundary conditions.

Hide All

Hides all the defined temperature boundary conditions.

Velocities

You may set Velocity Boundary Conditions using the Define Initial Velocity option on the Constraints
tab, or by right-clicking Velocities in the Display tree. See the Define Initial Velocity (p. 710) page for
information on the Single Surface Contact options.

When set, velocity boundary conditions will appear in the Display Tree as shown below.

Figure 163: Velocities Tree

Right-click a defined velocity boundary condition set to choose from the following options.
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Delete

Deletes the selected velocity boundary condition.

Rename

Opens a dialog box to specify a new name for the selected velocity boundary condition.

Modify

Opens a Modify Initial Velocity Parameters DEZ which allows you to adjust the initial translational
and rotational velocities.

For full information on the options available, see Define Initial Velocity (p. 710) in the Help.

Parts

Figure 164: Parts Tree

The Parts Display tree contains a list of all the parts in the loaded Geometry and Mesh files. If a part is
active, then all the mesh and active geometry elements that are associated it will be displayed.

The exception to this rule is if a certain subset is enabled, the entities of that subset are displayed inde-
pendently of the active parts in the Parts Tree.

Parts Display Options

Right-click Parts to view the following display options.
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Figure 165: Parts Display Options

The options are described in the following sections:

Create Part

Assembly Tools

Show Parts Info

More Part Display Options

Create Part

Parts can be created by four methods.

Figure 166: Create Part Window
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Create Part by Selection

 Select geometrical or mesh entities to create a part.

Create Part near Position

 Select a position using x, y, and z coordinates to create a part.

Figure 167: Create Part by Near Position window

• Locations

Enter x, y, z coordinates of a specific position.

• Nodes

Toggle this ON if nodes are to be selected.

• 1d elems

Toggle this ON if 1d elements (lines and curves) are to be selected.

• 2d elems

Toggle this ON if 2d elements (surfaces) are to be selected.

• 3d elems

Toggle this ON if 3d elements (volumes) are to be selected.

• Toggle OFF the options that you do not wish to select.
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Create Part in Region

 Define a region by specifying the range of x, y, and z coordinates that bound the region.

• Min and Max Coordinates

Enter the minimum and maximum coordinates that represent the region.

• Include partially enclosed

Includes elements partially enclosed in the region specified by the coordinates.

• Nodes

Toggle this ON if nodes are to be selected.

• 1d elems

Toggle this ON if 1d elements (lines and curves) are to be selected.

• 2d elems

Toggle this ON if 2d elements (surfaces) are to be selected.

• 3d elems

Toggle this ON if 3d elements (volumes) are to be selected.

• Toggle OFF the options that you do not wish to select.

Create Part with Blocks

 Select blocks to create a part.

Assembly Tools

Assemblies can be used in Ansys ICEM CFD to help organize data. An assembly is a collection of
parts.

Note:

It is important to note that an assembly is treated as a part with the syntax of ASSEMBLY
/ PART. The "/" character denotes an assembly. In as such, the base level assembly can
contain entities, but this is not a recommended practice. Assemblies can contain other
assemblies, denoted by the syntax ASSEMBLY1 / ASSEMBLY2 / PART, but it is recommen-
ded that assembly, sub-assembly, and part names be unique.

Assemblies with their constituent parts will appear in the Display tree as shown below.
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Figure 168: Parts Tree with Parts and Assemblies

Note:

Assembly names appear in black font, and part names appear in non-black colors. If a
part color is set to white, a contrast background color will automatically appear in the
Display Tree window to make the part names readable.

Create Assembly

Assemblies can be created through the following ways:

• Using the Create Part option and entering the syntax ASSEMBLY1 / PART1 as the Part
name. Then entities can be selected to be added to PART1 in ASSEMBLY1.

• Parts can also be dragged and dropped into assemblies through the Display Tree. Parts
in an assembly can be moved into other assemblies, and entire assemblies can also be
added to other assemblies.

• Selecting Create Assembly in the Parts Display Options menu will open the Create As-
sembly DEZ.

Figure 169: Create Assembly DEZ

Assembly name

Base level assembly that parts will be added to. If this assembly exists, the selec-
ted parts will be added to it. If the assembly does not exist, it will be created.
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Create Assembly by Part Selection

This option allows you to select a set of parts to add to an assembly. Parts
that are in existing assemblies can also be selected. These parts will be moved
to the new base assembly. For example, if the Assembly name is defined as
ASSEM2 and a part ASSEM1/PART is selected, the new part will be moved directly
under ASSEM2 (named ASSEM2/PART).

Create Assembly by Wildcard

This option allows you to select a set of existing parts to add to an assembly.
The Wildcard text to search will be used to compare part names and used to
define which parts should be moved to the defined Assembly name. For example,
if the parts BOX_FRONT, BOX_BACK, BOX_SIDE, INLET, OUTLET exist in a model,
then entering the assembly name BOX_ASSEM and entering the Wildcard text
BOX will create an assembly BOX_ASSEM containing the three parts BOX_FRONT,
BOX_BACK, and BOX_SIDE.

Remove Assembly

Selecting Remove Assembly in the Parts Display Options menu will remove the assembly
structure, flattening the Parts tree hierarchy renaming the parts to include the assembly name.

For example, if an assembly ASSEM contains parts PART1, PART2, and PART 3, then selecting
Remove Assembly will cause the tree to show parts named ASSEM#PART1, ASSEM#PART2, and
ASSEM#PART3.

Assembly Display Options

Right-click any assembly in the Display tree to view the Assembly Display options.

Rename

allows you to rename the selected assembly.

Blank

makes the selected assembly invisible.

Show

displays the selected assembly.

Merge to part

merges the constituent parts with the selected assembly.
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Create Sub-Assembly

allows you to create a sub-assembly within an existing assembly from a list of selected
parts. Selecting the Create Sub-Assembly option will open the Create Sub-Assembly
DEZ.

Figure 170: Create Sub-Assembly DEZ

Sub-Assembly name

specifies the sub-assembly name. The name also indicates the base assembly
within which the sub-assembly is created. For example, the sub-assembly name
ASM.1/ASM.2 indicates that ASM.2 is a sub-assembly within ASM.1.

Create Sub-Assembly by Part Selection

This field allows you to select a set of parts to be added to the sub-assembly.
Parts in existing assemblies can also be selected, and will be moved to the new
sub-assembly.

Note:

Parts can also be moved between assemblies and sub-assemblies by
dragging and dropping within the tree.

Delete

allows you to delete the geometry within the selected assembly.
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Show Parts Info

Reports part-by-part information about your model in the message window. You can use the sub-
menu to choose to display information about All Parts, only Geometry Parts, only Meshing Parts,
only Blocking Parts, or only parts with Boundary Conditions.

Tip:

To see information about specific parts, you can select them in the Display tree and
then access the context-sensitive menu using the right mouse button. See Individual
Part Display Options (p. 224)

• The geometry information reported includes the number of surfaces, curves, and points contained
in the part, the surface area, and the bounding box extents.

• The mesh information reported includes the number and the types of elements, the mesh area,
and the bounding box extents.

• The blocking information reported includes the total number of blocks as well as the count of
free, mapped and swept blocks.

• The boundary condition information report includes only those parts with boundary conditions
along with boundary condition type.

Note:

Boundary condition and other information about hidden component parts may also be
reported using Expose Component Parts (p. 222).

A simple example is shown.

------------------------------------------------------------------------------------
Info for part GEOM
------------------------------------------------------------------------------------
Geometry Info ----
Part contains 6 surfaces; Total surface area is 6.0
Part contains 12 curves
Part contains 8 points
Bounding box around part is {0 0 0} {1 1 1}
Part contains 2 hidden component part(s):
 GEOM:FORCE0 contains 1 surfaces
 GEOM:TEMP0 contains 1 surfaces

Mesh Info ----
Part contains 1548 element(s)
Part contains types LINE_2 (0) NODE (0) TRI_3 (0) 
Mesh area of part is 6
Bounding box around part is {0 0 0} {1 1 1}
Part GEOM contains 2 hidden component parts:
 GEOM:FORCE0 contains 232 elements of type(s) TRI_3
 GEOM:TEMP0 contains 229 elements of type(s) TRI_3

Boundary Condition Info ----
Part GEOM:FORCE0 contains bc type(s) FORCE MOMENT 
Part GEOM:TEMP0 contains bc type(s) TEMP 
------------------------------------------------------------------------------------

--------------------------------------------------------------------------
Info for part SOLID
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--------------------------------------------------------------------------
Geometry Info ----
No geometry in part SOLID
Mesh Info ----
No mesh in part SOLID
Blocking Info ----
Part contains 3 block(s)
Number of free blocks: 1
Number of mapped blocks: 1
Number of swept blocks: 1
--------------------------------------------------------------------------

More Part Display Options

Show All

Shows all parts in the display.

Hide All

Hides all parts in the display.

Reverse Blank All

Reverses which parts are blanked so that blanked parts become visible and visible parts are
blanked.

Tip:

If you have a large number of parts and want to blank most of them, it may be faster
to select the parts you want visible, then use Blank Select followed by a Reverse
Blank All.

Expand All

Expands the entire Part Tree.

Collapse All

Collapses the Part Tree.

Blank Selected

Blanks all selected parts. A list of selected, blanked parts is displayed in the message window.

Restrict Selected

Blanks all parts except selected ones.

Delete Empty Parts

Deletes empty parts.
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Expose Component Parts

Exposes the hidden component parts created in Ansys ICEM CFD and makes them available in
the Parts branch of the model tree.

Boundary conditions in Ansys ICEM CFD are assigned on a per part basis. When loads, constraints,
pressures, forces, displacements, etc. are applied on individual entities, you usually don't want
to see them as separate parts. So a hidden component part is created and the necessary
boundary condition will be applied to the hidden part. This is usually preferable since it cuts
down on clutter and these entities can be viewed or adjusted through the Loads or Displace-
ments branches of the tree. Such hidden parts will be reported when you display the part in-
formation (right-click a part and select Info (p. 224) from the part display options).

For example:

------------------------------------------------------------------------------------
Info for part GEOM
------------------------------------------------------------------------------------
Geometry Info ----
Part contains 6 surfaces; Total surface area is 6.0
Part contains 12 curves
Part contains 8 points
Bounding box around part is {0 0 0} {1 1 1}
Part contains 2 hidden component part(s):
 GEOM:FORCE0 contains 1 surfaces
 GEOM:TEMP0 contains 1 surfaces

The ':' in the part name GEOM:FORCE0 indicates that the part is a hidden component of the
part GEOM.

However, for various reasons, some users may occasionally want to expose these hidden com-
ponent parts as separate parts in the Parts branch of the model tree. This can be done with
the Expose Component Parts option.

When the Expose Component Parts option is used, such parts will be renamed with a '#' re-
placing the ':' and they will be available in the Parts Tree.

Part GEOM:FORCE0 renamed to GEOM#FORCE0
Part GEOM:TEMP0 renamed to GEOM#TEMP0

2 part(s) renamed
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Figure 171: Using the Expose Component Parts Option

Note:

This operation cannot be undone.

Tip:

CATIA V5 and other CAD tools use Component Parts for colors, etc. The hidden
component parts are included in the Ansys ICEM CFD geometry file during conversion.
You may find the Expose Component Parts option useful to expose the hidden
color ID as a part name.

Move Component Parts

This operation moves the component part into its parent. Unlike Expose Component Parts
where component parts are renamed, the number of parts in the tree is not increased, resulting
in reduced clutter. Following this operation, BCs on the hidden part are ignored. The operation
is not reversible.

Edit Attributes

Opens a table of the attributes of all the parts, as shown in the figure below. The part name,
color, material, and thickness can be edited directly in the table.

The columns that are grayed out are not applicable for the type of geometry found in that part.
Clicking the column heading will sort the data in ascending or descending order. Columns can
be toggled on and off by right-clicking the headings and selecting the desired options. The
column widths can be re-sized by moving the mouse over the column border and dragging it
to the desired width. The vertical grab bar at the right of the table can be dragged aside to
reveal the Display Window.

Figure 172: Edit Attributes
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Part Mesh Setup

Opens a table of the Part Mesh Setup options. This form is more efficient for large numbers of
parts than the Mesh > Part Mesh Setup (p. 371) table.

Figure 173: Part Mesh Setup

The columns that are grayed out are not applicable for the type of geometry found in that part.
Clicking on the column heading will sort the data in ascending or descending order. Columns
can be toggled on and off by right-clicking on the headings and selecting the desired options.
The column widths can be resized by moving the mouse over the column border and dragging
it to the desired width. The vertical grab bar at the right of the table can be dragged aside to
reveal the Display Window.

"Good" Colors

Automatically selects new colors for all Parts, trying to pick ones that are easy to distinguish
from the others in use. Normally, the colors are assigned by an algorithm that employs the
parts name, which results in the same family in two different projects having identical colors.
It is not, however, always possible to make all colors distinguishable from the others being
used. The Good Colors option provides an alternative.

Color By Material

Assigns colors according to material instead of parts.

Individual Part Display Options

Right-click any part(s) in the Display tree to view the following display options:

Info

Reports information about the selected part(s) in the message window.

The reported information follows the same format and content rules as Show Parts Info (p. 220),
but it is specific to the selected part(s).

Blank

Blanks the selected part in the display.
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Show

Shows the selected part in the display.

Add to Part

Allows you to add entities to an existing part.

Add to Part by Selection

Allows you to add geometry entities to the selected part. Click  (Select entities) and
select the entities to be added to the part.

Adjust Geometry Names

Adjusts the name(s) of the entities added to the part based on the original part selected.
This option is disabled by default, implying that the original entity names will be retained.

Add to Part by Region

Allows you to add mesh entities within the defined region to the selected part.
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Min X, Min Y, Min Z, Max X, Max Y, Max Z

Define the extents of the region.

Include partially enclosed

Allows you to include elements that are partially enclosed by the defined region.

Nodes

Allows you to add nodes within the defined region to the selected part.

1d elems

Allows you to add 1D elements within the defined region to the selected part.

2d elems

Allows you to add 2D elements within the defined region to the selected part.

Blocking Material, Add Blocks to Part

Allows you to add blocks to the selected part. Click  (Select block(s)) and select the
blocks to be added to the part.
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Break by connectivity

Creates a sub-part comprising all the surfaces along with attached mesh elements, from the
selected part. This option is valid only for parts containing surfaces. The following additional
options will be made available for the original part:

Merge to part

Merges the sub-part comprising the surfaces with the original part.

Create Sub-Assembly

Allows you to create a sub-assembly within the part from a list of selected parts. Selecting
the Create Sub-Assembly option will open the Create Sub-Assembly DEZ (see Create Sub-
Assembly (p. 219) for details).

Change Color

Allows you to change the part color to one of your choice.

Rename

Allows you to rename the part.

Delete

Deletes the part.

Parameters

Different solver parameters can be defined to perform different types of analysis. To define a parameter,
go to Solve Options → Setup Solver Parameters. See Setup Solver Parameters (p. 723) for details. To
edit a parameter, double left-click its branch in the tree.

Figure 174: Parameters Tree
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If gravity is defined, either within the boundary conditions in Ansys ICEM CFD or in an imported file, it
will appear in the Display Tree for editing.

Subcases

To solve a model for multiple, separate load settings, you can define Subcases. To define a subcase,

go to the FEA Solve Options tab, and click Set up a Subcase . For a description of which solvers
support subcases and details of setting up subcases, see Setup a Subcase (p. 742).

If subcases have been set up, you will see the tree structure listing active subcases by ID. To go directly
to the subcase settings DEZ to verify or edit the parameters, double-click the subcase ID.

Figure 175: Display Tree with Two Subcases
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Geometry
Figure 176: Geometry Menu

The Geometry tab contains the following options:

Create Point

Create/Modify Curve

Create/Modify Surface

Create Body

Create/Modify Faceted

Repair Geometry

Transform Geometry

Restore Dormant Entities

Delete Point

Delete Curve

Delete Surface

Delete Body

Delete Any Entity

Note:

General Naming Convention

Part names and entity names should be less than 64 alphanumeric characters. Names should
start with a letter, not a digit. Evaluators ( +, -, /, and * ) should not be used in names because
they can be misinterpreted as expressions or as denoting an assembly. Part names are written
with all upper-case characters. Entity names are case sensitive.

Create Point

The different options for creating points are shown below.
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• Part

The part name for the newly created point. The default naming behavior can be set in Settings >
Geometry Options (p. 96).

• Name

Enter a name for the point. If no entity name is given, the name of the point will be the part name
with a numeric extension. The default naming convention is described under Settings > Geometry
Options (p. 96).

Note:

This name field is very useful when you want to write a script. You can define a specific
name for a newly created entity through the Name field while writing the script itself
rather than the automatically generated name (which could be different in every session
depending on the order of creation of the entity).

Screen Select

The Screen Select option allows you to select the location of the point by clicking directly on
the display window. A temporary bright yellow point will be generated until you press the middle
mouse button to complete the selection.

• Allow work plane selection

This option allows you to select locations on any entity as well as in space.

Explicit Coordinates

The Explicit Coordinates option allows you to create a point by specifying the XYZ coordinates,
or create multiple points as a function of an equation.
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Create 1 point

Enter the X, Y, and Z coordinates of the point to be created.

Create multiple points

Allows you to create multiple points defined by functions of one variable (m). Expressions may
include: +, –, /, *, ^, ( ), sin( ), cos( ), tan( ), asin( ), acos( ), atan( ), log( ), log10( ), exp( ), sqrt( ), abs(
), distance(pt1, pt2), angle(pt1, pt2, pt3), X(pt1), Y(pt1), Z(pt1). All angles are written in degrees.

m1 m2 ... mn OR m1, mn, incr

There are two possible formats to define the variable m. List format (m1 m2 m3 ... mn) is a
simple list of the variable values, without commas. Loop format (m1, mn, incr) is the first value,
last value, and increment value, delimited by commas. For example, if the variable m has
values 0.1, 0.3, 0.5, and 0.7, this can be represented in both the following ways:

List format: 0.1 0.3 0.5 0.7

Loop format: 0.1, 0.8, 0.2

F(m) –> X

The coordinate X of the points to be created will be calculated as the expression of the specified
function of variable m.

F(m)–> Y

The coordinate Y of the points to be created will be calculated as the expression of the specified
function of variable m.

F(m)–> Z

The coordinate Z of the points to be created will be calculated as the expression of the specified
function of variable m.

Base Point and Delta

The Base Point and Delta option allows you to create a point with reference to an existing
point. Select the base point and enter in the offset along each axis to describe the location of the
new point.

Center of 3 Points/Arc

The Center of 3 Points option allows you to select 3 points or locations to define an arc. The
center point, or the point that is equidistant from all 3 points, will be created.
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Based on 2 Locations

The Based on 2 Locations option allows you to create a point based on two locations. Select
one of the following two methods:

• N Points

Enter a number (N) of points that you want to create equally spaced between 2 selected locations.

• Parameters

To create a parametric point along a 2-point vector, define the parameter value between 0 and 1,
and select the two points that represent the vector.

Curve Ends

The Curve Ends option allows you to select a curve to create points at the 2 ends of the curve.
Specify whether the selected curve is Bspline or Faceted.

For Bspline curves the following options are available.

Curve(s)

Click the icon and select the curve(s).

How

• Both

This option creates two points at the ends of the curve. The point at the start of the curve
(parameter = 0) will be named by default "pnt.01" and the end point (parameter = 1) will
be named "pnt.02".

• Min or Max coordinates

These options will create a point at the location along the curve at the specified minimum
or maximum coordinate. For example, if the xmin option is selected, the point along the
curve with the minimum X coordinate will be created.

Note:

If xmin = xmax for a curve, xmin will be created at the starting point of the
curve and xmax at the end point. This command creates end points and not
the peak points of the entire curve.

For Faceted curves, the following options are available.

Curve(s)

Click the icon and select the curve(s).
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Angle for curves

Allows you to extract points only for curves with angles greater than the specified angle.

Curve-Curve Intersection

The Curve-Curve Intersection option allows you to create a point at the intersection of two
curves. Select the intersecting curves.

Gap Tolerance

The distance between the two curves should be less than this value to create an intersection
point.

Parameter along a Curve

The Parameter along a Curve option allows you to create a parametric point along a curve,
select from the following two methods.

• N Points

Enter a number (N) of parametric points that you want to create along a curve.

• Parameters

Define the parameter value between 0 and 1, and select the curve.

Project Points to Curves

The Project Points to Curves option allows you to create a new point, or points, by projecting
existing points onto curves. The projection will be normal to the curve.

Curves

selects the curve(s) to which the point(s) will be projected.

Points

selects the point(s) to be projected.

Trim curve

If enabled, the curve(s) is (are) truncated at the new point.
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Move point

If enabled, the existing name is assigned to the new point, making this option particularly helpful
when scripting.

Note:

This option is not available if more than one curve is selected.

Project Point to Surface

The Project Point to Surface option allows you to create a new point by projecting an existing
point on to surface. The projection will be normal to the surface.

Surface

Select the surface to which the point will be projected.

Points

Select the point(s) to be projected.

Embed point

If enabled, the projected point will become attached to the surface data and a node will be created
at the projected point when mesh is generated.

Move point

If enabled, the existing name is assigned to the new point, making this option particularly helpful
when scripting.

Create/Modify Curve

The different options for creating and modifying curves are shown in Figure 177: Create/Modify
Curve Options (p. 234).

Figure 177: Create/Modify Curve Options
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• Part

The part name for the newly created curve. The default naming behavior can be set in Settings >
Geometry Options (p. 96).

• Name

Enter a name for the curve. If no entity name is given, the default naming convention will be followed
as described under Settings > Geometry Options (p. 96).

From Points

The From Points option allows you to create a Bspline curve by interpolating through n number
of points.

From Points

Click the icon and select any location on the screen to create points that define a curve.

Arc from 3 Points

The Arc option allows you to create an arc from three points.

From 3 Points

Creates a Bspline arc through three points.

Center and 2 Points

• Radius

If enabled, the radius will be set as the specified value. If disabled, the radius will be set
at the distance between the first two points selected.

• Keep Center or Start/End

The Keep Center option will take the first point selected as the center, the second point
as the first arc beginning, and calculate the arc end from the vector defined by the first
point and third point. The radius used will be determined by the Radius parameter.

The Keep Start/End option will use the first and second points selected as the arc ends
and calculate the center using the Radius parameter if specified, or else the average distance
between the first and second points, and the first and third points. The plane will be defined
by the three selected points.

• Points

Select 3 points.
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Circle from Center and 2 Points

The Circle from Center and 2 Points option allows you to create a circle of known radius and
center point in a plane.

• Radius

If toggled ON, the radius will be set as the specified value. If toggled OFF, the radius will be set at
the distance between the first two points selected.

• Start angle

For a full circle, the start angle is 0. Otherwise, specify the desired start angle.

• End angle

The end angle for a full circle is 360, and for a semi-circle is 180.

• Points

The first point selected is the center point of the circle. The next 2 points selected will be used to
define the plane of the circle.

Surface Parameters

The Surface Parameters option creates a curve that follows the parametric path of a selected
spline surface.

• Isocurve Methods

Select from three methods to create the curve.

– Direction on Surface

Select two points to indicate the isoparametric curve used to define the new curve.

– Point on Edges

Select a location on the surface edge to create a curve passing through that location, normal to
the edge. You can select any UV parameters, that is, any surface location, but it will automatically
use the nearest edge (minimum parametrical distance) from the selected location. You can altern-
atively select an existing point on the edge. A green line will be displayed to indicate the normal
direction from the selected edge.

– By Parameter
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Select either the U or V direction and the parameter value between 0 and 1 to create an isopa-
rametric curve.

Note:

If the UV boundary curve data is corrupted, then the following error message may appear:
"No active isocurve segments found for this parameter." Use the Geometry > Repair Geo-
metry > Build Topology function to resolve any gaps in the boundary curves.

Surface-Surface Intersection

The Surface-Surface Intersection option allows you to create an isoparametric curve from two
intersecting surfaces. You can choose the option to create a faceted curve, or a Bspline curve.

Surfaces

Isoparametric curves will be created for the intersections of the selected surfaces. If Only Different
Parts is enabled, then curves will be created at the intersections of the selected surfaces from
different parts only. If it is disabled, then curves will be created at the intersections of all the se-
lected surfaces. If no surfaces are selected, and Apply is pressed, then the operation will be applied
to all surfaces.

Parts

This option will apply the function to the selected parts. If Only Different Parts is enabled, then
curves will be created at the intersections of surfaces from different parts only. If it is disabled,
then curves will be created at the intersections of all surfaces within the selected parts. If no parts
are selected, and Apply is pressed, then the operation will be applied to all parts.

2 sets

This option will apply the function to two sets of selected surfaces. Specify the Curve Type, either
Bspline or Faceted. Select the sets of surfaces.

Project Curve on Surface

The Project Curve on Surface option allows you to create a curve by projecting an existing
curve onto a surface. This curve can be used to force nodes and line elements to follow a certain
path or to trim the surface as part of geometry creation or repair.

The following methods are available.

Normal to Surface

The selected curves are projected in a normal direction to each selected surface. Multiple curves
and surfaces may be selected.
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Specify Direction

Select one or more curves and one surface. Specify the direction using the drop-down list. The
curves are projected in the specified direction when you click Apply.

• X, Y or Z Direction

Projects the curve onto the surface along the specified vector: X direction (1 0 0), Y direction
(0 1 0), or Z direction (0 0 1).

• Screen Normal

Projects the curve based on the screen orientation of the model. The curve is projected in a
normal direction to the screen.

• Along a Vector

Projects the curve to the surface along a vector. Define the vector by selecting two screen
locations.

• Keep original

When enabled, the original curve is kept. When disabled, the original curve is deleted.

• Trim surfaces

When enabled, the projected curve will trim the surface.

Segment Curve

The Segment Curve option allows you to segment an existing curve into new curves. Select
from the following four methods to segment a curve.

• Segment by point

Select the point at which the curve is to be segmented.

• Segment by curve

Select the curve and the location on the curve. The curve will be split at the nearest point of inter-
section with another curve.

• Segment by plane

Define a plane to segment the curve by selecting an axis normal to the plane and a point on the
plane, or a vector normal to the plane and two points on the plane.

• Segment faceted by connectivity

To split two faceted curves that are merged together.

• Segment faceted by angle
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To split a faceted curve by a specified angle value.

Concatenate/Reapproximate Curves

The Concatenate/Reapproximate Curves option merges two or more existing curves into one
new curve. The original curve is deleted. Curves can be merged with the following options:

• Reapproximate Curve

Redefines the curve based on a locally set triangulation tolerance instead of the global tolerance.
Used to create a smoother curve definition.

• Concatenate Curve

Joins the curves selected that are separated by a gap less than the given tolerance limit.

• 2D Hull

Creates a convex 2D hull around the selected curves. The curves are connected into a faceted curve
that does not follow any concave shapes.

– Tolerance

The curve approximation tolerance.

– Max shrink

The relative shrink wrap tolerance. The value entered should be between 0 and 1. A typical value
is 0.2.

– Four curves

This option splits the concatenated faceted curve into four edges so that a surface can be created
from them.

Extract Curves from Surfaces

The Extract Curves from Surfaces option allows you to extract the boundary curves from a
surface. Specify whether the selected surface is Bspline or Faceted.

For Bspline surfaces the following options are available.

Check Topology

If enabled, curves will be created only on surfaces edges that do not have curves attached to
them.

Create New

If enabled, a new curve will be created for each surface edge.

For Faceted surfaces the following options are available.
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Angle for surfaces

Curves will be extracted only from surfaces with angles greater than the specified angle.

Min number of segments

Only curves with the specified minimum number of segments will be extracted.

Which curve segments

Specify whether curves will be extracted from the interior, exterior, or both sides of the surface.

Modify Curves

 Curves can be modified with the following options.

• Reverse direction

switches the direction of curves so that the curve start and end points are reversed. Click a curve
and an arrow will indicate its current direction. To reverse the curve direction, confirm by pressing
the middle mouse button.

Note:

This function is valid only for parametric (Bspline) curves. Faceted curves must first
be re-approximated in order to change the direction of the curve.

• Extend

Extends a curve to the specified point or curve, or extends the curve by a designated length.

Extend to Pnt

Extends the curve to a designated point. When you select the edge, the end closest to the se-
lected location is extended. An arrow will indicate which curve end will be extended.

Figure 178: Example of Extend Curve to Pnt

Curve Extended to
Point

Original Curves
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Extend to Crv

Extends the curve to another selected curve. The extension is a straight line tangential with
the end of the original curve.

Figure 179: Example of Extend Curve to Crv

Curve Extended to
Curve

Original Curves

Extend to Length

Extends the curve by the specified length. If the curve is not a straight line, it can be extended
as an arc or as a line. You can determine which end is extended during the curve selection.

Figure 180: Examples of Extend Curve to Length as Arc and Line

Extend Curve to Length as a
Line

Extend Curve to Length as an
Arc

During extension, a curve will be created in the direction of the extension. The original and
extension curves will then be concatenated and the concatenated curve will be re-approximated
(using an automatically determined tolerance) and replaced.

Note:

The re-approximation will use the default topology tolerance if it is smaller than
the automatically determined tolerance value.

• Match curves

Extends curve(s) to match at a point, tangency and/or radius of curvature.
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Accuracy

Select the method used to determine the best matching curve. The Geom method performs
geometric matching with internally set factors. The Exact method matches the end point, tan-
gency, and/or radius of curvature as closely as possible.

Figure 181: Example of Match Curves, Geom and Exact Methods

Original Curves 

Geom Method 

Exact Method 

Curves to Modify

The Both Curves option will adjust both curves to match. The First Curve option only modifies
the first curve selected.

Method

This determines the method of matching the curves. The following methods are available:

Common end point

Common end point and tangency

Common end point, tangency and radius of curvature

Common end point and radius of curvature
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Figure 182: More Examples of Match Curve Methods

Match Curves with Both Curves Option, and
Common End Point, Tangency, and Radius of
Curvature Method

Match Curves with Both Curves Option, and
Common End Point Method

Keep Original

Keeps the original curves and creates new ones to match.

• Bridge curves

Creates a new curve that connects two existing curves keeping tangency of first two curves. The
end that is closer to the location of the cursor when selecting the curves will be the end that is
bridged. The curve magnitude defines how far to keep the tangency as a fraction of curve length
from the start and end point (First and Second Curve, respectively). The magnitude can range
from 0 to 1, where 0 means no tangency is kept for 0 distance, and 1.0 attempts to maintain tan-
gency for the full curve length.

After selecting the curves to be bridged, you can adjust the curve magnitude by text entry or by
moving the sliders until the desired shape is achieved.

Figure 183: Examples of Bridge Curves

First Curve Magnitude = 0.50, Second Curve
Magnitude = 0.50

First Curve Magnitude = 0.30, Second Curve
Magnitude = 0.30

First Curve Magnitude = 1.00, Second Curve
Magnitude = 0.0

First Curve Magnitude = 0.70, Second Curve
Magnitude = 0.70
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Notice that for the Curve Magnitudes of 0.70, tangency to both curves cannot be maintained for
70% of the curve lengths, so a compromise is made. For the last example with the First Curve
Magnitude of 1.00, tangency to the first curve is attempted for the full length of the bridge, but it
does not maintain tangency to the second curve.

Create Midline

The Create Midline option creates the midline between two curves or sets of curves.

From 2 Curves

Select two curves and the midline of these curves will be created.

By Pairs

Select two sets of connected curves to create a single midline between them. Each set can contain
more than one curve.

Create Section Curves

The Create Section Curves option creates new curves at the intersection of selected surfaces with
single or multiple planes.

Surfaces

Select the surfaces.

Plane Setup

Specify the planes that intersect with the selected surfaces to create the new curves.

Normal to XYZ Plane

Select the plane normal to the X, Y, or Z axis. The plane will pass through the origin (0, 0, 0).

Start Point / Multiple

This option allows you to define a Start Point through which the plane must pass,
and allows for multiple planes defined by an offset value.

Delta Offset

To define multiple planes, a Start Point and End Point must be defined. The offset
value is defined as a fraction of the distance between the Start and End points. Planes
will pass through each offset point, as well as the Start and End points, resulting in
multiple section curves. For example, if a Delta Offset value of 0.5 is entered, a plane
will pass through the Start Point, the End Point, and the point halfway between the
Start and End points.
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Normal to Three Points

Select 3 points to define a plane. The plane normal to this will be used in the creation of the
new curves.

Normal to Existing Curve

Select a curve. The number of sections that is entered will result in equally distributed planes
normal to the selected curve at the local parameter. For example, if a curve that is a circle is
selected, and 10 sections are specified, then 10 planes normal to the circle, at every 36 degrees,
will be used to create the new curves.

Create/Modify Surface

The different options for creating and modifying surfaces are shown in Figure 184: Create/Modify
Surface Options (p. 245).

Figure 184: Create/Modify Surface Options

• Part

The part name for the newly created surface. The default naming behavior can be set in Settings >
Geometry Options (p. 96).

• Name

Enter a name for the surface. If no entity name is given, the default naming convention will be followed
as described under Settings > Geometry Options (p. 96).
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From Curves

The From Curves option allows you to create surfaces from curves. The following options are
available for creating surfaces from curves.

From 2-4 Curves

Select two to four curves to form the boundaries of a surface.

Tolerance

Adjacent curve ends must be within this tolerance distance in order for boundaries of
the surface to be created.

Note:

This function automatically closes gaps between boundary curves, using a best fit ap-
proximation. For the best results, manually connect curves to form a closed loop that
can be specified as the surface boundary.

From Curves

Select any number of curves to form a surface. The curves may be overlapping and unconnected.

From 4 Points

Select four points to define the new surface.

Curve Driven

The Curve Driven option creates a surface by sweeping one or more curves along a Driving
curve. The direction of the Driven curves changes with the curvature of the Driving curve.

Note:

This function provides predictable results for relatively simple driven curves that are either
a plane curve or that have a constant curvature. The results may be of lower quality for
3D curves with variable curvature.
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Figure 185: Example of Curve Driven Surface

Sweep Surface

The Sweep Surface option creates a surface by sweeping a reference curve along a vector
(Driving curve). The orientation of the swept curve(s) remain constant, and are swept in the same
direction of the vector or Driving curve.

Screen Vector Method

Define the vector by selecting two points, and select the curve(s) to be swept. The vector
will determine the size of the resulting surface. For example, for if the two vectors {0 0 0}
and {5 3 2} are entered, the curve will be swept such that a surface of 5 units in the X direction,
3 units in the Y direction, and 2 units in the Z direction will be created.

Driving Curve Method

Select the Driving curve and the curve(s) to be swept. The curve will be swept in the same
direction of the Driving curve, from parameter 0 to 1.

Figure 186: Example of Sweep Surface

Surface of Revolution

The Surface of Revolution option creates a surface of revolution by revolving a reference curve
around an axis with a specified start and end angle. The default start angle is 0, and the default end
angle is 360. More than one curve can be chosen to be revolved around the axis.
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Loft Surface over Several Curves

The Loft Surface over Several Curves option creates a surface by interpolating across two or
more curves. The tolerance value determines the degree of approximation. The smaller the tolerance
value, the closer the final surface to the input curves.

Offset Surface

The Offset Surface option creates a new surface by offsetting an existing surface. Enter the
distance to offset the surface normal to the base surface.

Distance

Distance to offset the surface normal to the base surface.

Surfaces

Select the surfaces to be offset.

Midsurface

The Midsurface option creates a new surface midway between two existing surfaces or parts.
Midsurfaces can be created with the following options.

Note:

After midsurfacing complicated models, gaps may sometimes exist between surfaces. To
close these gaps, the following operations can be used:

Create/Modify Surface > Extend Surface> Extend Curve to Surface(s) (p. 254)

Create/Modify Surface > Extend Surface> Close Gaps Between Midsurfaced
Parts (p. 254)

Repair Geometry > Stitch/Match Edges (p. 289).

By Parts Method

Select the parts for which midsurfaces are to be created for all paired surfaces. Each part should
be a solid part (consisting of surfaces making up a thin solid). The resulting surfaces would rep-
resent the midsurfaces for that part.

• Search Distance

The distance within which candidate pairs of surfaces are searched for. For example, if the
Search Distance is 10, then all pairs of surfaces within 10 units of distance are selected as can-
didates for midsurfacing. This value should be slightly higher than the maximum thickness of
the entire model. When this parameter is zero, selecting two surfaces will result in finding the
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midsurface. A nonzero value for the search parameter helps the code to find the midsurface
automatically for a large group of surfaces.

• How

This parameter sets the degree by which the operation is interactive.

– Quiet

This is the default setting, in which the operation is automated.

– Confirm

After midsurfacing, any surfaces that have not been successfully paired and midsurfaced will
be presented. You have the option to delete these surfaces (as they may be side surfaces
that should not get midsurfaced), put these surfaces into a subset for further evaluation, or
choose Cancel to ignore them.

– Present/Confirm

Will give you the following options for the pair of surfaces for which you want to generate
the midsurface. Allows you to view the new midsurface before creating it.

→ y = compress

This option will create the midsurface option that is displayed.

→ n = no

This cancels the midsurface operation.

→ p = partial

This will present the different options available for non-matching surfaces. The partial
option will create a midsurface by projecting the smaller surface in between the two
surfaces. The double partial option will create the midsurface to represent the smallest
common surface area of the two selected surfaces. The non-partial option will create
a midsurface between the entire selected surfaces, not just the overlapping portions.

→ a = surface 1

This option will display alternate midsurface options. For example, if one of the original
surfaces has a hole, the alternate midsurface options allows you to select the midsurface
with or without the hole.

→ d = delete

This option deletes the original surfaces.

• Parts

Clicking on the Parts selection icon will open a message window where the parts for midsurfacing
can be selected.
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• Keep original

Keeps the original surfaces after the midsurface creation.

• Delete unattached curves and points

Deletes unattached curves and points.

• Create assemblies

Creates assemblies of the selected parts for the midsurface creation.

• Partial

For non-matching surfaces, if this option is toggled ON, the midsurface will be created only
between the portions that overlap.

Note:

For the Confirm and Present/Confirm methods, the partial options are presented
in the display.

• Similar pairs only

Identifies the matching surfaces from the selected surfaces and generates the midsurface ac-
cordingly.

• Prefer connected pairs

Is disabled by default. If enabled, connectivity of surfaces over proximity will be used to determ-
ine the best surface pairs for creating the midsurface. Also, if there are no connected surfaces,
then no midsurfaces will be created. If disabled, then the pairs of surfaces used for midsurfaces
will be determined by distance and surface normals.

Note:

It is recommended that Build Topology be applied before using this function.

Note:

If Settings > Geometry Options > Inherit part name is set to Create New, and Keep
Original and Create assemblies are both disabled, the newly created midsurface will
be placed in new part. If both options are enabled, the created midsurface will be
placed in the same part, as part of the subset MIDS, and original geometry will be
moved to the subset ORIG in the same part.

By Surfaces Method

Any surfaces can be selected to create a midsurface, independent of which part the individual
surfaces belong to. All possible midsurfaces will be created for the selected surfaces.
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See description of options above.

By Pairs Method

Identifies pairs of connected surfaces via flood fill, re-approximates sides with more than one
surface, and then creates a single midsurface between the two sides.

• Side 1 and 2

Specify the different sides of the surface pairs.

• Keep original

Keeps the original surfaces after the midsurface creation.

• Delete unattached curves and points

Deletes unattached curves and points.

• Partial

For non-matching surfaces, if this option is enabled, the midsurface will be created only between
the portions that overlap.

Note:

For the Confirm and Present/Confirm methods, the partial options are presented
in the display.

Segment/Trim Surface

The Segment/Trim Surface option allows you to segment a selected CAD surface by a Bspline
curve. The selected curve must lie on the surface, and must form an enclosed loop if it is fully contained
within the surface boundaries. Surfaces can be segmented by the following four options.

• By Curves

Select the curve(s) to segment the selected surface.

• By Plane

Specify a plane by defining three points on the plane, or by a vector normal to the plane and a
point that the plane passes through. The surface will be segmented by this plane.

• By Connectivity
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Segments surfaces that are merged by definition but not physically connected.

Note:

This option applies only to faceted data.

• By Angle

Splits the surface by the value of the angle prescribed.

Note:

This option applies only to faceted data.

Merge/Reapproximate Surfaces

The Merge/Reapproximate Surfaces option allows you to merge two surfaces at their seam. If
you select NURBS data surfaces, you will be given the option to convert them into faceted data before
merging.

The options for re-approximating surfaces will create one surface from a set of selected surfaces while
re-approximating the surface boundaries to a given tolerance. This is useful for several operations,
including the following:

1. To clean up surface data by creating a re-approximated surface from multiple segmented surfaces.

2. To clean up more complicated geometric formats into a more simple surface data structure that
is easier to manipulate. For example, some CAD systems will represent a four sided surface as a
trimmed plane. Re-approximation will create a ruled surface to replace this.

3. To convert a faceted surface representation to a Bspline representation if the boundaries of the
faceted surface is well defined.

Note:

To perform this operation, Build Topology is necessary.

There are four options to merge surfaces:

• Merge Surfaces

Merges two surfaces that are separated by a gap within the specified tolerance.

• Reapproximate selected surface(s)

Re-approximates the selected surfaces into one surface.

• Reapproximate selected surface(s) bounded by curve(s)
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Re-approximates two adjacent surfaces that are joined by a common curve.

• Reapproximate selected surface(s) bounded by hull

Re-approximates surfaces that are bounded by a hull.

– Faceted only

Allows you to select faceted surfaces only.

• Reapproximate each surface

Allows you to choose the automated Quiet option, or the Confirm option that will display the
merged surface before creating it.

– Faceted only

Allows you to select faceted surfaces only.

Untrim Surface

The Untrim Surface option is for spline surfaces only. This option untrims or removes any pre-
vious segmentation of the selected surface(s).

Create Curtain Surface

The Create Curtain Surface option creates a surface extruded from a selected curve and projected
onto a target surface, normal to the target surface.

Select the initial curve and surface, as shown in the example below. The Trim surface option will at-
tempt to trim the set of surfaces selected to form a T-connection.

Figure 187: Select Curve and Surface for Curtain Surface Function

The final surface obtained is shown in Figure 188: Curtain Surface (p. 254).
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Figure 188: Curtain Surface

Extend Surface

The following options are available for extending surfaces.

Extend Curve to Surface Method

Extends selected curves to selected surfaces. The following methods and options are available.

• Closest

Projects the selected curve(s) to the selected surface(s), and creates new surface(s) normal to
the selected surface(s).

• Tangential from edge

Extends a surface edge to the selected surfaces in a direction normal to the selected edge. The
extension follows the curvature of the original surface.

• Tangential along U/V

Extends a surface edge to the selected surfaces in the u or v direction of the original surface.

• Trim surfaces

Attempts to trim the selected surface(s) to form a T-connection.

• Tolerance

This value is the build topology tolerance.

Extend Surface at Edge Method

Extends a surface at the selected edge.

• Surface

Select the surface to be extended.

• Curve

Select the edge at which the surface is to be extended.

• Extension
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The relative length of the extension. A value of 0.2 defines an extension of 20% of the original
surface.

• Absolute distance

If this is toggled ON, then the Extension value is taken as an absolute distance instead of a
relative factor.

• Trim surfaces

Attempts to trim the selected surface(s) to form a T-connection.

Close gaps between midsurfaced parts

This function requires connected regions of surfaces to be in separate parts. For each part selected,
the single edges are checked for their proximity to the surfaces of the other parts. If the proximity
is within the specified distance, it will attempt to extend the surfaces in the same way as the Extend
Curve to Surface Method.

• Parts

Select the parts that the surfaces belong to.

• Dist.

Enter the maximum gap distance to be closed.

• Method

– Closest

Projects the selected curve(s) to the selected surface(s), and creates new surface(s) normal
to the selected surface(s).

– Tangential from edge

Extends a surface edge to the selected surfaces in a direction normal to the selected edge.
The extension follows the curvature of the original surface.

– Tangential along U/V

Extends a surface edge to the selected surfaces in the u or v direction of the original surface.

• Preview Vectors

Displays the possible vectors of the surface extension. You can select individual vectors to Ex-
clude or Include.

• Extension Arrow Size

Select the vector arrow size.

• Trim surfaces

Attempts to trim the selected surface(s) to form a T-connection.
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• Tolerance

This value is the build topology tolerance.

Geometry Simplification

The Geometry Simplification option creates a set of faceted surfaces wrapped around the se-
lected geometry, including surfaces, curves, or points. The original geometry is retained.

Convex Hull Method

There are 3 methods to choose from, single hull, interactive split and regular split.

For faceted data, it may be helpful to first merge all surfaces, and then merge all nodes of the concat-
enated surface within a tolerance. This will reduce the computation time.

There are three different options for the Convex Hull Method.

• Single Hull

Creates a crude wrapped surface around the actual selected surfaces as shown in Figure 190: Single
Hull Option (p. 257).

Figure 189: Example Geometry
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Figure 190: Single Hull Option

• Interactive Splits

In this method, the application prompts you to draw lines representing split planes. These planes
do not need to be aligned with the global axis.

Figure 191: Split Planes
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Figure 192: Interactive Splits Method

• Uniform Splits

In this method, a uniformly spaced grid of planes is used to segment the actual selected surfaces
and a hull is then created around each segment. You must define the number of planes in the X,
Y and Z directions. The planes (X, Y, Z axes) are either aligned to the global coordinate system (the
Model option) or to that of the current Screen orientation, with the X-axis horizontal, Y-axis vertical,
and Z-axis normal to the screen. A large number of planes will create a three-fold large number of
segmented components, which may take a long time to process for complicated geometry. For
example, a 10 x 10 x 10 grid will create 1000 components.

Coarsen before Creating Hull

Faceted entities will be coarsened to reduce the triangulation and the processing time.

Tolerance

Edges of the faceted triangles will be merged within the tolerance setting during the coarsening
process. The value is an absolute setting.

Remove Interior Faces

If enabled, the interior hull surfaces of segments created by the Interactive Splits or Uniform
Splits  methods will be removed. Only the outer shell formed around the selected surfaces will
be retained.

Hull for Each Part

Each segment created after a hull is built around a component will be put into a new part.

Cartesian Shrinkwrap
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Wraps a complicated geometry using a Cartesian staircase mesh. The mesh is then locally projected
and smoothed to get a simplified representation of the geometry.

Note:

For the resulting mesh, if surfaces mesh sizes are set, then this will override the global max
size value.

The following options are available:

Max. cell size

The size of the facets of the shrinkwrap. This should be set to just a little larger than the largest
hole you want to ignore.

Num. of smooth iterations

Number of smoothing iterations to be performed.

Surface projection factor

Factor from 0 to 1 that determines how well the shrinkwrap will project to the geometry after
the staircase mesh is created.

Part for envelope

Determines the Part that the Shrinkwrap will be created in. You can select an existing part, use
the screen select to select a part on the screen, or type in a new part name in the field. The in-
herited option will place the shrink wrapped mesh in the same part as the geometry that it lays
on, this is determined by a normal vector ray calculated from each facet.

Wrap part by part

Creates an individual shrinkwrap per part.

Active parts only

If enabled, then shrinkwrap will only be applied to the active parts.

Create Geometry

If disabled, the wrap produced is mesh. If enabled, the wrap is automatically converted into a fa-
ceted geometry. When used in conjunction with the inherited option for Part for envelope, the
Part names for the new geometry entities will be the inherited names followed by "_WRAP" to
differentiate them from the original geometry.

Figure 193: Engine Geometry (p. 260) shows an engine geometry. Such engine geometries may
have much more detail than is needed for an under hood analysis and can be simplified. The
geometry can be wrapped to close holes, combine parts, and generally simplify the data as shown
in Figure 194: Wrapped Engine (p. 260).
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Figure 193: Engine Geometry

Figure 194: Wrapped Engine

The wrapped surface mesh can then be used with a bottom-up tetra method to generate a volume
mesh or converted to faceted geometry as described.

Figure 195: Mesh with Volume Mesh Cut Plane

Standard Shapes

The Standard Shapes option creates standard geometrical shapes. The following options are
available.
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Figure 196: Create Standard Shapes Options

Box 

There are two methods to creating a box.

• Specify

Define the lengths of the box sides in the X, Y, and Z directions and select the point for the
box origin. For example, an  X Y Z size of "1 1 1" and Box Origin "0 0 0" will result in a box
with sides of length one, with its origin at the coordinates (0,0,0).

• Entity bounds

Creates a bounding box around the selected entities. The X, Y, and Z lengths of the box can
be scaled by the specified factor.

– Adjust min/max values

If this is enabled, the minimum and maximum coordinate values of the box will be dis-
played. To create a new box, you can change any of these values and click Apply.

Sphere from 2 points 

• Radius

If enabled, then the radius length can be defined.

• Start/End angles

The angles (in degrees) are measured from the normal of the center plane of a sphere (the
pole). An arc from the Start angle to the End angle will be rotated 360 degrees. For example,
a Start angle of 0 and an End angle of 90 will result in the top half of a sphere.

• Locations

The application prompts you to select two locations on the screen. The first is the center of
the spherical surface, and the second defines the normal of the center plane (pole). If Radius
is toggled OFF, then the second point will determine the length of the radius as well.

Cylinder 

• Radius1 and 2

Specify the Radius1 and Radius2 of the respective base circles of the cylinder.
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• Base1 and Base2

If enabled, the respective bases circles will be created.

• Two axis Points

Select two points to define the axis of the cylinder.

Drill a Hole 

• Surface

Select the surface in which the hole is to be drilled.

• Remove Hole

Enable if you wish to replace a current hole. This will allow you to select a curve (hole) which
will be deleted and replaced with the new specified hole. If no curve is selected, the last hole
created will be removed.

Note:

If Remove Hole is enabled, and the selected curve is a feature and not a hole,
that curve will still be removed.

• Radius

Enter the radius length.

• Location

Select the point of the center of the hole.

Plane normal to curve 

• Side

Enter the length of the side for the uniform surface.

• Location on curve

Select the location on the curve at which the normal plane is to be created.

• Curve parameter

Instead of selecting the location on the curve, the distance along the curve can be specified.

Disc normal to curve 

• Radius

Enter the radius length for the disc.
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• Location on curve

Select the location on the curve at which the disc is to be created.

• Curve parameter

Instead of selecting the location on the curve, the distance along the curve can be specified.

Trim normal to curve 

Creates a plane normal to the selected curve and trims this plane with the selected surface(s).
The plane will only be created if the intersection curve of the plane to be created and the selected
surfaces is a closed loop.

Surfaces

Select the surface that will be used to trim the newly created plane.

Location on curve

Click the selection icon and select the location on the curve where the plane will be created.
Click Apply to create the plane.

Curve parameter

To specify the location on curve using the curve parameter (between 0 to 1), select any location
on the curve, enter the curve parameter, and click Apply.

In the example in Figure 197: Surfaces and Curve Selection (p. 263), the top and bottom surfaces
of the hemisphere are selected. And the point on the curve is selected for the creation of the
plane. In the second figure, note that the created plane's intersection with the selected surfaces
creates a closed loop.

Figure 197: Surfaces and Curve Selection
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Figure 198: Trim Normal to Curve – Plane Creation

Create Body

 Bodies can be created from surfaces that make up a volume or from a solid volume. Certain meshing
operations, for example 3D Multizone blocking, require a body or material point to function.

Part

Enter a name for the body. If no entity name is given, the default naming convention will be followed
as described under Settings > Geometry Options (p. 96).

Select an option for creating the body:

By Material Point

By Topology

By Material Point

 A body can be defined by creating a Material Point within a closed volume. Material Points can
be created at a specified point or at the centroid of two points.

In the example geometry shown in Figure 199: Creating Material Point (p. 265), the material point is
specified at the centroid of the cube, therefore the body will be defined as the inner cube. A volume
mesh generated for the body will fill the inner cube as shown in Figure 200: Volume Mesh of Defined
Body (p. 265).
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Figure 199: Creating Material Point

Figure 200: Volume Mesh of Defined Body

By Topology

 Bodies can be created using the surface, or solid, geometry with options to use either the Entire
Model or Selected surfaces.

• If your model does not contain any solid geometry, the software automatically detects any closed
volumes appropriate to creating bodies (material point plus surfaces forming the closed volume).

• If your model contains solids and Entire Model is selected, you will be asked if you wish to create
the body from the existing solids?

Yes

A material point will be added within each solid volume.

Use this option if you intend to initialize the blocking using the 3D Multizone method.
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No

The existing solids will be discarded and bodies will be created from the surface geometry.

Note:

In order for a body to be created, there can not be any gaps between surfaces used to
define the closed volumes.

The default part name will be BODY, unless you enter another part name. If no entity name is given,
the name of the body to be created will be the part name plus a numeric extension.

Tip:

In order to import Tetin files from Ansys ICEM CFD into the Mechanical application or the
DesignModeler application, use the Entire Model option to build bodies from the topology
first.

A body will be created for each closed volume. In the example geometry shown in Figure 201: Create
Body by Topology (p. 266), the Entire Model option is used. (Alternatively, use the Selected surfaces
option and select all the surfaces). Two bodies will be created from the two closed volumes. Each
body can then have separate volume meshes as shown in Figure 202: Volume Mesh of Separate
Bodies (p. 267).

Figure 201: Create Body by Topology
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Figure 202: Volume Mesh of Separate Bodies

Create/Modify Faceted

The Create/Modify Faceted option allows you to create/modify faceted curves and surfaces. Faceted
curves and surfaces can be created and modified with the following options.

Create/Edit Faceted Curves

Surfaces

Faceted Cleanup

Figure 203: Create/Modify Faceted DEZ

• Part

The part name for the newly created entity. The default naming behavior can be set in Settings >
Geometry Options (p. 96).

• Name

Enter a name for the faceted curve or surface. If no entity name is given, the default naming convention
will be followed as described under Settings > Geometry Options (p. 96).

Create/Edit Faceted Curves

 Faceted curves can be created and edited with the following options.

Convert from Bspline
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Create Curve

Move Nodes

Merge Nodes

Create Segments

Delete Segments

Split Segment

Restrict Segment

Move to New Curve

Move to Existing Curve

Figure 204: Create/Edit Faceted Curves Options

Convert from Bspline

The Convert from Bspline option converts Bspline curves to faceted curves.

Create Curve

The Create Curve option creates a faceted curve from specified locations.

Move Nodes

You can move nodes with any of the following options. After choosing the option, click Apply.

Screen

Select the curve, and then click and drag the node to the desired location.

Location

Specify the node and its new location.

Plane

A node can be moved along a plane normal to a specified axis or vector. Define the plane by
choosing the normal axis or vector, and click Apply. Select the curve, then click and drag the
node.
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Surface

The node of a curve can be moved along a constraint surface. Select the curve and the surface,
then click and drag the node of the curve along the surface.

Line

A node can be moved along a certain line. Specify the line by choosing two points and clicking
Apply. Select the curve, then click and drag the node along the line.

Offset

Specify the offset in the X, Y, and Z directions to move the node.

Merge Nodes

 A node can be merged to a selected point on another curve. First select the faceted curve,
followed by the reference curve. Then the fixed point on the reference curve has to be selected.
After that the node selected on the first faceted curve merges with the point selected on the refer-
ence curve.

Create Segments

The Create Segments option allows you to add segments to an existing curve. First select a
curve to which the new segments will be added. Then select points on the screen to create the
segments. The selection is in continuation mode: each point selected adds to the segment, until
the middle mouse button is pressed. The points are not constrained to existing nodes; rather they
are constrained to any location on the visibly displayed geometry.

Delete Segments

The Delete Segments option allows you to delete segments from an existing curve. First select
the curve to edit, then select the segments to be deleted from that curve.

Split Segment

The Split Segment option splits selected segments of the selected curve into two. Split location
is at the middle of the element.

Restrict Segment

 Select the curve and then select the segment on the curve to be displayed, while the display
of all the other segments of the curve will be restricted.
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Move to New Curve

The Move to New Curve option moves the selected segments to a new curve. Select the
curve and then select the segment to move.

Move to Existing Curve

The Move to Existing Curve option moves the selected segments to a n existing curve. Select
the initial and destination curves, then click and drag the curve to the new location.

Surfaces

 Faceted surfaces can be created and modified with the following options:

Convert from Bspline

Coarsen Surface

Create New Surface

Merge Edges

Split Edge

Swap Edge

Move Nodes

Merge Nodes

Create Triangles

Delete Triangles

Split Triangles

Delete Non-Selected Triangles

Move to New Surface

Move to Existing Surface

Merge Surfaces
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Figure 205: Create/Modify Faceted Options

• Part

The part name for the newly created surface. The default naming behavior can be set in Settings
> Geometry Options (p. 96).

• Name

Enter a name for the surface. If no entity name is given, the default naming convention will be
followed as described under Settings > Geometry Options (p. 96).

Convert from Bspline

The Convert from Bspline option converts a CAD (Bspline) surface into triangulated surface
data. You have the option to delete the old CAD surfaces.

To reconvert the faceted surface into a Bspline surface, see Geometry > Create/Modify Surface >
Merge/Reapproximate Surfaces. (p. 252)

Note:

Converting a faceted surface to a Bspline surface is a difficult operation and requires
the boundaries of the faceted surface to be well defined.

Coarsen Surface

The Coarsen Surface option reduces the number of triangles on a faceted surface. This option
is useful for reducing the amount of data. After the surface is selected, the application prompts to
select curves and then points in order to maintain the sharp features of the surface. Otherwise, the
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original surface integrity may not be maintained. The curves and points that have been extracted
from the selected surface by one of the following methods should be selected:

Create curve > Extract from surface

Create curve > Build topology

Repair Geometry > Create topology

Create point > Extract from curve

Tolerance

Distance within which to merge nodes of the surface. Default is 1/10th of the Min edge length. The
Min edge value is the length of the shortest edge on the selected surface. The tolerance value is a
maximum deviation from the original surface triangulation.

Create New Surface

The Create New Surface option allows you to create a new faceted surface from three selected
points, three locations selected on the screen, or from edges.

The following options are available when creating faceted surfaces using the From edges method:

Allow internal edge selection

If enabled, this allows the selection of non-single (internal) edges to create a new surface. In-
ternal edges have more than one adjoining triangle.

Complete edges

If enabled, this allows selection of edges that are not connected.

Merge Edges

The Merge Edges option merges one set of edges to another set of edges in faceted surfaces
by aligning and merging the edge nodes.

Allow internal edge selection

If enabled, this allows the selection of non-single (internal) edges to be merged. Internal edges
have more than one adjoining triangle.

Merge tolerance

Merges edges that lie within the specified tolerance of each other.

Merge ends

If enabled, the starting and end nodes of the edges will be merged. If disabled, the starting
and end nodes will not be affected.
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Split Edge

 First select the surface, then the edge to be split. The selected edge and the adjacent elements
will be split into two, as shown in the example.

Figure 206: Edge Selected to Split

Figure 207: Split Edge

Swap Edge

The Swap Edge option swaps edge of two adjacent triangles. The original edge will be replaced
by an edge that connects the other two corners of the triangles, as shown in the example.
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Figure 208: Edge Selected to Swap

Figure 209: Swapped Edge

Move Nodes

You can move nodes of faceted surfaces with any of the following options. After choosing the
option, click Apply.

Location

Moves nodes to a selected location on the geometry. First select any location on the geometry,
then select the nodes to be moved and press the middle mouse button.

On screen

Moves nodes anywhere on the plane defined by the screen. Select the surface, then click and
drag the surface node.

On plane

Moves nodes on a plane intersecting the node and normal to a specified axis or vector. First,
select the surface, describe the plane within the menu, and then move the click and drag the
node on that plane.

Normal

Define the plane to move the node by typing in the i j k values of the normal of the plane
within the box.

Offset XYZ

Specify the offset in the X, Y, and Z directions to move the node.
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Line

A node can be moved along a certain line. Specify the line by choosing two points and clicking
Apply. Select the surface, then click and drag the node along the line.

Merge Nodes

The Merge Nodes option merges nodes from one surface with nodes on another surface.

Screen

Merges two or more nodes together. First select the surface with the nodes that are to be
merged. Then select the reference surface(s). Select a point on the reference surface to merge
the nodes with. Then select the nodes to be merged, and click the middle mouse button to
accept. Pressing the middle mouse button twice will exit from the function.

Tolerance

Merges nodes that lie within the specified tolerance of each other. This is useful for reducing
data. Other faceted editing functions and repair methods will also be more robust if duplicate
nodes within a surface are removed.

Create Triangles

 First select a surface to which the new triangles will be added. Then select three points on
the screen to create the triangles. The points are not constrained to existing nodes, but can be at
any location on the displayed geometry.

Note:

Selecting nodes for creating faceted triangles requires solid or solid/wire display mode
for surfaces.

Delete Triangles

 Select the surface to edit (the surface facets will be displayed in white), then select the triangles
to be deleted from that surface.
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Figure 210: Triangle Selected to be Deleted

There are two options for deleting triangles:

Delete Selection

Deletes only the selected triangle.

Figure 211: Delete Selection

Keep Selection

Retains the selected triangle and deletes the rest of the surface.

Figure 212: Keep Selection

Split Triangles

The Split Triangles option splits selected triangles into three triangles. The split location is
at the centroid of the element.
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Figure 213: Triangle Selected to be Split

Figure 214: Triangle Split

Delete Non-Selected Triangles

The Delete Non-Selected Triangles option deletes the triangles that are not selected.

Move to New Surface

The Move to New Surface option creates a new surface from the selected triangle(s).

Move to Existing Surface

The Move to Existing Surface option moves the elected triangle(s) to an existing surface.

Merge Surfaces

The Merge Surfaces option merges two faceted surfaces.

Faceted Cleanup

 Faceted surfaces can be cleaned up with the following options:

Align Edge to Curve

Close Faceted Holes
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Trim By Screen

Trim By Surface Selection

Repair Surface

Create Character Curve

Figure 215: Faceted Cleanup Options

Align Edge to Curve

There are three different alignment methods.

Align to Curve

Projects the nodes of the selected surface edge to the nearest location on the selected curve.
The application prompts to select the surface, the curve, and the boundary edge(s) of the selected
surface to align to the curve. The nodes attached to the edges will be projected to the nearest
location on the curves.

Project Node to Curve

Projects the selected nodes of the selected surface to the nearest location on the selected curve.
The application prompts you to select the surface, the curve, and the nodes of the selected
surface to align to the curve. This option allows you to select any nodes on the surface in
comparison to the Align to Curve method, where only boundary edges/nodes can be moved.
The nodes selected will be projected to the nearest location on the curves.

Smooth Edges

This option will take a set of boundary edges and smooth out the transition along the edge.
The application prompts you to select a surface, and a set of boundary edges of the surface.
The software will internally create a temporary Bspline curve through the nodes of the edges
using the tolerance value entered for Smooth Tol, and project the nodes to this smoothed
Bspline. By adjusting the Smooth Tol value you can adjust the transition of the boundary edges.
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Close Faceted Holes

The Close Faceted Holes option creates new triangles to fill in the gap between a selected
set of curves or edges. Select the boundary edges of the hole. The selected curves or edges do not
necessarily have to form a closed loop.

Trim By Screen

The Trim by Screen option cuts a hole through surfaces using points selected from the screen.
Select points on the screen to draw the hole on a surface and to cut the hole through all the surfaces
below it.

Trim By Surface Selection

The Trim by Surface Selection option cuts a hole through surfaces using points on a surface.
Select points on the surface to create the hole.

Repair Surface

The Repair Surface option creates a Bspline patch to replace an area of the faceted surface.
You can define the perimeter of the patch by selecting locations. The patch is projected to the fa-
ceted surface. The faceted surface is then cut out and replaced with a Bspline patch. Figure 216: Using
the Repair Surface Option (p. 280) shows the use of this option to patch holes in the surface mesh.
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Figure 216: Using the Repair Surface Option

Surf Locations

allows you to select the faceted surface and then select locations on that faceted surface to
define the patch to be replaced.

Curve Shape

determines how the surface locations are used to define the patch (see Figure 217: Options for
Curve Shape (p. 281)).

• Lines: Locations are connected by straight lines.

• Smooth : Locations are connected by a smooth curve.

• Circle : First three locations are used as three points on a circle. The circular shape is then
projected to the faceted surface to determine the final patch.
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Figure 217: Options for Curve Shape

Keep original

allows you to keep the original faceted surface patch under the Bspline surface patch.

Create Character Curve

The Create Character Curve option creates a Bspline patch to replace an area of the faceted
surface where two features join. This can be a sharp, smoothed or arc (fillet) connection. You can
define the rough character line and how far on either side of this line should be used to make the
patch. An array of faceted surface locations on either side of the character line are determined and
smoothed out to create a smoother surface. These are then used to extract an intersection curve
to define the theoretical intersection of the character curve. Finally, the faceted surface within the
character curve area is replaced with the Bspline surface.

Figure 218: The Create Character Curve Option

Figure 219: Replacing a Faceted Fillet Using the Create Character Curve Option (p. 282) shows the
use of this option to replace a faceted fillet with a smoother Bspline fillet.
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Figure 219: Replacing a Faceted Fillet Using the Create Character Curve Option

PreCurve

allows you to select locations along the character line you want to capture.

PreSides

allows you to select two locations, one in each plane on either side of the character curve. This
determines how far from the character curve the Bspline patch extends in each direction.

Curve Shape

determines how the surface locations are used to define the PreCurve.

• Lines: Locations are connected by straight lines.

• Smooth : Locations are connected by a smooth curve.

• Arc : First three locations are used as three points on a circle. The arc is then projected to
the faceted surface to determine the curve.

Show Presurface

shows a preview of the Bspline surface before applying the function.

Note:

This was part of the Mesh Prototyper product functionality and the algorithm includes
other options which can be scripted for.
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Repair Geometry

The main objective in CAD repair is to detect and close gaps between neighboring surfaces (faces).
Typically, the procedure for geometry repair is as follows:

1. Build Topology builds curves and points, which will help to diagnose the model for geometrical
problems. The curves will automatically take on colors to show their association to adjacent surfaces.

2. Repair any gaps or holes in the topology.

The options for repairing geometry are outlined in subsequent sections:

Build Topology

Check Geometry

Close Holes

Remove Holes

Stitch/Match Edges

Split Folded Surfaces

Adjust Varying Thickness

Make Normals Consistent

Feature Detect Bolt Holes

Feature Detect Buttons

Feature Detect Fillets

• Part

The part name for newly created curves and points. The default naming behavior can be set in Settings
> Geometry Options (p. 96).

Note:

Existing entities will keep their names and parameters.
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Build Topology

The Build Topology option creates a series of curves and points from surface edges and corners
depending on the proximity of the surface edges to each other. If the curves are within a geometric
tolerance, they are merged together as one. The curves are then displayed in a specific color to illustrate
their connectivity in the surface data, which can be used to determine any gaps or holes in the geo-
metry.

Note:

Dormant Entities

Curves and points can be made dormant either by deleting them with the Delete
permanently option disabled, through building topology with feature angle and filter
points/curves enabled, or through feature detection tools. If a curve or point is dormant,
it will not be recreated when building topology, but build topology may make it active.
If a curve or point is permanently deleted, it is removed from the database. If the to-
pology is rebuilt, the curve will be recreated. Flood fill, and patch based meshing will
also fail across a boundary (curve or point) that has been permanently deleted. Curves
and points that are unattached to surfaces or curves will always be permanently de-
leted, as the sole purpose of dormant curves and points is to maintain connectivity
between attached geometry.

Note:

Embedded Entities

Points that are within the build topology tolerance from a surface, and curves that
are parallel to a surface within the build topology tolerance and not on the boundary
of the surface will be embedded into the surface. If a point or curve is embedded or
linked to the surface it means that the surface has connectivity to these curves and
points. The patch dependent mesher requires this connectivity to include the
curve/point as a boundary to the mesher. An embedded curve or point is different
than a boundary curve or point in that it is doubly connected to the surface instead
of having a single connection like a boundary entity. An embedded curve is connected
to the surface twice (on positive and negative sides of the surface), whereas the
boundary curves are only attached to the surface on one side.

If the embedded curve is attached to a second surface, the embedded curve becomes
a multiple edge, and defines a T-connection. Typical T-connections connect 3 surfaces,
but since in the case of an embedded curve the underlying surface is not fully trimmed,
the doubly connected edge helps represent the geometry in a more accurate fashion.
That is, the connection is defined to the positive and negative side of the base surface
and to the boundary of the second surface.

Table 2: Build Topology Colors

Single or free edge curves (those adjacent to only one
surface)

Yellow
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Double edge curves (curves adjacent to two surface)Red

Multiple edge curves (curves adjacent to three or more
surfaces)

Blue

Unattached curves (not attached to any surface)Green

Topology can be built with the following options.

Tolerance

The tolerance is defined in units of the model, and controls how accurately you want to treat
surface-to-surface proximity. The tolerance between two surfaces is shown in Figure 220: Toler-
ance (p. 285).

Figure 220: Tolerance

For any two faces (surfaces) that meet at a common edge (curve), there is typically a finite distance
between the two edges. By default, a curve is associated with all the edges of each face. In the
figure above, a curve would be associated to edge 1, and a second curve would be associated to
edge 2. This topology of the two surfaces would indicate a gap in the model.

Typically, Ansys ICEM CFD meshers can handle this if the gap is smaller than the proposed element
size on the surfaces or curves. Therefore, you would set a tolerance larger than the gap if you are
using a large element size. A tolerance smaller than the gap would create yellow curves which
could be fixed.

The recommended tolerance is approximately 1/10th the size of the average mesh size.

Filter by angle

Filtered curves are made dormant if the surfaces on either side meet at less than the specified
angle. Filtered points are made dormant if the curves on either side meet at less than the specified
angle. Feature curves and points that meet at greater than the specified angle remain. Since
Octree Tetra forces the mesh to respect curves and points, removing unnecessary ones increases
the patch independence and mesh quality. Points or curves (even double yellow curves) can also
be deleted manually for the same purpose.
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Filter points

Enabling this option will filter points by the angle between their respective curves, as long as the
angle is not zero.

Filter curves

Enabling this option will filter curves by the angle between their respective surfaces, as long as
the angle is not zero.

Method

Topology can be built for All parts, Only visible parts, or by Selection of specific entities.

Note:

The All parts option is different from choosing the Selection Method and then Select
all appropriate objects (key = a), and will yield a different result. The All parts option
includes dormant entities, but the Selection Method > Select all appropriate objects
does not include dormant entities.

Part by part

The topology is built part by part.

Single curve cleanup

Enter a value for the Single Edge Tolerance. This option will merge single curves only that are
within the Single Edge Tolerance distance of each other.

Note:

This is useful for certain models with small features, where the Build Topology
Tolerance must be kept smaller than those features. In such cases, larger gaps
with single edges can be cleaned up with this option.

Split surface at T-connections

Surfaces that form a T-connection will be split and trimmed at the common edge. When meshed,
the mesh will conform to the common edge.

Split facets at interior curves

Faceted surfaces are trimmed along interior curves that do not span the surface or form a closed
loop. When meshed, the mesh will conform to the interior curve.

Join edge curves

Combines edges with the defined angle to concatenate smaller curves into a single curve. This
option applies to both Bspline and faceted data.
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Delete unattached curves and points

Deletes any green curves and unattached points. Sometimes you may keep these since they could
be used as construction curves.

Keep dormant as dormant

Entities that were made dormant by the user will be kept dormant when the topology is built.

Keep old point names

Attempts to retain the existing point names when Build Topology is run, otherwise new names
will be created. Default is on.

Ignore Local Feature

This option allows Build Topology to disregard local tolerance, relative to edge length, and merge
away features that are smaller than the global Build Topology tolerance. Default is Off.

This option is useful if a model has a range of scales and retaining the small feature would cause
high cell count or poor quality. The model shown in Figure 221: Model with Small Feature (p. 287)
has a small feature which is highlighted.

Figure 221: Model with Small Feature

If the global Build Topology tolerance is set to a value larger than the local feature size, the curves
of the local feature may become degenerate and be collapsed when this option is enabled.
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Figure 222: Use Local Tolerance Option

(B) Ignore Local Feature enabled(A) Ignore Local Feature disabled (default)

Check Geometry

The geometry can be checked by all parts, only visible parts, selected parts, or selected surfaces.

The following methods and options can be used to check the geometry.

Results Placement

specifies how the results will be placed. The surfaces that are found can be shown, placed in a
specified part, or in a specified subset.

Check Surfaces

• Edges

Specify whether the geometry should be checked for Single edges or Multiple edges.

• Curvature/Area

If Curvature is selected, specify a High or Low curvature and a Ref. Angle. Surfaces with
curvatures higher or lower than the reference angle will be found. For example, if a Low curvature
of 5 degrees is specified, all surfaces with curvature less than 5 degrees will be found.

If Area is selected, specify Large or Small, and the Ref. Area. If Large is selected, then surfaces
that have an area larger than the Ref. Area will be found, and if Small is selected, then surfaces
that have an area smaller than the Ref. Area will be found.

• Normal

This will find all surfaces with a normal within the tolerance angle from the specified axis.

Close Holes

The Close Holes option closes holes in the surface by creating a new surface. The necessary
condition for closing the hole is that the curve must form a closed loop.
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Figure 223: Example of Closed Hole

Curves

Select the curves representing the edges of the hole. After clicking Apply, confirm by pressing
Y.

Multiple Holes

If there is more than one hole, you can select the curves for all the holes at one time. But the
holes will be closed individually.

Remove Holes

The Remove Holes option removes the hole composed of curves that form a continuous loop.
A new surface is not created, as with the Close Holes operation. Instead, the trim features adjacent
to the selected curves are deleted.

Figure 224: Example of Removed Hole

Stitch/Match Edges

The Stitch/Match Edges option stitches or matches edges separated by a gap. Select a pair of
curves or multiple pairs of curves to fix. The curve pair will be highlighted in white and will automat-
ically fit to the screen. If multiple pairs have been selected, after each pair is fixed, the next pair will
then be highlighted and fit to the screen. The following methods can be used to stitch or match
edges:

User Select

After selecting curves, enter the appropriate key to select from any of the methods of stitching
or matching edges: (n)o change, (f )ill, (b)lend, (t)rim, (m)atch, (a)uto, or (x) for cancel. Each method
is explained below. The User Select method is useful when employing a series of different options.
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Match

Adjacent surfaces are modified so that one edge matches the other.

Extend/Trim

Recalculates the intersection of the two adjacent surfaces of a gap. Recommended if one or both
of the edges appear jagged.

Figure 225: Surfaces Before Extend/Trim

Figure 226: Trimmed Surfaces

Fill

Creates surfaces to fill in a gap. The surfaces are created between a calculated center point and
the selected curves. This is recommended for curve pairs that are more or less coplanar. Any
overlap using this method can usually be ignored.

Blend

Creates a ruled spline surface between the curves. Recommended for curve pairs that are not co-
planar and that have a high degree of curvature.

Figure 227: Blend method
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n = no change

No repair is attempted. If fixing multiple pairs of curves, the next pair will be presented. If only
one pair of curves was initially selected, you can select a new set of curves.

a= auto

Automatically determines the best method, fill, blend, trim or match, to fix the gap or hole.

x= cancel

No repair is attempted and the operation is ended.

p = set/unset partial

Enable or disable for whole or partial fixing of the gap. If this is enabled (prompt will
read Unset partial), matching will project the ends of the shorter edge normal to the
larger edge instead of stretching it to match the entire larger edge; fill or blend will create
a surface between the smaller edge and normal projection to the larger edge.

The different parameters for the Stitch/Match Edges operations are described below.

Max Gap Distance

This should be slightly more than the maximum gap between any two surfaces of the entire
model. This option is available for the User Select method.

Single curves only

allows you to restrict to single curves only. This option is available for the User Select method.

Partial

Enable or disable for whole or partial fixing of the gap. If this is enabled, (prompt will read Unset
partial), matching will project the ends of the shorter edge normal to the larger edge instead of
stretching it to match the entire larger edge; fill or blend will create a surface between the smaller
edge and normal projection to the larger edge. This option is available for the Match, Fill, and
Blend methods.

Confirmation

After the repair option is selected, the result will be made visible. You need to give confirmation after
viewing the result.

y = yes

Saves the change.

n = no

The change is not saved.

r = retry

To retry repair by selecting a different repair method.
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Using Stitch/Match Edges for Y-Junctions

The following example shows how to use Stitch/Match Edges to close gaps in T- or Y-junctions, as
shown in the figure below.

Figure 228: Example of Y-Junction with Gaps

First, select the three curves that need to be stitched to close the gap. Select the Extend/Trim
method. This will trim and stitch two edges together and then automatically connect the third
surface. The result is shown below.

Figure 229: Y-Junction with Stitched Edges

Split Folded Surfaces

 Folded surfaces are segmented and new curves created where the surface is folded at an angle
greater than the specified Max angle. It will help the surface Mesher (Shell) as additional curves are
placed on the surface. The Max angle option measures from each end of the surface. The first point,
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from one edge, whose tangent deviates more than specified angle (default is 90 degrees) splits the
surface. For a cylinder, this will generate more than one curve.

Adjust Varying Thickness

The Adjust Varying Thickness option allows you to assign a thickness to the selected surface
using the following methods:

From Solid Method

Specify Corners Method

Find Surfaces Without Thickness Assigned

From Solid Method

This option assigns thickness values to a surface based on the midsurface/solid model.

Midsurface(s)

Select the set of midsurfaces.

Solid surface(s)

Select the set of surfaces on both sides of the midsurface(s).

Max thickness

Limits the thickness assigned to a surface. The thickness values get assigned at certain control
points along a surface. Each control point thickness is found by projection normal to the surface
in either direction. The sum of these projections (positive or negative) define the thickness. An
empty (default) Max thickness value means that there is no thickness limit.

Note:

Thickness computations could be inaccurate if the surface data is not very good and
a control point projection is not projected correctly. If you see this it would be re-
commended to try one of the following:

• Improve the surface data.

• Limit the selection of midsurface/solid surfaces to just the local region.

• Reduce the order of the surface to reduce the number of control points.

• Use a maximum thickness to limit the thickness computed.

• Use the Specify corners method to define the assigned thicknesses manually.

Order

Defines the number of control points along a surface. For example, Order 4 means 4 x 4 control
points along the surface or 16 total control points. For a 4-sided surface, along each edge there
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would be 4 interpolation points creating a thickness interpolation surface between the 16 total
points along the edges.

Specify Corners Method

This option can be used to assign thickness values to a surface as well as to display the assigned
thickness values of a surface.

Surface

Select a surface or set of surfaces. If the thickness values are assigned, they will be displayed.
If multiple surfaces are selected, the only value that will be displayed is the value of the first
surface selected.

Order

Defines the number of control points along a surface. For example, an order of 4 x 4 control
points means that there are 16 total control points along the surface. For a 4-sided surface,
along each edge there would be 4 interpolation points creating a thickness interpolation surface
between the 16 total points along the edges.

Corner/Middle Points

The thickness values for each specific control point.

Note:

There is currently no convenient way to visualize specific control points, so the best way
to see the results is by right-clicking Geometry > Surfaces > Show Surface Thickness in
the Display Tree. The thickness values can then be assigned in an iterative method.

Find Surfaces Without Thickness Assigned

This option will evaluate a set of selected surfaces and find surfaces that do not have thickness in-
formation assigned. If Settings > Geometry Options > Inherit Part Name > Create New (p. 96) is
enabled, the surfaces without thickness information will be moved to a new part. If the Inherit
Part Name option is disabled, then the names of the surfaces found will only be listed in the
message window.

Note:

The Display should be set to Solid mode so that the surfaces which do not have
thicknesses assigned will be highlighted in gray, and can be easily recognized.

Part

Enter the name of the new part (or select the default name) or choose an existing part.

Surface

Select the surface or set of surfaces.
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Make Normals Consistent

There are two methods available.

Make Consistent

Aligns the normals of all the surfaces in the direction of the selected Reference surface normal.
The check box Reverse normals will align the normal of all the surfaces in the opposite direction
of the reference surface normal.

Reverse Normal

Reverses the normal of the selected surface.

Feature Detect Bolt Holes

The Feature Detect Bolt Holes option detects single edged connected regions in a part whose
diameter is between the defined min and max values. When a bolt hole is detected, the following
occurs:

• The bolt hole curves are either placed in a subset (if Settings > Geometry Options > Inherited part
name is set to Inherited), or placed in the defined part name (if Settings > Geometry Options >
Inherited part name is set to Create New).

• The curves that are marked as bolt holes have the mesh parameter settings modified to the defined
Number of quad layers and height ratio (Ring offset ratio). If smart sizing is used, the mesh size
will also be adjusted as defined in the note below.

Curves to check

The bolt hole detection will be run on the selected curves. If no curves are selected, the bolt hole
detection will be run on the entire model.

Num quad layers

The number of quad layers of uniform height to be grown from the hole. This is equivalent to
the Tetra Width mesh curve parameter.

Ring offset ratio

An expansion ratio from the first layer of elements on the curve. This ratio will be multiplied by
the element height of the previous layer to define the next layer. You can enter any positive real
number. This is equivalent to the Height Ratio mesh parameter.

Min / Max diameter

Bolt holes with diameters within this specified range will be found.
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Remove holes below min

If the min diameter is set larger than holes you want to remove, then this option will remove all
holes smaller than the Min diameter.

Note:

It is recommended that mesh sizes be set before using this feature, as the offset layers
require the mesh size of the curves to be set properly.

If the mesh size and Num quad layers are defined, the smart sizing will try to decrease the mesh
size so that the defined mesh size is obtained at the top of the quad layers rather than at the bolt
hole. The smart sizing function calculates the ratio of the original mesh size at the outer ring of the
quad layers to the new mesh size and reduces the original mesh size by this ratio.

In the example below, bolt holes without smart sizing are shown. Uniform mesh spacing was set on
all curves prior to bolt hole detection.

Figure 230: Bolt Hole Without Smart Sizing

An example of bolt holes with smart sizing is shown below, with the same original uniform mesh
spacing.
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Figure 231: Bolt Hole With Smart Sizing

Note:

If you run bolt hole detection multiple times with smart sizing, the mesh size will be reduced
each time. Smart sizing uses the current mesh size to compute what the new size should
be. To avoid excessive refinement, it is recommended that this feature be run only once,
or redefine the nominal mesh size on the curves before running bolt holes a second time.

Feature Detect Buttons

The Feature Detect Buttons option detects button features and puts them into geometry
subsets.

Figure 232: Example of Button Features
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All curves within the button are made dormant so that the meshing of the button is handled in a
special way.

There are three types of buttons that can be detected: Standard buttons, Fillet buttons and Split
buttons. By default the software will look for standard buttons, but there also options to also check
for fillet and split buttons.

A fillet button is enclosed by a set of fillets, while a split button is enclosed by two surfaces. See the
examples below.

Figure 233: Example of Fillet and Split Buttons

Split ButtonFillet Button

Surfaces to check

Select the surfaces that will be checked for buttons.

Fillet buttons

If enabled, the selected surfaces will also be checked for fillet buttons.

Rel. Tolerance

This option is applied to detection of fillet buttons only. If this is disabled, the default tolerance
that will be used is 0.001. If this is enabled, a relative tolerance can be specified for button detec-
tion.

Fillets are detected if its boundaries are created from arcs. To check whether a curve is an arc,
the curve deviation from an arc will be checked using this tolerance.

Split buttons

A split button is a button enclosed by 2 surfaces. If enabled, the selected surfaces will be checked
for split buttons as well.

Feature Detect Fillets

The Feature Detect Fillets option detects fillet regions and puts them into subsets.

Surfaces to check

Select the surfaces in which to check for fillets.
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Min fillet length

Specify the minimum fillet length.

Max fillet length

Specify the maximum fillet length.

Note:

The fillet length can be found using the equation:

L = R * θ * π / 180.

where R = radius of the fillet and θ = fillet angle in degrees.

All the fillets with lengths between the specified maximum and minimum lengths will
be placed in the subset.

Min fillet curvature

Specify the fillet curvature angle in degrees. All the fillets whose curvature is greater than the
specified curvature will be placed in the subset.

Relative Tolerance

If this is disabled, then 0.001 will be used as the (default) relative tolerance. If enabled, the relative
tolerance for fillet detection can be specified. The absolute tolerance will be calculated as relative
tolerance * curve length.

Fillets are detected if its boundaries are created from arcs. To check whether a curve is an arc,
the curve deviation from an arc will be checked using this tolerance.

Transform Geometry

 Use transformation tools to change the position or size of the selected entity or entities.

Figure 234: Transformation Tools
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Select

Click the Select geometry icon, and then choose the entities to be transformed.

Note:

For material point selection using the box method, the partial enclosure setting will allow
you to select the body’s material point without selecting attached surfaces, if any exist.

Tip:

In complex geometry, if only one entity type is being transformed, display only that entity
type and hide others with the display tree options.

Keep Topology

Retains topology information (connectivity, curves, and points as described in Build Topology (p. 284))
through the transformation. Default is on.

Note:

• This applies only if the entire geometry is selected.

• If you select nothing and click Apply, the entire geometry will be selected and Keep
Topology will be applied.

The following transformation tools are available:

Translation

Rotation

Mirror Geometry

Scale Geometry

Translate and Rotate

Clicking the Copy option causes the transformation functions to apply to a copy of the selected entities.
By default, all newly created copies will be placed in the same part as the parent entity. To place copies
in a new part, use IncrementParts.

Note:

The Settings > Geometry Options > Inherit part name toggle does not apply to Transform
Geometry options.

Translation

There are two methods of defining a translation vector.
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Copy

If enabled, a copy of the selected entities will be translated.

Number of copies

Specify the number of copies.

IncrementParts

To add the newly created copies of entities to a new part, click the IncrementParts icon. A window
will open with the list of the parts of the selected entities. If a part is selected, the new entities
will be placed in a new part named [old_part_name]_0. For multiple copies, each copy will be
placed in a separate part, for example, GEOM_1, GEOM_2, GEOM_3, etc.

Method

Choose an option to set translation direction and distance:

Explicit

Type the offset distances of the translation for all three directions.

Vector

• Through 2 points

Select two existing points to set translation direction. The first point selected will represent
the tail of the vector while the other will represent the head of the vector.

• Distance

Specify the distance of the translation. If distance is not specified, the (default) translation
distance will be the distance between the two selected points.

Rotation

The Rotation option rotates the selected geometry about an axis.

Copy

If enabled, a copy of the selected entities will be rotated.

Number of copies

Specify the number of copies of the selected entities to be created.

IncrementParts

To add the newly created copies of entities to a new part, click the IncrementParts icon. A window
will open with the list of the parts of the selected entities. If a part is selected, the new entities
will be placed in a new part named [old_part_name]_0. For multiple copies, each copy will be
placed in a separate part, for example, GEOM_1, GEOM_2, GEOM_3, etc.
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Angle

If this is enabled, you can manually specify the angle of rotation. If disabled, the angle of rotation
is automatically set based on the number of copies. For n copies, the angle of rotation is set to
360/(n + 1). For example, for 1 copy, the angle of rotation is 180 degrees, and for 2 copies, it is
120 degrees.

Axis

The axis of rotation can be defined as one of the global axes, or by a vector through two specified
points.

Center of Rotation

The center of rotation may be chosen as the Origin, Centroid (of the geometry) or another specified
point.

Mirror Geometry

The Mirror Geometry option mirrors selected geometry about a plane.

Copy

If enabled, a copy of the selected entities will be mirrored.

IncrementParts

To add the newly created copies of entities to a new part, click the IncrementParts icon. A window
will open with the list of the parts of the selected entities. If a part is selected, the new entities
will be placed in a new part named [old_part_name]_0. For multiple copies, each copy will be
placed in a separate part, for example, GEOM_1, GEOM_2, GEOM_3, etc.

Plane Axis (Normal)

Define the normal of the mirroring plane, either as one of the global axes, or by a vector through
two specified points.

Point of Reflection

The point of reflection may be chosen as the Origin, Centroid (of the geometry) or another specified
point.

Scale Geometry

The Scale Geometry option allows you to scale the selected geometry in all three directions or
in any particular direction.

Copy

If enabled, a copy of the selected entities will be scaled.
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IncrementParts

To add the newly created copies of entities to a new part, click the IncrementParts icon. A window
will open with the list of the parts of the selected entities. If a part is selected, the new entities
will be placed in a new part named [old_part_name]_0. For multiple copies, each copy will be
placed in a separate part, for example, GEOM_1, GEOM_2, GEOM_3, etc.

X, Y, Z factor

Enter the scale factor for each direction.

Center of Transformation

The center of the scaling transformation may be chosen as the Origin, Centroid of the geometry,
or another Selected point.

Translate and Rotate

The Translate and Rotate option allows you to translate and rotate the geometry at the same
time.

Copy

If enabled, a copy of the selected entities will be created in the new location.

IncrementParts

To add the newly created copies of entities to a new part, click the IncrementParts icon. A window
will open with the list of the parts of the selected entities. If a part is selected, the new entities
will be placed in a new part named [old_part_name]_0. For multiple copies, each copy will be
placed in a separate part, for example, GEOM_1, GEOM_2, GEOM_3, etc.

3 points –> 3 points

Select six points in all. The first three points will be used as the reference for the entity to be
transformed. The second set of three points is used to define the transformation. The result will
match the first points of both sets, and the direction from the first to the second point, and the
plane defined by the third point.

Curve –> Curve

Select two curves. The first curve is used as a reference for the entity to be transformed. The
second curve is used to define the transformation. The result will match the beginning (parameter
= 0) of both curves, the direction from parameter 0 to 0.5, and the plane defined by the end
(parameter 1) of the curves. A curve used to define the transformation can be included in the
entities selected to be transformed.

LCS –> LCS

Select two local coordinate systems. Click Apply.

The result will match the origin and the axes of the first to the second LCS.
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Restore Dormant Entities

This Restore Dormant Entities option restores dormant curves and points.

Dormant curves and points are a fundamental part of Ansys ICEM CFD feature build topology. When
build topology is performed, the software builds connectivity information between surfaces. For example,
a surface is attached to a set of curves that is attached to a set of points. This information is needed
for flood fill operations, patch based meshing, and many geometry operations that require connectivity
information. When a curve is made dormant, the curve is still in the database and can be restored
through this feature. Also, connectivity between the surfaces still exists. Dormant curves and points can
also be displayed by right-clicking Curves and Points Display Trees and selecting Show Dormant.

Curves and points can be made dormant either by deleting them with Delete permanently option dis-
abled, through building topology with feature angle and filter points/curves enabled, or through feature
detection tools. If a curve or point is dormant, it will not be recreated when building topology, but
build topology may make it active. If a curve or point is permanently deleted, it is removed from the
database. If the topology is rebuilt, the curve will be recreated. Flood fill, and patch based meshing will
also fail across a boundary (curve or point) that has been permanently deleted. Curves and points that
are unattached to surfaces or curves will always be permanently deleted, as the sole purpose of dormant
curves and points is to maintain connectivity between attached geometry.

Delete Point

The Delete Point option deletes selected points.

Delete unattached

automatically deletes unattached points.

Delete permanently

permanently deletes the selected points and removes them from the database.

Join incident curves

If two curves are attached at a point, and they do not form a sharp angle, then if the point is deleted,
this option will concatenate the curve.

Delete All Dormant Points

deletes all dormant points.

Delete Curve

The Delete Curve option deletes selected curves.

Delete unattached

automatically deletes unattached curves.
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Delete permanently

permanently deletes the selected curves and removes them from the database.

Delete All Dormant Curves

deletes all dormant curves.

Delete Surface

The Delete Surface option permanently deletes the selected surfaces and removes them from the
database.

Delete Body

The Delete Body option permanently deletes the selected bodies and removes them from the
database.

Body

Click Select Material Point and then select bodies for deletion. You may individually select bodies
containing material points.

Delete All Solids

Click Delete All Solids to delete solid bodies that do not contain material points.

Delete Any Entity

The Delete Any Entity option deletes selected entities.

Delete unattached

automatically deletes unattached entities.

Delete permanently

permanently deletes the selected entities and removes them from the database.
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Mesh
Figure 235: Mesh Menu

The Mesh tab contains the following options:

Global Mesh Setup

Part Mesh Setup

Surface Mesh Setup

Curve Mesh Setup

Create Mesh Density

Define Connectors

Mesh Curve

Compute Mesh

Global Mesh Setup

The Global Mesh Setup options provide the general and specific meshing algorithm parameters
used for the various meshers. The global mesh parameters are stored in the geometry file and help
define global controls for the following:

Global Mesh Size

Shell Meshing Parameters

Volume Meshing Parameters

Prism Meshing Parameters

Set Up Periodicity

Figure 236: Global Mesh Setup Parameters
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For a comprehensive list of the different meshing parameters and which methods they apply to, see
Table 3: Parameters for Surface Meshing Methods (p. 308), Table 4: Parameters for Volume Meshing
Methods (p. 309), and Table 5: Parameters for Other Meshing Methods (p. 311).

Table 3: Parameters for Surface Meshing Methods

Surface Meshing Methods

ShrinkwrapPatch Indep.Patch Dep.AutoblockMesh
Parameters

Global Parameters

YYYYMax Element*

NYYNMin Size
Limit*

NYNNElements in
gap

NYNNRefinement

NYNNPeriodicity

Part Meshing Parameters

N/AN/AN/AN/AInternal Wall

N/AN/AN/AN/AThin Wall

N/AN/AN/AN/AHexa-core

N/AN/AN/AN/APrism setting

Surface Meshing Parameters

NNYYIgnore Size

N/AN/AN/AN/ASurface mesh
type

Prism Meshing Parameters: See Table 5: Parameters for Other Meshing Methods (p. 311)

Surface Parameters

YYYYMax size*

N/AN/AN/AN/AHeight

N/AN/AYN/AHeight ratio

N/AN/AN/AN/ANo. of layers

N/AYN/AN/ATetra width

N/AYN/AN/ATetra size
ratio

NYNNMin Size
Limit*

NYYYMax
deviation*

N/AYYYSurface mesh
type

Curve Parameters

NYYYMax size*
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Surface Meshing Methods

ShrinkwrapPatch Indep.Patch Dep.AutoblockMesh
Parameters

NYYYNo. of nodes

NNYNHeight

NNYNHeight ratio

NNYNNo. of layers

N/AYN/AN/ATetra width

NYNYMin Size
Limit*

NYNYMax
deviation*

NNYNBunching

NYNNDensities*

NYYNConnectors

*Scale Factor is applied

Table 4: Parameters for Volume Meshing Methods

Volume Meshing Methods

CartesianHexa
Dom.

Adv.
Front

DelaunayOctreeMesh
Parameters

Global Parameters

NYYYYMax
Element*

NN/AN/AN/AYMin Size
Limit*

NNNNYElements
in gap

NN/AN/AN/AYRefinement

NN/AN/AN/AYPeriodicity

Part Meshing Parameters

NN/AN/AN/AYInternal
Wall

NN/AN/AN/AYThin Wall

N/AN/ANYYHexa-core

NN/AYYYPrism
setting

Surface Meshing Parameters

NN/AN/AN/ANIgnore
Size
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Volume Meshing Methods

CartesianHexa
Dom.

Adv.
Front

DelaunayOctreeMesh
Parameters

N/AYYYNSurface
mesh type

Prism Meshing Parameters: See Table 5: Parameters for Other Meshing Methods (p. 311)

Surface Parameters

YN/AN/AN/AYMax size*

NN/AN/AN/AN/AHeight

NN/AN/AN/AN/AHeight
ratio

NN/AN/AN/AN/ANo. of
layers

N/ANNNYTetra
width

N/ANNNYTetra size
ratio

YN/AN/AN/AYMin Size
Limit*

NN/AN/AN/AYMax
deviation*

N/AYYYNSurface
mesh type

Curve Parameters

NN/AN/AN/AYMax size*

NN/AN/AN/ANNo. of
nodes

NN/AN/AN/AN/AHeight

NN/AN/AN/AN/AHeight
ratio

NN/AN/AN/AN/ANo. of
layers

N/ANNNYTetra
width

NN/AN/AN/AYMin Size
Limit*

NN/AN/AN/AYMax
deviation*

NN/AN/AN/ANBunching

YNNYYDensities*

NYYYYConnectors
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Volume Meshing Methods

CartesianHexa
Dom.

Adv.
Front

DelaunayOctreeMesh
Parameters

*Scale Factor is applied

Table 5: Parameters for Other Meshing Methods

Other Methods

Blockingpre inflation (Fluent
Meshing) Prism

post inflation
Prism

Mesh Parameters

Global Parameters

YYYMax Element*

NN/AN/AMin Size Limit*

NYNElements in gap

NN/AN/ARefinement

YNYPeriodicity

Part Meshing Parameters

N/AN/AN/AInternal Wall

N/AN/AN/AThin Wall

N/AN/AN/AHexa-core

YN/AN/APrism setting

Surface Meshing Parameters

NN/AN/AIgnore Size

NN/AN/ASurface mesh type

Prism Meshing Parameters

NYYGrowth law

YYYInitial height
See Offset Methods in Additional
pre inflation (Fluent Meshing)
settings (p. 359)

YYYHeight ratio

YYYNumber of layers

YYYTotal height
See Offset Methods in Additional
pre inflation (Fluent Meshing)
settings (p. 359)

N/AYYFillet Ratio
(used to derive offset-weight)

N/AYYMax prism angle
(used to derive project-adja-
cent-angle)

N/AYYMax height over base
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Other Methods

Blockingpre inflation (Fluent
Meshing) Prism

post inflation
Prism

Mesh Parameters

(used to derive min-aspect-ra-
tio)

YYYPrism height limit factor
See Offset Methods in Additional
pre inflation (Fluent Meshing)
settings (p. 359)

Smoothing Options

N/AYYNumber of volume smoothing
steps See note in Smoothing

Options (p. 356)

Advanced Prism Meshing Parameters

N/AYN/AAuto Reduction
See note in Advanced Prism
Meshing Parameters (p. 361)

N/AYN/AStair Step
See note in Advanced Prism
Meshing Parameters (p. 361)

Surface Parameters

YN/AN/AMax size*

YYYHeight

YYYHeight ratio

YYYNo. of layers

N/AN/AN/ATetra width

N/AN/AN/ATetra size ratio

NN/AN/AMin Size Limit*

NN/AN/AMax deviation*

NN/AN/ASurface mesh type

Curve Parameters

YN/AN/AMax size*

YN/AN/ANo. of nodes

YYYHeight

YYYHeight ratio

YYYNo. of layers

N/AN/AN/ATetra width

NN/AN/AMin Size Limit*

NN/AN/AMax deviation*

NN/AN/ABunching
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Other Methods

Blockingpre inflation (Fluent
Meshing) Prism

post inflation
Prism

Mesh Parameters

NN/AN/ADensities*

NN/AN/AConnectors

*Scale Factor is applied

Global Mesh Size

The Global Mesh Size parameters affect meshers at the surface, volume, and inflation (prism)
layer levels.

Global Element Scale Factor

multiplies other mesh parameters to globally scale the model. For a list of parameters affected
by this scale factor, see the tables in Global Mesh Setup (p. 307).

For example, if the Max Element Size of a given entity is 4 units, and the Global Element Scale
Factor is 3.5, then the actual maximum element size used for meshing of that entity will be 4 *
3.5 = 14.0 units. The Global Element Scale Factor can be any positive real number, and it allows
you to globally control the mesh size instead of changing the mesh parameters for different en-
tities.

Display

when enabled, a reference mesh element will be displayed that corresponds to the specified
element size.

Global Element Seed Size

Max Element

controls the size of the largest element. The largest element size in the model will not exceed
the Max Element size multiplied by the Global Element Scale Factor. It is recommended
that the Max Element value is a power of 2. Even if you specify a value other than a power
of two, some meshers (Octree/Patch Independent) approximate the Max Element size to the
nearest power of two while meshing.

Note:

If the Max Element size is set to 0, the Automatic Sizing feature will be implemen-
ted. Autosizing temporarily sets a Global Max Element size, which produces a uni-
form mesh, if no surface or curve sizes are smaller. If most surface sizes are not set
(< 22%), the autosizing will set the Global Max Element size to 0.025 * the bounding
box diagonal of the geometry. If most surface sizes are set (> 22%), the autosizing
will set the Global Max Element size to be the largest surface size that is specified.

If the Global Max Element size is too large (>= 0.1* the bounding box diagonal),
and either no surface sizes are set or are also greater than this value, a message
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will appear informing you that the mesh size may be inadequate to represent the
geometry and asking if you want to run with autosizing instead.

Curvature/Proximity Based Refinement

when enabled, the mesh is automatically refined based on geometry curvature and proximity.
This will result in larger elements on flat planar surfaces and smaller elements in areas of high
curvature or within small gaps. The algorithm attempts to satisfy the Refinement and Elements
in Gap settings, but is limited by the Min size limit. The effective Min size limit is scaled by the
Global Element Scale Factor, as is done with the Max Element Size.

Note:

This option currently applies only to Octree and Patch Independent meshing.

All other mesh sizes will be rounded to the nearest power of 2 of the Min Size Limit value.

The following options are applicable when Curvature/Proximity Based Refinement is enabled:

Min size limit

specifies the size limit for the smallest element. Mesh elements will be prevented from being
subdivided smaller than this value. If, however, the Refinement and Elements in Gap settings
are satisfied without refining down to this minimum size, refinement will stop on its own and
may never subdivide down to this Min size limit value.

To see a mesh element of this size displayed on the screen, enable the Display option and
click Apply.

Tip:

You may set local Min size limit smaller than this global setting using Part Mesh
Setup, Curve Mesh Setup, or Surface Mesh Setup. The recommended process is
to define the largest targeted minimum size globally and then set smaller values
locally if needed.

Elements in Gap

is used to force the Octree/Patch Independent mesher to create a defined number of elements
in a gap (proximity based refinement). The specified value may not be possible if the Min size
limit is too large, as the mesh can not be refined smaller than the Min size limit. Any positive
integer can be entered for this option.

Refinement

defines the number of edges that would fit along a radius of curvature if that radius were
extended out to 360 degrees. This is generally used to avoid having too many elements along
a given curve or surface, if the Min size limit is too small for that particular curve. Any positive
integer can be entered for this option. See the example in Figure 237: Refinement (p. 315).
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Figure 237: Refinement

Ignore Wall Thickness

prevents the Curvature / Proximity Based sizing function from refining for closely spaced
parallel surfaces, though it will still resolve other forms of proximity. The Elements in Gap
function may cause the model to over-refine within or around thin walled sections of a
model. In these cases, the refinement results in relatively uniform elements and high mesh
density in those areas. This can dramatically increase the element count. Enabling the Ignore
Wall Thickness option will result in a mesh that uses larger elements in the thin walled area.
There will still be refinement near the edges of the thin wall, but it will not refine most of the
area. These larger elements will not be uniform and are likely to have lower quality. These
higher aspect ratio tetra elements are also more likely to result in holes or non-manifold vertices
in the thin wall, which can be addressed using the Define Thin Cuts  (p. 330) option for Octree
Tetra meshing.

In the following examples, all refinement was controlled automatically by the Curvature /
Proximity Based Refinement sizing function.

Figure 238: FEA Model with Ignore Wall Thickness Option Disabled
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Figure 239: FEA Model with Ignore Wall Thickness Option Enabled

In the CFD example shown, there is a thin wall separating larger volumes. There is no need
to refine the mesh for the wall thickness because meshing is not required within the wall. In
this example, the quality is better when using Ignore Wall Thickness because of fewer size
transitions.

Figure 240: CFD Model with Ignore Wall Thickness Option Disabled

Another view of the same CFD model

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.316

Mesh



Figure 241: CFD Model with Ignore Wall Thickness Enabled

Shell Meshing Parameters

The Shell Meshing Parameters control the various surface meshing algorithms. These parameters
also control the surface mesh that is used for various volume meshers.

Mesh type

specifies the type of surface mesh. If an individual surface is assigned a different type of surface
mesh, then the local control will override the global setting.

All Tri

meshes the geometry with a pure triangular mesh.

Quad w/one Tri

allows for a Quad Dominant mesh with one tri element per surface. The tri element allows
for better transition between uneven mesh distribution on the loop edges. Automatic tri-re-
duction steps may even remove the tri element.

Quad Dominant

creates a quad mesh that allows for several transitional triangles. This mesh type is very useful
in meshing complicated surfaces where a pure quad mesh may have poor quality.

All Quad

meshes the geometry with a pure quadrilateral surface mesh.

Note:

This mesh type requires uniform sizes otherwise it will create some tri elements to
maintain connectivity.
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Mesh method

specifies the meshing method or algorithm to be used. If an individual surface is assigned a dif-
ferent type of mesh method, then the local control will override the global setting.

Autoblock

This method uses the mapped or block-based meshing algorithm. It automatically determines
the best fit to obtain the defined minimum edge and orthogonality. For surface patches that
cannot be mapped (having more or less than 4 corners), the Patch Dependent method is
called through this block-based algorithm.

Patch Dependent

This is a free surface mesh generator that meshes closed regions called loops. Loops are created
from surfaces or curves, and holes and internal curves are taken into account. The mesh is
seeded according to the node spacing defined on the curves. Mesh from adjacent loops
sharing a single curve is automatically joined together. This meshing method gives the best
quad dominant quality while capturing surface details.

Note:

For Patch Dependent meshing using Mesh Type of All Tri, the Curve Mesh
Setup parameters of Height, Height Ratio, and Num Layers are respected,
but quad elements will be used for the offset layers.

If only Height Ratio is used in conjunction with the Global Shell Meshing
Parameter Adapt Mesh interior, it can control the rate of transition for the
All Tri or Quad Dominant mesh types.

Patch Independent

Patch independent meshing is best for low quality geometry or surfaces with poor connectivity.
It uses the Octree method to create a robust patch independent surface mesh. See The Octree
Mesh Method in the Ansys ICEM CFD User's Manual.

The geometry does not need to be a closed volume. If the Mesh Type is set to Quad mesh,
the Patch Independent mesher will first generate a tri mesh, which can be automatically
converted to a pure quad or quad dominant mesh.

Note:

Patch independent meshing does not respect surface meshing parameters that
have been set. However, it can take advantage of Octree parameters such as
Curvature/Proximity Based Refinement, and Density Regions. Refer to the Table
of Meshing Parameters (p. 307).
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Figure 242: Example of Patch Independent Meshing

Shrinkwrap

Shrinkwrap meshing is best for geometry with gaps in STL representation. It uses the Cartesian
method to initially generate all Quad mesh, with Quad dominant / All Tri options for better
capturing of features. This generates watertight shell mesh with feature suppression. If the
capture of greater detail is desired, then the Patch Independent Octree Tetra mesh would
produce a better result, given that the model is of sufficient quality.

Note:

The shrinkwrap mesher requires a closed volume input.

Figure 243: Example of Shrinkwrap Meshing

Autoblock Options

The Autoblock mesh method creates a 2D surface blocking in the background to generate 2D shell
mesh. Since blocking is used in the background, you will essentially define the controls for the in-
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termediate blocking file that will be generated. For more information on blocking and mesh gener-
ation, see Blocking > Create Block > 2D Surface Blocking (p. 414).

General Parameters

Ignore size

ignores sliver surfaces smaller than the specified value by merging the smaller loop with
the adjacent loop.

Surface Blocking Options

The meshing algorithm on a surface to surface basis can be varied among the following options:

Free

All surfaces will be meshed similar to Patch Dependent Meshing.

Some mapped

Some surfaces will be meshed as orthogonally meshed surfaces, and the remainder will be
meshed similar to Patch Dependent Meshing. Surfaces with primarily 4 corners and 4 sides
are likely to be mapped (orthogonally meshed), even if they also have other shallow corners
or multiple edges. Surfaces with more or less than 4 clear corners will be meshed as free
blocks.

Mostly mapped

Most surfaces will be meshed as orthogonally meshed surfaces, and the remainder will be
meshed similar to Patch Dependent Meshing. This is achieved by blocking subsurfaces, for
example, a triangular surface may be blocked in a 3 block Y pattern (quarter Ogrid), and a
half circle may be blocked with a C-grid (half Ogrid). In other cases, a surface with 5 or 6
corners may be split to create 2 mapped regions.

Merge mapped blocks

attempts to group mapped surfaces to form larger mesh regions.

Note:

Blocks can be converted between free and mapped blocks using Edit Block > Convert
Block Type.

Note:

For more descriptions of the different block types, see  User’s Manual > Hexa > Hexa
Block Types .
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Patch Dependent Options

General Parameters

Ignore size

ignores sliver surfaces with an edge that is smaller than the defined value by merging the
smaller loop with the adjacent loop.

Respect line elements

forces the surface mesher to respect nodes from given line elements on curves instead of
creating new nodes. This is useful to connect a mesh to an existing mesh.

In Figure 244: Line Element Generated (p. 321), a curve of element count 14 was meshed
and a line element was generated.

Figure 244: Line Element Generated

In Figure 245: Line Element Count Changed (p. 322), the element count was changed from
14 to 10.
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Figure 245: Line Element Count Changed

If the four curves are chosen for Patch based surface meshing, and Respect line elements
is enabled, line element mesh will remain intact. The resulting mesh is shown in Figure 246: Re-
spect Line Elements Enabled (p. 322).

Figure 246: Respect Line Elements Enabled

When Respect line elements is disabled, the surface mesh created has ignored the line
element mesh and readjusted the mesh on the curves based on the element count, as
shown in Figure 247: Respect Line Elements Disabled (p. 323).
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Figure 247: Respect Line Elements Disabled

Respect line elements is useful to make sure that new mesh matches and connects with
an existing mesh. This is particularly useful if the existing mesh came from another mesher,
such as Ansys ICEM CFD Hexa mesher, or from an outside product. This option is also
helpful if there is a complex edge distribution that would be hard to match with the curve
parameter controls.

In the example in Figure 248: Example of Respect Line Elements Option (p. 323), the inner
fan was meshed using the Ansys ICEM CFD Hexa mesher and the outer shroud was meshed
with Respect line elements to create a node for node conformal mesh.

Figure 248: Example of Respect Line Elements Option

Quadratic elements

when enabled, generates the patch dependent surface mesh with mid side nodes (quadratic
elements), such that triangles have 6 nodes (3 corners and 3 mid side nodes) and quads
have 8 nodes (4 corners and 4 mid side nodes). The mid side nodes are projected to the
surface and the resulting edge shape is quadratic (rather than linear). When this option is
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disabled, the patch dependent surface mesh consists of linear triangles and quads, each
with 3 or 4 corner nodes, respectively.

Note:

Typically FEA solvers prefer quadratic elements. Most CFD solvers do not support
quadratic elements at all.

Tip:

You can also use the Create Mid Side Nodes (p. 663) option to convert linear
elements to quadratic.

Boundary Parameters

Protect given line elements

is available when Ignore size is set and Respect line elements is enabled in the General
section of the Shell Meshing Parameters list. If enabled, it will protect existing line elements
that are smaller than the Ignore size value from being removed.

Smooth boundaries

smooths the surface mesh boundaries after meshing. This will typically give better quality
mesh, but it may not respect the initial node spacing.

Allow free bunching

if enabled, it allows free bunching for patch independent (Octree, with or without Tetra)
surfaces. If disabled, curve bunching is done by the Patch Dependent mesher and respected
by Patch Independent functions.

Offset type

Standard

Offsets will be created normal to the edges without special solutions for sections with
small or large angles, such as corners. The number of nodes on the offset front may not
be identical as the number of nodes on the initial boundary.
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Figure 249: Standard Offset Example

Simple

Offsets will be created normal to the edges without special solutions for sections with
small or large angles, such as corners. The number of nodes on the offset front is
identical to the number of nodes on the initial boundary.

Figure 250: Simple Offset Example

Forced Simple

This option is the same as simple offset, but without collision checking.
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Figure 251: Forced Simple Offset Example

Interior Parameters

Force Mapping

If the boundary is nearly quadrilateral, the mesher forces the generation of structured mesh
instead of unstructured mesh up to this specified block quality. Default value is 0. For hybrid
meshes a value of 0.2 is preferred.

Max nodes adjustment

For opposite boundaries with differing node counts, this function will calculate the ratio of
the node counts as a percentage. For all ratio percentage values less than this specified
value, mapping will be applied to the mesh. For all ratio percentage values greater than
this specified value, mapping will not be applied.

Project to surfaces

If enabled, it will allow the mesher to project the mesh to the surface.

Note:

Disable this if the geometry does not have surfaces.

Adapt mesh interior

Uses the surface sizes to coarsen the mesh internally. For example, if curve size is set to 1,
and surface size to 10, then the mesh will start with a mesh size of 1 on the curves, but
transition to 10 in the middle of the surface. This is more effective on larger surfaces where
the element reduction is more dramatic.

The default growth rate for the transition to the surface max size is 1.5. This growth rate
can be adjusted by setting the surface Height Ratio to between 1.0 and 3. Sizes below 1.0
are inverted (for example, 0.667 becomes 1.5). Sizes above 3 are ignored and the default is
used. If this option is enabled, Force Mapping is disabled on surfaces whose maximum size
setting exceeds its perimeter curve sizes by a factor of 2 or more.
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The difference in the transition rate is shown in Figure 252: Example of Adapt Mesh Interior
option (p. 327):

Figure 252: Example of Adapt Mesh Interior option

Adapt Mesh Interior option disabled

Adapt Mesh Interior option enabled

Surface Height Ratio = 3Default Surface Height Ratio =
1.5

Note:

The Max Element size specified in the General Parameters takes precedence
over this value.

Note:

For All Quad, Quad Dominant, and Quad with one Tri mesh, the Force Mapping
option has priority over this option. To apply the Adapt mesh interior option
to these types of mesh, set the Force Mapping value to 0.

Orient to surface normals

orients the shell normals in the same direction as the surface normals. This option is enabled
by default.
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Repair Parameters

Try harder

• Level 0

If the mesher fails, no further meshing step is tried. The problem(s) will be reported.

• Level 1

If the mesher fails, simple triangulation is attempted to fix the problems (for "All Tri" and
"Quad Dominant" mesh types only).

• Level 2

All Level 1 steps will be completed. If necessary, all Level 1 steps will be retried without
merging at dormant curves.

• Level 3

All Level 2 steps will be completed. If necessary, surface meshing will be retried with the
Tetra mesher.

Improvement level

• Level 0 does pure Laplacian smoothing. Nodes are moved while keeping the mesh topo-
logy unchanged.

• Level 1 will mesh any failed loop with an STL method if element types Quad Dominant
or All Tri has been selected. This makes the mesher more robust. Very bad quadrangles
will be split into triangles.

• Level 2 will operate as Level 1, and also will combine triangles to quadrangles and will
split more bad quadrangles into triangles. This option is most used.

• Level 3 will operate as Level 2, and also will move nodes off curves to improve the
quality.

Respect dormant boundaries

If enabled, all dormant curves and points are included in the mesh boundary definitions.
The default is off.

Relax dormant boundaries for smoothing

If Mesh dormant is enabled, then this option allows nodes on dormant curves and points
to be moved in order to improve smoothing.

Patch Independent Options

This method uses the Octree Tetra process to create a robust patch independent surface mesh. See
The Octree Mesh Method in the Ansys ICEM CFD User's Manual.
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Shrinkwrap Options

Num. of smooth iterations

is the number of smoothing iterations that will be performed to improve mesh quality.

Surface projection factor

controls the tightness of the shrinkwrap to the geometry. Values can range from 0 to 1.0, where
a value of 0 indicates shrinkwrap totally free from the geometry, and a value of 1.0 indicates
shrinkwrap that is strictly on the geometry. The example in Figure 253: Surface Projection
Factor (p. 329) illustrates the results of using different values for the Surface projection factor.

Figure 253: Surface Projection Factor

Surface Projection
Factor = 0.2

Surface Projection
Factor = 0.9

Volume Meshing Parameters

The Volume Meshing Parameters control the various volume meshing algorithms. Each mesh
type has different options, as described in the following sections.

Tetra/Mixed

Hexa-Dominant

Cartesian

Tetra/Mixed

The following Mesh Methods are available for Tetra/Mixed volume meshing:

Robust (Octree)

Quick (Delaunay)

Smooth (Advancing Front)
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Fluent Meshing

Robust (Octree)

The Robust (Octree) option will generate a tetra mesh using a top-down meshing approach. An
Octree mesher does not require an existing surface mesh because one is created by the Octree
process. It will accept a variety of parameters in a more general way. For instance, curve sizes are
respected, but specific curve node spacing distributions are not. For a better understanding of
the Octree meshing methodology, see The Octree Mesh Method in the Ansys ICEM CFD User's
Manual.

Run as batch process

allows you to run the meshing operation in batch mode.

Fast transition

enables a faster transition from the more refined elements to coarser elements instead of a
more gradual transition when computing the mesh. This will reduce the number of elements
in the overall mesh. This option is particularly useful if you plan to delete the Octree volume
mesh anyway since it saves time and memory during mesh generation.

Edge criterion

determines to what extent a tetra is cut to represent geometry. The entered value is a factor
of the tetra edge. After subdivision, if a tetra edge intersects an entity (surface), the tetra will
be cut if the subdivision of the edge from the intersection is less than the prescribed value.

The values can range from 0 to 1. A larger value (above 0.5) may be prescribed if you want
to ignore inexact duplicates, however geometry may not be properly captured if the value
is too large. Increasing the value will increase the nodes moving to fit to the geometry. Redu-
cing the value will increase refinement near entities, and will also reduce non-manifold vertices
in trailing edges. The default of 0.2 is adequate for most cases. This value is useful in cases
where thin cuts fail or are difficult to setup.

Figure 254: Edge Criterion

Edge criterion = 0.01Edge criterion = 0.2

Define thin cuts

allows you to resolve gaps based on pairs of surface or curve parts which are close to each
other. The thin cut definition prevents surface elements from spanning between nodes on
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the two parts specified. This helps prevent non-manifold nodes in areas where the mesh size
may be larger than the gap.

Figure 255: Thin Cuts (p. 331) shows an example of thin cuts. If the face of a tetra element has
a surface/line/node on part A, then it cannot have a surface/line/node in part B.

Figure 255: Thin Cuts

Note:

If the surfaces of the two parts, A and B, meet (see Figure 256: Thin Cuts for Inter-
secting Parts (p. 331)), then the contact curve must be in a third part, C, or the thin
cut will fail.

Figure 256: Thin Cuts for Intersecting Parts

Clicking the Define thin cuts button will bring up the Thin cuts window where pairs of parts
can be selected or entered to define a thin cut "pair". A part can belong to more than one
thin cut pair.

The following limitations apply to the definition of thin cuts:

• If two surfaces approach asymptotically, the thin cut definition may eventually fail.

• If the separation rule of thin cuts is violated at any point, all thin cuts will fail and be
deactivated.
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Due to the existing limitations with defining thin cuts, in some cases, it may be more effective
to adjust the edge criterion.

Edit entry

allows you to enter or edit the names of the parts in a pair.

Select

allows you to select parts from a window displaying all the part names. The pair of parts
selected should not be touching. If two surface parts meet along an edge (such as a sharp
cusp) the curves and points between the parts must be in a third part name.

Add

adds the thin cut pair selected or entered.

Modify

allows you to modify a thin cut pair.

Delete

allows you to delete a thin cut pair definition.

Done

saves the thin cut pair definitions and closes the window.

Cancel

cancels the thin cut pair definitions.

Smooth mesh

when enabled, the mesh is smoothed after finishing subdivision down to the specified mesh
sizes.

Iterations

number of iterations to be performed for the smoothing to match the supplied Min
quality.

Min Quality

all elements with quality less than the specified value will be smoothed. The default
is 0.4.

Coarsen mesh

is a useful option if the geometry to be captured is difficult to mesh with the desired coarse
mesh size. This allows the Octree process to fit to the geometry and flood fill with a finer
mesh and then automatically coarsen it. For instance, it could mesh to capture features with
approximately 150k elements and then automatically coarsen down to 15k elements while
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still maintaining the features. For most situations, you should mesh without this option and
coarsen the mesh with the Edit Mesh tools where there are more controls available.

Iterations

number of iterations to be performed for the coarsening to meet the specified Worst
Aspect Ratio.

Worst Aspect Ratio

a limiting factor for mesh coarsening (any elements below this quality will be excluded
from the next iteration of coarsening).

Fix Non-manifold

if enabled, the mesher will do additional work to try to fix non-manifold elements. These are
only a possible problem, depending on your model and solver. See here for a description of
non-manifold elements (p. 634). It is strongly recommended to leave this option on and that
you check for non-manifold elements after the mesh is computed.

Note:

You may still have non-manifold elements for several reasons. They may be
representative of the true geometry, and acceptable to the solver and therefore
not a problem. It is also possible that the meshing parameters may be too
coarse to cope with the geometry; in which case you could reduce the mesh
size and/or apply thin cuts and/or reduce the edge criterion to allow for sub-
division within the thin space. If only a few non-manifold elements exist, you
can repair them with mesh editing. Try splitting nodes or delete the non-
manifold elements and remesh locally.

Close Gaps

is used to close gaps in the surface mesh between different materials. If enabled, triangles
will be created to fill these gaps.

Fix Holes

if disabled, the mesher will not perform extra steps to try to close holes to form a watertight
volume. If enabled, the mesher will perform extra steps to close holes with a clear solution.
If the mesher detects leakage with an unclear solution, it will interactively prompt you for
the solution.

Use active local coordinate system

allows you to orient the Octree mesh along the active local coordinate system instead of
along the global coordinate system. If the LCS is not Cartesian, the equivalent Cartesian LCS
is used.
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Figure 257: Orienting Octree Tetra Mesh Along LCS

Note:

This option is helpful when converting oriented Octree tetra mesh to oriented
hexa hybrid mesh (Convert Tetra to Hexa method – 12 tetra to 1 hexa).

Figure 258: LCS Oriented Octree Tetra Mesh Converted to LCS Oriented
Hexa Mesh

In such cases, make sure the Use active coordinate system option is enabled for
the 12 tetra to 1 hexa method in the Convert Tetra to Hexa DEZ (see the Convert
Tetra to Hexa (p. 659) section).

Quick (Delaunay)

The Quick (Delaunay) option will generate a tetra mesh using a bottom-up meshing approach
(Delaunay Tetra algorithm). This algorithm requires an existing, closed surface mesh. If this has
not yet been created, it will automatically create the surface mesh from the geometry as defined
by the Global Mesh Setup settings (or the Surface Mesh option). The volume mesh will then be
generated from this surface mesh. You can also run this in two steps by creating/importing a
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surface mesh first and then running this mesher. If a surface mesh exists, you can also specify
the Input as Existing Mesh when Compute Mesh is applied.

Note:

A closed surface mesh is needed to contain the volume mesh. You can run a mesh
check for single edges, overlapping elements or duplicate elements ( Edit Mesh >
Check Mesh  (p. 569)). Single edges may appear on the edges of internal baffles, but
should not be found on the outer perimeter of the model or the Delaunay fill will fail.

Delaunay Scheme

allows you to select the Delaunay scheme to be used.

Standard

uses the standard Delaunay scheme with a skewness-based refinement.

TGlib

uses the latest Fluent Meshing Delaunay volume grid generation algorithm that utilizes
a more gradual transition rate near the surface, and a faster transition rate towards the
interior. Like the standard Delaunay scheme, it uses a skewness-based refinement.

Use AF

uses the latest Fluent Meshing Advancing Front Delaunay algorithm which has
smoother transitions than the pure Delaunay algorithm.

Note:

The TGlib options will be ignored when the Create Hexa-Core option is enabled
for the Quick (Delaunay) method.

Memory scaling factor

The initial memory requirements will be multiplied by this factor. If no value is supplied, the
default is taken as 1. The initial memory requirement is calculated from the surface mesh (or
from volume mesh if it is supplied). If the initial memory calculation falls short, it will double
it and try again. It will restart 3 times before failing due to insufficient memory allocation.

Spacing Scaling Factor

The rate at which the tetra grow from the surface mesh. It is similar, but not mathematically
identical, to the expansion factor used by other algorithms. This value directly affects the
number of tetra elements generated.

Fill holes in volume mesh

This is for use on an existing tetra mesh with internal voids (cavity re-meshing). This will fill
the voids without regenerating the full tetra domain. You could delete the tetra mesh in a
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region, insert a new surface mesh component and then cavity re-mesh to the existing tetra
mesh. Alternatively, this could be used simply to remesh a region of poor tetra mesh.

Mesh internal domains

If this option is enabled, the Delaunay tetra mesher will also attempt to fill internal volume
regions. With this option disabled, only those volumes adjacent to external shell elements
will be meshed.

Flood fill after completion

This option only pertains to models with multiple material points. If this option is enabled,
the volume mesh will be assigned to different volume parts based on material point contain-
ment.

Verbose output

When enabled, the mesher outputs more detailed messages to help in debugging any potential
problem. In general, you should not need to have this option enabled, but it may help to
enable this for debugging.

Smooth mesh

When enabled, the mesh is smoothed after finishing subdivision down to the specified mesh
sizes.

Iterations

Specifies the number of iterations to be performed for the smoothing to match the
supplied Min quality.

Min Quality

All elements with quality less than the specified value will be smoothed. The default
is 0.4.

Smooth (Advancing Front)

The Smooth (Advancing Front) option will generate a tetra mesh using a bottom-up meshing
approach using the Advancing Front Tetra mesher. The surface mesh will be created as defined
by the Global Mesh Setup settings (or Surface Mesh option). The volume mesh will then be
generated from this surface mesh. If a surface mesh exists, you can also specify the Input as Ex-
isting Mesh when Compute Mesh is applied.

This meshing method results in a more gradual change in element size. The initial surface mesh
should be of fairly high quality.

Note:

The surface mesh should be one enclosed volume with no single edges, multiple
edges, non-manifold vertices, overlapping elements or duplicate elements. Sudden
changes in element size, either adjacent to one another or across a narrow volume
gap, can cause quality issues or even failure.
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The surface mesh must be either tri or quad elements for the Advancing Front mesh
method.

Expansion Factor

The ratio at which to grow the tetra from the surface mesh. The default is 1. This value directly
affects the number of tetra elements generated.

Do Proximity Checking

This option will check the proximity between nodes to prevent clustering or stretching so
that small gaps are filled properly. Enabling this option will result in a longer meshing time.

Flood fill after completion

This option only pertains to models with multiple material points. If this option is enabled,
the created mesh will be assigned to their different volume parts.

Verbose output

When enabled, this option writes more messages to help in debugging any potential problem.
In general you should not need to have this option enabled, but if the mesher has a problem
meshing, it may help to enable this for debugging.

Fluent Meshing

The Fluent Meshing option will allow you to create a tetrahedral volume mesh from the surface
mesh, on a part-by-part basis, using Ansys Fluent in batch mode. Optional prism layers that use
many of the parameters as described in Prism Meshing Parameters (p. 345) may be created. The
option of pre inflation or post inflation prism creation, as well as optional hexahedral elements
in the core, is done at the time the volume mesh is computed. See Tetra/Mixed Mesh Type (p. 399).

In addition, the following volume fill options may be specified:

Expansion Factor

The ratio at which to grow the tetra elements from the final inflation layer. The default
is 1.2. Reducing this value leads to an increase in the number of tetra elements generated.

Flood fill after completion

If this option is enabled, the created mesh will be assigned to different volume parts
based on flood filling from material points. This option only pertains to models with
multiple material points.

Verbose output

When enabled, this option writes more messages to help in debugging any potential
problem. In general you should not need to have this option enabled, but if the mesher
has a problem, it may help to enable this for debugging.
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Hexa-Dominant

The Hexa-Dominant option will generate a hexa-dominant mesh using a bottom-up meshing ap-
proach. The Hexa-Dominant mesher starts with surface quad dominant mesh and uses an Advancing
Front scheme to fill as much of the volume as possible. For simple volumes, it can fill it completely.
For more complicated volumes, it usually fills several layers in from the surface with hexa elements
and then fills the middle with tetras and pyramids. Then a diagnostic is run, and if those central
elements are poor, the inner volume will be meshed again with the Delaunay mesher. The surface
mesh will be created with the parameters defined under Global Mesh Setup (p. 307) or Surface Mesh
Setup (p. 376). The volume mesh will then be generated from this surface mesh. If a surface mesh
exists, you can also choose to specify Existing Mesh for the Input.

Remesh Center

deletes tetra elements from the center region of the mesh, and remeshes it using the Delaunay
mesher. This will result in better quality mesh at the center region.

Cartesian

The Cartesian option will generate a Cartesian mesh using a top-down meshing approach. This
creates pure Cartesian and unstructured Cartesian meshes with H-Grid refinement. The mesher
works by continuously refining the initial grid in a binary fashion in each dimension, and eliminating
the non-volume cells, up to the specified maximum refinement. The Cartesian mesher does not
require an existing surface mesh and will ignore meshing parameters defined to control local surfaces.

The following mesh methods are available.

Body-Fitted

Hexa-Core

Body-Fitted

The Body-Fitted option creates unstructured hexa mesh of uniform size based on Cartesian mesh
and fits it to the geometry. This works for both CAD and STL geometries. The mesher can handle
"dirty" geometries as long as the cell size is larger than the gap size.

Note:

The cell size should be smaller than the thickness of the model.

Projection Factor

controls the tightness of the body-fitted Cartesian mesh to the geometry. Values can range
from 0 to 1.0, where a value of 0 indicates Cartesian mesh totally free from the geometry,
and a value of 1.0 indicates mesh that is strictly on the geometry.

• If the Projection Factor is set to 0, the resulting Cartesian mesh will have high quality hexa
elements that transition via stairstepping (see Figure 259: Body-Fitted Cartesian Mesh With
Projection Factor = 0 (p. 339)).
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Figure 259: Body-Fitted Cartesian Mesh With Projection Factor = 0

• If the Projection Factor is set to 1, every node will be on the geometry surface (see Fig-
ure 260: Body-Fitted Cartesian Mesh With Projection Factor = 1 (p. 339)). However, there
may be hexa elements where two faces are planar.

Figure 260: Body-Fitted Cartesian Mesh With Projection Factor = 1

• A Projection Factor of 0.9 will result in a mesh that deviates slightly from the surface so
that the element quality is not as bad (see Figure 261: Body-Fitted Cartesian Mesh With
Projection Factor = 0.9 (p. 340)). The mesh is wavy as a result of this trade-off between
capturing the geometry and obtaining a reasonable quality mesh.
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Figure 261: Body-Fitted Cartesian Mesh With Projection Factor = 0.9

Split Degenerate

splits boundary quad and hexa elements with flat corners (triangular shaped), and propagates
this split to produce higher quality elements. This option does not introduce pyramids or
tetra elements.

Note:

The shorter edge length introduced by this option may pose a problem for
some users such as reducing the time step for explicit solvers. Also, the quality
improvement is usually not as good as the improvement produced by the
Create Pyramids option. You should try different options to determine which
produces the best result for a particular topology and for a particular solv-
er/physics.

Figure 262: Body-Fitted Cartesian Mesh with Boundary Hexa Elements (p. 340) shows the BFC
mesh having boundary hexa elements with flat corners.

Figure 262: Body-Fitted Cartesian Mesh with Boundary Hexa Elements
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Figure 263: Split Degenerate Option (p. 341) shows the results of using the Split Degenerate
option. The boundary hexa element has been split and the split is propagated through the
neighboring elements.

Figure 263: Split Degenerate Option

For this model, the use of an inflation layer proves to provide the best quality, as shown in
Figure 264: BFC Mesh with Inflation Layer (p. 341).

Figure 264: BFC Mesh with Inflation Layer

Create Pyramids

remeshes bad quality hexa elements (with determinant quality less than 0.05) using a Delaunay
algorithm. This effectively replaces the poorest hexa elements with higher quality tetra and
pyramid elements.

Refinement Type

Uniform

creates hexa elements of uniform size.
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2-to-1

creates hexa elements of varying size with 2-to-1 size transition. This will introduce
hanging nodes in the mesh.

3-to-1

creates hexa elements of varying size with 3-to-1 size transition. This mesh can be
made conformal using the Edit Mesh > Resolve refinements option for limited
configurations.

Aspect Ratio

allows you to control the aspect ratio of the otherwise uniform Cartesian mesh. This can be
used to fill the volume more efficiently in cases where there is a strong gradient aligned with
the coordinate system. The default setting is 1 1 1. Changing the aspect ratio allows you
to stretch the Cartesian grid. For example, setting the aspect ratio to 1 2 0.75 will result
in a Cartesian mesh that is twice as long in the Y direction as the X direction and 0.75 times
the size in the Z direction. This is applied to the entire model.

You can also create a Cartesian file with varying aspect ratio. Use the Hexa blocking tools to
create a block with splits and edge parameters to control the distribution. Then, use the File
> Blocking > Write Cartesian Grid option to convert the blocking to a Cartesian grid file.
You can then refer to this file when computing the grid (see the Cartesian file (p. 407) option
for details).

Figure 265: Hexa Mesh With Varying Aspect Ratio (p. 342) shows the Cartesian mesh for a
Femur, with the aspect ratio varying along the shaft.

Figure 265: Hexa Mesh With Varying Aspect Ratio

Project Inflated Faces

allows full projection to the surface for inflated faces rather than limiting the projection with
the projection factor.

Outer Bounding Box

allows you to specify the outer mesh region for external flow meshes by setting the min-max
coordinates of the flow region. This can be used instead of explicitly creating the tunnel
geometry.
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min-max Coordinates

specify the explicit coordinates or click the selection icon to pick diagonal min and max co-
ordinates to specify the outer bounding box size.

Use active local coordinate system

allows you to orient the mesh along the active local coordinate system instead of along the
global coordinate system. LCS are translated to equivalent Cartesian coordinates.

Boundary Layers

The Body-Fitted Cartesian mesher can create a layer of hexa elements parallel to the wall. These
are necessary for properly capturing curvature and can be subdivided to get boundary layers.
For some geometry parts, such as inlets, outlets and "flat" sides, you may not want to have this
offset. However, you may want to apply inflation to flat parts if they are not in the Cartesian
planes (X Y Z) to prevent stair-stepping. To determine if a part will have a single offset layer (with
uniform aspect ratio), enable prism for the appropriate parts in the Part Mesh Setup (p. 371) dialog.
For Ansys ICEM CFD, standard prism controls do not apply for Body-Fitted Cartesian meshing.
Instead, if the prism option is enabled for a specific part, and then meshed using the Cartesian
Body-Fitted method, the boundary layer will be offset. The boundary layer is determined on a
part by part basis, so parts must be created and surfaces assigned appropriately.

Figure 266: Example of Boundary Layers in Body-Fitted Cartesian Mesh

In Figure 266: Example of Boundary Layers in Body-Fitted Cartesian Mesh (p. 343), the prism option
is enabled for the SURFS part containing the walls of the corner pipe but disabled for the INLET
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and OUTLET parts. When the Body-Fitted Cartesian mesh is computed, the boundary layer is
grown along the SURFS part to better capture curvature, but terminates at the INLET and OUTLET.
This single boundary layer can then be split to increase near wall resolution if needed.

Define Thin Cuts

The Define thin cuts option allows you to prevent elements stretching across a gap. You can
define the thin cut pair using the Define thin cuts button in the Tetra/Mixed Meshing parameters
for the Robust (Octree) mesh method (see the Define thin cuts (p. 330) option).

Note:

The thin cuts option works best for regions of the mesh which will be cut away, rather
than thin solid regions where the mesh is to be retained.

Hexa-Core

The Hexa-Core option will generate a hexa-core mesh using a bottom-up meshing approach. It
will retain the tri surface or prism mesh, delete the existing tetra mesh, and remesh the volume
interior with Cartesian meshing. The tetra elements will be mapped to the tri or prism faces with
the Delaunay algorithm.

Note:

Hexa-Core is implemented as part of Tetra meshing. Under Compute Mesh >
Volume Mesh, the Create Hexa-Core option can be selected when using
Tetra/Mixed Mesh Type, and Robust (Octree) or Quick (Delaunay) Mesh Methods.

Figure 267: Example of Hexa-Core Mesh

Fill holes in volume mesh

will remesh only the missing tetra portions. This option is required only for multiple tetra
fill volume regions. It is disabled by default, as it is not necessary for single volume fill
(internal meshes).

Refinement Type

Uniform

creates hexa elements of uniform size.
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2-to-1

creates hexa elements of varying size with 2-to-1 size transition. This will intro-
duce hanging nodes in the mesh.

3-to-1

creates hexa elements of varying size with 3-to-1 size transition. This mesh can
be made conformal using the Edit Mesh > Resolve refinements option for
limited configurations.

Outer Bounding Box

allows you to specify outer mesh region for external flow meshes.

min-max Coordinates

specify the explicit coordinates or click the selection icon to pick diagonal min and max
coordinates to specify the outer bounding box size.

Use active local coordinate system

allows you to orient the mesh along the active local coordinate system instead of along
the global coordinate system.

Prism Meshing Parameters

The Prism Meshing Parameters includes a detailed description of the settings and functions
that affect the prism meshing process.

You can use the ICEM CFD post inflation process to create prisms from existing volume or surface
mesh, from any of the Tetra/Mixed volume mesh methods. Alternatively, using the Fluent Meshing
method gives the option to create pre inflation prisms from an existing geometry, with or without
surface mesh or volume mesh.

Note:

To define a direction for pre-inflation prism growth into a volume containing more
than one region of the same material due to an internal wall, an initial volume mesh
(for example, tetrahedral by octree method) is needed.

Global Prism Settings

Prism Element Part Controls

Smoothing Options

Additional pre inflation (Fluent Meshing) settings

Advanced Prism Meshing Parameters

See the Prism Mesh section in the User's Guide for more general information on prism meshing.
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Global Prism Settings

Growth Law

determines the height of the layers given the initial height and height ratio.

• Linear

The prism height of a particular layer is calculated by , where
h = initial height, r = height ratio, and n = layer number.

The total height at layer n is .

• Exponential

The prism height of a particular layer is calculated by , where h = initial height,
r = height ratio, and n = layer number.

The total height at layer n is .

• WB-Exponential

This is the exponential growth law as defined in Ansys Workbench. The prism height of

a particular layer is calculated by , where h = initial height, r = height
ratio, and n = layer number.

Figure 268: Prism Growth Law (p. 346) shows a box with edge length = 1, h = 0.05, r = 1.5, and
n = 5, with different growth laws applied.

Figure 268: Prism Growth Law

Note:

These post inflation growth laws correspond to equivalent Fluent Meshing pre infla-
tion methods as follows.

Table 6: Growth Law Name Equivalents

Pre-inflation Growth Methodpost inflation growth law

linearLinear
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geometricExponential

exponentialWB-Exponential

Initial height

is the height of the first layer of elements.

Note:

If the initial height is set to 0, it will be automatically determined by the local triangle
size, where the height of the last layer will be the minimum attached triangle edge
length times the Prism height limit factor.

Height ratio

is the expansion ratio from the first layer of elements on the surface. This ratio will be multiplied
by the element height of the previous layer to define the height of the next layer.

Number of layers

is the number of layers to be grown from the surface or curve.

Total height

is the total height of all the prism layers.

Note:

If neither the initial height nor the total height is set, the prism layer heights will be
"floating" in order to produce a smooth volume transition to the tetrahedra (see
Figure 269: All Prism Heights Floating (p. 348)). In order to smooth the volume trans-
ition, the last prism layer height must not exceed a certain height-to-base ratio. This
value is 0.5 by default, but can be adjusted using the Prism height limit factor.

The Prism height limit factor combined with the shortest edge of the base triangle
for each column are used to calculate the last prism height for each column. This is
combined with the growth ratio, number of layers and the growth law to back cal-
culate the initial height required for each column in order to produce a smooth
growth ratio. If you would rather have a fixed initial height, you can redistribute the
prism layers later.

You can use a combination of floating prism layer height and prescribed initial/total
height on selected entities/parts (see Figure 270: Combination of Prescribed and
Floating Prism Heights (p. 348)). In this case, the initial height has been set on only
the valve part. The prism heights on the valve part are now calculated using the
specified initial height along with the growth law, ratio, and number of layers. All
other prism heights remain floating.
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Figure 269: All Prism Heights Floating

Figure 270: Combination of Prescribed and Floating Prism Heights

Compute params

will compute the missing parameter based on the given parameters if one of the parameter
values is blank.

Fix marching direction

if enabled, prisms are grown in a direction normal to the base triangles on the surface. However,
the quality of mesh is still controlled by Min prism quality.

When Fix marching direction is enabled, directional smoothing applies only to the first layer.
The initial direction is evaluated from the face normals attached to the vertex to be extruded.
This is done by interpolation. For further layers, the direction is "fixed" and directional
smoothing is disabled.
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Figure 271: Use of the Fix Marching Direction Option

Fix Marching Direction Disabled

Fix Marching Direction Enabled

In the first example in Figure 271: Use of the Fix Marching Direction Option (p. 349), Fix Marching
Direction is disabled and the prism direction is controlled by the directional smoothing steps
and the Ortho weight value. In the second example, Fix Marching Direction is enabled. The
prisms grow normal to the surface, except in cases of extremely poor quality first layer elements.

In the next set of examples in Figure 272: Fix Marching Direction Option (p. 349), prisms were
grown largely orthogonal to the base triangles up to the 3rd layer, beyond which the Min prism
quality caused a change in direction. This method may be more appropriate when growing
prism in the VORFN region.

Figure 272: Fix Marching Direction Option

Fix Marching Direction DisabledFix Marching Direction Enabled

Note:

If you do not use any directional smoothing, the prism marching direction is already
fixed.
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Min prism quality

locally prevents or adjusts prism growth in problem areas in order to maintain quality. Complex
geometry combined with aggressive prism parameters may result in poor quality elements. If
the quality does not meet the minimum value, the prism elements are re-smoothed directionally,
or pyramids are used to replace some prism elements. Setting a value that is too high will result
in local prism interruptions and more pyramids.

Table 7: Effect of Min Prism Quality and Initial Height (p. 350) demonstrates the effect of Min
prism quality on prism mesh of two different initial heights.

Table 7: Effect of Min Prism Quality and Initial Height

Initial Height = 0.15, Growth Ratio = 1.2, Number of Layers =
5

Actual Prism QualityMin prism quality value

0.0030.0

0.0650.01

0.10.075

0.130.1

Initial Height = 0.1, Growth Ratio = 1.2, Number of Layers =
5

Actual Prism QualityMin prism quality value

0.1460.0

0.1460.01

0.1460.075

0.1460.1

In contrast, for the mesh with an Initial Height of 0.1, the prism quality is already higher than
the Min prism quality value.

Fillet ratio

tries to create a fillet proportional to the total height of the prism. When prisms are grown in
the corner zone of a tet mesh, it is possible to control the prism layer smoothness along a fillet
using this parameter.

Note:

For meshing corners with angles less than 60 degrees, there may not be space for
a fillet.
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Figure 273: Examples of Fillet Ratio

Fillet Ratio = 0.0 means no fillets.

Fillet Ratio = 0.5 limits the radius of the inner
prism fillet to 0.5 times the height of the total
prism thickness.

Fillet Ratio = 1.0 allows the radius of the inner
prism fillet to equal the prism layer thickness.

Increasing the Fillet ratio typically improves the internal angles of the prisms and results in
more full prism layers in tight geometries. However, the increased prism height reduces the
aspect ratio quality measure and may give bad angles in the triangle prism cap.

Note:

For Fluent Meshing pre inflation prism growth, the parameter offset-weight is
equal to fillet ratio.

Max prism angle

controls prism layer growth around angles and when adhering to adjacent surfaces. This is the
maximum internal angle between the base and the extruded direction. This parameter can
range from 140 to 180 degrees. If extruding from one surface and not its neighbor, and the
angle between the two surfaces is less than the specified value, the prisms will adhere to the
adjacent wall.

For instance 135 is the theoretical minimum needed to go around a 90 degree corner (90+45
meeting up with the 90+45 coming from the other surface); to account for tolerances, the
minimum setting is 140 degrees. A max prism angle of 180 allows the mesh to fold back on to
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its self, like at the trailing edge of a wing or a cusp between pipes in a manifold (90+90 meeting
up with the 90+90 from the other side).

Figure 274: Max Prism Angle – Example 1

Max Prism Angle = 140 degrees

Here, the angle between the planes is
158.2 (21.8) degrees. Since the Max prism
angle is less than the angle between the
walls, the prism layers are capped with
pyramids.

Max Prism Angle = 180 degrees

Here, the Max prism angle exceeds the
separation angle between the surfaces, so
the prism remains attached to the adjacent
surface.

Figure 275: Max Prism Angle – Example 2

Max Prism Angle = 140 degrees

Here, the Max prism angle is set to 140, which is
not enough to meet the prisms from the under
side of the cusp.

Max Prism Angle = 180 degrees

Here, the Max prism angle is set to 180 and the
Min prism quality is set to 0.0001 so that the
prisms from the top surface can meet the prisms
from the lower surface. The prisms where the two
surfaces meet have large internal angles and poor
quality.

Note:

Pyramids are usually not favorable. However in "cusp" situations such that exist on
the trailing edge of a wing or within a manifold where two pipes meet at a slight
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angle, it is better to have the prism layer terminate with pyramids than try to wrap
around the cusp. It is recommended that Max prism angle be set to 160 degrees,
particularly for applications with cusp geometry.

Note:

For Fluent Meshing pre inflation prism growth, the parameter project-adjacent-
angle is derived from this parameter using:

project-adjacent-angle = max prism angle – 90 deg.

Max height over base

When the prism aspect ratio (ratio of height over base of the base triangle) reaches this value,
the prism stops growing.

The examples in Figure 276: Max Height Over Base (p. 353) illustrate the use of this option for a
6 layer prism mesh.

Figure 276: Max Height Over Base

No Value Set for Max Height Over Base

In this case, the prisms with a smaller base have
the same height as the prisms with wider
bases. The resulting tall prisms have much
greater volume than their adjacent tetra
elements and are not considered ideal.

Max Height Over Base = 1.0

If the Max height over base is set to 1.0, then
the prism height can not exceed the average
base length. Prisms that would have exceeded
this are not grown. Other prisms may not grow
due to related quality issues.

Note:

For the Fluent Meshing pre
inflation method, this is the
default value.
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Max Height Over Base = 0.5

In this case, even the initial height would
exceed this ratio for the elements in the corner,
so no prisms are grown there. Generally, the
initial height at the wall would be less than
half the smallest element size.

Note:

For Fluent Meshing pre inflation prism growth, the parameter min-aspect-ratio
is derived from this parameter using:

min-aspect-ratio = 1.0 / max height over base.

Prism height limit factor

restricts the prism aspect ratio (height of each prism element over base size for each column)
to the specified value by limiting the prism growth ratio, but maintains the number of layers.

If the initial height is set globally or on a part or entity, and the growing prism layers reach the
specified aspect ratio, the growth ratio is reduced so that the height for additional layers will
remain constant at that height limit factor (aspect ratio).

If the initial height is not set globally and not set on the part or entity, it will "float" (see the
Total height section (p. 347)) to improve the transition to the tetrahedra. You can then use the
prism height limit factor to control the transition by adjusting the maximum height-over-base
ratio of the prisms. This will be used to calculate the initial heights on a column by column
basis and so that a single growth ratio will be used and produce a smoother transition to the
maximum prism height for each column. If the initial height is left to "float" and the prism
height limit is not set, a value of 0.5 will be used to obtain smooth volume transition from the
prisms to the attached tetra.

Figure 277: Prism Height Limit Factor

No Value Set for Prism Height Limit Factor
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Prism Height Limit Factor = 0.5

Prism Height Limit Factor = 1.0

Ratio multiplier

This is a global parameter that multiplies the Height Ratio for each successive layer when using
the Exponential Growth Law, creating hyper-exponential growth. For example, if the Height
Ratio is set to 1.2, and the Ratio multiplier set to 1.1, then the ratio between the first two
layers will be 1.2, the ratio between the second and third layer will be (1.2 * 1.1), the ratio
between the third and fourth layer will be (1.2 * 1.1 * 1.1), etc. The default value is 1.

The prism height of a particular layer is calculated by , where h = initial height,
r = height ratio, n = layer number, and m r  = ratio multiplier.

The ratio at any layer is calculated using , and will be limited by the Ratio max option
under Advanced Prism Meshing (p. 361).

Prism Element Part Controls

These settings are required when growing prism mesh without an existing tetra mesh. A part name
is required to assign the prism elements correctly. This can be done by typing a new name or se-
lecting from the list of parts.

You may assign a different volume part to the prism, or add a side or top part in order to better
differentiate it from the tetra region. In this case, be sure to add the prisms to the main volume
part before generating output to the solver so it will be seen as one volume.

You may want to grow prisms away from the flow domain (towards the outside region). In this
case, the top triangles (Top Part), as well as side quads (Side Part) must also be assigned to named
parts.

New volume part

allows you to specify a new part for prism elements, either from an existing surface or volume
mesh.
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Side part

allows you to specify a part for the quad faces on the side boundaries of the prism elements.

Top part

allows you to specify a part for the tri faces capping off the top of the last prism layer.

Extrude into orphan region

allows you to extrude prisms away from the existing volume, instead of into it.

In Figure 278: Prisms Extruded into the Orphan Region (p. 356), prism mesh was extruded from the
pipe mesh region. The part STEEL_SIDE represents the metal's thickness.

Figure 278: Prisms Extruded into the Orphan Region

Smoothing Options

Number of surface smoothing steps

is the number of iterations that the surface mesh is smoothed before prism layer generation.
The quality of the final prism mesh mostly depends on triangle quality. The recommended
minimum quality to start is 0.3.

Note:

Set smoothing steps to 0 while extruding only one layer. Otherwise the default value
is usually adequate.
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Triangle quality type

select a quality criterion for improving the triangular surface mesh by smoothing. This operation
is performed before prism growth begins and after the final prism layer is created.

The available quality type options include:

inscribed_area

normalized ratio between the area of the inscribed circle and the area of the triangle
(default).

inscribed_ratio

(2 * radius of the maximum inscribed circle) / (radius of the minimum circumscribed
circle). Maximum value = 1.0 for an equilateral triangle.

height_over_base

normalized minimum height over base of the triangle.

Laplace

uses inscribed_area for triangle quality and adds directional smoothing. The Ortho
weight parameter determines whether to emphasize prism layer orthogonality or tri-
angle quality.

Note:

Laplace smoothing is typically best for final prism quality.

skewness

normalized triangle skewness.

min_angle

normalized minimum angle in a triangle.

max_angle

normalized maximum angle in a triangle.

Number of volume smoothing steps

is the specified number of smoothing steps on the existing Tetra mesh before prism layer
generation. A smooth Tetra mesh is essential for a high quality prism mesh. Smooth the Tetra
mesh and perform all diagnostics before running this smoother, in which case you may reduce
the number of iterations.

Note:

The smoother is much more effective before prism mesh is grown.
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However, if Fluent Meshing mesh method is chosen, any volume smoothing
steps will occur post inflation and the cell skewness threshold for smoothing is
based on the number of steps. If steps > 5, then skew threshold is 0.9, otherwise
it is 0.95.

Note:

If extruding only one layer, set smoothing steps to 0. Otherwise the default
value is usually adequate.

Max directional smoothing steps

is the number of smoothing steps for the face normal vectors before the next prism layer is
created. The default value is appropriate for most problems.

First layer smoothing steps

smooths the first layer with the given number of steps.

Ortho weight

determines the priority for the directional smoothing steps. You may choose a number between
0 and 1, where 0 emphasizes triangle quality and 1 emphasizes prism orthogonality. This value
is applicable only if the Laplace smoothing option is selected.

Figure 279: Ortho Weight = 0.1

In the example in Figure 279: Ortho Weight
= 0.1 (p. 358), the Ortho weight is set to
0.1. The smoother focuses on improving
the quality of the triangle caps, based on
Triangle quality type, while allowing the
grid lines to bend. This typically results in
improved tetra quality.
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Figure 280: Ortho Weight = 0.5

Figure 280: Ortho Weight = 0.5 (p. 359)
illustrates the same mesh with Ortho
weight = 0.5.

Figure 281: Ortho Weight = 0.9

Figure 281: Ortho Weight = 0.9 (p. 359)
illustrates the mesh with Ortho weight =
0.9. The smoother attempts to maintain
orthogonality with the wall. Bending is
allowed when tetra quality doesn't meet
a minimum threshold.

Figure 282: No Directional
Smoothing or Ortho Weight Applied

Ortho weight is applied only during
directional smoothing. If no directional
smoothing is applied, the mesh is grown
orthogonal to the wall in a fixed marching
direction and poor elements are simply
removed, as shown in Figure 282: No
Directional Smoothing or Ortho Weight
Applied (p. 359).

Additional pre inflation (Fluent Meshing) settings

These parameters are specific to the pre inflation process.
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Fluent Meshing Offset Method

In addition to their described function, several global prism meshing parameters are used to
determine the Fluent Meshing Offset Method.

If Prism height limit factor is unspecified, the Fluent Meshing Offset Method will be uniform
with First Height determined as follows:

• If Initial height is specified, that value is used for Fluent Meshing First Height.

• If Initial height is unspecified, the First Height value is calculated using Total height,
Height ratio (r) and Number of Layers (n).

First Height = Total height / (1 + r + r^2 + r^3 + ... + r^(n-1))

If Initial height and Prism height limit factor are both specified, the Fluent Meshing Offset
Method will be last ratio with the following parameters:

• Fluent Meshing First Height = Initial height.

• Fluent Meshing Last Percent = 1 / Prism height limit factor.

However, if Max height over base is set, then the Fluent Meshing Last Percent parameter
will be limited to a maximum of 1 / Max height over base.

If Prism height limit factor is specified but no Initial height or Total height, the Fluent
Meshing Offset Method will be aspect ratio with the following parameters:

• Smoothing Options are disabled.

• Fluent Meshing Last Aspect Ratio = 1 / Prism height limit factor.

• Fluent Meshing First Aspect Ratio = Last Aspect Ratio * (r^(n-1)), where r = Height ratio and
n = Number of layers.

Fix First Layer

This option allows you to keep the specified first layer height and scale the heights for the re-
maining layers in situations where prism layers may intersect.

Number of Orthogonal Layers

Used to specify the number of inflation layers which are orthogonal to the surface mesh.

Gap Factor

Used to control the thickness of the tetra layer in regions of proximity. Increasing the Gap
Factor will force a wider gap for a more robust tetra volume mesh, but may result in lower
quality prisms (high aspect ratio). Decreasing the Gap Factor allows the inflation layers to come
closer together which may improve prism quality but have negatively impact robustness. The
default value is 0.5, which means that the minimum gap is one half the maximum base edge
length at the node considered.
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Enhance Normal Computation

If enabled, the mesher will attempt to smooth the current prism cap surface by aligning adjacent
face normals to within 0.1 degree. The default is disabled.

Enhance Offset Computation

If enabled, the mesher will attempt to smooth the current prism cap surface by adjusting the
layer offset to within 0.1 %. The default is disabled.

Smoothing Level

Used to choose the amount of smoothing after each prism layer is generated.

Note:

If Smoothing Level is set to High, then cell-quality-improve is set to true
which involves smoothing of normals in the current layer and perturbation smoothing
to improve cell quality in the lower layer.

Max Allowable Cap Skewness

Sets the quality criterion for triangles in the prism cap surface after smoothing. If this parameter
is not achievable, prism meshing will stop. The default value is 0.98.

Max Allowable Cell Skewness

Sets the cell quality criterion for the prism layers after smoothing. If this parameter is not
achievable, prism meshing will stop. The default value is 0.90.

Min Last Layer Aspect Ratio

Used to override the calculated, or default, value.

The default value is 2.0, if both Max height over base and Prism height limit factor are un-
specified.

Advanced Prism Meshing Parameters

Auto Reduction

In some cases, the prism mesher is unable to create the specified number and size of layers
due to geometry constraints. If this option is enabled, the prism mesher will automatically reduce
the layer size to meet the required number of layers without creating pyramids or other problems
in the mesh.

This is useful for solvers that require complete prism layers with no pyramids. In Figure 283: Ex-
ample of Auto Reduction (p. 362), the prism parameters were set for 6 layers. Without Auto
Reduction, there will be stair stepping down to 4 layers in the gap. With Auto Reduction en-
abled, the mesher created 6 layers as specified by automatically reducing the layer size to fit
and redistributing the prism layer as appropriate to improve quality.

361
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Global Mesh Setup



Figure 283: Example of Auto Reduction

Auto Reduction enabledAuto Reduction disabled

Note:

For Fluent Meshing pre inflation prism growth, if Auto Reduction is set, layer com-
pression is used to avoid invalid mesh in areas of proximity or collision. In these
areas, the defined heights and ratios are reduced to ensure the same number of
layers throughout the entire prism mesh.

Blayer 2d

This option is used to create a boundary layer in a 2D mesh using prism meshing. This surface
mesh can be used with a 2D solver or swept to create the volume mesh.

Note:

Using Prism BLayer 2D is more advanced than applying an Offset with the Patch In-
dependent meshers. Offset is controlled by setting the Height, Ratio and Number of
layers parameters on the curves. 2D prism controls are the same as regular prism
controls, except you must select the surface part as well as the curve part. 2D Prism
can also be applied on an existing shell mesh in the same way that 3D prism is applied
to an existing tetra mesh.

Note:

Since 2D prisms are really just quads, the split prism and redistribute prism commands
do not work.

2D prism works with quad or tri mesh and can be controlled with the 3D prism controls to adjust
number of layers, initial height, orthogonality, etc.
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Figure 284: BLayer 2D Applied to a 2D Surface with Quad Mesh

Figure 284: BLayer 2D Applied to a 2D Surface with Quad Mesh (p. 363) shows a 2D surface with
quad mesh, with prism applied to the top and left curves.

Figure 285: BLayer 2D Applied to a 2D Surface with Tri Mesh

Figure 285: BLayer 2D Applied to a 2D Surface with Tri Mesh (p. 363) shows a 2D surface with
tri mesh, with prism applied to the top and left curves. Note that the initial height is "floating"
in this case.
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Figure 286: BLayer 2D and Additional Prism Parameters Applied to a 2D Surface with Tri
Mesh

Figure 286: BLayer 2D and Additional Prism Parameters Applied to a 2D Surface with Tri
Mesh (p. 364) shows the same 2D surface with tri mesh, with prism initial height set to 1, ortho
weight set to 0.5, and number of layers set to 7.

Delete Base Triangles

If enabled, the triangles at the interface with the existing tetra elements will be deleted when
growing into ORFN regions.

Delete Standalone

If enabled, triangles that are not attached to anything will be deleted.

Do Checks

If enabled, additional checks are done on the mesh. These include checking interfaces between
materials and checking for pockets within the mesh. Results are reported in the message window
and the prism log file.

Do Not Allow Sticking

If enabled, "pointy" tetrahedra are not allowed to be stuck between layers.

Incremental Write

If enabled, after each layer is generated, the prism data will be written into a separate mesh
file. The files will be located in your working directory with default file names prism_layer#.uns,
and with # incremented for each layer. This can help to isolate and correct problems at a spe-
cific layer in the prism mesh.

Intermediate Write

If enabled, the prism file will be written out after each layer is created. This is a fail safe measure.
If the Prism mesher is not able to complete all the layers or is interrupted for some reason, you
can load the saved mesh file and continue. The mesh file will be located in your working directory
and named "prism.uns".
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Interpolate Heights

if set to On, determines the prism layer heights of prism nodes without given heights by con-
structing new data points from prism nodes with fixed heights. If there are no fixed heights,
the size of the triangle is used. By default, Interpolate Heights is off.

Refine Prism Boundary

If enabled, this allows the Prism mesher to refine the boundary between the prisms and tetras,
if this will improve the mesh quality.

Stair Step

This option affects the behavior of the Stop Columns option, and is only effective if Stop
Columns is enabled.

If Stair Step is enabled, the difference in adjacent prism columns is limited to 1 layer. When
disabled, adjacent columns can have different numbers of layers that differ by more than 1.

Note:

Stair stepping is enabled by default in Fluent Meshing inflation.

Figure 287: Using the Stair Step Option (p. 365) shows the prism layers grown on a ship sail. The
second image shows that when the Stair Step option is disabled, the prism layers are fully ex-
truded on the sail.

Figure 287: Using the Stair Step Option

Stair Step option enabled

Stair Step option disabled
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Stop Columns

If enabled, a column of prisms is stopped if the marching direction cannot be determined or a
collision is detected. If disabled, and a collision is detected at any point, the entire next layer
is stopped unless Auto Reduction is also enabled. In many cases, disabling this option may
cause the Prism mesher to terminate prematurely.

Figure 288: Example of Stop Columns and Stair Step Options

Stair Step option enabled:

Stair Step option disabled:
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Use Existing Quad Layers

This option deals with cases where a prism layer meets a wall. If enabled, the software will at-
tempt to align the boundary of the prism layers to the existing quad surface mesh. If the existing
mesh has a different structure or the prism mesh has trouble mapping to the structure, then
the prism faces will be used for the surface mesh. If disabled, this option will adjust the existing
mesh to follow the faces of the uncovered prisms.

Max Jump Factor

The maximum allowable jump in height between neighboring vertices (default is 5.0). If adjacent
prism columns exceed this ratio, the Prism mesher will terminate prematurely and an error
message will note that Max Jump Factor was exceeded.

Max Size Ratio

The maximum allowable size ratio when growing larger prisms into smaller tetra elements
(default is 0.0).

Min Smoothing Steps

The minimum number of marching direction smoothing steps (default is 6). This does not
override Max directional smoothing steps, but acts as a lower limit.

Min Smoothing Val

The marching directions will be smoothed until the quality is above this value (default is 0.1)
or the Max directional smoothing steps is reached. If Min Smoothing Val is met, but the
Max directional smoothing steps has not been yet reached, smoothing will continue until the
number of Min Smoothing Steps have been completed.

Ratio Max

The maximum height ratio between prisms from one layer to the next.

Tetra Smooth Limit

The tetra elements will be smoothed until they are above this value (default is 0.3).
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Verbosity Level

Set a value of 0, 1 (default) or 2 to adjust the amount of detail included in the messages output
during the prism meshing process.

Verbosity level 2 is typically used only by developers and can slow the prism generation process
if there are a significant number of problems in the mesh.

Read a Prism Parameters File

allows you to select an existing prism parameters file. This will be used to set all the prism
parameters, including Advanced Prism Meshing Parameters. These prism parameters files can
be shared between projects for consistency and easy setup.

Set Up Periodicity

The Set Up Periodicity option allows you to define periodicity.

Define Periodicity

ensures that the nodes line up from one periodic face to another.

Tip:

Periodicity can be set for both Tetra and Hexa meshes.

Rotational periodic

This option ensures that the nodes will line up along an axis symmetric model, and also force the
nodes to be rotationally periodic with one another. An example of rotational periodicity is that a
node and its periodic counterpart on an opposing periodic face share the same R and Z coordinates
of a cylindrical coordinate system. Ansys ICEM CFD has the ability to mesh all the way to the
axis of rotation.

Figure 289: Rotational Periodic Geometry

There are three methods to defining the Rotational axis.

The User defined methods require the following parameters:
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• Base

The x-, y-, and z-coordinates of the origin for the axis of rotation. These values are always inter-
preted in the global coordinate system.

• Axis

A vector defining the direction of the axis of rotation (i j k).

• Angle

The angle that makes up the computational domain within the axis symmetric model. An angle
of 360 degrees would mesh the entire rotational domain.

Note:

– Angle must be positive value.

– The Angle value must divide 360 degrees an integer number of times, with zero
remainder.

OR

Sectors

The number of sectors in 360 degrees that make up the entire rotational computational domain.

The Vector method requires 2 points to define the vector for the axis of rotation, and the angle
to define the rotational domain.

An example of a rotational periodic mesh is shown in Figure 290: Rotational Periodic Mesh (p. 370).

369
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Global Mesh Setup



Figure 290: Rotational Periodic Mesh

Translational Periodicity

This option ensures that the nodes line up along a translational symmetric model, as illustrated
in Figure 291: Translational Periodic Geometry (p. 370) and Figure 292: Translational Periodic
Mesh (p. 371). Enter the Offset vector value that defines one periodic face from the other (Dx Dy
Dz).

Figure 291: Translational Periodic Geometry
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Figure 292: Translational Periodic Mesh

Convert coordinates to global coordinates

allows you to specify the Axis or Offset periodic coordinates in an active local coordinate system
(LCS).

Behind the interface, periodicity is always defined in the global coordinate system. When you
click this control, the Axis vector (or Offset if translational periodicity) will be normalized and the
LCS-based parameters will be converted to global coordinates.

This control is disabled if the Axis (Offset) coordinates are unchanged; or if LCS data is missing
or inactive. For more information on working with a LCS, see Local Coordinate Systems (p. 204)

Note:

• For rotational periodicity, Base parameters (x-, y-, and z-coordinates of the origin
for the axis of rotation) are always interpreted in the global coordinate system.

• If you click Apply without clicking this button, the Axis or Offset coordinates will
be interpreted in the global system without conversion.

Part Mesh Setup

The Part Mesh Setup option opens a dialog where you can specify the mesh parameters for different
parts, as shown in Figure 293: Part Mesh Setup Window (p. 372).

Parameter setting hierarchy:

• A value of 0 entered for a Part level setting causes the global parameter value to be used.

• Part level settings will override Global settings where appropriate. See the detailed description
for each parameter.
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• Entity level settings, for example on a surface or curve, will override Part level settings where
appropriate.

Tip:

Clicking the header cell for a parameter (for example,max size) will open up a window in
which you specify the same parameter value for all available parts.

After you enter the parameters, click Apply, and then Dismiss to close the window.

Figure 293: Part Mesh Setup Window

Prism

Select the parts on which prism layers will be grown. Volume, surface and/or curve parts can
be selected. If there are multiple volume parts and none have the prism option enabled, then
prism mesh will grow from the selected surface parts into the adjacent volumes. If only certain
volume parts have prism enabled, then prism mesh will be grown into only those volume
parts.

For each selected part, these locally-set values will affect prism growth: Height, Height Ratio,
Num Layers, Prism height limit factor, and Prism growth law. If parameters are not set locally,
then the global settings will be applied. A full description of these parameters is found under
Mesh > Global Mesh Setup > Global Prism Settings (p. 346).

Ansys ICEM CFD supports both pre-inflation (Fluent meshing) or post-inflation prism growth.
These processes are described in Prism Mesh Process. The decision for which process to use is
made in the Compute Mesh DEZ. See Tetra/Mixed Mesh Type (p. 399) or Compute Prism
Mesh (p. 409) in the Compute Mesh section.

For 3D, the prisms are grown from the shell (tri or quad) elements of each part. This can be
done with or without a volume mesh, but having a tetra volume mesh during prism growth
helps with collision avoidance and ensures that you will have a volume mesh after prism gen-
eration is complete. For 2D, the prisms are grown from the curve parts into the selected surface
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parts (must be selected). The 2D prism only works if Advanced Prism Meshing Parameters >
Blayer 2D (p. 361) is enabled.

Note:

• You can compute a prism mesh using the ICEM CFD post inflation method without
an input geometry loaded. Prism will generate a temporary faceted surface model
from the input mesh. The pre inflation (Fluent Meshing) method requires geometry
to determine growth direction.

• Different prism heights can be specified on adjacent parts, though a transition
region with unspecified height is required in between these parts.

• If a surface part separates two or more volume parts, select the volume parts on
the side of the surface you want to grow the prisms. If you select both sides,
prisms will grow in both directions from the surface part. If you want different
prism properties on either side of a surface grown into 2 volumes, do one at a
time (run prism iteratively).

• If adjacent tri-element parts have heights that differ by more than a factor of 2,
the prism mesher may fail (this limit is controlled in the Advanced Prism Meshing
Parameters). Not setting a height for Prism, (here or in the Global Prism Para-
meters DEZ) will allow the height to float. You can also allow the height to float
globally and set specific initial heights per part or on an entity by entity basis.

Hexa-Core

Enable this option to use Hexa-Core meshing for the volume part, and to set the desired
parameters. The global parameters for Hexa-Core meshing can be set under Mesh > Global
Mesh Setup > Volume Meshing Parameters > Cartesian Mesh Type > Hexa-Core Mesh Meth-
od (p. 344). The default Max Size is based on a weighted average of the perimeter surface ele-
ments.

If all or none are selected, Hexa-Core will fill all volumes (similar to Prism).

To enable Hexa-Core meshing for all available parts, click the hexa-core header and all available
parts will be selected.

Max Size

specifies the maximum element size. The actual maximum element size will be this value mul-
tiplied by the Global Element Scale Factor.

Note:

Local maximum element sizes defined on bodies/materials can be used to limit the
maximum size for the Hexa-Core method. For other methods, such as BFCart, Octree
Tetra or Delaunay Tetra, you will need to set the local maximum size using a density
region (refer to Create Mesh Density (p. 386) for details). This is because the material
is applied (via flood-fill from the material point) after subdivision is complete.
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Height

specifies the height of the first layer of elements normal to the surface or curve. For volume
meshing, this parameter affects the Hexa and Prism initial mesh layer height. For Patch Depend-
ent Surface meshing, when applied to a curve, this value can affect the initial height of the
layer of quads along that curve. For example, this could be used to specify the initial height of
a quad ring around a bolt hole.

Height Ratio

is the expansion ratio from the first layer of elements on the surface. This ratio will be multiplied
by the element height of the previous layer to define the next layer.

The default growth rate for the transition to the surface Max Size is 1.5. This growth rate can
be adjusted by setting the surface Height ratio to between 1.0 and 3. Sizes below 1.0 are inverted
(for example, 0.667 becomes 1.5). Sizes above 3 are ignored and the default is used.

When applied to curves, the Height Ratio can have several effects on Patch Dependent meshing.
When used with an initial Height and Number of Layers, it determines the growth rate of one
layer of quads over the previous layer. When used with the Adapt Mesh Interior setting, it
affects how quickly the mesh transitions from the curve sizes to the surface sizes.

Num Layers

is the number of layers to be grown from the surface or curve.

Tetra Size Ratio

controls the growth (edge length) of tetra mesh as it moves away from the surface when using
the Robust (Octree) method. This parameter affects the transition rate over a larger number
of transitions, since adjacent-cell size transitions are constrained to powers of 2.

Note:

For other tetra/mixed methods, the corresponding parameter is set using Volume
Meshing Parameters (p. 329).

For example, if the surface size is 2, the volume size is 64, and the size ratio is 1.5, then com-
paring size transitions for different tetra methods would result in something like the following:

76.8951.2634.1722.7815.1910.136.754.532Delaunay

64323216884422Octree

Over many layers, both the Octree and Delaunay methods show size growth at a rate of approx-
imately 1.5, but because the Octree method has to fit it to powers of 2, the layer-by-layer ratio
is not constant. Also, as you can imagine, changing this to 1.4 or 1.6 might not make that much
difference to the Octree mesher, at least not for the first few layers, but would directly change
the Delaunay progression.

Tetra Width

creates the specified number of tetra layers with element size as specified by the Max Size.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.374

Mesh



This parameter applies to the Robust (Octree) method only.

Min size limit

Mesh elements will be prevented from being subdivided smaller than this value.

This parameter works only with the Curvature/Proximity Based Refinement option under
Global Mesh Size (p. 313). You can override the global setting on particular entities or parts by
setting this value smaller than the global setting. The actual minimum size will be this value
multiplied by the Global Element Scale Factor.

Max Deviation

is a method of subdivision based on the proximity of the centroid of a tri or quad surface ele-
ment to the actual geometry. If the distance is greater than this value, the element will auto-
matically split and the new nodes will be projected onto the geometry. The actual distance is
the value multiplied by the Global Element Scale Factor.

Prism height limit factor

is used to create a local maximum aspect ratio for prisms on selected surface(s). A full description
is available in Global Prism Settings (p. 346). If zero, the global or part value is used.

Prism growth law

is used to specify a local growth law for prisms on selected surface(s). A full description of the
available laws is available in Global Prism Settings (p. 346). If undefined, then the global or part
law is used.

Int Wall

if enabled, the part will be meshed as an internal wall. This applies to Octree Tetra Meshing
only. This is necessary if you wish to mesh the surface of an internal wall within a volume.

Split Wall

if enabled, the part will be meshed as a split wall with overlapping pairs of elements and nodes,
so that both sides of the wall are effectively treated as having surface elements. This applies
to Octree Tetra Meshing only.

Show size params using scale factor

adjusts the reference element display to show the actual Max Size on each entity after mul-
tiplying the set maximum size by the Global Element Scale Factor. To display this size for
each entity, use the display options in the Display Tree, such as the Tetra Sizes or Hexa Sizes
options under Surfaces.

Apply inflation parameters to curves

allows you to apply the inflation parameters (Height, Height ratio, and Num. layers) to curves.
By default, these parameters are applied only to surfaces because these options can produce
a different result with the Patch Dependent Surface mesher when applied to curves. For instance,
if you intend for these parameters to affect only Prism generation (volume mesh), they should
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not be applied to the curves if you also intend to use the Patch dependent surface mesher and
do not want the surface mesh to be affected.

Remove inflation parameters from curves

allows you to remove any parameters related to inflation layers from curves.

Surface Mesh Setup

The Surface Mesh Setup option allows you to set mesh parameters for selected surfaces. For
models with blocking, this applies only to 3D blocking.

Figure 294: Surface Mesh Setup

Surface(s)

specifies the surfaces for which meshing parameters are to be defined.

Maximum size

specifies the maximum element size. The actual size is this value multiplied by the Global Element
Scale Factor. You may end up with small elements on the selected entities if you are using
Curvature/Proximity Based Refinement or Maximum Deviation.
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Height

is the height of the first element, normal to the entity. This value applies to Hexa mesh only, and
can be any positive real number.

Height ratio

is the expansion ratio from the first layer of elements on the surface. This ratio will be multiplied
by the element height of the previous layer to define the next layer. This value is used for Prism
and Hexa mesh, and can be any positive real number.

The default growth rate for the transition to the surface Max Size is 1.5. This growth rate can be
adjusted by setting the surface Height ratio to between 1.0 and 3. Sizes below 1.0 are inverted (for
example, 0.667 becomes 1.5). Sizes above 3 are ignored and the default is used.

Number of layers

is the number of layers to be grown from the surface or curve.

Tetra width

creates the specified number of tetra layers with element size as specified by the Max size.

Tetra size ratio

controls the growth of tetra as it move away from the surface. It is used for Tetra mesh.

Min size limit

Surface elements will be prevented from being subdivided smaller than this value.

This parameter works only with the Curvature/Proximity Based Refinement option under Global
Mesh Size (p. 313). You can override the global or part setting on selected surfaces by setting this
value smaller than the global setting or part setting, whichever is smaller.. The actual minimum size
will be this value multiplied by the Global Element Scale Factor.

Maximum deviation

is a method of subdivision based on the proximity of the centroid of a tri or quad surface element
to the actual geometry. If the distance is greater than this value, the element will automatically split
and the new nodes will be projected onto the geometry. The actual distance is the value multiplied
by the Global Element Scale Factor.

Note:

This only applies to the interior of surface mesh, not to the boundary. Node
bunching settings for the boundary curves will still be respected.

Prism height limit factor

is used to create a local maximum aspect ratio for prisms on selected surface(s). A full description
is available in Global Prism Settings (p. 346). If zero, the global or part value is used.
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Prism growth law

is used to specify a local growth law for prisms on selected surface(s). A full description of the
available laws is available in Global Prism Settings (p. 346). If undefined, then the global or part law
is used.

Mesh type

specifies the mesh type for the selected surface. If a mesh type is selected for a specific surface,
then this will override the global mesh settings. See Global Mesh Setup > Shell Meshing Paramet-
ers (p. 317) for a description of mesh types.

Mesh method

specifies the mesh method for the selected surface. If a mesh method is selected for a specific surface,
then this will override the global mesh settings. See Global Mesh Setup > Shell Meshing Paramet-
ers (p. 317) for a description of Mesh methods.

Remesh selected surfaces

allows you to remesh selected surfaces after changing surface mesh parameters. The new surface
mesh will automatically be generated.

Blank surfaces with params

when toggled, the surfaces with parameters applied to them will be make invisible or visible.

Curve Mesh Setup

The Curve Mesh Setup option allows you to set mesh parameters for curves. This feature is useful
for both surface and tetra meshing in controlling mesh size or distribution on surface boundaries. There
are several parameters, but in most cases setting the element size is sufficient for meshing.

There are the following methods for setting the Curve Mesh Size:

• Figure 295: Curve Mesh Setup – General (p. 379): This method involves entering the parameter
values in the provided fields.

• Figure 296: Curve Mesh Setup – Dynamic (p. 384): This method allows you to select a curve and
adjust the values using the mouse buttons.

• Figure 297: Curve Mesh Setup – Copy Parameters (p. 385): This method allows you to copy curve
mesh parameters to the selected curve(s).
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Figure 295: Curve Mesh Setup – General

General

allows you to enter the following parameter values in the respective fields:

Select Curve(s)

specifies the curves for which mesh parameters are to be defined.
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Maximum size

is the maximum element size for the selected curves. The actual element size will be this value
multiplied by the Global Element Scale Factor. The element size can be displayed by right-
clicking Curves in the Model tree and selecting Curve Tetra Sizes or Curve Hexa Sizes.

Number of nodes

is the number of elements for the selected curves. This is an alternative option to setting the
element size. The number of elements entered should be more than 2. The node spacing can
be displayed by right-clicking Curves in the Model tree and selecting Curve Node Spacing.

Height

is the height of the first elements, normal to the curve. This value applies to Hexa mesh and
Patch Dependent Surface mesh, and can be any positive real number.

Height Ratio

is an expansion ratio from the first layer of elements on the curve. This ratio will be multiplied
by the element height of the previous layer to define the next layer. You can enter any positive
real number. This parameter applies to Hexa, Prism mesh, and Patch Dependent Surface mesh.

Number of layers

is the number of layers to be grown from the surface or curve.

Tetra width

creates the specified number of tetra layers with element size as specified by the Max size.

Min size limit

Curve elements will be prevented from being subdivided smaller than this value.

This parameter works only with the Curvature/Proximity Based Refinement option under
Global Mesh Size (p. 313). You can override the global or part setting on selected curves by setting
this value smaller than the global setting or part setting, whichever is smaller.. The actual minimum
size will be this value multiplied by the Global Element Scale Factor.

Maximum deviation

is a method of subdivision based on the proximity of the centroid of a tri or quad surface element
to the actual geometry. If the distance is greater than this value, the element will automatically
split and the new nodes will be projected onto the geometry. The actual distance is the value
multiplied by the Global Element Scale Factor.

Prism height limit factor

is used to create a local maximum aspect ratio for prisms on selected curve(s). A full description
is available in Global Prism Settings (p. 346). If zero, the global or part value is used.
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Prism growth law

is used to specify a local growth law for prisms on selected curve(s). A full description of the
available laws is available in Global Prism Settings (p. 346). If undefined, then the global or part
law is used.

Advanced Bunching

contains options providing more control over the mesh parameters. Refer to Blocking > Pre-
Mesh Params > Edge Params > Bunching Laws (p. 521) for more detailed explanation.

Bunching law

BiGeometric

This is the default bunching law. The two initial heights and ratios define parabolas in
a coordinate system where the number of node points is the X-axis and the cumulative
distance along the edge is the Y-axis. The parabolas are truncated where their tangent
lines are identical; the spacing is linear between these points. If there are not enough
nodal points to form this linear segment, a hyperbolic law is used and the ratios are ig-
nored.

Biexponential

The Spacing1 and Ratio1 parameters define the distribution from the beginning of the
edge to the midpoint of the edge using an Exponential law. Spacing2 and Ratio2 are
similarly used to define the distribution from the terminating end of the edge to the
midpoint of the edge.

Curvature

The spacing of the node intervals is calculated according to the curvature of the function
defining the distribution.

Exponential1

The spacing of the ith interval from the beginning of the edge is defined using an expo-
nential function of the Spacing1 and Ratio1 parameters.

Exponential2

Similar to Exponential1, except that Spacing2 and Ratio2 parameters are used and the
distribution starting point is the terminating end of the edge.

FullCosinus

The spacing of node intervals is calculated using the cosine function. The ends of the
edge have the same constraint values for spacing and ratio.

Geometric1

Spacing1 is used to set the first distance from the starting end of the edge, then the
remaining nodes are spaced with a constant growth ratio. Only Spacing1 is specified.
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Geometric2

Similar to Geometric1, except that Spacing2 is used to define the distribution starting
from the terminating end of the edge.

HalfCosinus1

The spacing pattern follows a half cycle of a Cosine function. Distribution begins from
the starting point of the edge and the parameters for spacing and ratio differ on either
end.

HalfCosinus2

Similar to HalfCosinus1 in that the parameters for spacing and ratio follow a half cycle
of a Cosine function, but distribution starts from the terminating end.

Hyperbolic

The spacing parameters for each end are used to define a hyperbolic distribution of the
nodes along the edge. You can set Spacing1 and Spacing2, and the growth ratios are
determined internally.

Poisson

The spacing of the node intervals is calculated according to a Poisson distribution. Re-
quested values of Spacing1 and Spacing2 are used. Requested values of Ratio1 and Ratio2
are not used directly, but are used to determine if the requested spacing is appropriate.
If not, the spacing will be adjusted automatically.

Uniform

The nodes along the edge are uniformly distributed.

Spacing

The spacing of the first node from the beginning of the edge (first cell height). When an
edge is selected, an arrow appears along the edge. Spacing 1 refers to the parameters at
the beginning end of the arrow, and Spacing 2 refers to the edge end where the arrow is
pointing.

Ratio

specifies the growth rate from one cell height to the next. Ratio 1 refers to the parameters
at the beginning end of the arrow, and Ratio 2 refers to the edge end where the arrow is
pointing, as shown in the figure below.

Max Space

specifies the maximum element spacing of the curve.
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Curve direction

displays the curve direction with a yellow arrow along the curve at the midpoint. The arrow
points from side1 (spacing 1 and ratio 1) toward side2 (spacing 2 and ratio 2). This is enabled
by default.

Reverse direction

reverses the curve direction.

Note:

The Reverse direction button just flips side 1 and 2, it does not reverse the
spacing, the bunching law, etc.

Adjust attached curves

adjusts the mesh sizes on attached curves with the specified parameters. This applies to curves
that are attached at an angle between 60 and 120 degrees only. In order to select this option,
the Max size parameter and the bunching law of the reference curve must be specified. The
attached curves will automatically be assigned one of the following bunching laws, depending
on the curve direction: Geometric 1, Geometric 2, or BiGeometric. The curve bunching of the
attached curves will correspond to the values of Height and Height Ratio for the reference
curve.

Remesh attached surfaces

allows you to change the mesh by changing the element size or number of elements on the
curve. This option should be used when meshing has been completed, but you want to change
the curve mesh sizes. The new surface mesh will automatically be generated.
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Figure 296: Curve Mesh Setup – Dynamic

Dynamic

Select the curve parameter to be modified by clicking the increment/decrement icon ( ) next to
it. This will display the values for that parameter for each curve. You can then select the value for
a specific curve and use the left mouse button to increase the value or the right mouse button to
decrease the value in increments set in the Value field.
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Curve Properties (Dynamic)

allows you to specify the increment for specific curve mesh parameters in dynamic mode. Select
the curve mesh parameter in the Incr/Decr for field, enter the value by which to increment/decre-
ment the parameter in the Value field, and click Apply in the Curve Properties (Dynamic)
group box.

Figure 297: Curve Mesh Setup – Copy Parameters
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Copy Parameters

allows you to copy curve mesh parameters to the selected curve(s).

From Curve

allows you to select the curve to copy the parameters from.

To Selected Curve(s)

specifies the curve(s) to which the parameters will be copied.

Copy

Relative

allows you to copy the parameters from the source curve relative to the curve length of the
specified curve(s).

Absolute

allows you to copy the exact parameters from the source curve to the specified curve(s),
regardless of curve length.

Blank curves with params

blanks curves with prescribed parameters. Curves without parameters will remain visible.

Note:

The number of nodes and the meshing laws specified take precedence in determining the
number of nodes. Then spacings 1 and 2 are equally balanced, followed by ratios 1 and 2,
which are also equally balanced, and finally Max space is considered.

Create Mesh Density

The Create Mesh Density option allows you to create or manipulate a density region. This is a
polyhedral (or polygonal for 2D) zone in which one can prescribe a local maximum element size. This
is useful for refining the mesh in a volumetric zone that is not adjacent to any geometry, for example,
in the wake region of a vehicle. You can have density regions within one another, or partially intersecting
one another.
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Figure 298: Create Density DEZ

Figure 299: Example of Mesh Density

A smaller mesh size within one density region will supersede that of a greater mesh size if they overlap
or intersect. The density region does not have to be totally within the volumetric domain, but can inter-
sect geometry and partially be within the dead zone.

Note:

• The density region is not part of the geometry, and mesh nodes are not constrained to
the density region.

• Density regions are not applied when computing the volume fill using the Fluent meshing
method.

• Density regions affect only Tetra, Cartesian, and Patch Independent surface mesh methods.
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Name

specifies the name for the density region. Enter an appropriate name or accept the default.

Size

specifies the local maximum mesh size that can occur within the density region. This will be multiplied
by the Global Scale Factor.

Ratio

specifies the tetra growth ratio away from the density region.

Width

For a density region, this specifies the number of layers (N) of the specified element size away from
the boundary of the density region that should have a constant expansion ratio. The layer N + 1
will have a tetra size of the Size value multiplied by the Ratio.

For line and point densities, the Size value multiplied by the Width is the radius of the region that
the density region influences.

Density Location

The location of the density region can be defined in the following ways:

• From Points

Select one or more points to define the boundaries of the density region.

• From Entity Bounds

Select an entity to define a density region within its boundaries.

Define Connectors

The Define Connectors option allows you to define connectors. Connectors are meshing directives
assigned to geometry so that when the geometry is meshed, mesh links are created between different
parts. Line or shell elements are created to link parts with node to node connections. In general, mesh
connectors are defined with the geometry so that if a geometry is updated parametrically, the connectors
can be updated from one tetin file to a second tetin file. See Main Menu > File Menu > Import Geo-
metry > Reference Geometry  (p. 40) for more information.

Figure 300: Define Connectors Options
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The various types of connectors are shown in Figure 300: Define Connectors Options (p. 388).

Arbitrary Connectors

Bolt Weld Connectors

Seam Weld Connectors

Spot Weld Connectors

Spot Weld From File

Arbitrary Connectors

The Arbitrary Connectors option allows you to create arbitrary connectors between any two
entities. Each node of the start entity will have a connector to the end entity, but the end entity does
not have to have all of its nodes connected. Arbitrary connectors are always created from the nearest
point of the first entity to the nearest point of the second entity. The following options are available:

Arbitrary connector name

You can enter a name for the arbitrary connector, or use the default name.

Source

You can either select entities (generally curves) or existing parts as the source.

Target

Target entities are surfaces or parts containing surfaces. If only one or some of the surfaces of
the part are to be selected for the target, then use the Entities method. If all the surfaces in the
part are required to be selected, then use the Existing Part method.

Note:

Ensure that the source and the target entities are selected in the correct order, select
the source entity first and then the target entity.

Connector Part Name

The part name for the connectors is automatically generated, starting with ARB_WELD0.

Max projection

A value slightly more than the distance between the source and the farthest target surface.

Active

If disabled, the connector will not be created when remeshing.
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Bolt Weld Connectors

The Bolt Weld Connectors option allows you to create bar elements inside a hole which all
connect to one node at the center. These are also named bolt spiders because of their appearance.
It is important to put the bar elements which circle the hole into a part of their own, because con-
nectors will be created from all the bars in the specified part. If hole curves are put into a separate
part before surface meshing, hole bars will automatically be in a separate part from the rest. This is
because when the surface mesher runs, bar elements are put in the same part as the curves they lie
on. If the part is changed after surface meshing, the bar elements must also be changed in order for
the bolt weld connectors to be created. The following options are available:

Bolt hole name

A new part name for the bolt curves is automatically generated, starting with BOLT_CURVES0.

Bolt curves

specifies the curves representing the bolt hole.

Connector Part Name

specifies the part name for the connectors which is automatically generated, starting with
BOLT_WELD0.

Num quad rings

is the number of quad layers to mesh around the bolt curves. This is subject to the space available
around the curves.

Washer

Washers are represented by line (bar) elements and the thickness of the washer is represented
by the quad layer(s) generated. The line elements will go from the inner and outer rings of the
quad layer(s) to the center of the bolt hole to allow the load to get transferred from the bolt to
both sides of the washer.

Note:

To generate a washer at least one quad layer must be specified.

Active

if disabled, the connector will not be created when remeshing.

Seam Weld Connectors

The Seam Weld Connectors option allows you to create bar elements from all nodes that lie
on the specified curve to a specified surface. The created connectors will be normal to the surface,
so the surface elements may be automatically split in order to create nodes at the proper locations
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to connect the bars. If nodes are aligned around the seam within a tolerance, then the elements will
not be split.

Seam connector name

The part name is generated automatically, starting with SEAM_CURVES0.

Weld type

• Point to point

creates a row of bar elements between the nodes of the source curves and the nearest nodes
of the target surface mesh.

• Curtain tris/quads

creates quad elements with some tri elements in between the nodes of the source curves and
the nodes of the target surface mesh. Curtain welds are generally intended to be defined on
single edges to close a gap between two parts.

Note:

In many cases, extending surfaces by using Geometry > Create/Modify Surface
> Extend Surface > Close gaps Between Midsurfaced Parts  (p. 254) is a more
robust way of ensuring the creation of shell elements to represent the connection
between parts.

• Tent

is a specialized method that creates curtain elements with additional tent elements and defines
particular meshing parameters on the source curves. The geometry is modified by surface ex-
tension or curtain surface functions. The Tent welds extend the surfaces to intersection and
then diagonal quads represent the fillet welds.
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Tent Weld type

select either T welds or Lap welds.

Diagonals

For T welds, diagonals can be added to the Positive or Negative directions, or both. For
Lap welds, diagonals can be added only to either the Positive or Negative directions.

No. layers

number of quad rows along the welds.

Tent weld spacing

– Distance to Weld Toe

The weld spacing can be determined by specifying the Distance to weld toe, the Number
of layers to toe, and the Growth ratio after weld parameters.

– Weld fillet radius

The weld spacing can also be determined by specifying the fillet radius of the weld.

Source curves

specifies the curves representing the edge of surface to be seam welded to the target surface.

Note:

The source curves information may not be retained when you try to modify an existing
seam weld connector.
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Target part

specifies the surface part to which the connectors will attach. The connectors will be normal to
the surface. Since new nodes are projected, the surface elements must lie on top of a surface,
and they must be in the same part as the surface.

Max projection

is a value slightly more than the distance between the source entity and the farthest target surface.

Part name

The connector part name is automatically generated, starting with SEAM_WELD0.

Element splitting

• Remesh area (Tri/Quad)

remeshes the area of the seam weld after computing the mesh and connector.

• Terminate

terminates the split to keep the mesh count down. It doesn’t give as many high aspect ratio
quads, but it creates many tri elements.

• Propagate

propagates the split through the mesh until the propagation is stopped by a tri element or it
exits to the ORFN region.

Note:

This may result in new quad elements with poor aspect ratios.

Spot Weld Connectors

The Spot Weld Connectors option allows you to create bar elements from all nodes that lie on
the specified part to a specified surface. The created connectors will be normal to the surface, so the
surface elements may be automatically split in order to create nodes at the proper locations to connect
the bars. If the nodes are aligned within a tolerance, the surface elements will not be split.

Spot welds support 3T welds, which are 3 plates being welded together. For a 3T spot weld, pick 2
parts as Target parts.

A spot weld is intended to be used in the middle of a surface. It can also be defined on a surface
boundary, with the condition that the source points should split the curve at the surface boundary.

The following options are available for Spot Weld connectors:
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Spot Weld name

The part name is automatically generated, starting with SPOT_POINTS0.

Source points

specify points which represent one end of the connectors.

Note:

The source point must be embedded in the source surface and both must belong to
the same part.

Target parts

specifies the two parts that are to be connected.

Connector Part name

The part name for the connectors is automatically generated, starting with SPOT_WELD0.

Max projection

is a value is slightly greater than the maximum distance between two target parts.

Weld options

• Point to Point

creates a line element attached to the nodes of both surfaces, and normal to both surfaces.

– Element Splitting

→ Remesh area (Tri/Quad)

remeshes the area of the spot weld after the mesh is created.

→ Terminate

terminates the split to keep the mesh count down and doesn’t give as many high aspect
ratio quads, but it creates many more tri elements.

→ Propagate

propagates the split through the mesh until the propagation is stopped by a tri element
or it exits to the ORFN region.

• Mesh independent line

This is like the point weld, but the nodes on the two sides do not have to be forced into the
mesh. Instead, any nodes in the nuggets area are connected to the line element through a
second set of line elements for both sets of surface mesh. Typically, the first line element is
defined as an RBE2 element in Nastran, and the second set of line elements on each side are
defined as RBE3 elements, which have a weighting factor based on how close it sits to the node
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of the line element. If the leg of the RBE3 is approximately zero, it gets a weighting value of
one, and if it is large the weighting value is approximately zero.

– RBE3 Part Name

For a mesh independent weld, there is a weld element (that does not connect to the mesh),
and connector elements that connect the weld element to the mesh. The connector elements
to into the RBE3 Part. Typically, this weld is used for Nastran, where the line elements in this
part should get an RBE3 Element Property.

• Mesh independent hexa

This is like the line independent weld, but the base line element (RBE2) is replaced by a Hexa
element with a thickness defined by the diameter. Each of the four nodes at each surface has
a RBE3 connection from its node to all nodes of the nearest element. The Hexa elements typically
get a rigid material property, and the line element connectors are weighted as in a line mesh
independent weld.

– Weld Radius

defines the weld diameter. The weld diameter (Radius * 2) would be equal to the diagonal
of the Hex element for each face that is near the shells.

– RBE3 Part Name

Contains the line elements that connect the Hexa element to the mesh. These line elements
should get an RBE3 element property.

• Area weld

An hourglass type of weld, where there is a nugget area or diameter, and a node in the center
between the two surfaces meshes, where the center node is attached to any nodes within the
diameter on either side. This is mesh independent, and the weld/line elements adapt to where
the mesh is.

– Weld Radius

The weld connects all the nodes on the defined parts within the specified radius to the
central node.

Active

if disabled, the connector will not be created when remeshing.

Spot Weld From File

The Spot Weld from File option allows you to create bar elements from the weld data file.

Spot Weld data file

enter or browse for the path to the Weld data file. See below for sample lines of a Weld data file.
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DiameterPID3PID2PID1ZYXNo.Description

554525543251520.413531.8723046.2781MASTIC

554525543251526.115528.3543095.9522MASTIC

554525543251531.003525.2583145.9523MASTIC

5452554325537.187695.3653340.52544WSPOT

546255452554325524.562695.9823370.48545WSPOT

105462554525543251543.035520.3743456.3346MASTIC

105462554525543251537.365525.3043260.05547MASTIC

1054525543251543.285519.9323491.9948MASTIC

Note:

The first column must define the connection type. The X, Y, and Z columns define the
coordinates of the connection location. The PID1, PID2, and PID3 columns define the
parts connected. The Diameter column is important for MASTIC connections. For WSPOT
connections, the Diameter column should be left blank.

Spot Weld report file

After welding, a Weld report file of this name will be generated and placed in the working directory.
This will list all the welds, which ones failed and why. Common reasons for failure include missing
or misnamed parts or badly placed welds.

Element splitting

• Remesh area (Tri/Quad)

remeshes the area of the weld after the mesh is created.

• Terminate

terminates the split to keep the mesh count down and doesn’t give as many high aspect ratio
quads, but it creates many more tri elements.

• Propagate

propagates the split through the mesh until the propagation is stopped by a tri element or it
exits to the ORFN region.

Connector Part name

The part name for the connectors is automatically generated, starting with SPOTWELDFILE0.

Max projection

is the value slightly more than the maximum distance between two target parts.
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Mesh Curve

The Mesh Curve feature extracts 1D line elements from the selected curves. If the curve mesh size
has been defined, it will be respected.

Figure 301: Mesh Curve DEZ

Compute Mesh

The Compute Mesh option allows you to generate the mesh specified by the mesher and various
parameters.

Figure 302: Compute Mesh Options

The settings in the Global Mesh Setup options (p. 307) will be applied unless otherwise specified.

Compute Surface Mesh

Compute Volume Mesh

Compute Prism Mesh

Compute Surface Mesh

The Compute Surface Mesh option generates a surface mesh. By default the software tries to
apply good meshing parameters for use in surface meshing, but you can apply additional controls
by changing the meshing parameters. The parameters that control the surface meshing are defined
under Global Mesh Setup (p. 307), Part Mesh Setup (p. 371), and Surface Mesh Setup (p. 376) or Curve
Mesh Setup (p. 378)

Overwrite Surface Preset/Default Mesh Type

if enabled, the specified mesh type will be used instead of the mesh type set in Global Mesh
Setup > Shell Meshing Parameters (p. 317).
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Overwrite Surface Preset/Default Mesh Method

if enabled, the specified mesh method will be used instead of the mesh method set in Global
Mesh Setup > Shell Meshing Parameters (p. 317).

Input

specifies the geometry that will be used as input for the surface mesh.

All

meshes the entire geometry.

Visible

meshes the visible geometry.

Part by Part

meshes the selected parts one by one. This provides non-conformal mesh between part inter-
faces.

From Screen

allows you to select the entities to be meshed from the display.

Note:

For Patch Dependent meshing, if curves that form a closed loop are selected and
meshed with one element type, and then remeshed using another element type, the
original elements will not be deleted.

Compute Volume Mesh

The Compute Volume Mesh option generates a volume mesh using the selected volume mesh
type and method. The descriptions of the different options and their parameters are described in
Global Mesh Setup > Volume Meshing Parameters (p. 329). The volume mesh will be applied using
the parameters that are set there.

Load mesh after completion

This option applies to all the Compute Volume Mesh options. If disabled, the surface mesh will
not be loaded into the GUI. This may be useful for big models.

The available volume mesh types are as follows.

Tetra/Mixed Mesh Type

Hexa-Dominant Mesh Type

Cartesian Mesh Type
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Tetra/Mixed Mesh Type

There are four different Mesh Methods available for Tetra/Mixed Meshing: Robust (Octree), Quick
(Delaunay), Smooth (Advancing Front), and Ansys Fluent Meshing. The different options for
each mesh method are:

Robust (Octree) Mesh Method

This algorithm ensures refinement of the mesh where necessary (based on entity sizes and the
curvature and proximity based refinement settings), but maintains larger elements where possible,
according to the ICEM CFD octree algorithm and applied settings (such as tetra ratio). For addi-
tional information see The Octree Mesh Method.

Create Prism Layers

generates post inflation prism layers in the tetra volume mesh that is created, according to
the prism meshing parameters that are specified under Global Mesh Setup > Prism Meshing
Parameters (p. 345), Part Mesh Setup (p. 371), Surface Mesh Setup (p. 376), and/or Curve Mesh
Setup (p. 378).

Create Hexa-Core

generates a hexa-core mesh using a bottom-up meshing approach. It will retain the tri
surface or prism mesh, delete the existing tetra mesh, and remesh the volume interior with
Cartesian meshing. The tetra elements will be mapped to the tri or prism faces with the
Delaunay algorithm.

Input

specifies the geometry that will be used as input for the Volume Mesh.

All

meshes the entire geometry.

Visible

meshes the visible geometry.

Part by Part

meshes the selected parts one by one. This provides non-conformal mesh between part
interfaces.

From File

runs the mesher in batch mode from an existing tetin file. Enter the name of the Tetin
file or browse the file manager.

Use Existing Mesh Parts

forces the Octree Tetra mesher to align to the surface mesh of the selected existing
mesh parts when the All or Visible option is selected for the input geometry. The Octree
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tetra mesh will be generated in its normal top down (volume first) method and then
be “made conformal” with the existing surface mesh.

Quick (Delaunay) Mesh Method

uses the Delaunay Tetra mesher and a bottom-up meshing approach to generate a mesh. The
surface mesh can be an existing mesh or will be created with the parameters defined under
Global Mesh Setup > Shell Meshing Parameters (p. 317) or Surface Mesh Setup (p. 376). The
volume mesh will then be generated from this surface mesh. The Delaunay method is robust
and fast.

Note:

This method works with quads or tris or a combination of both. Quads will use
pyramids to transition to the Tetras. The surface mesh can have multiple volumes
and have multiple edge elements. However, the Delaunay mesh method requires
a closed surface mesh, and cannot tolerate single edges, overlapping elements
or duplicate elements. You can run a mesh check ( Edit Mesh > Check Mesh
(p. 569)) before generating the volume mesh. Also, sudden changes in element
size, either adjacent or across a narrow volume gap, can cause quality issues or
failure.

Create Prism Layers

generates post inflation prism layers in the tetra volume mesh that is created, according to
the prism meshing parameters that are specified under Global Mesh Setup > Prism Meshing
Parameters (p. 345), Part Mesh Setup (p. 371), Surface Mesh Setup (p. 376), and/or Curve Mesh
Setup (p. 378).

Create Hexa-Core

generates a hexa-core mesh using a bottom-up meshing approach. It will retain the tri
surface or prism mesh, delete the existing tetra mesh, and remesh the volume interior with
Cartesian meshing. The tetra elements will be mapped to the tri or prism faces with the
Delaunay algorithm.

The Hexa-Core mesh parameters are specified under Global Mesh Setup > Volume Meshing
Parameters > Cartesian Mesh Type > Hexa-Core Mesh Method (p. 344).

Volume Part Name

allows you to select from the list of existing volume parts, select a part from the screen, or
supply a new name. The created mesh will be assigned to this part name.

If you select inherited, the mesher will place the volume element into the same part as an
existing material point. For the Delaunay method, the existing material point name will be
used, but without its specific location. This option works well for models with only one
material point. For more advanced models, such as conjugate heat transfer models or
models with sections of porous media, you should enable the Flood fill after completion
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option (available in the Quick (Delaunay) (p. 334) mesh method options) to use each mater-
ial point with its location to determine the volume mesh part names for each region.

Note:

When the inherited option is selected, the mesher will run the flood fill operation,
even if Flood fill after completion is disabled under Volume Meshing Paramet-
ers in the Global Mesh Setup.

Input

specifies the geometry that will be used as input for the Volume Mesh.

All Geometry

meshes the entire geometry.

Existing Mesh

allows the mesher to align to the existing mesh.

Part by Part

meshes the selected parts one by one. This provides non-conformal mesh between part
interfaces.

From File

runs the mesher in batch mode from an existing tetin file. Enter the name of the Tetin
file or browse the file manager.

Smooth (Advancing Front) Mesh Method

This option will use the Advancing Front Tetra mesher to generate a mesh using a bottom-up
meshing approach. The surface mesh will be created with the parameters defined under Global
Mesh Setup > Shell Meshing Parameters (p. 317) or Surface Mesh Setup (p. 376). The volume
mesh will then be generated from this surface mesh.

Note:

The surface mesh should be one enclosed volume with no single edges, multiple
edges, non-manifold vertices, overlapping elements or duplicate elements. Sudden
changes in element size, either adjacent to one another or across a narrow volume
gap, can cause quality issues or even failure.

The surface mesh must be either tri or quad elements for the Advancing Front mesh
method.

The primary advantage of the Advancing Front Method is the ability to generate a smoothly
transitioning Tetra mesh, with a volume growth ratio controlled by the Expansion Factor under
the Global Mesh Parameters.
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Create Prism Layers

generates post inflation prism layers in the tetra volume mesh that is created, according to
the prism meshing parameters that are specified under Global Mesh Setup > Prism Meshing
Parameters (p. 345), Part Mesh Setup (p. 371), Surface Mesh Setup (p. 376), and/or Curve Mesh
Setup (p. 378).

Volume Part Name

allows you to select from the list of existing volume parts, select a part from the screen, or
supply a new name. The created mesh will be assigned to this part name.

If you select inherited, the mesher will place the volume element into the same part as an
existing material point. For this method, the existing material point name will be used, but
without its specific location. This option works well for models with only one material point.
For more advanced models, such as conjugate heat transfer models or models with sections
of porous media, you should enable the Flood fill after completion option (available in
the Smooth (Advancing Front) (p. 336) mesh method options) to use each material point
with its location to determine the volume mesh part names for each region.

Input

specifies the geometry that will be used as input for the Volume Mesh.

All Geometry

meshes the entire geometry.

Existing Mesh

allows the mesher to align to the existing mesh.

Part by Part

meshes the selected parts one by one. This provides non-conformal mesh between part
interfaces.

From File

runs the mesher in batch mode from an existing tetin file. Enter the name of the Tetin
file or browse the file manager.

Fluent Meshing

This option will use Ansys Fluent Meshing technology to create a tetrahedral volume mesh
from an existing geometry and/or mesh, with additional options for boundary layer inflation
and/or hexa-core volume mesh.

Create Prism Inflation Layers

Enables the prism creation processes and allows you to select an inflation option.
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Post Inflation Layers

replaces the tetrahedral mesh near the surfaces with prism layers using the ICEM
CFD post inflation algorithm, according to the prism meshing parameters that are
specified under Global Mesh Setup > Prism Meshing Parameters (p. 345), Part Mesh
Setup (p. 371), Surface Mesh Setup (p. 376), and/or Curve Mesh Setup (p. 378).

Pre Inflation Layers

creates prism layers from the surface mesh using the Ansys Fluent Meshing pre
inflation algorithm before filling with tetrahedral mesh. If no geometry is available
to identify prism growth direction, pure tetra meshing will be done without prisms.

Create Fluent Mesh with Hexa-Core

The Delaunay algorithm is used to fill the gap between the hexa core elements and
the surrounding shell mesh or prism layer with conformal tetra and pyramid elements.

Run interactive Fluent Meshing

imports the mesh and settings but the journal macros need to be run interactively.
Recommended for expert users only.

Volume Part Name

allows you to select from the list of existing volume parts, select a part from the screen,
or supply a new name. The created mesh will be assigned to this part name.

If you select inherited, the mesher will place the volume element into the same part
as an existing material point. For this method, the existing material point name will be
used, but without its specific location. This option works well for models with only one
material point. For more advanced models, such as conjugate heat transfer models or
models with sections of porous media, you should enable the Flood fill after comple-
tion option (available in the Fluent Meshing (p. 337) mesh method options) to use each
material point with its location to determine the volume mesh part names for each
region.

Frozen volume mesh parts

allows you to select parts that will not be remeshed when using the Fluent Meshing
option. This is useful, for example, to preserve one or more meshed regions while
remeshing others.

Note:

• Parts to be remeshed require a volume mesh. A surface mesh and mater-
ial point is not sufficient.

• If remeshing a tet mesh region next to a frozen hex mesh, the tet mesh
will be connected to the hex mesh using pyramids. Inflation layers will
connect to the hexas, if possible.
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Input

specifies the source data for the volume mesher.

All Geometry

meshes the surfaces according to the global surface mesh setup, then grows the
volume mesh from the surface mesh.

Existing Mesh

grows the volume mesh from the existing surface mesh.

If no surface mesh exists, one is created from the existing volume mesh.

Part by Part

meshes the selected parts one by one. This provides non-conformal mesh between
part interfaces.

From File

runs the mesher in batch mode from an existing tetin file. Enter the name of the
Tetin file or browse the file manager.

Hexa-Dominant Mesh Type

This option will generate a Hexa-Dominant mesh using a bottom-up meshing approach. The Hexa-
Dominant mesher starts with surface quad dominant mesh and uses an Advancing Front scheme
to fill as much of the volume as possible. For simple volumes, it can fill it completely. For more
complicated volumes, it usually fills several layers in from the surface with hexa elements and then
fills the middle with tetras and pyramids. Then a diagnostic is run, and if those central elements
are poor, the inner volume will be meshed again with the Delaunay mesher. The surface mesh will
be created with the parameters defined under Global Mesh Setup > Shell Meshing Parameters (p. 317)
or Surface Mesh Setup (p. 376). The volume mesh will then be generated from this surface mesh or
the specified input.

Input

allows you to select from the following types of input to generate the mesh.

All Geometry

meshes the entire geometry.

Existing Mesh

allows the mesher to align to the existing mesh parts.

Volume Part Name

allows you to select from the list of existing volume parts, select a part from the screen, or
supply a new name. The created mesh will be assigned to this part name.
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Cartesian Mesh Type

This option will generate a Cartesian mesh using a top-down meshing approach. The mesher works
by continuously refining the initial grid in a binary fashion in each dimension, and eliminating the
non-volume cells, up to the specified maximum refinement. The Cartesian mesher does not require
an existing surface mesh and will ignore meshing parameters defined to control local surfaces. The
mesh will be refined until the finest cell size does not exceed the Max element size specified in
Global Mesh Setup or the Surface Mesh setup.

Body-Fitted Mesh Method

Body-Fitted Mesh Method

This option creates unstructured hexa mesh based on Cartesian mesh and fits it to the geometry.
This works for both CAD and STL geometries. The mesher can handle "dirty" geometries as long
as the Max element size is larger than the gap size.

Note:

The max element size should be smaller than the thickness of the model.

Figure 303: Handling of Gaps in the Geometry (p. 405) shows an example where the gap in the
geometry is ignored by the body-fitted mesh method.

Figure 303: Handling of Gaps in the Geometry

Volume Part Name

allows you to select from the list of existing volume parts, select a part from the screen, or
supply a new name. The inherited option will use the material points in the geometry to de-
termine the part name for each region. The created mesh will be assigned to this part name.
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Enforce Split

These options allow you to use a pre-existing Cartesian mesh as the basis for the body-fitted
Cartesian algorithm. This Cartesian mesh can be created elsewhere or can be created from
Ansys ICEM CFD Hexa Blocking. It can include biasing and various aspect ratios. It can also
be aligned with various features of the geometry.

None

does not enforce a pre-existing Cartesian mesh, but rather creates a Cartesian mesh
within the BFCart algorithm. This background mesh may have a given aspect ratio and
may be aligned with the LCS. These options are controlled by the Global Mesh Parameters
for BFCart.

Figure 304: BFCart Mesh Generated Using the None Option (p. 406) shows an example
where this option has been used.

Figure 304: BFCart Mesh Generated Using the None Option

Initial

In order to body fit, the BFCart algorithm must take the inverse of the Cartesian mesh.
The end result of the process is that the nodes of the original Cartesian mesh become
the centers of the resulting mesh. The split lines of the original mesh end up between
the split lines of the final mesh.

Figure 305: BFCart Mesh Generated Using the Initial Option (p. 407) shows an example
where this option has been used.
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Figure 305: BFCart Mesh Generated Using the Initial Option

Final

With the Final option, the supplied Cartesian mesh is inverted before the rest of the
process begins so that the later body fitting inversion changes it back and the final grid
can line up with the original. Due to internal complexities, this only works if the "uniform"
Cartesian mesh is used. It does not work for 2 to 1 hanging node Cartesian mesh.

Figure 306: BFCart Mesh Generated Using the Final Option (p. 407) shows an example
where this option has been used.

Figure 306: BFCart Mesh Generated Using the Final Option

Cartesian file

specifies the Cartesian grid file to be used when starting from an existing Cartesian
grid file rather than generating one based on the mesh parameters of the current
model. When used in conjunction with the File > Blocking > Write Cartesian Grid
option to export a block file as a Cartesian grid, you will be able to use block splits
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and edge parameters to control Cartesian bunching, distribution and aspect ratio.
The imported mesh is used as the starting point before body fitting takes place.

Key-Points

The Key-Points option can be used to align the body-fitted Cartesian mesh with corner
points. Behind the scenes, this uses Key-Point blocking to create a Cartesian file aligned
with the points and then uses the Final option with that file to align the Cartesian splits
with the points. This option is useful for models having features aligned in Cartesian dir-
ections. An example of a circuit board is shown in Figure 307: BFCart Mesh Generated
Using Key-Points (p. 408) with several features aligned in the Cartesian directions.

Figure 307: BFCart Mesh Generated Using Key-Points

Tolerance

specifies the minimum distance between adjacent grid lines. The default value is 0.0.
If the default value is used, the tolerance will be computed internally based on the
minimum entity dimension.

Inflation

contains options for growing the body fitting inflation layer.

Defined

grows the inflation layer on the parts for which the prism option is enabled in the Part
Mesh Setup dialog. The setting works as an on/off toggle. The other Part Mesh Setup
options for prisms, including initial "height", "ratio" and number of layers ("width"), are
not yet used for BFCart inflation.

All

grows the inflation layer on all parts.

None

does not grow the inflation layer regardless of the settings in the Part Mesh Setup dialog.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.408

Mesh



Figure 308: Selective Inflation for the Body-Fitted Cartesian Mesh (p. 409) shows the inflation
options available for the Body-Fitted Cartesian mesh generated for a sphere with a gap.

Figure 308: Selective Inflation for the Body-Fitted Cartesian Mesh

(A) Inflate Parts set to None — The mesh quality is poor as the stair step mesh is projected
to the round surfaces of the sphere.

(B) Inflate Parts set to All — All parts are inflated, including the flat surface in the gap. The
mesh quality is not as good as it could be due to miter elements generated in some corners.

(C) Inflate Parts set to Defined — Only the sphere surfaces are inflated, while the gap surface
part is not inflated. The inflation from the curved walls runs into the gap and gives the best
resulting quality. On the left of the gap, the inflated hexas are split propagated to give better
boundary resolution.

Compute Prism Mesh

 Generates prism inflation layers into the volume mesh to resolve boundary layer effects efficiently.
Existing tetra mesh is restructured to maintain proper connectivity and quality. The prism layers are
typically orthonormal to the viscous wall boundaries. The prism meshing parameters can be specified
under Global Mesh Setup > Prism Meshing Parameters (p. 345), Part Mesh Setup (p. 371), Surface Mesh
Setup (p. 376), and/or Curve Mesh Setup (p. 378).
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Input

allows you to select the mesh in which the prism inflation layers will be generated.

• Existing Mesh

creates prism mesh in the existing mesh.

• From File

runs the Prism Mesher in batch mode from an existing mesh (*.uns) file. Enter the name of the
file or browse the file manager.

Select Parts for Prism Layers

allows you to define the parameters of prism layers for different parts.

Figure 309: Select Parts for Prism Layer

Select the parts on which prism layers will be grown. Volume, surface and/or curve parts can be
selected. If there are multiple volume parts and none have the prism option enabled, then prism
mesh will grow from the selected surface parts into the adjacent volumes. If only certain volume
parts have prism enabled, then prism mesh will be grown into only those volume parts.

For each selected part, these locally-set values will affect prism growth: Height, Height Ratio,
Num Layers, Prism height limit factor, and Prism growth law. If parameters are not set locally,
then the global settings will be applied. A full description of these parameters is found under
Mesh > Global Mesh Setup > Global Prism Settings (p. 346).

Ansys ICEM CFD supports both pre-inflation (Fluent meshing) or post-inflation prism growth.
These processes are described in Prism Mesh Process. The decision for which process to use is
made in the Compute Mesh DEZ.

For 3D, the prisms are grown from the shell (tri or quad) elements of each part. This can be done
with or without a volume mesh, but having a tetra volume mesh during prism growth helps with
collision avoidance and ensures that you will have a volume mesh after prism generation is
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complete. For 2D, the prisms are grown from the curve parts into the selected surface parts (must
be selected). The 2D prism only works if Advanced Prism Meshing Parameters > Blayer 2D (p. 361)
is enabled.

Note:

• You can compute a prism mesh using the ICEM CFD post inflation method without
an input geometry loaded. Prism will generate a temporary faceted surface model
from the input mesh. The pre inflation (Fluent Meshing) method requires geometry
to determine growth direction.

• Different prism heights can be specified on adjacent parts, though a transition region
with unspecified height is required in between these parts.

• If a surface part separates two or more volume parts, select the volume parts on the
side of the surface you want to grow the prisms. If you select both sides, prisms will
grow in both directions from the surface part. If you want different prism properties
on either side of a surface grown into 2 volumes, do one at a time (run prism iterat-
ively).

• If adjacent tri-element parts have heights that differ by more than a factor of 2, the
prism mesher may fail (this limit is controlled in the Advanced Prism Meshing
Parameters). Not setting a height for Prism, (here or in the Global Prism Parameters
DEZ) will allow the height to float. You can also allow the height to float globally
and set specific initial heights per part or on an entity by entity basis.

Inflation Method

Select the appropriate prism growth process.

• Pre Inflation (Fluent Meshing) creates prism layers from a valid surface mesh before com-
puting the volume fill.

• Post Inflation (ICEM CFD) Prism replaces computed volume mesh near the surface with
prism layers.

Create Fluent Mesh with Hexa-Core

The Delaunay algorithm is used to fill the gap between the hexa core elements and the surrounding
shell mesh or prism layer with conformal tetra and pyramid elements. This option is available only
when using Pre Inflation.

Run interactive Fluent Meshing

imports the mesh and settings but the journal macros need to be run interactively. Recommended
for expert users only. This option is available only when using Pre Inflation.

Volume Part Name

allows you to select from the list of existing volume parts, select a part from the screen, or supply
a new name. The created mesh will be assigned to this part name. This option is available only
when using Pre Inflation.
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If you select inherited, the mesher will place the volume element into the same part as an existing
material point. For this method, the existing material point name will be used, but without its
specific location. This option works well for models with only one material point. For more advanced
models, such as conjugate heat transfer models or models with sections of porous media, you
should enable the Flood fill after completion option (available in the Fluent Meshing (p. 337)
mesh method options) to use each material point with its location to determine the volume mesh
part names for each region.

Frozen volume mesh parts

allows you to select parts that will not be remeshed when using the Fluent Meshing option. This
is useful, for example, to preserve one or more meshed regions while remeshing others. This option
is available only when using Pre Inflation.

Note:

• Parts to be remeshed require a volume mesh. A surface mesh and material point is
not sufficient.

• If remeshing a tet mesh region next to a frozen hex mesh, the tet mesh will be
connected to the hex mesh using pyramids. Inflation layers will connect to the hexas,
if possible.

Load mesh after completion

if disabled, the mesh file will not be loaded into the GUI. This may be useful for big models.
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Blocking
Figure 310: Blocking Menu

The Blocking tab contains the following options to create blocking over any geometry.

Create Block

Split Block

Merge Vertices

Edit Block

Associate

Move Vertex

Transform Blocks

Edit Edge

Pre-Mesh Params

Pre-Mesh Quality

Pre-Mesh Smooth

Block Checks

Delete Block

Create Block

The Create Block option establishes new blocking.

Figure 311: Create Block Options

The following options are available for creating blocks:
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Initialize Blocks

From Vertices/Faces

Extrude Face

2D to 3D Blocks

3D to 2D

Note:

If a blocking file is not loaded, then only the first option, Initialize Blocks, will be active. If
a blocking file is already loaded, then all the options will be active.

Inherit Part Name

when enabled, the created blocks will inherit their part name from the entities they were created
from. When initializing 2D surface blocking (p. 416), the part name can be inherited from underlying
surface parts. For other blocking operations, such as Extrude Face (p. 433) or 2D to 3D (p. 435)), which
start from an existing blocking, the part name of the new blocks is inherited from the blocks they
were created from. If this option is disabled, all blocks will be in the part name specified in the drop-
down list at the top of the Create Block DEZ.

Note:

Mesh created within each block will belong to the same part as its block. This part name
is also used to tag the elements on export and is useful for assigning material (or zone)
properties in the solver.

Initialize Blocks

The Initialize Blocks option allows you to initialize blocks with the following options:

3D Bounding Box

allows you to create a 3D block enclosing the selected entities. If no entities are selected, the
block will encompass the entire geometry.

Ansys ICEM CFD Hexa blocking is typically done in a top down method that starts from a single
large block which is subdivided down to create the topology. Initializing this 3D bounding box
is the first step.
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Note:

Not selecting any entities is more efficient, particularly for scripting, if you intend to
block the geometry extents.

Project vertices

when enabled, the initial block vertices will be moved to the nearest locations on the geometry.

Orient with geometry

attempts to find the best fit of the geometry in any orientation, and to create the smallest
block possible around the geometry selected.

2D Blocking

enables the creation of a surface blocking composed of six 2D face blocks forming a box
around the geometry.

Initialize with settings

allows you to use the user-defined settings set in the Hexa/Mixed Meshing Options DEZ
(Settings > Meshing Options > Hexa/Mixed) and saved under .aienv_options for block
initialization. For example, you can set the default bunching ratio to 1.2 and the multigrid
level to 3 and save the settings. Future block initialization with the Initialize with settings
option enabled will use these settings as default.

This option is enabled by default.
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2D Surface Blocking

Creates 2D surface blocking based on input. This 2D surface blocking can be used to create a
shell mesh, or as a precursor to the 2D to 3D operation to create 3D MultiZone blocks or to ex-
trude/rotate the 2D blocks into 3D blocks.

When Inherit Part Name is enabled, the part name will be inherited from the underlying surface
parts.

Note:

If surface mesh sizes (max size, height, and height ratio) have been previously set, they
will be used to calculate the distributions for the blocking edges.

2D Surface Blocking can be initialized from either Surface or Curve geometry:

From Surfaces

Select specific surfaces for initializing 2D surface blocking. If none are selected, all surfaces
will be initialized. In general, a 2D block is created for each surface, but some sliver faces may
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be skipped if they are smaller than the ignore size, or faces may be skipped if using options
for Merge blocks across curves.

Note:

Geometry topology information is required to establish connectivity between the
blocks. You can check topology by right-clicking on Curves in the model tree and
enabling the Color by Count option. Make sure that you have double edges (red
curves) between surfaces that you want connected. Single edges (yellow curves)
may indicate a gap between surfaces. Build diagnostic topology (p. 284) if necessary.

From Curves

Select specific curves for initializing free 2D surface blocking. One 2D surface block is created
from the selected set of curves.

This option may be useful to build an intricate surface blocking from multiple simpler profiles,
with the ultimate intent of extruding the 2D blocking.

Tip:

This process expects the curves to be approximately planar. For severely non-planar
curves, use ICEM CFD Quad as the Free Face Mesh Method.

Surface Blocking

Whether initialized from Surfaces or from Curves, set the Surface Blocking Method, Free Face
Mesh Type, and Free Face Mesh Method.

Method

specifies the surface blocking method. The following options are available:

Note:

Blocks can be converted between free and mapped blocks using Edit Block >
Convert Block Type.

Free

creates all free (unstructured) 2D blocks. Unstructured blocks can have any number
of sides, and have a different number of nodes on opposite sides, with a resulting
nonuniform element pattern. The mesh inside free blocks is paved (recursive loop al-
gorithm) and can be all quad, quad dominant, quad with one tri, or all tri.

Note:

The default mesh type that will be used is defined under Settings >
Meshing > Hexa/Mixed > Unstruct face mesh type. You can override the
default setting by changing the mesh type in the Free Mesh Type list. After
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the 2D Surface Blocking is generated, you can modify the mesh type for
any particular Free block using the Blocking > Edit Block > Convert Block
Type option.

Some mapped

maps surface patches with 4 corners (possibly more sides). A mapped surface has
matching numbers of nodes on opposite sides. The mesh is "mapped" across to the
opposite side of the block and is always quad surfaced mesh. Remaining surfaces with
more or less than 4 corners are blocked with "free" blocks as above.

Mostly mapped

tries to subdivide surface patches with more or less than 4 corners into mappable
patches. For instance, a 3 cornered surface is divided into a quarter Ogrid (Y-Block)
pattern. A half circle is divided into a half Ogrid (C-Block) pattern, other arbitrary shapes
are simply divided. Other surface patches with 4 corners are also mapped. Any remain-
ing patches or sections of patches which still cannot be mapped (more or less than
4 corners) are blocked with "free" blocks as above.

Figure 312: Surface Blocking Methods (p. 418) shows the Free, Some mapped, and
Mostly mapped surface blocking methods.

Figure 312: Surface Blocking Methods

Swept

creates surface blocks in preparation for the 2D to 3D Fill > Swept operation. Sides
of sweepable bodies are mapped, sources are free or mapped and copied to the targets.
This method can handle multiple sources and targets.

Swept Surfaces

This option is available only for the Swept Method. Select all the source and target
surfaces (multiple sources and targets are supported). If it is easier, select all surfaces
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involved (sources, targets, sides). If you intend to sweep everything, do not select
surfaces at all and everything will be selected.

Figure 313: Surface Blocking-Swept (p. 419) shows the swept surface blocking. In this
case, geometry topology was built between the two parts so that the sweep could
pass through both parts.

Figure 313: Surface Blocking-Swept

Note:

The 2D Surface blocking is automatically imprinted to deal with multiple
source and target situations.

Note:

As with all the 2D surface blocking methods, geometry connectivity trans-
lates into blocking connectivity, so make sure to check topology.

Free Face Mesh Type

specifies the type of mesh for the free blocks. The following options are available:

All Tri

All Quad

Quad Dominant

Quad w/one Tri

Free Face Mesh Method

specifies the process for meshing free faces. The following options are available:

ICEM CFD Quad - method is based on a recursive loop-splitting algorithm.

Gambit Pave - method is based on the Gambit paving advancing front algorithm.
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Auto - method lets the program determine the method based on size and curvature.

Merge blocks across curves

By default, surface patches are defined by each surface. However, surfaces can be combined
to improve the blocking or prevent slivers. This is controlled or limited by dormant curves or
the Ignore size tolerance.

Behind the scenes, a "loop" is formed around the perimeter of each surface. If two blocks are
merged across a curve, the loops on either side are simply replaced by a loop that includes
the perimeters of the 2 surfaces combined. The geometry (curves and surfaces) is unaffected
by the operation.

Method

All

will merge a sliver surface with its larger neighbor if the characteristic edge length is
less than the tolerance.

Respect non-dormant

will not merge if the curve between the surfaces is not dormant. This does not mean
it will force a merge if the curve is dormant. Tolerance still determines the merge.

None

will not merge based on tolerance.

Merge dormant

will merge across dormant curves regardless of tolerance.

Note:

To make a curve dormant, delete without the Delete Permanently option.
The Build Topology → Filter curves option will also make curves dormant
based on a feature angle. To restore a dormant curve, use the Geometry
→ Restore dormant entities option. To view dormant curves, right-click
Curves in the model tree and enable Show Dormant.

Note:

After creating the 2D blocking, the Edit Block > Merge Blocks option can be
used to achieve a similar result.
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Ignore size

specifies the tolerance that Merge blocks across curves uses to determine whether to
merge sliver blocks to the adjacent block. The sliver block's distance across the thin edge
must be smaller than this value for the block to be merged to the adjacent block.

Note:

These parameters apply only when From Surfaces method is selected.

Initialize with settings

allows you to use the user-defined settings set in the Hexa/Mixed Meshing Options DEZ
(Settings > Meshing Options > Hexa/Mixed) and saved under .aienv_options for block
initialization. For details, refer to Initialize with settings (p. 415) described above.

Note:

These parameters apply only when From Surfaces method is selected.

2D Planar

allows you to create a 2D Planar block in the XY plane fitting around the entire geometry. 2D
planar blocking is intended to work in the XY plane, and moving it to another orientation will
make it difficult to position internal vertices. It is better to rotate your geometry to the XY plane
where Z=0.

Initialize with settings

allows you to use the user-defined settings set in the Hexa/Mixed Meshing Options DEZ
(Settings > Meshing Options > Hexa/Mixed) and saved under .aienv_options for block
initialization. For details, refer to Initialize with settings (p. 415) described above.

3D Multizone

An automated method to create 3D blocking using the sequential operations of 2D Surface
Blocking followed by 3D Fill. The volume is decomposed into a combination of mapped, swept
and free blocks. Source imprint surfaces and Mapped/Swept Decomposition options affect how
the volume is decomposed and can aid with sweeping, etc.

Important:

MultiZone requires body information to run.
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• If importing geometry using Import Model (p. 18), the body information already
exists. Use Geometry → Create Body → By Topology to visualize the material
point(s) in the bodies. See By Topology (p. 265).

• If a geometry was created in ICEM CFD or imported using another option, you
should ensure that the topology information is complete (see Build Topo-
logy (p. 284)). You can create the material point(s) using Geometry → Create
Body, and select either By Material Point or By Topology. See Create
Body (p. 264).

When creating 3D MultiZone blocking on models with multiple bodies, the blocks of the different
bodies will be put into different Parts, starting with the Part name defined (default is CREATED_MA-
TERIAL_1), and incremented for each body.

Note:

If your geometry contains an internal surface, perform the following steps before ini-
tializing the blocking:

1. Create a new Part containing only the internal surface.

2. Set the new part as an Internal wall in the Part Mesh Setup dialog box.

Source Imprint Surfaces

Select faces to be used to imprint feature edges in the initial 2D surface blocking.

In the MultiZone decomposition process, the source faces define the path for sweeping,
leaving the other faces to be treated as side faces. Then, in trying to create as many swept
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blocks as possible, the software tries harder to make non-source faces mapped and source
faces free. All source faces must be properly matched with other source faces. If source faces
cannot be properly paired, the software will not be able to create as many swept or mapped
blocks, resulting in free block(s).

Swept Mesh Type

Select the shape of elements supported in the structured regions.

Hexa

(Default). Supports an all hexahedral mesh, extruded from quad surface elements, for the
3D fill mesh.

Hexa/Prism

Supports a hexahedral dominant mesh, with prisms extruded from quad and triangle
surface elements, for the 3D fill mesh.

Prism

Supports a prism mesh, with prisms extruded from triangular surface elements, for the
3D fill mesh.

3D Free Mesh Type

Select the shape of elements supported in unstructured regions when it is not possible to
generate a pure hex or hex/prism mesh without slicing.

Tetra

Regions of the model that cannot be blocked to support a mapped mesh will be filled
with tetrahedral elements extruded from all triangular faces.

Tetra/Pyramid

Regions of the model that cannot be blocked to support a mapped mesh will be filled
with tetrahedral elements in the core, transitioning to pyramid elements, extruded from
quad faces at the surface.

Hexa Dominant

Regions of the model that cannot be blocked to support a mapped mesh will be filled
primarily with hexahedral elements, transitioning to pyramids and tets as needed.

Hexa Core

Regions of the model that cannot be blocked to support a mapped mesh will be filled
primarily with an array of hexahedral elements aligned to the Cartesian coordinate system.
This is connected to the remainder of the free prism/tetra hybrid mesh by automatic cre-
ation of pyramids.

Hexa Core allows for a reduction in the number of elements for quicker solver run time
and better convergence.
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Mapped/Swept Decomposition

Select a strategy for how to decompose the volume into mapped, swept and free blocks.

None

Decomposition is not allowed, resulting in one free 3D block with all faces also being free.

Standard

(Default) Software tries to create mapped, then swept, then free blocks as possible. For
models that are sweepable, all blocks that are created should be mapped and/or swept.
Selecting source imprint surfaces may be necessary for these cases. For models where the
decomposition is not straight-forward, free blocks with a combination of free and mapped
faces will be created.

Aggressive

Very similar to Standard, but the software tries to generate more mapped faces in the
process. For some cases this could help create more mapped or swept blocks. In other
cases it may not help with the decomposition, but may result in more mapped faces at-
tached to free blocks.

Free Face Mesh Method

Select the method for generating the 2D mesh on surfaces and areas that are free meshed.

Default

Automatically uses a combination of Uniform and Pave mesh methods depending on the
mesh sizes set and face properties.

Uniform

Uses a recursive loop-splitting method to create a highly uniform surface mesh.

This is a good option when all edges have the same sizing and the faces being meshed
do not have a high degree of curvature. The resulting mesh orthogonality is generally
very good.

Pave

This is a more reliable method to create an all-quad mesh on faces with high curvature,
and also when neighboring edges have a high aspect ratio.

Merge blocks across curves

By default, surface patches are defined by each surface. However, surfaces can be combined
to improve the blocking or prevent slivers. This is controlled or limited by dormant curves or
the Ignore size tolerance.

Behind the scenes, a "loop" is formed around the perimeter of each surface. If two blocks are
merged across a curve, the loops on either side are simply replaced by a loop that includes
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the perimeters of the 2 surfaces combined. The geometry (curves and surfaces) is unaffected
by the operation.

Method

All

will merge a sliver surface with its larger neighbor if the characteristic edge length is
less than the tolerance.

Respect non-dormant

will not merge if the curve between the surfaces is not dormant. This does not mean
it will force a merge if the curve is dormant. Tolerance still determines the merge.

None

will not merge based on tolerance.

Merge dormant

will merge across dormant curves regardless of tolerance.

Note:

To make a curve dormant, delete without the Delete Permanently option.
The Build Topology → Filter curves option will also make curves dormant
based on a feature angle. To restore a dormant curve, use the Geometry
→ Restore dormant entities option. To view dormant curves, right-click
Curves in the model tree and enable Show Dormant.

Ignore size

specifies the tolerance that Merge blocks across curves uses to determine whether to
merge sliver blocks to the adjacent block. The sliver block's distance across the thin edge
must be smaller than this value for the block to be merged to the adjacent block.

Initialize with settings

allows you to use the user-defined settings set in the Hexa/Mixed Meshing Options DEZ
(Settings > Meshing Options > Hexa/Mixed) and saved under .aienv_options for block
initialization. For details, refer to Initialize with settings (p. 415) described above.

From Vertices/Faces

The From Vertices/Faces option allows you to create blocks from vertices or faces in either 2D
or 3D. The available options are described in the following sections:

3D Blocks

2D Blocks
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3D Blocks

The following 3D block types can be created:

Mapped

allows you to create 3D mapped (structured) blocks by specifying the vertices, edges or faces
of adjacent blocks.

Select a Method and specify the blocking features (faces, edges or vertices) by clicking or by
manual entry.

Corners

Select eight vertices (or locations) as shown in Figure 314: Selection of Vertices/Locations
for Mapped Block Creation (p. 426) to create 3D mapped blocks.

Figure 314: Selection of Vertices/Locations for Mapped Block Creation

While selecting a combination of vertices and locations:

1. First select the vertices to be used, ensuring that the order of selection is appropriate.

2. Click the middle-mouse button to confirm the selection of the vertices.

3. Select the remaining locations on the geometry (not necessarily points) to complete
the selection of 8 vertices/locations.

Edges

Select four edges to create a new 3D mapped block. Order of selection is important (Z-
pattern) to avoid block errors.
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Figure 315: Selection of Edges for Mapped Block Creation

Faces

Select faces of adjacent blocks as shown in Figure 316: Selection of Faces for Mapped Block
Creation (p. 427) to create a new 3D mapped block.

Note:

The selected faces must be mapped. Other types will generate a warning mes-
sage.

Figure 316: Selection of Faces for Mapped Block Creation

Swept

allows you to create a swept block by selecting corners, edges or faces of adjacent blocks.

Select a Method and specify the blocking features (faces, edges or vertices) by clicking or by
manual entry.

Corners

Select six or more vertices in order (different than for mapped block creation). In the example
shown, eight vertices are selected as endpoints of four edges in a U-pattern.
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Figure 317: Selection of Vertices for Swept Block Creation

Edges

Select three or more edges, in order (different than for mapped block creation). In the ex-
ample shown, four edges are selected in a U-pattern to form the edges of a swept block.

Figure 318: Selection of Edges for Swept Block Creation

Faces

Select two faces to create a 3D swept block.

Note:

This operation converts mapped blocks to swept blocks. If there is a swept or free
block included in the blocks that are to be converted, there may be an error.

Quarter Ogrid

allows you to create the advanced topology known as a Y-Block or Quarter Ogrid. This topology
is used to fit three Hexa Blocks into a wedge. Select six vertices/locations as shown in Fig-
ure 319: Selection of Vertices/Locations for Quarter Ogrid (p. 429) to create the Quarter Ogrid.
The three vertices of one side of the wedge must be selected first, in clockwise or counter
clockwise order. Then the remaining three vertices can be selected. It is important that the 4th
vertex selected should be connected to the 1st, 5th to the 2nd and 6th to the 3rd respectively.
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Figure 319: Selection of Vertices/Locations for Quarter Ogrid

Figure 320: Quarter Ogrid Created

While selecting a combination of vertices and locations:

1. First select the vertices to be used, ensuring that the order of selection is appropriate.

2. Click the middle-mouse button to confirm the selection of the vertices.

3. Select the remaining locations on the geometry (not necessarily points) to complete
the selection of 6 vertices/locations.

Degenerate

allows you to create a degenerate block which is a prismatic block with 5 sides. Previously,
these could only be created by collapsing one side of a hexa block to create a wedge. The
bottom up creation follows the exact same method as the Quarter Ogrid (Y-Block) creation.
However, only one block is created and there will be a row of prism elements along one edge.
Many solvers can not handle this type of blocking, so be sure to consult your solver manual
before using degenerate blocks.

Select six vertices/locations as shown in Figure 321: Selection of Vertices/Locations for Degenerate
Block (p. 430) to create the Degenerate block. The 4th vertex selected should correlate to the
1st, the 5th to the 2nd, and the 6th to the 3rd.
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Figure 321: Selection of Vertices/Locations for Degenerate Block

Figure 322: Degenerate Block Created

While selecting a combination of vertices and locations:

1. First select the vertices to be used, ensuring that the order of selection is appropriate.

2. Click the middle-mouse button to confirm the selection of the vertices.

3. Select the remaining locations on the geometry (not necessarily points) to complete
the selection of 6 vertices/locations.

Sheet

allows you to create a structured sheet block from 4 vertices. The vertices should be selected
in the order of a Z pattern (shown in Figure 323: Selecting Vertices/Locations for a Sheet
Block (p. 431)). Click the middle mouse button to confirm the selection of the vertices.
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Figure 323: Selecting Vertices/Locations for a Sheet Block

Free-Sheet

allows you to create a free sheet block from 4 vertices.

2D Blocks

Note:

The 2D Blocks option allows you to create a block for a 2D blocking only. To create a
2D (sheet) block with a 3D blocking, even if the only 3D block is unstructured, you need
to use the Sheet (p. 430) option described in the 3D Blocks (p. 426) section.

The following 2D block types can be created from vertices:

Mapped

allows you to create 2D blocks from any four specified vertices or locations.

In Figure 324: Selection of Vertices for 2D Mapped Block (p. 431), four vertices are selected to
create a mapped block.

Figure 324: Selection of Vertices for 2D Mapped Block
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Figure 325: Mapped Block Created

While selecting a combination of vertices and locations:

1. First select the vertices to be used, ensuring that the order of selection is appropriate.

2. Click the middle-mouse button to confirm the selection of the vertices.

3. Select the remaining locations on the geometry (not necessarily points) to complete
the selection of 4 vertices/locations.

In Figure 326: Selection of Vertices and Locations for 2D Mapped Block (p. 432), a mapped block
is created from two vertices and two locations.

Figure 326: Selection of Vertices and Locations for 2D Mapped Block

Figure 327: Mapped Block Created
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Free

allows you to create a free block using the selected vertices.

Extrude Face

The Extrude Face option is used to extend 3D blocking by pulling one or more faces A new 3D
block, or blocks, is created alongside the existing block.

The following methods can be used to define the extent of the extruded block faces.

Interactive

Fixed Distance

Extrude Along Curve

Interactive

Select the face(s) to be extruded with the left mouse button and then press the middle mouse
button and drag to interactively extrude the face(s). When Inherit Part Name is enabled, the new
extruded block inherits the part of the adjacent volume block (is in the same blocking material).

Use the No projection option (default is enabled) for extruding faces when there is no geometry
target. If extruding to an existing geometry target, disable this option.

Note:

The Interactive method supports only mapped faces for selection. Other types will
generate a warning message.
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Fixed Distance

Select the face to be extruded and specify the distance for normal extrusion. When Inherit Part
Name is enabled, the new extruded block inherits the part of the adjacent volume block (is in the
same blocking material).

Use the No projection option (default is enabled) for extruding faces when there is no geometry
target. If extruding to an existing geometry target, disable this option.

The face selection and extrusion of the block is shown in Figure 328: Face Selected for Extrusion
by Fixed Distance (p. 434) and Figure 329: Extrusion Completed (p. 434).

Figure 328: Face Selected for Extrusion by Fixed Distance

Figure 329: Extrusion Completed

Extrude Along Curve

Select the face to be extruded, the curve along which the extrusion is to occur, and the end point
of the curve. When Inherit Part Name is enabled, the new extruded block inherits the part of the
adjacent volume block (is in the same blocking material). The face selection and extrusion of the
block is shown in Figure 330: Face and Curve Selected for Extrusion Along Curve (p. 435) and Fig-
ure 331: Extrusion Completed (p. 435).
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Figure 330: Face and Curve Selected for Extrusion Along Curve

Figure 331: Extrusion Completed

2D to 3D Blocks

The 2D to 3D option allows you to convert 2D or surface blocking to 3D. The following options
are available:

MultiZone Fill

The MultiZone Fill option converts surface blocking into 3D blocking. This requires a closed
volume(s) of structured and/or unstructured surface blocks. It can produce a structured blocking
if all the surface blocks are structured 4 sided blocks, otherwise unstructured or swept blocks may
result.

Figure 332: 2D Blocking – Before Fill
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Figure 333: After Fill – 3D Blocking

The following options are available for the MultiZone Fill Method.

Create Ogrid around faces

allows you to add Ogrid layers on the selected parts.

Note:

When using this method for blocking a model with a floating internal volume, this
method has difficulty connecting the internal and external volumes and the internal
volume may merely be superimposed within the outer volume. Splitting the model
with a connecting plane will allow a topological connection and solve this problem.

Surface Parts

allows the selected parts to be marked for Ogrid layer creation. These parts can be default
selected by setting prism parameters in the Part Mesh Setup parameters menu. The other
prism settings such as initial height, ratio and number of layers can also be set. You can then
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either accept the default selection here or add/remove parts as desired. The number of layers
will be constant throughout a boundary layer, but varying the initial height will affect the
total height above those surfaces.

Offset distance

specifies the height of the Ogrid boundary layer calculated from the Part Mesh Setup para-
meters for height, ratio, and number of layers set for individual parts. If the Part Mesh Setup
parameters are not set, the offset distance will be calculated from the Global Prism Paramet-
ers. The value displayed is the average height calculated, however, the Ogrid boundary layer
will be created based on the offset calculated for each individual part. For example, in Fig-
ure 334: Variable Ogrid Height (p. 437), the initial height on the highlighted surface was set to
half the height of the other surfaces.

Figure 334: Variable Ogrid Height

If you override this calculated height, it will apply to the entire Ogrid. It will prioritize the initial
height and ratio and adjust the number of layers to fit the user-specified total height.

Note:

The number of layers must be constant for the entire Ogrid layer, if you set varying
numbers of layers, the greatest will be used.

Note:

The variable Ogrid height affects the initial Ogrid generation to make the process
more automatic but Multi-zone builds an editable blocking with flexible vertices.
So, any edge length, including Ogrid heights, can easily be changed interactively.
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Fill Type

Simple

creates a simple free block or volume region. This saves time on complex models by not
attempting to decompose the volume into mapped or swept blocks. This is recommended
for external aerodynamics applications.

Swept

uses algorithms which resolve swept configurations better.

Advanced

uses algorithms which can decompose the volume into a combination of mapped, swept
and unstructured blocks. It automatically imprints free faces to aid with sweeping, etc.
This will give a result similar to the Multi-zone Method found in Ansys Meshing. Some
work decomposing the geometry or surface blocking beforehand can improve the results.

Note:

Behind the scenes several possible algorithms are run to create the 3D blocking.
One such algorithm is similar to converting each surface block into one element,
with Mapped blocks converted into quads; then in an operation similar to the
Hex dominant mesher, the volume is filled with hexa elements. If this is success-
ful, then these are converted back into 3D blocking to replace the original 2D
surface blocking. Other algorithms use the mapped side mesh to guide the
sweeping of unstructured faces into swept blocks (similar to the Cooper tool).
Any remaining volumes are simply declared as unstructured blocks and can be
filled with one of the bottom up options, including Tetra, Hexa Core or Hexa
Dominant mesh.

Translate

allows you to specify the X, Y and Z distance to extrude the 2D Block. When Inherit Part Name
is enabled, the 3D block inherits the blocking material (part) of the original 2D block.

Unstructured 2D blocks will be converted to Swept blocks on translation.
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Rotate

allows you to extrude a 2D Block by rotation. When Inherit Part Name is enabled, the 3D block
inherits the blocking material (part) of the original 2D block.

Unstructured 2D blocks will be converted to Swept blocks on rotation. Degenerate (axis-collapsed)
swept blocks can also be handled. The degenerate 7–node hexa elements on the axis can be
converted to regular elements using the Write 7–node-hexas as pyramids option in the
Hexa/Mixed Meshing Options DEZ (see Hexa Meshing (p. 100)).
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Figure 335: 2D to 3D Rotate for a 2D Unstructured Block (p. 440) shows an example of a 2D unstruc-
tured block extruded using the 2D to 3D rotate option using an Angle of 30 degrees, Number
of copies set to 1, and Points per copy set to 7 as shown in the DEZ above.

Figure 335: 2D to 3D Rotate for a 2D Unstructured Block
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Center of Rotation

specifies the center of rotation. The Origin option allows you to rotate the block in the specified
axis direction about the origin (0,0,0). The User option allows you to rotate the block about
a specified point.

Axis of Rotation

specifies the axis or vector about which to rotate the block.

Angle

specifies the angle of rotation for each block copy.

Number of copies

specifies the number of copies of blocks.

Points per copy

specifies the number of nodes on the extruded edges.

Set Periodic Nodes

defines periodicity at both the geometry and blocking level, and will override any existing
periodicity information set under Global Mesh Setup > Set Up Periodicity (p. 368).

Note:

For periodic nodes, the Angle value must divide 360 degrees an integer number
of times, with zero remainder.
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Collapse Axis Nodes

allows you to collapse all the nodes lying on the axis of rotation.

Extrude points, Extrude curves

when enabled, the original 2D geometry gets converted to 3D as well. Points are extruded
to 3D curves and curves are extruded to 3D surfaces.

Note:

The node to point association must be defined before extrusion in order for points
to be extruded to produce 3D curves. Similarly, the edge to curve association must
be defined for the curves to be extruded to 3D surfaces.

3D to 2D

The 3D to 2D option converts 3D Blocking into 2D Blocking, as shown in Figure 336: 3D Block-
ing (p. 442) and Figure 337: 2D Blocking (p. 442).

Figure 336: 3D Blocking

Figure 337: 2D Blocking
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Split Block

The Split Block option allows you to make multiple blocks from a single block.

The following options are available for splitting blocks:

Split Block

Ogrid Block

Extend Split

Split Face

Split Vertices

Split Free Face

Imprint Face

Split Free Block

Split Block

The Split Block option splits the blocking at the selected edge.

Figure 338: Split Block Options
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Visible

splits only blocks that are visible, where visibility is managed by blanking blocks in the graphical
window or by using the index control.

Selected

splits only the selected blocks.

Copy distribution from nearest parallel edge

copies the edge distribution (initial heights, ratios and bunching law) from the nearest parallel
index to the new edges created by the split operation. This is useful when adding splits to a
blocking after already setting up advanced distributions on existing edges. With this option dis-
abled, the default edge distribution ( Settings > Meshing Options > Hexa/Mixed  (p. 100)) is
used. Parallel node counts are always used when splitting a block.

Project vertices

enables the automatic projection of the new vertices to the underlying geometry.

Move O-Grid nodes

moves internal nodes (that are not projecting) which are attached via an Ogrid edge to external
nodes (nodes that are projecting) relative to the projection.

Note:

This option is available only if Project vertices is enabled.

Split at nearest meshed node

causes the split to happen at a given node and propagate with that node to other parallel edges.
Node distribution on the edges on either side of the split is unaffected. Node distribution along
the new split is inherited from the nearest parallel edge.

Split Method

Screen select

allows you to select the position manually where the block is to be split.

Prescribed point

allows you to split the edges through the selected point.

Relative

allows you to split the edge with the given parameter.

Absolute

allows you to split the edge in proportion to the maximum grid length in the edge direction.
Edge direction corresponds to minimum vertices number to maximum vertex number.
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Curve parameter

allows you to split the edge through a selected point on a curve. Select the edge to be split
first, and then the curve at the point through which the split will be placed.

Note:

The Split Block option will only propagate splits through mapped faces, and will
terminate at free faces. For 2D blocking, all mapped blocks attached edge to edge
will be split, but the split will terminate at any free block. For 3D blocking, a split will
propagate through mapped blocks and swept blocks, if the split is along the sweeping
direction. A split in 3D blocking will terminate at free 3D blocks and swept blocks, if
the split is in any direction other than the sweeping direction.

Ogrid Block

The Ogrid Block option allows you to modify a single block or blocks to a 5 sub-block topology
(7 sub-blocks in 3D) as shown below. It arranges grid lines into an "O" shape to reduce skew where
a block corner lies on a continuous curve or surface. There are several variations of the basic Ogrid
generation technique.

Figure 339: Ogrid Demonstration

The Ogrid can be created with or without face selection as shown in Figure 340: Ogrid Creation With
and Without Face Selection (p. 446).
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Figure 340: Ogrid Creation With and Without Face Selection

a) Circular Cylinder

b) Block Inside Cylinder

c) Ogrid created without face selection

d) Ogrid created with face selection

Ogrids can be created or removed by selecting or deselecting Blocks, Faces, Edges, and Vertices.
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Figure 341: Ogrid Creation Options

The following options are also available:

Clear Selected

clears the previously selected entities.

Around block(s)

enables the creation of the Ogrid extending outward from the selected block(s) surfaces.

Offset

specifies the height of the Ogrid layer.

Absolute

when enabled, the value assigned for Offset is the actual length of the radial edge of an Ogrid.
Assigning a Offset of 7 would make all the radial edges of the Ogrid 7 units in length.

When Absolute is disabled, Offset behaves like a relative distance: A value of 1 causes the Hexa
Mesher to place the Ogrid at a location where the resulting blocks will be distorted the least. A
higher value makes the inner blocks of the Ogrid smaller, with the surrounding blocks larger, and
a smaller value makes the inner blocks larger and the surrounding blocks smaller.

Link Shape

when enabled, the internal Ogrid block will be created with all internal edges and faces shaped
by the nearest, corresponding geometry. This can help create a more exact offset of the internal
edges/faces, and help maintain more uniform grid heights in the OGrid region. However, edges
and blocks internal to the OGrid may not be able to smooth away as quickly thereby affecting
the mesh in those regions. That is, if enabled, the mesh quality in the OGrid regions should improve
while the mesh in the internal blocks could get worse, and the overall mesh quality may suffer.
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In Figure 342: Link Shape Example (p. 448), an Ogrid split in a simple cylinder is shown with Pro-
jected mesh shape enabled. The Ogrid in the upper images was created with Link Shape disabled.
In the lower images, Link Shape was enabled.

Figure 342: Link Shape Example

Extend Split

The Extend Split option allows you to extend block splits to a selected edge or to all edges.
You can select specific blocks or all visible blocks to extend the split.
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Figure 343: Extend Split Options

Edge Select

Selected Edge

when selected, allows you to select an edge to extend the split (see Figure 344: Edge Selected
to Extend Split (p. 449) and Figure 345: Block Split Extended to One Edge (p. 449)).

Figure 344: Edge Selected to Extend Split

Figure 345: Block Split Extended to One Edge
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Block Select

contains options for selecting blocks when the Selected Edge option is selected.

Visible

when selected, the split will be extended through all visible blocks.

Selected

when selected, allows you to select specific blocks through which the split will be
extended.

All Edges

when selected, the block split will extend to all the edges (see Figure 346: Block Split Extended
to All Edges (p. 450)).

Figure 346: Block Split Extended to All Edges

Project vertices

enables the automatic projection of the new vertices to the underlying geometry.

Split Face

The Split Face option allows you to split a mapped face at a desired location.

You can use the drop-down list to choose a Selection Method:

Specify Edge

After selecting a face, select the edge where the split will take place. Hold down the left
mouse button to slide the cursor to the desired split location. Release the left mouse button
and press the middle mouse button to accept the location and to complete the face split
operation. This method works for both 2D and 3D blocking.

In the Figure 347: Specify Edge Example (p. 451), one face of a 3D blocking is split. The split
is manually positioned in the middle of the face.
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Figure 347: Specify Edge Example

Automatic

After selecting a face, any available splits are applied immediately. Splits are located where
non-corner nodes exist on edges. This method works for 2D blocking only.

See the Figure 348: Automatic Example (p. 452). Splits are located where adjacent edges inter-
sect edges of your selected face.

Tip:

• The Automatic method supports the selection of multiple faces by utilizing the
corner vertices tool from the selection toolbar.

• If you do not explicitly select any face(s), all existing mapped faces will be selec-
ted.

451
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Split Block



Figure 348: Automatic Example

Note:

The selected face(s) must be mapped. Other types will generate a warning message.

Split Vertices

The Split Vertices option allows you to split a degenerate vertex. This is equivalent to uncollapsing
an edge.

The block and vertex shown in Figure 349: Vertex Selected to Split (p. 452) is the result of collapsing
a single block. Select the appropriate vertex to split, and click Apply to split the vertex as shown in
Figure 350: Split Vertex (p. 453)

Figure 349: Vertex Selected to Split
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Figure 350: Split Vertex

Split Free Face

The Split Free Face option allows you to split the free face of a block, which splits the face into
two free faces. Select either two or four corner vertices, depending on whether you are splitting a
face that can be split by 1 edge or splitting a face with a hole in it where you need 2 edges to split
the face into 2 pieces. A face can not be split by a dangling edge (an edge that would be connected
to the same face on both sides).

For example, you cannot split the top face from the outer perimeter to the inner loop with a single
split defined by two vertices.

To include the inner loop edges in your split, you need to use two edges defined by four vertices.
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Imprint Face

The Imprint Face option includes tools for you to imprint loops of edges from one face onto
block(s) (2D) or face(s) (3D).

Blocks

When a 2D blocking is loaded, this option is used to select the target block(s) to be imprinted.

Target Face(s)

When a 3D blocking is loaded, this option is used to select the target face(s) to be imprinted.

Imprint Edges

selects the source loop of edges to be imprinted.

Imprint Direction

Use the Method drop-down list to choose the direction for imprinting.
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Normal to Face

The default option will generally imprint the face/block using the normal of the imprinted
face. However, for 3D blockings, if the source and target have side faces that directly connect
them, these side faces will be used to compute the normal.

Specify Direction

Sets the direction using the axes of the global coordinate system (X, Y, or Z Direction) or a
user-defined vector.

The vector may be determined by graphical selection of the start and end points or by
manually entering the start and end point coordinates. Syntax for manual entry is {x1 y1 z1}
{x2 y2 z2}. If only one point is specified as {x y z}, the vector start point will be the origin.

An example demonstrating the Imprint Face option with Normal to Face imprint direction is shown
in Figure 351: Use of the Imprint Face Option (p. 455).

Figure 351: Use of the Imprint Face Option

(A) The 2D surface blocking for the geometry

The central block cannot be swept because it has different features on either side.

(B) The 2D surface blocking with the faces imprinted on either side of the central
block

The imprinting process is applied twice - in one instance, select the back face as
the target and the loop of edges at the base of the smaller cylinder as the source;
the front face and edges at the base of the larger cylinder for the other.
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In addition to the simple, single loop imprint shown in the example, ICEM CFD supports the following
loop structures:

• Multiple disconnected loops.

• Multiple nested loops.

• Multiple connected loops.
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• Loops including boundary edges.

Note:

It is possible to select an open loop, as shown. The software searches unselected
edges for a unique closed loop. If a unique closed loop cannot be found, an error
is generated.

Split Free Block

The Split Free Block option allows you to decompose a free block into multiple volumes in a
single operation. You can then convert the split free blocks to structured or swept blocks as required.

Choose from the following Methods:

From Edges
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By imprint

Blend across loops

From Sheets

From Edges

Splits a free block by constructing a single face or several faces from loops of selected edges.

Select the blocking entities using the selection tools for Free Block and Edges. The resulting split
depends on the blocking topology and edge loop selection.

Note:

The split needs to fully separate the block. Hanging faces (baffle face that don't fully
split the block) are not supported.

Nested loops

All edges are chosen in one pass even if the selection contains multiple loops. The edges
should be near planar as a single face is constructed from the selection, creating the split.

The example shown illustrates how the split face includes the selected, planar edges. In
Figure 352: Single Free Block with Holes (p. 458), the initial 3D multizone blocking has been
created and Split Block was used to position edge splits aligned with the holes.

Figure 352: Single Free Block with Holes
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Figure 353: Nested Edge Loops Selected (p. 459) shows the selection of edges necessary to
split the free block.

Figure 353: Nested Edge Loops Selected

The split is completed as shown in Figure 354: New Free Block Created (p. 459). The original
free block has been blanked to better illustrate the new free block.

Figure 354: New Free Block Created

Separated Loops

Selection of edges may contain multiple loops and may be chosen in multiple passes. Indi-
vidual loops are found from the selection and used to create one sheet per loop. The block
is split at these sheets.

The example shown illustrates how the split sheets are created individually at the edge
loops. In Figure 355: Single Free Block showing Connecting Tubes (p. 460), the initial 3D
multizone blocking has been created.
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Figure 355: Single Free Block showing Connecting Tubes

Figure 356: Individual Edge Loops Selected (p. 460) shows the selection of edges necessary
to split the free block.

Figure 356: Individual Edge Loops Selected

The split is completed as shown in Figure 357: New Free Blocks Created (p. 461). The original
free block has been blanked to better illustrate the new free blocks.
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Figure 357: New Free Blocks Created

You can see how one free block can be separated into multiple free blocks in one operation.
This approach is helpful for cases such as this perforated plate example.

By imprint

The By imprint option extends Imprint Face (p. 454) to include splitting the 3D block between
source Edges and Target Face(s). The new, 3D block is converted to mapped (if all faces are mapped
faces) or swept (if the block contains two matching free faces and all others are mapped).

Note:

This option applies to 3D blocks only.

Imprint Direction supports Method options similarly to Imprint Face (p. 454).

Normal to Face

The default option will attempt to imprint source edge(s) by projection along the normal
of the target face. If the source and target have side faces that directly connect them, these
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side faces will be used to compute the normal. The shape for the internal edges created
by the split will be linked to the edges, corresponding to the nearest curves, of the side
faces.

Specify Direction

Allows you to set the imprint direction.

• To align the imprint direction with one of the axes of the global coordinate system,
select X Direction (or Y Direction or Z Direction).

• To align the direction with a user-defined vector, select 2 Point Vector. The start
and end points may be determined by graphical selection or by manually entering
their coordinates. Syntax for manual entry is {x1 y1 z1} {x2 y2 z2}. If only one point
is specified as {x y z}, the vector start point will be the origin.

• To link the direction to a feature, select Split along curve.

The software prompts you to select start and end vertices. If the selected vertices
can be connected over one or more edges of a single block, then the split shape
will be linked to the set of edges.

Figure 358: By imprint example (p. 462) illustrates how to select a free face and two edge-loops to
imprint and split in one operation.

Figure 358: By imprint example

(A) The initial blocking consists of a single block with two extrusions on one side.
The goal is to project the edge loops from the extrusions to the free face on the
back side of the rectangular block.

(B) The selected face and edges are identified.
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The side faces of the new block(s) will be mapped; and the resulting block type
depends on the type of face attached to the edges selected for imprinting. If selected
edges surround a mapped face, the imprint should result in a mapped block. If the
edges surround a free face, the imprint should result in a swept block.

The region surrounding the new blocks will be free or swept depending on the type
of its side faces. If the side faces were mapped, the surrounding region will be a
swept block; free side faces will result in a free block.
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Tip:

If you do not get the expected results, you can adjust the face and block type using
Convert Block Type (p. 481).

Note:

In addition to the simple, internal loops shown in the example, this option supports the
same loop structures as Imprint Face (p. 454).

Blend across loops

Splits a free block by sweeping a face or by projecting a loop of edges through the free block.

Select a Method using the drop-down list:

From Faces
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Creates a block by sweeping the selected source face through the free block to the selected
target face. The vertices of the source face are projected to their nearest counterpart on
the target face.

1st Face

Select a source face for the split operation.

2nd Face

Select a face to identify a target.

Note:

The type of selected faces determines the type of the created block:

• If two mapped faces are selected, the result will be a mapped block.

• If two free faces are selected, the result will be a swept block.

• Mixed selection (free and mapped faces) will generate an error.

An example showing the From Faces option is shown in Figure 359: Use of the From Faces
Option (p. 465).

Figure 359: Use of the From Faces Option

(A) The initial 3D blocking shows a single free block. Features extruded from
the top surface do not have matching edges on the bottom surface.

(B) Imprint Face (p. 454) is used to create a free face on the bottom surface,
below one of the features.
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(C) The newly imprinted face is selected as the 1st Face and the correspond-
ing surface near the top of the model is selected as the 2nd Face.

(D) The split block operation creates a new swept block between the two
selected faces.
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From Edges

Creates a block by sweeping the selected edges in the first loop to the selected edges in
the second loop. Both loops must have the same number of edges.

The order in which the edges are selected is important as a face will be constructed between
each pair of edges. That is, a face will be constructed between the first edge on the first
loop and the first edge of the second loop, another will be constructed between the second
edge of the first loop and the second edge of the second loop, similarly for third edge and
so on.

Note:

The created side faces are mapped. The type of faces containing the edge loops
determines the type of the created block:

• If two mapped faces, the result will be a mapped block.

• If two free faces, the result will be a swept block.

• Mixed (free and mapped) faces will generate an error.

Select the blocking entities using the tools:
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Free Block

Identifies the block to be split.

1st Loop

Select edges, in order, to create a source loop. The loop has to be closed. Open
loops may be closed using the Imprint Face (p. 454) feature or the Split Free
Face (p. 453) feature.

2nd Loop

Select edges, in order, to create a target loop.

An example showing the From Edges option is shown in Figure 360: Use of the From
Edges Option (p. 468).

Figure 360: Use of the From Edges Option

(A) The initial 3D blocking shows a single free block with two hexagonal-
shaped holes on opposite faces. The holes are not the same size and their
edges are not parallel.

(B) After selecting the free block, the edges of the first loop are selected.
Note the start edge and direction of selection.
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(C) The edges of the second loop are selected. The first edge and order of
selection determine the edge association between first and second loops.

(D) The split operation creates a new free block between the two edge
loops.
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From Sheets

The From Sheets option requires that you first create sheet block(s) which will then be used to
split the free block.

The sheet blocks used to split the free block are internal faces which pass through the volume. The
split sheets can be either contiguous or separated by other faces. However, the selected split sheets
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combined with other faces of the free block should split the volume into manifold regions. Only
those sheets which form the closed volume need to be specified.

Note:

• Currently, the sheet faces must be structured. However, other faces of the free
block to be split can be of any type (structured or free). A structured sheet can
be created from 4 vertices or points (see the Sheet (p. 430) option in the 3D
Blocks (p. 426) section).

• Free blocks with multiple shells can be split only if the split sheets connect inner
and outer shell faces. This will result in single shell manifold volumes after the
split.

• Split sheets must be connected to the boundary faces, a rectangular region fully
embedded inside the free block is not supported.

Merge Vertices

The Merge Vertices menu offers options for combining two or more points.

Figure 361: Merge Vertices Options

The following options are available for merging vertices:

Merge Vertices

Merge Vertices by Tolerance

Collapse Block

Merge Vertex to Edge

Merge Vertices

The Merge Vertices option allows you to merge two or more vertices.

Tip:

To remove a single, hanging vertex in the middle of an edge between 2 free faces, select
only that vertex.

Two vertices can be merged with the following options:
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Propagate merge

propagates the merged vertices throughout the affected block(s).

Note:

The behavior of this operation depends upon the type of block.

• If Propogate merge is disabled on a mapped block, the result is a degenerate
block.

• When you merge vertices that are on a side face of a swept block, the merge
must propogate through the stack of swept blocks because degenerate blocks
are not allowed.

• If the merge is propogated to a free block, the face (if mapped) becomes a
degenerate mapped face.

• If you merge nodes on a free block, collapsing an edge, any attached mapped
faces will become free.

Merge to average

merges at the average distance of the two vertices.

Force merging

If enabled (default is off ), mapped faces of free blocks are converted to free faces where required
to force the merge.

Rebuild orphan

deletes the VORFN part and rebuilds it. This may be necessary in some cases to clean up the
VORFN blocks.

Update associations

If enabled, associated curves are grouped and the new edge is associated to the grouped curve.
Or, where curve grouping is not appropriate, curve associations are released.

Update edge bunching

If enabled, the edge node count of the removed edge will be added to the tangential neighbor
edge.

If Merge to average is also enabled, the removed edge node count will be split, with half the
nodes being added to neighbor edges on each side.

Examples

In the examples shown below, the Propogate merge and Merge to average options are used in
different combinations on mapped blocks.
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When selecting the vertices, the first vertex is retained and the second vertex is merged with the first
as illustrated in Figure 362: Selection of Vertices to be Merged (p. 473).

Figure 362: Selection of Vertices to be Merged

• In the first example, both Propagate merge and Merge to average are disabled. Only the selected
vertices are merged (see Figure 363: Merge Vertices Without Options (p. 473)). Notice that this oper-
ation results in a degenerate block.

Figure 363: Merge Vertices Without Options

• With Propagate merge disabled and Merge to average enabled, the selected vertices will be
merged at the average distance of the two (see Figure 364: Merge to Average Option Only (p. 474)).
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Figure 364: Merge to Average Option Only

• Propagate merge is enabled and Merge to average is disabled. All the connected vertices will
be merged according to the index value (see Figure 365: Propagate Merge Option Only (p. 474)).
For example, if the Vertex to Keep has indices (x1, y, z) and Vertex to Merge has the indices (x2,
y, z), then all the vertices having indices (x1,*,*) will merge with the same family of vertex having
the indices (x2,*,*). That is, a vertex having indices (x1,y1,z1) will merge with the vertex having indices
(x2,y1,z1).

Figure 365: Propagate Merge Option Only

Note:

After selecting the vertices, a Confirm delete station window will ask you to confirm
the direction and the index range to delete the vertices to be merged.

• In the last example, both Propagate merge and Merge to average are enabled. All the connected
vertices will be merged similar to the previous case, but at an average distance between the selected
vertices (see Figure 366: Both Propagate Merge and Merge to Average Options Selected (p. 475)).
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Figure 366: Both Propagate Merge and Merge to Average Options Selected

Merge Vertices by Tolerance

The Merge Vertices by Tolerance option allows you to merge only those nodes that come
under the specified tolerance limit. Select the vertices to be merged, and specify the tolerance value.

Collapse Block

The Collapse Block option allows you to collapse a block or an edge by shrinking one or more
edges to zero length. This modifies the topology of the remaining non-degenerate blocks. Select the
edge to define the direction that is to be collapsed to zero size. It is possible to add blocks interactively,
which will all be collapsed in the specified direction.

In Figure 367: Selection of Blocks and Edge for Collapse (p. 475), the edges and blocks selected to be
collapsed are shown in red. Figure 368: Collapsed Blocks (p. 475) shows the collapsed blocks.

Figure 367: Selection of Blocks and Edge for Collapse

Figure 368: Collapsed Blocks
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Merge Vertex to Edge

The Merge Vertex to Edge option allows you to merge a selected vertex and edge. The selected
edge will be split and merged with the selected vertex.

This is most often utilized when the region between the edge and vertex contains no blocks, and the
two disconnected topologies which do not have matching vertices can be merged. Examples of this
would include connecting bottom up blocking or merging blocking topologies.

Figure 369: Connected Blocking Topologies (p. 476) shows two sub topologies which are connected
at the corners but not the middle. The resulting surface mesh is shown in Figure 370: Resulting Surface
Mesh — Unmatched (p. 477). The top of the lower part is curved to fit the upper part as the edges
are projected to the same curves. However, as the edges are not shared, the mesh across these edges
is neither connected nor matched.

Figure 369: Connected Blocking Topologies
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Figure 370: Resulting Surface Mesh — Unmatched

The lower block can be split to provide the matching vertices and then the Merge Vertices function
could be used, or the Merge Vertex to Edge function can be used to merge the "hanging" vertices
directly to the edge. This will split the edges for the connection, but the block will still appear as a
single block (see Figure 371: Vertex Merged to Edge (p. 477)). After merging the vertex with the edges,
the surface mesh will be properly connected (see Figure 372: Resulting Surface Mesh —
Matched (p. 478)).

Figure 371: Vertex Merged to Edge
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Figure 372: Resulting Surface Mesh — Matched

Edit Block

 Use the Edit Block menu to modify existing blocks.

Figure 373: Edit Block Options

The following options are available for editing blocks:

Merge Blocks

Merge Faces

Modify Ogrid

Periodic Vertices

Convert Block Type

Change Block IJK

Renumber Blocks

Transfer Blocks
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Merge Blocks

The Merge Blocks option allows you to merge several small blocks into larger blocks. The
number of blocks before and after the merge is displayed in the message window.

Selected

merges two or more selected blocks. All pairs which have a common face will be merged, selected
blocks which do not have a neighbor will be ignored. This includes a mixed operation involving
free and mapped blocks.

Note:

For 3D blocking, your selection must be only mapped blocks or only free blocks. You
may not mix mapped and free blocks in one merge operation.

Tip:

You can also use the Merge Faces (p. 479) option to merge two or more 2D, free blocks.

Automatic

automatically merges all the blocks in the current Block part to the least number of blocks possible.
Any pairs which share a common face will be merged (internal face will be removed).

IJK Direction

merges selected blocks in the direction determined by the selected reference edge. Any pairs
where the common face is perpendicular to the selected direction will be merged. If no blocks
are selected, then all blocks are included.

Note:

Only 3D mapped blocks may be merged with this option.

Merge Faces

The Merge Faces option allows you to merge two or more faces and their corresponding blocks.

Method

specify which of the following options to use for selecting the merge faces:

Face Corners

Select two vertices on diagonally opposite corners of the faces to be merged. The selected
vertices must have one common index value.
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This method allows two or more mapped block faces to be merged into a single mapped
block face.

Block Faces

Directly select two or more faces to be merged. The selected faces must form a closed
set.

Note:

If all selected block faces are of type Mapped, then the merged face will also
be of type Mapped. If selected block faces are mixed types of Mapped and
Free, then the merged face will be of type Free.

Tip:

You can use this option to merge two or more 2D, free blocks.

Modify Ogrid

The Modify Ogrid option allows you to modify the scale factor of an Ogrid.

Method

specifies the method for modifying the Ogrid.

Rescale Ogrid

allows you to rescale the Ogrid.

Block Select

allows you to select all visible blocks or specific blocks.

Edge

is the radial Ogrid edge selected.

Absolute distance, Offset

control the rescaling of the Ogrid. If Absolute distance is disabled, the Offset value works
as a factor multiplied by the current Ogrid size, where values less than 1 result in a smaller
Ogrid, while values greater than 1 yield a larger Ogrid. If Absolute distance is enabled,
the Offset value is the new length of the radial edge of the Ogrid.

Reset Ogrid Orthogonality

allows you to reset the orthogonality of the selected edge. When an Ogrid is created, a radial
set of edges connect the internal/outer Ogrid vertices to the external/inner Ogrid vertices.
The vertices are orthogonal to each other along the radial edge. This orthogonality may be
modified when vertices are moved.
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Periodic Vertices

The Periodic Vertices option allows you to make selected pairs of vertices into periodic nodes.

Create

allows you to select pairs of nodes that should be periodic transforms of one another. A face is
a periodic transform of another if its four corners are periodic transforms of the other face's nodes.
When a periodic face is split, all the new vertices and faces will be periodic.

Note:

An axis node should be selected twice in order to make it periodic with itself.

Remove

allows you to select a pair of vertices to remove the periodicity.

Note:

To generate a periodic mesh, remember to make the initial block periodic. Further
splits will maintain this periodicity. It is much easier to make the first four pairs of
vertices periodic then to match up many vertices later to be made periodic.

Auto Create

creates periodic links between block vertices on the periodic boundaries automatically.

Note:

This works on a 3D Blocking with model periodicity defined. It finds the periodic
twins through Geometry transformation and blocking edge connectivity. Periodic
vertices that are associated to points are found directly by geometry transformation.
It expects that periodic points are within a geometric tolerance of 1.0e-05. Periodic
vertices that are projected to curves are found through periodic curve pairs or
blocking edge connectivity along the periodic direction. Surface associated vertices
are first found by transformation or best closest match.

Convert Block Type

The Convert Block Type option allows you to convert blocks into the following blocking types.
See Hexa Block Types for a description of the different block types.

Mapped

converts a block to a mapped block. The block converted must have 4 corners in 2D (or 8 corners
and 6 mapped faces in 3D). The Mapping algorithm forces the number of nodes on opposite sides
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to be equal. If they are not equal, the larger number will be used. This number of nodes will be
propagated through all parallel edges.

Free

converts a block to a free (unstructured) block. In 2D, this will result in a paved surface which can
be all triangles, quad dominant, quad with one tri, or all quad. In 3D, the free block mesh type
can be Tetra (Delaunay, Fluent Meshing or Advancing Front), Hexa Core or Hexa Dominant mesh.
In 2D, this is most often used to solve issues with poor internal angles after mapping to curves
or to prevent node counts from propagating across a face.

Note:

An error will be reported if the selected block is in the VORFN part.

Figure 374: Conversion of a Mapped Block to a Free Block

(A) Mapped Block

(B) Free Block with All Quad Mesh

(C) Free Block with Quad with one Tri Mesh

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.482

Blocking



(D) Free Block with Quad Dominant Mesh

(E) Free Block with All Tri Mesh

Swept

converts a mapped block or free block to a swept block. You could convert a mapped block to
a swept block to improve the mesh quality in a particular direction. Alternatively you could convert
a free block to a swept block to get a more structured mesh along the sweep path.

Select a Swept Face as the source face.
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If converting a free block, pick one of the two free faces of the block.

Note:

• All side faces must be type mapped before attempting to convert a free block.
See Free face to mapped, below.

• The number of edge levels on the side faces may not match. The software will
add implicit splits (not visible in the graphics window) as required to complete
the conversion.

If converting a mapped block, pick a face where the mapped block produces an over-constrained
mesh. That face, and all parallel faces, will be converted to free and then the mesher, with more
freedom in face meshing, will sweep the face mesh through the block(s).

Note:

If converting a mapped block, the sweep will propagate in the initial direction
from the selected block to the next, through all connected, mapped blocks. While
mapped blocks must have the same nodes on opposite sides of the block in all I,
J and K directions, a swept block may have varying nodes in two directions (across
the selected face which is converted to free) and is mapped in the third (perpen-
dicular to the selected face).

Figure 375: Conversion of a Mapped Block to a Swept Block

(A) Mapped Block
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(B) Swept Block

Merge parallel blocks will merge all adjacent mapped faces at the same index level, before ap-
plying the sweep.

Y-Block

converts a degenerate (wedge) block to a Y-block (quarter Ogrid).

Mapped face to free

allows you to convert a mapped external face to a free face. The effect on the 3D block depends
on the block type:

• A mapped face of a mapped block will be converted to free and the mapped block itself
to swept.

• A mapped face of a free block will be converted to free.

• A mapped face of a swept block cannot be converted to free.

In Figure 376: Converting Mapped Face to Free (p. 486), the circular face adjacent to the hexa mesh
is initially mapped. The unseen volume is free (unstructured tetra in this case). This results in poor
elements at the corners (the maximum angle approaches 180 degrees as the mesh is refined).
Using this option to convert the structured face to an unstructured face (quad dominant in the
example) results in improved quality.
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Figure 376: Converting Mapped Face to Free

Free face to mapped

allows you to convert an unstructured (free) face to structured (mapped) face. This works for 2D
blocking or faces of 3D blocking.

This can be used to convert side faces on a Free block to mapped in preparation for converting
the Free block to Swept (all side faces must be mapped for the conversion to be successful). It
can also be used to convert the source face of a Swept block to Mapped. When the source face
is converted to mapped, the entire swept block becomes mapped and adjacent swept blocks also
become mapped.

Choose the Method based on the complexity of the model:

Basic

Use this method if the free face has only four vertices.

Advanced

Use this method if the free face has more than four vertices.

After you identify the face, you can identify which vertices are to be the corner vertices
(maximum of four) and/or which are to be side vertices. If your selection is ambiguous,
corner vertices will be chosen and the face will be converted.

Note:

With Auto Pick Mode enabled, as soon as the software can unambiguously
identify corner and side vertices, the face will be converted.

Tip:

If converting the free end face of a swept block on a tube, you do not need
to select any corner or side vertices. The software will recognize the concentric
edge loops of the annular, free face and convert it into four mapped faces.
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Reverse swept direction

reverses the sweep direction for a swept block. This can be useful in some situations where you
want to better control the seeding on the free face of the sweep, such as when using a reference
mesh (see the Reference Mesh  (p. 495) option for the Associate Face to Surface option).

Merge sheet with free block

allows you to merge a 2D (sheet) block with a 3D free block. Using this option will ensure node
to node connections between the two regions. For CFD users, this option can be used to connect
a wall-mounted baffle with the rest of the mesh. For FEA users, this option can be used to combine
2D and 3D portions of the geometry.

Figure 377: Merging 2D (Sheet) Block With a Free Block (p. 488) shows an example where a wall-
mounted baffle has been connected to rest of the mesh using this option.
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Figure 377: Merging 2D (Sheet) Block With a Free Block

3D free block mesh type

converts a free block mesh to an unstructured mesh type of Tetra or Hexa-Core mesh. Fig-
ure 378: Changing the 3D Free Block Mesh Type (p. 488) shows the conversion of the unstructured
Delaunay tetra mesh (with a Free Quad Dominant face) to hexa-dominant mesh using this option.

Figure 378: Changing the 3D Free Block Mesh Type

Free face mesh type

converts the free face mesh type to the type selected. Figure 379: Changing the Free Face Mesh
Type (p. 489) shows the conversion of the free face mesh type from the default quad-dominant
to the all tri type which is more appropriate for the tetra mesh in the adjacent free block.
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Figure 379: Changing the Free Face Mesh Type

Note:

The selected face must be type free. Other types will generate a warning message.

Change Block IJK

The Change Block IJK option allows you to change the IJK indices of a block.

IJK->KIJ

changes indices from IJK to KIJ.

Set Origin

sets the origin at a selected vertex.

Align Blocks

aligns all blocks with reference to a selected block.

Set IJK

sets the current IJK indices to new IJK indices.

Renumber Blocks

The Renumber Blocks option allows you to renumber blocks.

Transfer Blocks

The Transfer Blocks option allows you to transfer blocks from the regular block topology to
the output blocks.

You can use this option after manipulating the regular blocks using any block topology function (for
example, Split Block, Extend Split, Merge Blocks). Select the blocks to be transferred and click Apply.
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The Output Blocks option in the Display Tree (Blocking > Pre-Mesh) is used to toggle Output Blocks
for viewing; editing; or writing the multiblock, structured mesh files.

Associate

Figure 380: Blocking Associations Options

The following options are available for blocking associations.

Associate Vertex

Associate Edge to Curve

Associate Edge to Surface

Associate Face to Surface

Disassociate from Geometry

Update Associations

Reset Associations

Snap Project Vertices

Group/Ungroup Curves

Auto Associate

Associate Vertex

The Associate Vertex option allows you to associate vertices and project the vertex onto itself,
points, curves, surfaces and parts. Select the vertex and the entity to project it onto.

Note:

To associate a vertex to a part, the part can contain only one point. Curves and surfaces
are not allowed.
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Associate Edge to Curve

The Associate Edge to Curve option allows you to associate the edges of blocks to curves or
to curve parts.

When associating edges to curves,

• Vertices at the end of the edges are also associated to the same curve unless they were previ-
ously associated to another curve or point.

• Edge segments can be individually associated after using edge splits.

• Multiple edges can be associated with multiple curves, but all the curves will be grouped into
a single composite curve.

When associating edges to a curve part, the part must contain only curves. Points and surfaces are
not allowed.

Note:

Associating edges to curves also results in the creation of line elements along those curves.
For 2D planar blocking, it is essential that all the perimeter edges be associated with
perimeter curves because many solvers use the perimeter line elements as boundaries.

Project vertices

If enabled, the vertices will automatically be projected to the corresponding curves.

Project to surface intersection

If enabled, the surface-surface intersection will be captured correctly. This is for poor geometry
situations where the intersection curve may not match with the intersection of the surfaces. If
you associate an edge with a curve using this option, the edge will be colored purple. The edge
is associated with the curve, but when the mesh is generated, the nodes will first project to the
curve, and then they will project to the surface (the true surface/surface intersection).

In the examples in Figure 381: Examples of Project to Surface Intersection (p. 492), the intersection
curve is slightly above the surface. The green edge on the left is associated with the curve without
enabling this option and therefore its nodes are off the true surface intersection. The purple edge
on the right is associated to the curve with this option. The edge is therefore associated with the
curve, but the nodes ultimately project to the surface intersection. This is better than simply
projecting the edge to the curve because the nodes are guided by the curvature of the curve.
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Figure 381: Examples of Project to Surface Intersection

Project ends to curve intersection

If enabled, the vertices will be enforced at the ends of the curve.

Reference Mesh

allows you to use an existing mesh edge distribution to seed an unstructured or swept face. This
option can be used to obtain a better quality mesh or to set up node for node contact with a
preexisting unstructured mesh.

To use this option, an unstructured mesh must be loaded and the mesh edge must match the
blocking edge, including associations to surrounding curves.

Associate Edge to Surface

The Associate Edge to Surface option allows you to associate the edges of blocks to surfaces.
The color of the selected edges will turn white/black, indicating that the nodes on that edge will be
projected to the nearest active surface. By default, edges and faces between two blocking materials
(boundary faces) will automatically associate with the nearest active surface. Related vertices and
edge splits will also be associated with the nearest active surface. When moving vertices or edge
splits, there will be no movement until the cursor passes over an active surface. Ensure that the vertices
or edge splits are moving on the correct surface.
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Associate Face to Surface

The Associate Face to Surface option allows you to adjust how faces relate to the geometry.
By default, edges and faces between two blocking materials (boundary faces) will automatically asso-
ciate with the nearest active surface.

Click the selection icons to select the face(s) and the surface part.

The following options are available for associating faces to surfaces:

Closest

finds the closest surface for projection. For boundary faces, this returns face association to the
default. It can also be used to force internal faces to follow a surface.

Interpolate

interpolates the shape of the meshed face from the shape of the bounding edges, rather than
projecting the nodes to the surface. The surface mesh will still inherit the family name of the
closest surface part. Use this feature if a face crosses a missing or poor quality surface.

Part

projects the face to the surface that is in the specified part. This is useful for closely spaced curved
surfaces, such as turbine blades, to ensure that each face projects to the correct surface, and not
merely the closest surface.

Note:

If you associate the face to a part which contains no surfaces, it will instead interpolate
the mesh and place the elements in the specified part. This can be used to control the
part name of the interpolated mesh.

Shared Wall

allows you to set a general projection rule regarding faces between two specific volume parts.

Create

sets the rule that the faces between the specified volume parts should always be projected
to surfaces of the specified surface part.

Remove Shared Wall

removes the above rule for a given pair of volume parts.

None

removes the default behavior so that edges/faces between specified volumes do not automat-
ically associate with surfaces. This is useful when there is no boundary between volumes or
if you are using volume parts to break up a model for display or selection purposes, but the
separate regions don’t represent physical differences which would require a boundary.
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Link Shapes

allows the internal face to have the same shape as the linked boundary face. The faces can be
unlinked by disassociating them. Select the boundary face and the associated internal face.

Note:

The internal, linked face takes its shape from the nearest parallel face that is projected
to the boundary.

A model with two different materials is shown in Figure 382: Example of Link Shapes (p. 494). The
Shared Wall option is set to None, so there is no projection between the parts.

• In figure (A), the internal face is not linked to the face above, near the boundary. The
boundary face projects to the curved surface (not shown), but the internal face is interpol-
ated straight across the volume.

• In figure (B), the internal face has been linked with the top face. The mesh curvature
transition is more gradual, crossing both blocks instead of just the top one.

Figure 382: Example of Link Shapes

(A) Internal Face not Linked to the Boundary Face
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(B) Internal Face Linked to the Boundary Face

Reference Mesh

allows you to use an existing surface mesh to seed an unstructured or swept face. This option
can be used to obtain a better quality mesh or to set up node for node contact with a preexisting
unstructured mesh.

An example demonstrating the use of the Reference Mesh option is shown in Figure 383: Using
the Reference Mesh Option (p. 495). The Multi-zone blocking on the geometry was generated
automatically and one half mapped by default. The other half is an unstructured swept block with
"all tri" free faces. To use a reference mesh, load an unstructured surface mesh and make sure the
mesh perimeter matches the edge perimeter, including associations to surrounding curves. Verify
the sweep direction (see the Reverse Swept Direction  (p. 487) option) for the swept block. Select
the Reference Mesh option, select the appropriate unstructured face and click Apply. The swept
mesh will be seeded with the reference mesh.

Figure 383: Using the Reference Mesh Option

(A) The automatically generated Multi-zone blocking/mesh on the geometry.
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(B) The unstructured quad dominant surface mesh used as the reference mesh.

(C) The resulting swept mesh seeded with the reference mesh.

Selected Surface

allows you to associate the selected face(s) with the specified surface.

Disassociate from Geometry

The Disassociate from Geometry option allows you to disassociate the selected edge, surface
or face that is associated to the geometry.

The selection of different entities to be disassociated can be done individually or together.

Note:

Any association can be removed (associated to nothing), however, you can easily overwrite
associations without disassociating first. For instance, if an edge is associated with a curve,
you can directly associate it with a surface, you do not need to first disassociate it.
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Update Associations

The Update Associations option allows you to set associations to the nearest entities of the
assigned type.

Vertices

updates associations of all vertices.

Edges

updates associations of all edges.

Faces

updates associations of all faces.

Only Dormant entities

when enabled, will update associations for blocking that was associated with entities that are
now dormant to the closest entities instead.

Update Blocking

allows you to update blocking to a new geometry file. This option is used when there are geometric
changes while the topology remains the same. Update Blocking uses the entity names. If blocking
is created for one geometry file and saved, and then a second geometry file with consistent entity
names is opened, the Update Blocking option will attempt to update the blocks to the new
geometry file.

• Parametric

When there is a parametric change in geometry, then Parametric method will update the
blocking associations. When the initial blocking file is saved in relation to the first geometry
file, the vertices contain links to the geometry in terms of the curve T parameter space and
surface UV parameter space. Using the Parametric method will move the vertices to the same
parametric space of the new geometry file.

• Morphing

For some changes in geometry, such as geometric entities moved a large distance, or a Trim
Surface operation, the Morphing Method should be used. This approach uses the Parametric
method for curves, but for surfaces it will evaluate whether the surfaces are trimmed and adjust
the vertices linked to the UV parameter space to a more accurate position based on attached
curves. Instead of moving the surface vertices based on the UV parameter space, the surface
vertices will be moved in reference to neighbor vertices.

The original geometry and blocking is shown in Figure 384: Original Geometry and Blocking (p. 498).
The geometry is then scaled in the Z direction as shown in Figure 385: Geometry Scaled in Z Direc-
tion (p. 498). Finally, the result of updating the blocking associations is shown in Figure 386: Blocking
Associations Updated (p. 498).
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Figure 384: Original Geometry and Blocking

Figure 385: Geometry Scaled in Z Direction

Figure 386: Blocking Associations Updated

Reset Associations

The Reset Associations option resets the associations of exterior blocking entities back to asso-
ciation with the nearest entity.
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Vertices

allows you to reset the vertex-point associations.

All

resets associations for all vertices.

Only visible

resets associations for visible vertices.

Edges

allows you to reset the edge-curve associations.

All

resets associations for all edges.

Only visible

resets associations for visible edges.

Faces

allows you to reset the face-surface associations.

All

resets associations for all faces.

Only visible

resets associations for visible faces.
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Snap Project Vertices

The Snap Project Vertices option allows you to project all the vertices that are associated to
respective points, curves or surfaces. The following options are available for projecting vertices:

All Visible

projects all visible vertices to their respective entity.

Selected

projects selected vertices to their respective entity.

Move Ogrid nodes

moves internal nodes (that are not projecting) which are attached via an Ogrid edge to external
nodes (nodes that are projecting) relative to the projection.

Note:

Projection only applies to active parts. Projection will not be affected by entities that are
blanked but are included in visible parts. If you do not want nodes to be moved to certain
entities, the entities must be placed in a separate part that is disabled.

Group/Ungroup Curves

The Group/Ungroup Curves option allows you to group curves into a composite curve, or un-
group composite curves into separate curves. This is needed for associating an edge to a set of curves.
The curves should first be grouped into a composite curve, and then the edge can be associated to
that composite curve.

Composite curves can be displayed by right-clicking on Curves in the Display Tree and selecting the
option Show Composite.

Group Curves

groups the selected curves into one composite curve. The selected curves can include existing
composite curves.

Selected

groups only the selected curves.

All tangential

groups all curves that are tangential to the selected curves.

You can use the default value of 10 degrees, or set a value for Tangential angle tolerance.
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Part by Part

groups all the curves in each part into composite curves.

Ungroup Curves

allows you to select the composite curve to ungroup.

Auto Associate

The Auto Associate option allows you to associate edges to curves. Auto Association looks at
the topology of the surfaces and the topology of the blocking and attempts to link the edge projections
of the blocking in relation to the topology of the geometry.

Move Vertex

Figure 387: Move Vertices Options

The following options are available for moving vertices:

Move Vertex

Set Location

Align Vertices

Align Vertices In-line

Set Edge Length

Move Face Vertices

Move Vertex

The Move Vertex option allows you to modify the location of a vertex. Select a vertex using
the left mouse button, accept the selection by pressing the middle mouse button, and use the right
mouse button to cancel the selection. After fixing the constraints, select the vertex to move.

Single Method

allows you to select a single vertex to be moved.
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Multiple Method

allows you to select multiple vertices for movement.

Movement Constraints

allows you to constrain a vertex to moving in any direction.

Normal to Surf

allows you to move the vertex normal to the surface.

Move dependent

allows you to move dependent vertices.

There are different types of vertices/edges, and their movement is governed by their projection as
shown in Figure 388: Different Types of Vertices and Edges (p. 502).

Figure 388: Different Types of Vertices and Edges

White Edges/Vertices

These are between two material volumes. The edge and the associated vertices will be projected
to the closest CAD surface between these material volumes. Vertices can only move on the surfaces.

Blue Edges/Vertices

These are in the volume. The blue vertices can be moved by selecting the edge just before it and
can be dragged onto that edge.

Green Edges/Vertices

These edges and the associated vertices are being projected to curves. The vertices can only be
moved on the curves that they are projected to.

Red Vertices

These cannot be moved, they are projected to fixed points. They can only be moved by first
changing their projection to one of the other projection types.
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Set Location

The Set Location option allows you to move vertices by setting their location with the following
options:

Set Position

allows you to modify the coordinates of selected vertices. The vertices may be selected individually.
You can also select a Reference Point and based on its position, modify the X, Y, and Z (or R, θ,
and Z) directions of the selected vertices.

Multiple vertices can be selected and modified at the same time. Typically, this function is used
to modify a number of vertices to one specific coordinate, for example Y=0, to ensure a true
symmetry plane.

Reference From

allows you to select the reference point of the vertices to be moved. The reference point can
either be an existing vertex, or a position on the screen.

Set Coordinate System

sets the appropriate coordinate system.

• Cartesian Coordinate System

Select which direction to move the vertices: X, Y, Z, or the Normal direction. Enter the
number of units of distance.

• Cylindrical Coordinate System

Select which direction to move the vertices: R, θ, or Z direction. Enter the number of units
of distance.

Vertices to Set

specifies the vertices to be moved. Select the vertices to be moved and click Apply.

Increment Position

allows you to move vertices by the specified increment in any direction. For example, vertices
can be moved 10 units in the X-direction by entering "10" in the Modify X option.

Set Coordinate System

sets the appropriate coordinate system.

• Cartesian Coordinate System

Select which direction to move the vertices: X, Y, Z, or the Normal directions. Enter the
number of units of distance.

• Cylindrical Coordinate System
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Select which direction to move the vertices: R, θ, or Z directions. Enter the number of units
of distance.

Vertices to Set

specifies the vertices to be moved. Select the vertices to be moved and click Apply.

Align Vertices

The Align Vertices option is used to align all vertices based on their index value in the selected
dimension (I, J, K, O3 or higher Ogrid dimension). Vertex movement is constrained to a plane parallel
to the selected Move in plane.

Along edge direction

specifies an alignment direction parallel to the selected edge dimension. This automatically sets
the default Move in plane normal to the selected edge dimension.

Reference vertex

specifies the vertex to which the other vertices will be aligned. The reference vertex must be at
a location along the selected edge.

The selected reference vertex and all others with the same index value in the reference dimension
will not move.

Coordinate system

specifies the current active coordinate system, either Cartesian or Cylindrical.

• Cartesian Coordinate System

Move in plane

allows you to select a plane (aligned with the local coordinate system or user defined) in
which the vertices are to be moved.

For the User Defined option, choose a Method to define the plane.

User Input

specify the x-, y-, and z-coordinates of the normalized vector to the desired Move
in plane.
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By 3 plane locations

specify the plane by selecting three points in the graphic display. The normalized
edge vector is calculated and displayed as Plane Normal.

Note:

This option is chosen and the normalized edge vector is automatically
calculated if a radial Ogrid edge (dimension O3 or higher) is selected
for Along edge direction.

• Cylindrical Coordinate System

Parameter

allows you to specify which parameter of the vertices will be aligned to the reference vertex.

Align Vertices In-line

The Align Vertices In-line option allows you to align vertices to a defined line. Select two points
to define the reference direction of the line, and then select the vertices to align to that line.

Set Edge Length

The Set Edge Length option allows you to modify the length of edges explicitly. Select the
edge(s) to be modified and specify the length.

Freeze Vert(s)

allows you to override the default vertex adjustment and select which end vertex remains
“frozen” in the same position when the edge length is modified. This option is disabled by
default.

The default node movement is determined based on the association of the end vertices. If
the association is the same, both vertices are moved equally. In other cases, the more restrict-
ive vertex association is frozen automatically, and the other vertex is moved as per the length
specified. Vertices associated to an entity will be restricted as opposed to non-associated
vertices. The order of restrictive association is association to point > association to curve >
association to surface.

Note:

When selecting multiple vertices to be frozen, ensure that only one of the end
vertices of the edge being modified is selected.
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Move Face Vertices

The Move Face Vertices option allows you to move or rotate face vertices.

Note:

The selected face must be mapped. Other types will generate a warning message.

Move Face Vertices

allows you to move the face vertices. Select the face whose vertices are to be moved. Specify the
direction by entering an offset vector, or by selecting the start and end points for moving the
face vertices.

Rotate Vertices

allows you to rotate the vertices. Select the vertices to be rotated, the center point, and the angle
of rotation. Specify the rotation axis by entering a vector, or by selecting the start and end points.

Transform Blocks

Figure 389: Transform Block Window

The following options are available for transforming blocks.

Translate Blocks

Rotate Blocks

Mirror Blocks

Scale Blocks

Copy Periodic Blocking

Translate and Rotate

For the Translate, Rotate, Mirror, Scale and Translate and Rotate options, select the block(s) to be
transformed. When no specific blocks are selected, it implies that the whole blocking will be transformed.
You can specify whether to make copies of the blocks using the Copy option.
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You can use the Transform geometry also option to transform the geometry only when transforming
all the blocks. To use this option, do not explicitly select any blocks, which is functionally equivalent to
selecting all blocks.

Translate Blocks

The Translate Blocks option allows you to move the original block topology laterally without
rotation.

Select

Opens the Select Blocking-block menu to choose which blocks will be moved/copied.

Copy

If checked, the original block will remain, duplicate(s) will be created.

Transform geometry also

If checked, the geometry will be moved/copied with the selected block(s).

There are two methods to specify the distance of translation:

Explicit

allows you to specify the direction to move the block in X, Y, and Z directions.

Two Point Vector

allows you to specify the magnitude and direction to move the block by selecting two points to
define a vector.

Rotate Blocks

The Rotate Blocks option allows you to rotate the original block topology.

Axis

specifies the axis of rotation. Select the X, Y, Z axes, or another user-defined vector.

Angle

specifies the value of the angle the block is to move.

Center of Rotation

specifies the center of rotation. Select the origin, centroid, or a user-defined point.
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Mirror Blocks

The Mirror Blocks option allows you to mirror the topology about a specified plane.

The Plane Axis defines the plane orientation by its normal vector: X-axis, Y-axis, Z-axis, or a vector
defined by two points.

Specify the Point of Reflection as the origin, centroid, or a user-defined point.

Scale Blocks

The Scale Blocks option allows you to change the size of the topology.

Scale Blocks by setting a factor for each direction of the coordinate system.

Specify the Center of Transformation as the origin, centroid, or a user-defined point.

Copy Periodic Blocking

The Copy Periodic Blocking option allows you to copy the blocking for periodic models. This
feature is useful when the model is periodic but the geometry is available only for one sector. The
blocking is first done on the sector geometry, and then both the geometry and blocking are copied
and rotated to form the full model.

Note:

The periodicity settings defined in Mesh > Set Up Periodicity (p. 368) will be applied.

Num. copies

specifies the number of copies of the geometry to be made.

Increment parts

allows you to select Parts that will remain the same and the copies will be placed in Parts
with the same name plus an increment. By default, the copies of entities will be placed in
the same Part as the original. For example, two copies of the Part "Blade" can be created and
placed in Parts named "Blade_2", and "Blade_3".

Translate and Rotate

The Translate and Rotate option allows you to translate and rotate the blocking simultaneously.
The reference location and target locations can be defined by 3 points, a curve or LCS and the
blocking is translated and rotated to match.
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Copy

If enabled, a copy of the selected entities will be created in the new location.

Translate and Rotate Method

The three options for method are as follows:

3 points –> 3 points

Select six points in all. The first three points will be used as the reference for the entity to be
transformed. The second set of three points is used to define the transformation. The result
will match the first points of both sets, and the direction from the first to the second point,
and the plane defined by the third point.

Curve –> Curve

Select two curves. The first curve is used as a reference for the entity to be transformed. The
second curve is used to define the transformation. The result will match the beginning
(parameter = 0) of both curves, the direction from parameter 0 to 0.5, and the plane defined
by the end (parameter 1) of the curves. A curve used to define the transformation can be in-
cluded in the entities selected to be transformed.

LCS –> LCS

Select two local coordinate systems. Click Apply.

The result will match the origins and align the axes of the first LCS to the second LCS.

Edit Edge

Figure 390: Edit Edge Options

The following options are available for editing unstructured surface block edges:

Split Edge

Unsplit Edge

Link Edge

Unlink Edge

Change Edge Split Type
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Split Edge

The Split Edge option allows you to edit block edges using the following Split types.

Spline

allows you to select the edge to be split and converted to a spline. Click the edge and drag to
specify the desired shape of the spline. The change will be applied when the mouse button is
released. In Figure 391: Spline Type Edge Split (p. 510), the first picture shows the initial edge, and
the second picture shows the edge after a spline split.

Figure 391: Spline Type Edge Split

Linear

allows you to split the selected edge into linear edges. Figure 392: Linear Type Edge Split (p. 510)
shows linear splits of a straight edge.

Figure 392: Linear Type Edge Split

Control Point

is shown in Figure 393: Control Point Type Edge Split (p. 510).

Figure 393: Control Point Type Edge Split

Automatic Linear

allows you to automatically make the selected edge into a linear edge.
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All Edges

allows you to convert all the edges into linear edges.

Note:

This option corresponds to using the command ic_hex_auto_split_edge
-all in the replay script.

Automatic Spline

allows you to automatically split the selected edge(s) as splines.

All Edges

allows you to convert all the edges into splines.

Note:

This option is especially helpful for Multi-zone blocking.

Tangents

uses the tangencies of the attached edges at a vertex to a selected edge to split the selected
edge. Each edge will be split twice, once for each vertex. For example, for a simple Ogrid inside
of a block, if the internal block's edges were split with this option, the internal block would take
on a spherical shape.

Method

For each vertex, the edge can be split by one of the following methods:

Orthogonal

The length of the tangent edge will be based on the specified Factor. Enter a value
or use the sliding bar.

Enter Tangent

Specify a Tangency point in relation to the vertex. The length of the tangent edge
will be based on the specified Factor. Enter a value or use the sliding bar.

None

This option ignores the tangency of the vertex.
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All at Vertex (Smooth)

allows you to split all the edges connected to the selected vertex to improve the angles between
the edges at that vertex. If there are four edges, they will be split so that they meet at 90 degree
angles at the vertex.

Tip:

When using replay scripts, the command ic_hex_split_edge allows you to split the edge
at the specified location.

For example, ic_hex_split_edge 21 25 0 1.7 8.5 0 implies that edge 21–25
will be split at the location (1.7, 8.5, 0). The value 0 in this example indicates that this is
the first split between the vertices 21 (start vertex) and 25 (end vertex). Alternatively, a
value of 1 would indicate that the split is the second between the specified vertices, and
so on.

To use an existing point to indicate the location to be used, you can use the following in
the replay script:

set name pnt.00 ;# point must exist
set loc [ic_geo_get_point_location $name]
set x [lindex $loc 0]
set y [lindex $loc 1]
set z [lindex $loc 2]
ic_hex_split_edge 21 25 0 $x $y $z

Unsplit Edge

The Unsplit Edge option allows you to remove splits from edges. For the Single method, select
the vertex of the split edge to remove. For the All method, select the edge to remove all the splits.

Link Edge

The Link Edge option allows you to set the shape of edges. Select an edge for the source of
the shape and then one or more target edges.

Select a method from the drop-down list:

Selected

sets the shape of the target edge(s) with the specified scaling factor.

Interactive

sets the shape of the target edge(s) with an interactive slider for scaling factor.

In dimension

sets the shape automatically for all connected edges. Select the source edge for the Link
Edge Dimension, the Source index or vertex, and the Target index or vertex.
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Set a scaling Factor for the target edge shape with respect to the source edge shape.

If Link Direction is enabled, you can give an explicit direction by which the target edge mesh is
transformed from the source edge shape. This may be useful to avoid creating overlapping mesh in
situations such as:

• when the target edge shape is inverted from that of the source edge, for example in curved
imprinting.

• when the edge shape is a non-planar 3D spline curve.

• when the target edge is not in the same plane as the source edge shape.

Unlink Edge

The Unlink Edge option allows you to unset the shapes of edges linked by the Link Edge option.

Change Edge Split Type

The Change Edge Split Type option allows you to change the edge split type (for example,
change spline to linear). The options available are Spline, Linear, and Control Point.

Pre-Mesh Params

Figure 394: Pre-Mesh Parameters Options

The following options are available for Pre-Mesh parameters:

Update Sizes

Scale Sizes

Edge Params

Match Edges

Refinement
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Update Sizes

The Update Sizes option allows you to update sizes in the pre-mesh. The following options are
available for updating sizes in the pre-mesh:

Update All

recomputes the edge node spacing from blocking or from geometry as selected by Reset Edge
Bunching.

By default, Reset Edge Bunching is disabled and edge node spacing is computed based on
constraint equations with the default (BiGeometric) meshing law. You can adjust the number of
nodes on each edge based on the Global Surface or Curve Mesh Size and by default each edge
will follow the BiGeometric geometry law.

Note:

The default meshing law and bunching ratio are specified under Settings >
Meshing > Hexa/Mixed  (p. 100).

Note:

You can check the distribution by clicking Blocking > Edge > Show Edge Info
to verify that each edge follows the default (BiGeometric) geometry law.

Note:

For 3D blocking, the Curve Mesh Size parameters are only applied to edges that
are associated with curves. For 2D blocking, the Curve Mesh Size parameters are
applied to all curves.

If you enable Reset Edge Bunching, then all existing bunching parameters are removed and the
edge node spacing is computed based on geometry.

Keep Distributions

adjusts the number of nodes on each edge based on the Global Surface or Curve Mesh Size. It
differs from the Update All method in that the edges follows the geometric law assigned to it,
and not the default geometric law.

Note:

For 3D blocking, the Curve Mesh Size parameters are only applied to edges that are
associated with curves. For 2D blocking, the Curve Mesh Size parameters are applied
to all curves.
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Keep Counts

allows you to change the geometry law of the edges to the default (BiGeometric) geometry law.
This option differs from Update All and Keep Distribution in that the distribution of nodes is
not altered according to the Global Surface or Curve Mesh Size.

Curve->Edge bunching

transfers the Advanced Bunching Parameters specified for curves to their associated edges.

You can apply Advanced Bunching to curves using the options available for Curve Mesh Setup
(p. 378) in the Mesh tab. You can apply various bunching laws including Uniform, BiGeometric,
and Hyperbolic, (described in the Bunching Laws (p. 521) section) along with end spacing, ratios
and maximum spacing. This is primarily for use with the patch based surface meshers. Pre-Mesh
Params uses the smallest average mesh size to calculate the initial pre-mesh distribution. The
use of the Curve -> Edge bunching option to transfer the Curve Advanced Bunching Parameters
to the associated edges is shown in Figure 395: Using the Curve->Edge Bunching Option (p. 515).

Figure 395: Using the Curve->Edge Bunching Option

(B) Curve->Edge bunching transfers Curve
Advanced Bunching to Edge Parameters

(A) Update all does not respect Curve
Advanced Bunching

In this case, only one curve had Advanced
Parameters specified and this distribution
was copied to parallel edges.

Note:

Only intentionally set Advanced Bunching is transferred. Parallel edges without explicitly
set Advanced Curve bunching will get the same distribution as their neighbors. This
means it is not necessary to setup all the curves; parallel edges will automatically in-
herit the distribution from a single Curve with Advanced Bunching. To force the parallel
distribution back to the default uniform bunching, you must select Uniform explicitly
under Curve Parameters or adjust it afterward with the Edge Parameters.

Note:

This option is useful if you wish to store the Advanced Bunching with the Geometry
file. Generally speaking, you should use Blocking Edge parameters instead because
there are more options and it is easier to copy or link parameters.

Multiple Curve Advance Bunching can be applied in parallel as shown in Figure 396: Multiple
Curve Advanced Bunching (p. 516). Three different edge parameters are applied on the block
shown. Edge distribution will be copied to parallel neighbors without explicit Curve Advanced
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Bunching. To make the bunching return to the default uniform bunching, Curve Advanced
Bunching was explicitly set to Uniform.

Figure 396: Multiple Curve Advanced Bunching

Run Check/Fix Blocks

allows you to run the check for inconsistencies in the internal block data structures and fix them
if possible. The default setting corresponds to that set for Check/Fix Blocks in the Hexa/Mixed
Meshing Options  (p. 100) DEZ.

Scale Sizes

The Scale Sizes option allows you to scale the mesh size globally.

Factor

specifies the factor by which the mesh size will be globally multiplied.

In Figure 398: Block Mesh Scaled by Factor of 1.5 (p. 517), the mesh size (from Figure 397: Initial
Block Mesh (p. 516)) was changed by a factor of 1.5.

Figure 397: Initial Block Mesh
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Figure 398: Block Mesh Scaled by Factor of 1.5

Scale Initial Spacings

allows you to adjust the end spacings on each of the edges and the max space (each will be divided
by the factor) in addition to scaling the number of nodes. For example, if you entered a Factor
of 1.5 and enabled Scale Initial Spacings, the number of nodes on each edge would increase by
50% while the end spacing on each edge would be reduced by 33%.

Note:

This option only applies to the visible edges.

Edge Params

The Edge Params option allows you to modify the mesh parameters in a detailed manner by
specifying various bunching laws and the node spacing along any particular edge. Each edge has
several parameters that determine the spacing of the mesh along the edge: number of nodes, the
meshing law, initial length at the beginning/end of the edge, the expansion of the mesh from the
beginning/end of the edge to the interior, and the maximum element length along the edge.

The Edge Params icon brings up a window with all the mesh parameters. Once an edge has been
selected, the mesh parameters for that edge will be displayed. All parameter values may be modified,
except for the Edge ID and the Edge Length, which are pre-defined.

Note:

• You can also parameterize edge parameters using variables in replay scripts. Refer to
Parameterizing Edge Parameters for details.

• In blocking topologies that include hidden vertices, the reported vertex numbers may
not match the visible vertex numbers. See Vertices (p. 188) and Edges (p. 189).

Nodes

specifies the number of nodes along the edge. The number may be modified using the up and
down arrows or by entering a number in the field.
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Mesh law

Allows you to select one of several bunching laws described in detail in Bunching Laws (p. 521).

Spacing

specifies the spacing of the first node from the beginning of the edge (first cell height). When an
edge is selected, an arrow appears along the edge. Spacing 1 refers to the parameters at the
beginning end of the arrow, and Spacing 2 refers to the edge end where the arrow is pointing,
as shown in Figure 399: Edge Meshing Parameters (p. 518). You may modify the values of the
parameters available for the selected Meshing law. The actual values will differ from the requested
values only if the requested values cannot be met. For example, if the Edge length is 10 units,
and you specify an initial spacing of 6 on both sides and 11 nodes along the edge, the system
will simply space the nodes evenly, giving an initial spacing of 1 and a spacing ratio of 1.

Ratio

is the growth rate from one cell height to the next. Ratio 1 refers to the parameters at the begin-
ning end of the arrow, and Ratio 2 refers to the edge end where the arrow is pointing, as shown
in the figure below.

Figure 399: Edge Meshing Parameters

Max Space

specifies the maximum element spacing of the curve.

Spacing Relative

if enabled, the values of Spacing 1 and Spacing 2 are displayed as fractions of the edge length.

Nodes Locked

if enabled, the number of nodes will be fixed. However, Update All will override this and apply
the global parameter values to the mesh.

Parameters locked

if enabled, the Mesh law parameters will be fixed. However, Update All will override this and
apply the global parameter values to the mesh.

Copy Parameters

allows the bunching on the selected edge to be copied with various options. If the To All Parallel
Edges option is selected, the distribution of the current edge will be copied to all parallel edges.
Parallel edges are edges that start and end with the same index value. If the To Visible Parallel
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Edges option is highlighted, the distribution of the current edge will be copied to just the visible
parallel edges. By default, the bunching parameters of the parallel edges are based upon the rel-
ative lengths of the selected edge and destination edges. The To Selected Edges option allows
you to copy edge parameters to selected edges. The From Edge option allows you to copy a
node distribution from another edge to the selected edge. The application prompts you to select
the source edge from which to copy the node distribution. The Reverse options will copy the
node distribution and reverse it during the copy operation.

Copy Absolute

if enabled, the exact spacing from one edge will be copied to the specified edges, regardless of
edge length.

Linked bunching

allows the distribution of nodes on a single edge to be identical to the distribution of nodes on
a series of smaller, parallel edges. Linked bunching allows you to define a permanent relationship,
called links, between these edges. For example, if the node distribution must be modified on the
smaller edges, you do not have to specify any node distribution on the larger edge. The node
distribution on the larger edge will automatically be updated to reflect the node distribution on
the smaller edges. This is primarily used if there are splits that do not cross a block, but mesh
distribution on both sides need to match, as shown in the example below.

To use this option, first click the select icon for the Edge field (in the Pre-Mesh Params > Edge
Params DEZ and select the target edge, which is the longer edge with more nodes. Enable Linked
bunching and click the select icon to select the reference edge. It is important to select the par-
allel edge with the same base index as the target edge. In the example in Figure 400: Linked
Bunching Example (p. 519), the lowest of the three edges is selected because it shares the same
base index with the target edge.

Figure 400: Linked Bunching Example

Example of parallel edges with different node distributions

Target and Reference Edge selection
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Edges after Linked Bunching option is applied

Highlight dependent edges

highlights in red the dependent edges of the edge selected.

Highlight attached faces

highlights the faces attached to the selected edge.

Highlight Primary edges

highlights in yellow the linked primary edge of the selected edge. Linked edges depend on the
primary edge for their parameters.
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Reverse parameters

allows you to reverse the parameters for the ends of the selected edge. The parameters at the
beginning of the edge (end 1) are switched with the parameters at the end (end 2).

Note:

The number of nodes and the meshing laws specified in the Edge Mesh Parameters always
take precedence in determining the number of nodes. Then spacings 1 and 2 are equally
balanced, followed by ratios 1 and 2, which are also equally balanced, and finally Max
Space is considered.

Bunching Laws

BiGeometric

The default bunching law. The two initial heights and ratios define parabolas in a coordinate
system where the number of node points is the X-axis and the cumulative distance along the
edge is the Y-axis. The parabolas are truncated where their tangent lines are identical; the
spacing is linear between these points. If there are not enough nodal points to form this linear
segment, a hyperbolic law is used and the ratios are ignored.

Biexponential

The Spacing1 and Ratio1 parameters define the distribution from the beginning of the edge to
the midpoint of the edge using an Exponential law. Spacing2 and Ratio2 are similarly used to
define the distribution from the terminating end of the edge to the midpoint of the edge.

The node spacing is described by the following equation:

The parameters are computed according to the vertex constraints. If a ratio equals 0 at a vertex,
the spacing constraint at this vertex only is taken into account and the ratio constraint with
the neighbor spacing is left free by decreasing the polynomial order in the mathematical
function.

Curvature

The spacing of the node intervals is calculated according to the curvature of the function defining
the distribution.

Exponential1

The spacing of the i'th interval from the beginning of the edge is defined using an exponential
function of the Spacing1 and Ratio1 parameters.

The Exponential1 bunching law equation is as follows:
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where Si  is the distance from the starting end to node i, Sp1 is Spacing1, and R is the ratio

given by , where N is the total number of nodes and L is the total
edge length.

Exponential2

Similar to Exponential1, except that Spacing2 and Ratio2 parameters are used and the distribution
starting point is the terminating end of the edge.

From-Graphs

Opens the Relative Point Density vs Edge Distance DEZ where you can graphically create a
bunching law and immediately see it effects.
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The top of the DEZ has a set of global menus.

File

allows you to save or recall a distribution function.

Functions

allows you to choose from a list of preset distributions.

Reverse

allows you to flip the distribution function horizontally or vertically.

Spline/Linear

toggles between a piecewise linear and curved distribution.

Actual/Parameter

toggles between normalized units (range 0 to 1) and the model’s units.

The graphical display is a visual representation of the node density vs. edge distance. A higher
y-coordinate will result in a higher node density. Control points may be moved (click and drag),
added (click) or removed (double-click).

The Edge Distance display shows how the nodes will be distributed along the edge.

You may increase or decrease the number of nodes using the up or down arrows, or by
manually entering an new value.

Enable the check box to manually set the location of the first and last nodes, if desired.

FromEdgeSplits

Use this law to seed the bunching using edge splits. For example, you can use Split Edge (p. 510)
to split an edge arbitrarily. Then, if you apply this FromEdgeSplits bunching law to the split
edge, you can interactively adjust the node distribution by editing the edge split locations (Edit
Edge (p. 509), Move Vertex (p. 501), or similar).

Note:

• This law may only be applied to edges having Edge Splits created using Linear
or Automatic Linear method.

• The number of nodes equal the number of splits + 2.

• To automatically update node bunching when removing edge splits, use the Single
method.

FullCosinus

The spacing of node intervals is calculated using the cosine function. The ends of the edge
have the same constraint values for spacing and ratio.
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The normalized distance from the starting node, ti, is given by ,

where φ is found by a linear distribution of n-3 nodes over the range of 

to .

Geometric 1

Spacing1 is used to set the first distance from the starting end of the edge, then the remaining
nodes are spaced with a constant growth ratio. Only Spacing1 is specified.

The Geometric bunching laws are described by the following equation: ,

where Si  is the distance from the starting end to node i, R is the ratio, and N is the total number

of nodes. The ratio R is limited by 0.25 < R < 4.0.

Geometric2

Similar to Geometric1, except that Spacing2 is used to define the distribution starting from the
terminating end of the edge.

HalfCosinus1

The spacing pattern follows a half cycle of a Cosine function. Distribution begins from the
starting point of the edge, and the parameters for spacing and ratio differ on either end.

The normalized distance from the starting node, ti is given by ,

where φ is found by a linear distribution of n-3 nodes over the range of to

.

HalfCosinus2

Similar to HalfCosinus1 in that the parameters for spacing and ratio follow a half cycle of a Cosine
function, but a sin function is used to perform the calculation to make the distribution appear
to start at the terminating end.

Hyperbolic

The spacing parameters for each end are used to define a hyperbolic distribution of the nodes
along the edge. You can set Spacing1 and Spacing2, and the growth ratios are determined in-
ternally.

The following equations are the basis for the Hyperbolic Tangential bunching law. After an initial
distribution is calculated, iterative adjustments are applied for smoothing and tolerance
checking.
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The parameter limitations are:

Linear

The spacing of the node intervals is calculated using a linear function.

Note:

Selecting this option opens the Relative Point Density vs Edge Distance DEZ as
described in the From-Graphs option.

On-Screen

Use this option to manually adjust node placement by dragging along the selected edge.

Note:

This command will not work in batch mode or be recorded by Replay Control as it
requires your interaction with the graphical display.

Poisson

The spacing of the node intervals is calculated according to a Poisson distribution. Requested
values of Spacing1 and Spacing2 are used. Requested values of Ratio1 and Ratio2 are not used
directly, but are used to determine if the requested spacing is appropriate. If not, the spacing
will be adjusted automatically.

The mapping function is obtained by solving the following differential equation:

,
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with the following boundary conditions:

,

where Sp1 = Spacing1 and Sp2 = Spacing2.

The function P is required to satisfy the Neumann boundary condition. It is computed by an
iterative optimization process loop. Some parameter limitations are:

0.0 < Sp2 < 1.0

0.0 < Sp1 < 1.0 - Sp2

500 < Number of iterations < 9999

ReferenceMesh

The node spacing is derived from an existing mesh edge distribution. This may be useful to
seed an unstructured or swept face to obtain a better quality mesh, or to set up node for node
contact with a preexisting unstructured mesh.

To use this option, an unstructured mesh must be loaded and the mesh edge must match the
blocking edge, including associations to surrounding curves. Nodes Locked is enabled when
this law is applied.

If the node distribution is changed on the reference edge (for example by splitting), then the
PreMesh will go out of date and will have to be recomputed.

Spline

The spacing of the node intervals is calculated by an mspline function.

Note:

Selecting this option opens the Relative Point Density vs Edge Distance DEZ as
described in the From-Graphs option.

Uniform

The nodes along the edge are uniformly distributed.

Match Edges

The Match Edges option allows you to match the edge spacing of a reference edge to a con-
necting target edge. The node spacing on the end of the target edge that connects to the reference
edge will be modified to match the node spacing on the reference edge. The following methods are
available:
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Selected

allows you to match the end spacing of the selected target edge(s) to the adjacent end
spacing of the reference edge. Matching is done around a connected node, so with the inter-
active Selected method, all the target edges selected must be connected to the same node
as the reference edge. Match edges is a quick way to ease edge bunching size transitions
between connected edges and adjacent blocks.

Link spacing

links the target edge end spacing with the spacing on the reference edge. Further adjust-
ments to the reference edge end spacing will automatically be carried to the linked target
edges making updates easier. To remove or modify linked spacing, use the Edge Para-
meters DEZ. Alternatively, a match is reset when a new match is specified around the
same vertex, with or without the link spacing.

Automatic

allows you to automatically match edge spacing at selected vertices.

Vertices

specifies the selected vertices.

Spacing

Minimum

selects the edge having the minimum spacing defined at the selected vertex as the
reference edge.

Maximum

selects the edge having the maximum spacing at the selected vertex as the reference
edge.

Average

averages the spacing at the selected vertex.

Match Edges Dimension

allows you to select the dimension to be matched. For example, you may want to match
edges only in the Ogrid direction (o3). Or, for a turbine blade model, you may match in
the I and J directions first to match the edges in the plane, and then match in the Z dir-
ection for even distribution perpendicular to the plane. You can use the Select option
and select the reference edges to determine the index directions for matching, or use
the All option to match the edges in all directions at once.

Copy bunching

allows you to copy the edge bunching from the selected reference edge to either selected
edges or all parallel edges. When used with scripting, this function has the advantage of
listing the "from edge" and "to edge" rather than the specific edge parameters that existed
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during the recording. This is more parametric than copying bunching from the Edge Para-
meters DEZ.

Method

Selected Edges

allows you to copy the bunching from the reference edge to the selected target
edge(s). This copies the bunching law, end spacings, end ratios and number of nodes.

You can choose to Exclude Number of Nodes if you do not want that parameter
copied.

All Parallel Edges

allows you to copy the bunching from the reference edge to all parallel edges. If
Copy absolute is enabled, the exact spacing from one edge will be copied to the
specified edges, regardless of edge length.

Refinement

The Refinement option allows you to refine blocks by a scale factor, as shown in Figure 403: Block
Refined (p. 529).

Blocks

allows you to select the blocks to be refined.

Level

specifies the amount of refinement or coarsening to apply to the selected blocking. A Level value
greater than 1 will result in finer mesh, while a Level value less than 1 will result in coarsening
of the pre-mesh. Use fractional notation such as 1/2 or 1/3, for values less than 1.

Refinement Dimension

If All is selected, the blocks will be refined in every dimension. If Selected is chosen, you can
enter the dimension (edge) that specifies the direction in which to modify the block. The value
0 corresponds to the X or I direction, 1 corresponds to the Y or J direction and 2 corresponds to
the Z or K direction.
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Figure 401: Initial Mesh

Figure 402: Selection of Blocks and Edge for Refinement

The result is shown below for refinement level = 2 applied to the selected block, along the selected
dimension.

Figure 403: Block Refined
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Pre-Mesh Quality

The Pre-Mesh Quality option allows you to check the mesh quality. All the elements of the current
volume family will be included in the quality check.

Note:

Quality for volume elements only is calculated for 3D blocking. If you use Edit Mesh > Display
Mesh Quality for the same mesh, the quality may be different if surface elements are included
for that calculation.

Criterion

specifies the quality criterion. The criteria available for selection are described in Pre Mesh Quality
Options (p. 531).

Min overview

reports the minimum quality for all applicable metrics (except for Volume Change, which displays
maximum value) in the message window.

Histogram Options

allows you to set the minimum and maximum X-axis values, the maximum Y-height, and the number
of bars displayed in the histogram.

Note:

You can also change the histogram display settings and ranges by right-clicking in the
histogram window.
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Only visible index range

if the visible index range is reduced, then only the elements that are in the index range set by the
Index Control  (p. 183) will be checked. The Index Control window is accessible from the menu that
appears when right-clicking on Blocking in the Display Tree.

Active parts only

if enabled, only the elements within active parts (Display Tree) will be checked.

Pre Mesh Quality Options

The quality can be checked using many different criteria, as described in the following sections:

Angle

Aspect Ratio

Constant Radius

Custom Quality

Determinant (2x2x2 stencil)

Determinant (3x3x3 stencil)

Distortion

Equiangle Skewness

Eriksson Skewness

Ford

Hex. Face Aspect Ratio

Hex. Face Distortion

Max Angle

Max Dihedral Angle

Max Length

Max Ortho

Max Ortho 4.3v

Max Ratio

Max Sector Volume

Max Side

Max Warp

Max Warp 4.3v

Mid Node

Mid Node Angle

Min Angle

Min Ortho

Min Sector Volume

Min Side

Opp Face Area Ratio
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Opp. Face Parallelism

Orientation

Quality

Taper

Volume

Volume Change

Warpage

X Size

Y Size

Z Size

Angle

This option checks the maximum internal angle deviation from 90 degrees for each element. If the
elements are distorted and the internal angles are small, the accuracy of the solution will decrease.
It is always wise to check with the solver provider to obtain limits for the internal angle threshold.

Aspect Ratio

For hexahedral elements, the Aspect ratio is defined as the size of the minimum element edge
divided by the size of the maximum element edge. The values are scaled and the default range of
values is 1–20, such that an Aspect ratio of 1 indicates a regular element.

Constant Radius

This option computes the distortion of a plane, based upon the nodes that compose the surface.
The less warped the plane is, the better quality of mesh the model will have. The default range is
0–20, but if the computed range is above 20, the Min Value will be set to zero and the Max Value
will be automatically adjusted to ensure the histogram includes all existing elements.

Custom Quality

This option allows you to define your own quality metric as the combination of the following
quality criteria and element types: Determinant, Warp, Min Angle, and Max Angle.

You can specify the maximum and minimum quality levels of a histogram for quad and tri elements.
All values are adjusted to a scale of 0 to 1 when Recompute is pressed.

For example, if the Min Angle Quad is 30 degrees and the maximum is 45 degrees, then 30 degrees
will correspond to the minimum value in the custom quality and 45 degrees will correspond to the
maximum value.

Determinant (2x2x2 stencil)

The Determinant, more properly defined as the relative determinant, is the ratio of the smallest
determinant of the Jacobian matrix divided by the largest determinant of the Jacobian matrix. In
this option, the determinant at each corner of the hexahedron is found. The default range is 0–1
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with a Determinant value of 1 indicating a perfectly regular mesh element and 0 indicating an
element degenerate in one or more edges. Negative values indicate inverted elements.

Note:

This determinant is appropriate for 3D linear hexas and calculates more quickly than the
3x3x3 matrix because it does not include the unnecessary mid side nodes.

Determinant (3x3x3 stencil)

This is for hexahedral elements. This option is the same as the 2x2x2 stencil, but edge midpoints
of blocks are added to the Jacobian computation.

The Jacobian determinants for hexahedras will be calculated at r,s,t = -1,0,1 of the natural coordinate
system of the element (27 node positions). Next it calculates the maximum absolute determinant
of the 27 determinants (3x3x3). If this is at position i with absolute determinant value max0, then
for each of the 27 positions (j) (except i) the absolute distance of determinant j to determinant i
will be calculated. The final result will then be 1 minus the maximum of the absolute distances di-
vided by max0, so that the range of this quality criterion value will be between -1 and 1. The Jac-
obian determinant is the determinant of the Jacobian operator which connects the derivatives of
the natural coordinates (r,s,t) with the derivatives of the local coordinates (x,y,z). J = ((dx/dr dy/dr
dz/dr) (dx/ds dy/ds dz/ds) (dx/dt dy/dt dz/dt)).

Note:

A good book to understand the determinant calculation is: Finite Element Procedures,
by K.J. Bathe, Prentice Hall, New Jersey 07632, 1996.

Distortion

This is available only for hexa elements and is the measurement of the twisting of the element
from the ideal shape. For this the Jacobian determinants will be calculated at r,s,t=-1,0,1 of the
natural coordinate system of the element (27 node positions). The distortion is 27 times the minimum
of all absolute determinants divided by the sum of all 27 absolute determinants (0 if all Jacobian
determinants are 0).

Equiangle Skewness

This quality parameter applies to tetra, hexa, quad, and tri elements.

Element equiangle skew = 1.0 – max ((Qmax – Qe) / (180 – Qe), (Qe – Qmin) / Qe),

where

Qmax = largest angle in the face or element

Qmin = smallest angle in the face or element

Qe = angle of an equiangular face or element (60 degrees for a triangle or 90 degrees for a square).
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Eriksson Skewness

This is an empirical criterion, obtained for a hexahedral element by dividing the volume of the
closest parallelepiped by the product of its edges. It measures the shear of the parallelepiped closest
to the current element using least squares approximation. The default range of values is 0–1. Gen-
erally acceptable elements have skewness ranging from 0.5 to 1.

Ford

This is a hybrid quality parameter for 3 and 4 node (tri and quad shell) element meshes based on
weighted skewness, warpage, and aspect ratio values. It was custom developed for Ford Motor
Company to fit their established processes and metrics. The possible range is from 0 to 32.

Hex. Face Aspect Ratio

This quality parameter calculates the 3 averaged face areas (average of the areas of two opposite
faces) of hexahedra elements. The maximum of the six possible divisions of the averaged face areas
will be calculated and then inverted to normalize the result.

Hex. Face Distortion

This quality parameter calculates the product of the maximum edge size in the i direction multiplied
by maximum edge size in the j direction, multiplied by the same in the k direction, and then divides
this value by the volume of the hex element. The default range is 0–20, but if the computed range
is above 20, the Min Value will be set to zero and the Max Value will be automatically adjusted
to ensure the histogram includes all existing elements.

Max Angle

This calculates the maximum internal angle of each element. The range of values is 90–180 degrees.

Max Dihedral Angle

This is the maximum angular space contained between planes which intersect. It is measured by
the angle made by any two lines at right angles to the two planes. The range of values is 90–180
degrees.

Max Length

This calculates the maximum length of the diagonals of quad faces, and the maximum side length
of tri faces. This works for all meshes and element types. The default range is 0–20, but if the
computed range is above 20, the Min Value will be set to zero and the Max Value will be automat-
ically adjusted to ensure the histogram includes all existing elements.

Max Ortho

This calculates the maximum deviation of the internal angles from 90 degrees for each element.
The default range is 0–90.
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Max Ortho 4.3v

This calculates the maximum deviation of the internal angles of the elements from 90 degrees. For
elements other than hexas this diagnostic is equal to Max Ortho. For hexas this differs from Max
Ortho in the way that angles between 180 and 360 degrees are also considered (deviation up to
270 degrees).

Max Ratio

This calculates the maximum ratio of the lengths of any two edges that are adjacent to a vertex in
an element. The default range is 0–20, but if the computed range is above 20, the Min Value will
be set to zero and the Max Value will be automatically adjusted to ensure the histogram includes
all existing elements.

Max Sector Volume

This option is available for volume elements. For each element node the sector volume will be
calculated in the Gauss integration points of order 3 and the maximum of the calculated sector
volumes will be taken. The default range is 0–20, but if the computed range is above 20, the Min
Value will be set to zero and the Max Value will be automatically adjusted to ensure the histogram
includes all existing elements.

Max Side

This calculates the maximum side length of each element. The default range is 0–20, but if the
computed range is above 20, the Min Value will be set to zero and the Max Value will be automat-
ically adjusted to ensure the histogram includes all existing elements.

Max Warp

This calculates the maximum warp (in degrees) of all elements. This works only for structured volume
and surface meshes, linear hexahedral and linear quadrahedral elements. To determine warp of a
quadrilateral face, find the midpoints of all edges, which will be co-planar. Then, calculate the
maximum angle of any edge with the plane as defined, which is the warp of the face. The maximum
warp of a volume element or hexahedron is the maximum warp of its faces. For a 2D, planar mesh
of QUAD_4 elements, the warp will be zero for all elements. The default range is 0–90 degrees.

Max Warp 4.3v

This measure applies to quad, prism and hexa elements (for quadratic elements the linear part will
be checked).

To determine the warp of a quadrilateral face, the angles between the triangles connected at the
2 diagonals of the quad will be calculated and the maximum will be used.

The maximum warp of a volume element (prism or hexa) is the maximum warp of its quad faces.

For a 2D planar mesh of QUAD_4 elements, the warp will be zero for all elements.
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Mid Node

This calculates the maximum deviation of the mid node. The default range is 0–1.

Mid Node Angle

This calculates the angle by which the quadratic mid node is off from the linear edge. The default
range is 0–90.

Figure 404: Definition of Mid Node Angle

Min Angle

This calculates the minimum internal angle of each element. The default range is 0–90 degrees,
with 0 as degenerate and 90 as perfect.

Min Ortho

This calculates the minimum deviation of the internal angles from 90 degrees for each element.
The default range is 0–90.

Min Sector Volume

This option is available for volume elements. For each element node the sector volume will be
calculated in the Gauss integration points of order 3 and the minimum of the calculated sector
volumes will be taken. The default range is 0–20, but if the computed range is above 20, the Min
Value will be set to zero and the Max Value will be automatically adjusted to ensure the histogram
includes all existing elements.

Min Side

This calculates the minimum side length of each element. The default range is 0–20, but if the
computed range is above 20, the Min Value will be set to zero and the Max Value will be automat-
ically adjusted to ensure the histogram includes all existing elements.

Note:

Use this check if you are concerned about Min Side reducing the time step. There is also
a modified Laplace smoother that can help increase these min side elements.
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Opp Face Area Ratio

This is applicable for hexahedral elements only. This is the measurement of the worst ratio of the
areas of the opposite faces of the hexahedral element. Ideally, this value should be 1. The default
range is 0–20, but if the computed range is above 20, the Min Value will be set to zero and the
Max Value will be automatically adjusted to ensure the histogram includes all existing elements.

Figure 405: Definition of Opposite Face Area Ratio

In the figure above, let A1 = Area of Quad Face {ABDC}, and A2 = Area of Quad Face {EFHG}. If
A1>A2, then the Opposite Face Area Ratio of this pair of faces = A1/A2. If A1<A2, then the Opposite
Face Area Ratio = A2/A1. Similarly, the Opposite Face Area Ratio is found for each opposing pair
of faces, and the maximum of all three pairs is found as the measurement for this hexahedral ele-
ment.

Opp. Face Parallelism

This feature is also for hexahedral elements only. It is the measurement of the parallelism of the
hexahedral elements. If the opposite faces are ideally parallel, the value is 1. The default range is
0–20, but if the computed range is above 20, the Min Value will be set to zero and the Max Value
will be automatically adjusted to ensure the histogram includes all existing elements.

Orientation

This computes the direction of the face normal determined by the orientation of the nodes based
on the right hand rule. Face orientation should be into the volumetric domain.

Quality

The criterion Quality is calculated differently for different element types.

• Tri and Tetra

The quality is calculated as the minimum ratio of height to base length of each side (normal-
ized to 1).

• Quad
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The quality is calculated as the Determinant, as described in Determinant (2x2x2 sten-
cil) (p. 532).

• Hexa

The quality is a weighted diagnostic between Determinant (between -1 and 1), Max Orthogls
(normalized between -1 and 1; if deviation from orthogonality is greater than 90 degrees,
then the normalized value will be smaller than 0) and Max Warpgls (normalized between 0
and 1; warpage of 0 degrees is 1, warpage of 180 degrees is 0). The minimum of the 3 nor-
malized diagnostics will be used.

• Pyramid

The quality is calculated as the determinant.

• Prism

The quality is calculated as the minimum of the Determinant and Warpage. Warpage is
normalized to a factor between 0 and 1, where 90 degrees is 0, and 0 degrees is 1.

Taper

For hexahedral elements, the Taper is the maximum ratio of the areas of opposite faces. For quad
elements, it is the maximum ratio of the lengths of opposite edges.

Volume

This computes the volume of each element based on the corner points. The default range is 0–20,
but if the computed range is above 20, the Min Value will be set to zero and the Max Value will
be automatically adjusted to ensure the histogram includes all existing elements.

Volume Change

This quality metric is calculated for a specific element by finding the maximum volume of all its
neighboring elements and dividing it by the volume of the element itself. The default range is 0–20,
but if the computed range is above 20, the Min Value will be set to zero and the Max Value will
be automatically adjusted to ensure the histogram includes all existing elements.

Warpage

This computes the distortion of a plane, based upon the nodes that compose the surface. The default
range is 0–90, where a warpage value of 0 is flat (preferred) while 90 is degenerate.

X Size

This computes the length of the element profile in the X direction. The default range is 0–20, but
if the computed range is above 20, the Min Value will be set to zero and the Max Value will be
automatically adjusted to ensure the histogram includes all existing elements.
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Y Size

This computes the length of the element profile in the Y direction. The default range is 0–20, but
if the computed range is above 20, the Min Value will be set to zero and the Max Value will be
automatically adjusted to ensure the histogram includes all existing elements.

Z Size

This computes the length of the element profile in the Z direction. The default range is 0–20, but
if the computed range is above 20, the Min Value will be set to zero and the Max Value will be
automatically adjusted to ensure the histogram includes all existing elements.

Pre-Mesh Quality Histogram

After computing the determinant values of the elements, a histogram of the values will be displayed.
The X-axis represents the quality range for the particular type, and the Y-axis represents the number
of elements within a particular histogram bar. An arrow at the top of a histogram bar indicates that
there are more elements in that bar than are displayed per the current maximum number on the Y-
axis.

By clicking any of the bars with the left mouse button, the information about the precise number of
values that fall into this interval and its boundaries are displayed in the Messages window. Bars that
are clicked change color, and remain selected until clicked again. To display the elements within a
selected (highlighted) histogram bar, right-click the histogram window, and select Show.

The histogram of the Angle Quality for a certain hexahedral block is shown in Figure 406: Histogram
of Angle Quality (p. 539). The histogram options menu is also shown.

Figure 406: Histogram of Angle Quality

The histogram options are as follows:

Replot

allows you to change the parameters of the histogram using the Replot window.
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Figure 407: Replot Window

Min / Max X value

sets the minimum and maximum values of the particular quality type selected for the X-axis.

Max Y height

sets the maximum number of blocks for the quality ranges. A value of 0 will set the display
to such that the histogram with the largest number of elements is fully visible. A smaller
number will give increased resolution for quality ranges with fewer elements.

Num bars

sets the number of bars to use in the histogram display.

Reset

sets the maximum number on the Y-axis such that the histogram bar with the largest number of
elements is fully visible.

Show

displays the elements within the selected (highlighted) histogram bars.

Solid

redraws all selected elements using flat shading, according to the color map.

Done

closes the histogram window.

Pre-Mesh Smooth

The Pre-Mesh Smooth option allows you to smooth the pre-mesh.
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Figure 408: Pre-Mesh Smooth Options

There are three options available for smoothing blocking mesh as shown in Figure 408: Pre-Mesh Smooth
Options (p. 541).

Quality Method

Orthogonality Method

Multiblock Method

Quality Method

The following options are available for the Quality method for pre-mesh smoothing:

Smoothing iterations

specifies the number of smoothing iterations to be run.

Up to quality

specifies the quality level for smoothing. The default is 0.2.

Criterion

specifies the quality criterion for smoothing.

Determinant 3x3x3

Smoothing by Determinant 3x3x3 (p. 533) tries to locally improve the worst determinant of all
elements hanging on a node.

Angle

Smoothing by Angle (p. 532) tries to locally improve the worst angle of all elements hanging
on a node.

Advanced Options

contains advanced options for smoothing.

Only visible index range

If enabled, only the elements that are in the index range set by the Index Control  (p. 183)
will be checked. The Index Control window is accessed from the menu that appears when
right-clicking on Blocking in the Display Tree.
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Active parts only

If enabled, only the active parts will be smoothed.

Laplace smoothing

If enabled, performs Laplace smoothing for the surface. Laplace smoothing works on the
whole mesh and tries to create uniform transition.

Figure 409: Example of Laplace Smoothing

Original Mesh

Mesh after Laplace smoothing

Orthogonality Method

The Orthogonality method relaxes unstructured hexahedral meshes in order to obtain smooth grid
lines orthogonal to the boundary as well as smooth grid angles and transitions in the inner volume.
It first smoothes the surface mesh recognizing the topological boundary edges. If the number of
volume smoothing steps is greater than 0, after each surface smoothing step the inner volume will
be adjusted by performing 1 volume smoothing step. After the surface smoothing has been finished,
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the inner volume will be smoothed (according to the number of volume steps set). It can also smooth
real surface meshes.

Note:

A minimum of 10 iterations of smoothing of the surface mesh must be completed for
stability reasons.

The mathematical basis is that an elliptical differential equation of the form , where  is the

"control function", will be solved. It can be proved that by using the elliptical operator , smoothness
of the mesh will be achieved. The control function  will be specified so that the smoothed mesh
will obtain certain characteristics, such as orthogonality and layer height of the first layer.

Note:

The unstructured hexahedral smoother is also available under Edit Mesh >Smooth
Hexahedral Mesh Orthogonal to smooth an existing mesh.

Tips to improve smoothing success:

• Create the best possible starting condition by matching edge distributions.

• Create points (geometry) at the ends of the edges, and then associate the vertices (block) to them.
This may be used to contain an area of fine mesh along a wall, preventing it from being totally
smoothed out.

The following smoothing parameters are available for the Orthogonality method:
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Number of iterations on surface

specifies the number of iterations the smoother uses to relax the surface mesh (minimum is 10).
The default number of iterations on surface is also 10.

Number of iterations on volume

specifies the number of iterations the smoother uses to additionally relax the volume mesh after
surface smoothing has been finished (minimum is 0). When the number specified is greater than
0, a volume smoothing step will be performed after each surface smoothing step to adjust the
volume mesh to the surface mesh. The default number of iterations on volume is 5.

Smooth Type

If Orthogonality is selected, then the smoother tries to retain orthogonality and the height of
the first layer (a different height can be specified for different parts using Release Orthogonality
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/ Initial Height Options). If Laplace is selected, the smoother tries to equalize the mesh by setting
the control function  to 0 in the elliptical differential equation.

Freeze Options

freezes the specified areas of the surface boundary. You can freeze all surface boundaries, or se-
lected parts. To freeze Selected Parts, select the part(s), then click Selected part(s) Options.
Specify the frozen surface boundary by enabling Surface boundary. Specify the number of layers
to be frozen with the surface boundary by disabling Surface boundary and entering the number
of layers n in the Layers field. The number of layers is set to 0 by default. When Layers is greater
than 0, then the surface boundaries including the first n layers from the boundary will be frozen.
For example, a value of 3 indicates that three layers of nodes away from the surface will be frozen
along with the surface boundary.

Release Orthogonality / Initial Height Options

For certain situations, it may be helpful to release the orthogonality requirement from a certain
surface part or set the first layer distance (initial height of the first element off the wall) on certain
surfaces. These are mutually exclusive since orthogonality is required to set the first layer height.
Select the desired parts, and then click Selected part(s) Options. The default is to release ortho-
gonality for each part. You can set the initial height by disabling Release orthogonality and then
set the initial height by entering it in the Initial Height field.

Note:

You can set the Initial Height to -1 (default) in order to keep the starting initial height.

Smooth along curves

allows you to specify which edges (projected onto curves) should be smoothed. The smoothing
will be carried out when faces are smoothed. You can specify none, all, or selected curves. The
default is all.

Note:

If the mesh distribution has a relatively large dynamic range of mesh sizes along a
curve, then selecting this option may be counter productive.

Advanced Options

contains the following advanced smoothing options:
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Grid expansion rate

If a smoothing method other than Laplace is selected, then the grid expansion values will be
used to distribute the control function values into the inner volume. If the grid expansion rate
is greater than 0.0, the algorithm computes a pseudo-structured region in which the control
function values will be interpolated by an exponential decay (the grid expansion rate will then
control the negative exponent (e power -g) of the control function values). If it is 0.0 then a
Laplace interpolation of the control function values will be done, such as for an inner node,
the control function value will be averaged by the control function values of its neighbor
nodes.
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The default values are 0.0 for the surface mesh and for the inner volume. Reasonable values
other than 0.0 should be greater than 1.0.

Note:

It may be difficult to form the pseudo-structured regions in some cases. If you have
such problems, set the grid expansion rate back to 0.

Note:

If the grid expansion rate is set to 0.0 and the smooth type is set to Orthogonality,
the first layer height and the orthogonality at the boundary are still achieved, but
the next layers tend towards Laplace approaching the middle of the mesh. In case
of a Navier- Stokes mesh you can see the effect near the boundary where the first
layer is orthogonal to the boundary but the next layers curve as they equalize
(Laplace) the distances of the layer nodes.

Treat unstruct nodes

determines the method of treating inner unstructured nodes. An unstructured node is a node
on which no ij (surface) or ijk (volume) directions can be defined. For example, a node which
has more or less than 4 (surface) or 6 (volume) neighbors is clearly an unstructured node.

Note:

For most models, the effect of the this setting may be negligible.

Stabilization Factor

is used in the calculation of the new nodes and should be greater or equal to 1.0. A higher
factor will make the smoother more stable at the cost of orthogonality at the boundaries. If
there are problems with the smoother it is recommended that this value be increased to
around 8.0. Default values are 1.0 on surfaces and 2.0 in the volume. Increasing this parameter
may be helpful on certain model configurations if the smoother corrupts the mesh, especially
if it appears due to overly orthogonal boundaries.

Use Orthogonal Distance

if enabled, then the original boundary distance of a first layer node will be calculated by
projecting it to the boundary and measuring the distance to the projected point. Otherwise,
the length of the original grid line will be used. By default this option is disabled for both the
surface and volume.

In cases where there is a sharp angle between the grid lines from the first layer to the
boundary, if Use Orthogonal Distance has not been set, the calculated first layer distance
may be considerably greater than the distance of the first layer nodes to the boundary (because
the length of the grid line will be used). Hence, it may be advisable to set Use Orthogonal
Distance in the same way for both Surface and Volume. This would ensure that the first
layer grid line angles in the volume near the surface boundary would be similar to the nearby
surface boundary grid line angles.
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Define Edges On Part Border Options

allows you to define the border grid lines attached to the selected parts as edges, and the
node distribution on the edges will be frozen. The main purpose for defining these edges is
that they separate the two sides of the surface mesh. If an edge is topologically internal then
orthogonality will not be established there.

Surface Fitting

constrains boundary nodes to the true geometry surfaces. When disabled, the original quad
faces are used to determine the boundary constraints. This option is enabled by default.

Keep periodic geometry

when enabled, allows you retain original dimensions on periodic faces. With this option dis-
abled, point projected nodes may be moved on the corresponding surfaces during smoothing
with the orthogonal smoother. This option is enabled by default.

Active parts only

if enabled, only the active parts (parts that are turned on (activated) in the Parts branch of
the display tree, see the Parts (p. 213) section) will be smoothed. The geometry or mesh of the
active parts does not need to be displayed. When this option is disabled, the whole mesh will
be smoothed. This option is disabled by default.

Multiblock Method

The Multiblock method is used to smooth multiblock mesh. This smoother works on the base of the
(structured) blocks of the pre-mesh.

The Multiblock smoother is used to obtain smooth grid lines. It is specially optimized for blade con-

figurations. The mathematical basis is that an elliptical differential equation of the form ,

where  is the "control function", will be solved. It can be proved that by using the elliptical operator

, smoothness of the mesh will be achieved. The control function  will be specified so that the
smoothed mesh will obtain certain characteristics, such as orthogonality and layer height of the first
layer.

The following parameters are available for this method.

Relaxation Block(s)

allows you to select/deselect blocks. Click the appropriate selection icon to select or deselect
blocks.

Block Display Off

if enabled, the selected blocks will not be displayed on the screen.

Smoothing Direction

3D Direction

smoothes all the blocks of the pre-mesh independently.
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Select direction

allows you to select the smoothing direction.

Reference Edge

specifies the edge defining the smoothing direction. To select the smoothing direction
click the Edge selection icon. A block will be highlighted in the display. Click the edge
that defines the desired smoothing direction.

If I, J, or K is selected, and no Global vertices are selected, then the blocks of the pre-
mesh will be smoothed in planes starting and ending at the indices specified, and with
the increment specified. The planes in between will be interpolated and smoothed, if
Volume iterations is set greater than 0. If directions I, J, or K is selected, and the Global
Vertices option is selected, then the pre-mesh will be smoothed globally over selected
edges defined by its end vertices, in planes starting and ending at the indices specified,
and with the increment specified. The planes in between will be interpolated and smoothed,
if Volume iterations is set greater than 0.

For example, if you select a smoothing direction I, Start Index = 1, End Index = 20, and
Increment = 5, the nodes on the planes I = 1, 6, 11, 16, and 20 would be smoothed with
the remaining nodes interpolated. It is also possible to define a list of planes by specifying
the plane numbers separated by spaces in the Planes field. In this case the plane numbers
have higher priority than the Start and End Index fields.

Note:

To identify planes, use the Blocking Display Tree > Pre-Mesh > Scan
Planes (p. 196) function.

Auto Setup

When Auto Setup is selected, all subfaces which fulfill the following conditions will be selected
as Non-Relaxation Faces and Hold Cell Height Faces:

• Subfaces that belong to the selected blocks.

• Subfaces that are not perpendicular to the selected smoothing direction.

• Boundary subfaces with respect to the selected blocks. For example, they cannot be block
interfaces between two selected blocks.

• Subfaces that are not periodic.
Additionally, all vertices which are connected to the selected blocks will be defined as Global
Vertices.

Layer Options

These options allow you to select layer options when smoothing.
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Start Layer

is the index plane in smoothing direction at which the smoothing should start. The value
should be between 1 and less than or equal to the maximum index. If plane numbers have
been set under Planes then this field will not be used.

End Layer

is the index plane in smoothing direction at which the smoothing should end. The value
should be between 1 and less than or equal to the maximum index. If plane numbers have
been set under Planes then this field will not be used.

Increment

specifies the increment to smooth the planes between the Start and End Layers. The nodes
will be interpolated in between the layers.

Volume iterations

if set to greater than, 0 then only the nodes between the planes selected for smoothing will
be smoothed with this number of iterations after interpolation.

Planes

specifies the index planes in the smoothing direction for smoothing. The values should be
between 1 and less than or equal to the maximum index, and should be separated by blanks.
If specified then it will overwrite the values for Start and End Layer, and Increment.

Face Options

allows you to choose from the following options for selected subfaces:

Non-Relaxation Faces

freezes subfaces.

Hold Cell Height Faces

orthogonality and first cell height will be obtained on all grid lines perpendicular to the selected
subfaces.

Face Display Off

if enabled, then the selected faces will not be displayed.

Face Icons

enables the display of the selected faces by icon. Otherwise the selected faces will be shown
in solid display, at 90% of their full size.

Face Filters

allows you to filter the selected faces using the Use All Selected Faces, Use Only Block In-
terfaces, and Use Only Boundaries options.
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Remove periodic faces

if enabled, the periodic faces will be removed from the selection.

Select or deselect faces by clicking on the appropriate selection icon.

Vertices Options

Global Vertices

If any end vertices of a block edge have been selected, and a smoothing direction is selected,
then the pre-mesh will be smoothed globally in planes. It is recommended that all vertices
be selected as Global Vertices and that the real (not periodic) boundaries be frozen.

Layer Vertices

This option is intended to be used for Ogrid vertices. For neighbor nodes, the bisector will
be calculated placing the neighbor nodes on the bisector line in a distance specified as the
First Layer Distance. If the First Layer Distance is smaller than 0.0, the selected vertices will
not be used. Vertices can be added or removed from the selection list, and the First Layer
Distance can be changed for the selected vertices.

Layer Vertices are only used in global edge smoothing. To access this option, a smoothing
direction must have been selected.

Vertices Display Off

if enabled, the selected global or layer vertices will not be displayed.

Select or deselect vertices by clicking on the appropriate icon.

Clear all selections

resets all selections.

Advanced Options

contains the following advanced options:

Number of Iterations / Steps

Iterations in equation solver

specifies the number of iterations for the equation solver (default is 25). An equation
solver (SOR method) is used to solve the elliptic equation method.

Steps in global edge smoothing

specifies the number of smoothing steps in the global-edge smoothing method. In each
step the Pre-Mesh will be smoothed globally and the output will be used as input in the
next step (default is 25).
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Parameters

Projection limit

is useful for near-wall layers. This parameter is used for node distribution whose first
spacing from the surface is less than the geometry tolerance. A value greater than 0.0 will
define a distance normal to the surface up to which the nodes will be interpolated. A
single value of projection limit is used at all locations on the model.

Relaxation factor

is a factor to stabilize the smoothing value. Reasonable values should be between 0.0
(exclusive) and 1.0 (inclusive). The default value is 0.5.

Residual factor

is used during global edge smoothing. Starting from the 2nd global edge step, the average
change compared to the previous step will be calculated by dividing this value by the
value calculated in the 2nd step. If this relative value gets lower than the Residual factor,
a stop criterion has been reached. The default value is 0.05.

Surface fitting

constrains boundary nodes to the true geometry surfaces. With this option disabled, the
boundary nodes will be projected to the triangulation of the geometry surfaces.

Use projection

enables smoothing steps to be performed, allowing nodes to move away from constraints
(curves, surfaces), and then the nodes are finally projected back to the curve or surface.
By default, this option is disabled.

Use orthogonal positioning

is used during global edge smoothing or plane smoothing. If Hold Cell Height has been
set on a subface, a special method will be used to calculate the control function values
in a way that the first layer nodes will be placed to hold the original or user defined (layer
vertices) cell height and to be orthogonal (bisector) to the boundary. By default, this option
is enabled.

Use fractional positioning

is used during global edge smoothing or plane smoothing. If Use orthogonal positioning
has been set, the first layer nodes will not be moved in one step to the orthogonal position
but in a certain amount of steps (10). This is mainly to stabilize the orthogonal positioning
algorithm in highly clustered meshes. By default, this option is disabled.

Methods

In the structured smoother, several elliptic relaxation methods are available both for the
volume and faces (subface boundaries). The default method is Sorenson - Laplace. In the
case of global edge smoothing, this parameter is not relevant.

• Sorenson-Laplace
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Sorenson methods attempt to maintain node distributions (bunching) near the surface
boundaries while improving orthogonality. This hybrid method attempts to improve ortho-
gonality at the boundary while maintaining the first layer height from the boundary surface
and making a uniform node distribution in the interior

• Sorenson-Thomas & Middlecoff

This method improves orthogonality at the boundary while maintaining the first layer height
from the boundary surface and holding the original clustering on the interior.

• Thomas & Middlecoff

This method generally improves the orthogonality of grid lines across boundaries while
holding the original clustering in the interior.

• Laplace

This method attempts to give a uniform mesh size for all selected elements or to give a
uniform transition.

• Interpolation

This uses an algebraic transfinite interpolation method with Soni interpolants to generally
improve internal angles.

• Hilgenstock - Thomas & Middlecoff

Hilgenstock methods maintain orthogonality. This hybrid method maintains orthogonality
between block boundaries (subfaces) to give a smooth transition across subfaces, while
maintaining the first layer height from the boundary surface.

• Hilgenstock - Laplace

This attempts to improve orthogonality and uniform node distribution within the mesh.

Grid expansion rate

is the exponent for the exponential decay of Sorenson terms from the boundary to the interior
of a face. Reducing this factor will cluster the elements closer to the boundary. Default values
are 3.5 for faces and 4.6 for the volume.

Multiblock Settings

Load Settings

allows you to load previously saved Multiblock settings.

Save Settings

allows you to save the current Multiblock settings in a file.

Run in sequence

allows you to load different Multiblock settings files and run them in sequence. Click Start
sequence to begin running the sequence of files.
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Convert old settings

allows you to convert Multiblock settings which were created with the Ansys ICEM CFD 4.3
version.

Convert file

specifies the old settings file.

Save as file

specifies the new settings file.

Convert

starts the conversion.

Block Checks

The Block Checks option allows you to check the blocks. The following methods are available for
checking/fixing blocks:

Run Check/Fix

checks the internal data structures for inconsistencies and fixes them if possible.

• Enable Also Check Free/Swept to include free and swept blocks in the check, otherwise
only mapped blocks will be checked.

• Also Check Free/Swept will be enabled automatically if your blocking contains 3D free or
swept blocks. 2D blocks will be ignored.

Fix Inverted Block

fixes all the Inverted blocks. Inverted blocks have a negative determinant.

Invert Selected Block Method

inverts the selected blocks.

Pack Block Numbers

automatically renumbers all blocks in sequential order. This is to avoid very large block numbers
that can result after repeated block editing and VORFN rebuilds.

Delete Block

The Delete Block option allows you to delete the blocks from the topology. The Delete permanently
option is disabled by default.
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If Delete permanently is disabled, the block will be moved to the VORFN part. The VORFN part is es-
sentially dormant and mesh is not computed for it, however it does help to maintain connectivity.
Blocks can be retrieved from the VORFN region using the Add Blocks to Part option.

If Delete permanently is enabled, the block will be permanently deleted. At this point connectivity
will be broken and the VORFN region will be rebuilt. This can be useful in some situations, but this will
also result in a re-indexing of the blocking. The resulting index structure is usually more complicated
and may be more difficult to work with.

Figure 410: Example of Delete Blocks Permanently

Note that there are an equal number of nodes across the hole.

Block selected to be deleted.

After the block is deleted permanently, the edges on opposite sides of the hole are no longer connected
by a VORFN block and it is possible to adjust the edge distributions separately.
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Edit Mesh
Figure 411: Edit Mesh Toolbar

The Edit Mesh menu contains all of the operations necessary to manipulate, check, improve the quality
of the mesh and fix any problems.

Create Elements

Extrude Mesh

Check Mesh

Display Mesh Quality

Smooth Mesh Globally

Smooth Multiblock Domains Globally

Smooth Hexahedral Mesh Orthogonal

Repair Mesh

Merge Nodes

Split Mesh

Move Nodes

Transform Mesh

Convert Mesh Type

Adjust Mesh Density

Renumber Mesh

Assign Mesh Thickness

Reorient Mesh

Delete Nodes

Delete Elements

Edit Distributed Attribute

Note:

Within this menu, only the mesh elements and nodes can be checked or manipulated. You
cannot manipulate or check faceted data such as STL or Nastran that represents geometry.
Editing this type of data can be done in the Geometry menu.
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Create Elements

The Create Elements option is used for manually creating different element types. Generally, to
improve some bad elements or to get rid of some problems/errors in the mesh, some elements are
deleted and good quality elements are created manually. For example, a bad quad element can be
represented by two good tri elements.

Figure 412: Create Elements Options

Part

Select or enter a part name. The new elements created will go into this part.

The different options for creating elements are described in the following sections.

Node (Point Element)

Bar (Line Element)

Triangle

Quad

Tetra

Prism

Pyramid

Hexa

Auto Element Type

Node (Point Element)

The Node (Point Element) option creates a node element. You need to select a particular position
where a new node (point) should be created.

Note:

This does not refer to nodes that define mesh elements, but an actual zero dimension
element that is typically at an existing mesh node location. These node elements are
commonly used for applying loads, constraints, and other boundary conditions.
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Method

From nodes

allows you to select the nodes of the mesh to define new elements. A mesh must be loaded
so that nodes can be selected.

From points

allows you to select the points of the geometry to define new elements. A geometry file must
be loaded so that points can be selected.

From screen

allows you to select any arbitrary location by clicking on the screen.

Automatic element creation

automatically creates the element after selecting the point, node, or edge, without requiring
confirmation by pressing the middle mouse button.

Bar (Line Element)

The Bar (Line Element) option allows you to select two locations to specify a bar (line) element.
It is possible to select existing nodes, points, or arbitrary locations on the screen.

Method

From nodes

allows you to select the nodes of the mesh to define new elements. A mesh must be loaded
so that nodes can be selected.

From points

allows you to select the points of the geometry to define new elements. A geometry file must
be loaded so that points can be selected.

From screen

allows you to select any arbitrary location by clicking on the screen.

From elements

allows you to select any element(s) and line elements will be created for each edge of the
element(s).

Inherit parts

if enabled, the created line elements will be added to the same part as the original ele-
ments. Otherwise, the line elements will be added to the part specified in the Part field.
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From edges

allows you to select elements to define new line elements from their edges.

From curves

allows you to select a curve to define a new line element.

Automatic element creation

automatically creates the element after selecting the point, node, or edge, without requiring
confirmation by pressing the middle mouse button.

Triangle

The Triangle option allows you to select three locations to create a triangle. A triangular element
is a surface element. If not possible, a message will be displayed that it could not create the triangle
because the volume mesh could not be made consistent.

Method

From nodes

allows you to elect the nodes of the mesh to define new elements. A mesh must be loaded
so that nodes can be selected.

From points

allows you to select the points of the geometry to define new elements. A geometry file must
be loaded so that points can be selected.

From screen

allows you to select any arbitrary location by clicking on the screen.

Make Volume Consistent

automatically adjusts the volumetric elements to conform with the new element(s). This only applies
when creating triangles within a tetra mesh.

Automatic element creation

automatically creates the element after selecting the point, node, or edge, without requiring
confirmation by pressing the middle mouse button.

Quad

The Quad options allows you to select four locations to specify a quad element. A quadrilateral
element is a surface element. It is possible to select existing nodes, points, or arbitrary locations on
the screen. Select in a clockwise or counterclockwise order unless Automatic vertex distribution is
enabled (see below).
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Method

From nodes

allows you to select the nodes of the mesh to define new elements. A mesh must be loaded
so that nodes can be selected.

From points

allows you to select the points of the geometry to define new elements. A geometry file must
be loaded so that points can be selected.

From screen

allows you to select any arbitrary location by clicking on the screen.

Make Volume Consistent

automatically adjusts the volumetric elements to conform with the new element(s). This applies
when creating quads within a tetra mesh. Pyramids will be created to maintain node connectivity.

Automatic vertex distribution

For quad and hexa elements, if this option is enabled, the order of selection of nodes is disregarded,
and selected nodes will be automatically reordered to avoid creating a skewed element.

Figure 413: Example of Automatic Vertex Distribution option

Automatic Vertex Distribution enabledAutomatic Vertex Distribution disabled

Although the nodes were selected in the
same order as above, a good quality quad
element is created.

If the nodes were selected in the order
notated, a skewed element is created.

Automatic element creation

automatically creates the element after selecting the point, node, or edge, without requiring
confirmation by pressing the middle mouse button.

Tetra

The Tetra option allows you to select four locations in any order to create a tetra element. A
tetrahedral element has four tri faces.
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Method

From nodes

allows you to select the nodes of the mesh to define new elements. A mesh must be loaded
so that nodes can be selected.

From points

allows you to select the points of the geometry to define new elements. A geometry file must
be loaded so that points can be selected.

From screen

allows you to select any arbitrary location by clicking on the screen.

Automatic element creation

automatically creates the element after selecting the point, node, or edge, without requiring
confirmation by pressing the middle mouse button.

Prism

The Prism option allows you to select six total locations to create a prism element. A prism
element has two tri faces and three quad faces. Select the three locations of one face, then the three
locations for the other face in the same order.

Method

From nodes

allows you to select the nodes of the mesh to define new elements. A mesh must be loaded
so that nodes can be selected.

From points

allows you to select the points of the geometry to define new elements. A geometry file must
be loaded so that points can be selected.

From screen

allows you to select any arbitrary location by clicking on the screen.

Automatic element creation

automatically creates the element after selecting the point, node, or edge, without requiring
confirmation by pressing the middle mouse button.
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Pyramid

The Pyramid option allows you to select five locations to create a pyramid element. A pyramid
element has four tri faces and one quad face. Select four locations of the base quad face first in a
clockwise or counterclockwise order, then one location for the apex.

Method

From nodes

allows you to select the nodes of the mesh to define new elements. A mesh must be loaded
so that nodes can be selected.

From points

allows you to select the points of the geometry to define new elements. A geometry file must
be loaded so that points can be selected.

From screen

allows you to select any arbitrary location by clicking on the screen.

Automatic element creation

automatically creates the element after selecting the point, node, or edge, without requiring
confirmation by pressing the middle mouse button.

Hexa

The Hexa option allows you to select eight locations to create a hexa element. A hexahedral
element has six quad faces. Select four vertices in a clockwise or counterclockwise order for one face,
then four more in the same order for the opposing face. You can also select the two opposing faces.

Method

From nodes

allows you to select the nodes of the mesh to define new elements. A mesh file must be
loaded so that nodes can be selected.

From points

allows you to select the points of the geometry to define new elements. A geometry file must
be loaded so that points can be selected.

From screen

allows you to select any arbitrary location by clicking on the screen.

From Faces

allows you to select the two opposing faces to define the hexa element.
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Automatic vertex distribution

For quad and hexa elements, if this option is enabled, the selected nodes will be automatically
distributed to create the best element.

Automatic element creation

automatically creates the element after selecting the point, node, or edge, without requiring
confirmation by pressing the middle mouse button.

Auto Element Type

The Auto Element Type option allows you to create elements based on the number of vertices
selected. Select any number of 1-8 vertices. Press the middle mouse button to create an element
type.

Element createdNumber of vertices selected

Node element1

Bar (line) element2

Tri element3

Tetra element (if volume mesh is loaded), or Quad element (if pure
surface mesh is loaded)

4

Pyramid element5

Prism element6

(not supported)7

Hexa element8

Method

From nodes

allows you to select the nodes of the mesh to define new elements. A mesh must be loaded
so that nodes can be selected.

From points

allows you to select the points of the geometry to define new elements. A geometry file must
be loaded so that points can be selected.

From screen

allows you to select any arbitrary location by clicking on the screen.

Make Volume Consistent

Automatically adjusts the volumetric elements to conform with the new element(s).
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Automatic vertex distribution

For quad and hexa elements, if this option is enabled, the order of selection of nodes is disregarded,
and selected nodes will be automatically reordered to avoid creating a skewed element.

Extrude Mesh

The Extrude Mesh option allows you to create elements of one type from selected elements of
a lower dimension along a defined direction. This option is generally used to create a volume mesh of
non-varying cross-section from a 2D mesh profile.

Type of extruded elementsType of original elements

BarNode

QuadBar

Prism / HexaTri / Quad

The following options are common to each available method:

Elements

allows you to select the elements to be extruded.

New volume part name

specifies the part to which the new elements created during extrusion will belong.

New side part name

specifies the part to which shell elements created at the sides of the extrusion will belong.

New top part name

specifies the part to which shell elements created at the top of the extrusion will belong.

Method

The Extrude Mesh > Method is chosen from the drop-down list. The options are explained in
subsequent sections.

Delete options

If Delete original elements is enabled, the original elements selected for the extrusion will be deleted
from the mesh.

If the additional option No uncovered faces after delete is enabled, then the original elements
will only be deleted if no new uncovered faces will be created.
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Extrude by Element Normal

This method of extrusion will extrude the mesh along the normal of existing mesh elements. If the
normals of all the elements are not aligned in one direction, then you need to make all element
normals consistent before extrusion (Edit Mesh > Reorient Mesh > Reorient Consistent (p. 676)).

Number of Layers

specifies the number of layers to be extruded. By default it extrudes one layer.

Reverse direction

when enabled, elements will be extruded in the reverse direction of the normals of existing mesh
elements.

Note:

The direction of the element normals will not be changed.

Spacing type

determines the height of each layer. A Fixed spacing will make each layer that same height.
Spacing can also be defined by a Function of the layer variable, using Tcl syntax. See Tclers Wiki
for descriptions of Tcl syntax for different mathematical expressions.

For example, Spacing can be defined as 0.3*layer. Then the mesh will be extruded along the
defined vector, with the first layer height as 0.3, the second layer height as 0.6, etc.

Spacing can also be defined by a function of geometric growth as follows:

height1 * pow (ratio1, layer-1),

where height1 is the height of the first layer, pow is the expression for an exponent, and ratio1
is the growth factor.

Extrude Along Curve

This method allows you to o extrude mesh along a curve which defines variable direction. By default,
the orientation of each layer will be perpendicular to the curve.

Extrude curve

specifies the existing curve along which elements should be extruded.

Show curve directions

if enabled, an arrow indicating the direction of the selected curve will be displayed.

Orient axially

The orientation of each extruded layer of elements will be the same as that of the original layer
of elements.
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Figure 414: Extrusion Orientation

By default, the orientation of the extruded layers will be perpendicular to the

curve.

If Orient Axially is enabled, the orientation of the extruded layers will be the same
as the original layer of elements.

Reverse curve direction

allows you to extrude elements in the opposite direction to the curve direction (parametric).

Project to Geometry

if enabled, then all new boundary nodes will be projected to surfaces. The last layer of new nodes
will have the same projection type as the original nodes.

Number of layers

specifies the number of layers to be extruded. By default it extrudes one layer.

Twist per layer

specifies the number of degrees for the elements to be rotated per layer. This is used for helical
extrusions.

Spacing type

You can choose a Fixed spacing for each element or Curve bunching, which will use the Spacing
and Bunching law parameters that are specified for the Curve Mesh Size.
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Extrude by Vector

This method allows you to extrude elements in a linear direction defined by a vector.

Direction

Choose the Method using the radio buttons.

Explicit Vector

specifies the X Y Z vector components of the vector, based on the active coordinate system.
For example, "0 0 1" will extrude in the Z direction.

Vector by points

Define a vector by selecting two points. Elements will be moved in the direction of the defined
vector.

Number of Layers

specifies the number of layers to be extruded. By default it extrudes one layer.

Spacing type

determines the height of each layer. A Fixed spacing will make each layer that same height.
Spacing can also be defined by a Function of the layer variable, using Tcl syntax. See Tclers Wiki
for descriptions of Tcl syntax for different mathematical expressions.

For example, Spacing can be defined as 0.3*layer. Then the mesh will be extruded along the
defined vector, with the first layer height as 0.3, the second layer height as 0.6, etc.

Spacing can also be defined by a function of geometric growth as follows:

height1 * pow (ratio1, layer-1),

where height1 is the height of the first layer, pow is the expression for an exponent, and ratio1
is the growth factor.

Extrude by Rotation

This method allows you to extrude elements by rotating them about an axis or vector.

Axis

specifies the axis or a vector to indicate the direction of rotation, or the axis to which the normal
of the element is aligned.

Center of Rotation

allows you to select the origin or another point as the center of rotation.

Translate

If enabled, the extruded mesh will include both translational and rotational extrusion.
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Spacing

The fixed height of each extruded layer.

Direction

Choose the Method using the radio buttons.

Explicit Vector

specifies the X Y Z vector components of the vector, based on the active coordinate system.
For example, "0 0 1" will extrude in the Z direction.

Vector by points

Define a vector by selecting two points. Elements will be moved in the direction of the
defined vector.

Angle per layer

Angle of each layer of rotation.

Number of Layers

specifies the number of layers of the existing mesh for extrusion.

Merge Degenerated Elements

if enabled will merge all nodes on or near the axis of rotation within the defined Degeneration
tolerance (the default is 0.00001). For example, degenerate hexas with one degenerate face on
the axis (two sets of coincident nodes) will become prisms with one edge on the axis (two nodes).

Degeneration tolerance

If Merge Degenerated Elements is enabled, then this tolerance can be specified (default is
0.00001). This tolerance is used to find equal nodes in degenerated elements by using it as a ratio
between the current node distance and the maximum distance of all nodes in the element.

Check Mesh

The Check Mesh option allows you to locate problems with the mesh that will usually lead to
failure when translating or running the solution. Errors will most likely result in failure to write out the
mesh or read it into the solver. Possible Problems may lead to solution crashing or diversion. You can
select any combination of Errors and Possible Problems to check at one time.

The following options are available:

Set Defaults

enables the default mesh check options.
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Elements to Check

You can select All to check the full mesh or select Active to check mesh from the active parts only.

Check Mode

Select one of the following:

• Use Create Subsets to put all problematic elements in respective subsets, visually isolating
them for manual editing.

• To attempt to fix mesh problems individually, use the (default) Check/fix each option. After
each diagnostic check, you will be asked to respond to each problem found. If the model is
very large, each check could take some time.

• To attempt to fix all problems automatically, use the Check/fix each automatically option.
This mode performs this sequence:

1. Run "check/fix", if available. Any Yes/No dialog boxes will be answered "Yes", automatically.

2. Run "create subset", if available. Part names and subset names will be assigned automat-
ically.

3. Skip any other dialog box.

Some manual editing may still be required.

Interrupt

On the status bar that appears when Check Mesh is running, you can choose to interrupt the oper-
ation. The current check will be completed and any remaining checks will be skipped.

Errors

Duplicate element

locates elements that share all of their nodes with another element of the same type. Duplicate
elements should not exist in an ideal mesh.

Note:

The deleting of elements during the automatic fix will remove one of the two duplicate
elements, thereby eliminating this error without creating a hole in the geometry.

Uncovered faces

For a 3D mesh, all faces on a volumetric element should either be attached to the face of another
volumetric element or to a surface element. This function finds the volume elements that violate
this restriction. Usually this indicates a hole in the surface mesh. In the case of a 2D mesh, this
function finds edges of mesh elements that are not connected to another element or not capped
off by a bar (line) element at the perimeter (single or open edges).
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The automatic fix will cover these uncovered faces with triangles (surface mesh). This may or may
not be the proper solution. A better method may be to first select the flawed elements and then
decide if the uncovered faces are the result of missing surface mesh or the result of a hole. If it
is due to missing surface mesh, rerun the check and choose the Fix option. If the error points out
a hole in the model, you can attempt to correct the mesh by manually creating elements or
merging nodes.

Missing internal faces

Between every two adjacent volume elements that are in different parts there should be a surface
element. This function finds the volume elements that violate this restriction. A mesh with only
one volume part will not have missing internal faces. For 2D meshes, this function finds two ad-
jacent surface elements in different parts with no line element between them. The automatic fix
will create surface or line elements between these elements.

Periodic problems

checks surface parts that have periodic faces for inconsistency in the periodicity of the nodes.
Errors are reported if periodic matches are missing. Slight offsets in node positions are often re-
paired automatically during the check process. Remaining errors can be repaired manually using
Edit Mesh > Repair Mesh > Make/Remove Periodic.

Volume orientations

finds elements where the order of the nodes does not define a right-handed element.

Note:

This will be automatically corrected when Check/Fix is run.

Surface orientations

checks for volume elements that share the same surface element. In doing this check, it is required
to also check for:

• uncovered faces

• missing internal faces

• duplicate elements

This check will not find elements that occupy the same volume but are attached to regions of
mesh that are not connected.

Hanging elements

checks for line elements that have one node connected to surface mesh, and the other node free
(unconnected).

Penetrating elements

checks for surface elements that intersect or pass through other surface elements.
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Disconnected bar elements

checks for bar elements with both nodes unconnected.

Possible Problems

Multiple edges

refers to elements with at least one edge shared among three or more elements. Legitimate
multiple edges would be found at a "T" junction, where more than two geometry surfaces meet.

Triangle boxes

refers to groups of four triangles that form a tetrahedron with no volume element inside. This is
best fixed by merging two of the nodes that would collapse the unwanted triangle box.

2 single edges

refers to elements with two single edges. These are either corners of baffles or are triangles that
are protruding from a surface and are therefore undesirable in the mesh.

Single-multiple edges

refers to elements that have both single and multiple edges. These elements are probably not
wanted.

Stand-alone surface mesh

refers to surface elements that do not share a face with a volumetric element. This could be an
area with an extra surface element to be deleted or a missing volume element to be created.

Single edges

refers to surface elements with at least one edge that is not shared with any other surface element.
This would represent a hanging edge, and the element would be an internal baffle. These may
or may not be legitimate. Legitimate single edges would exist where the geometry has a zero
thickness baffle with a free or hanging edge.

Delaunay violation

refers to tri elements with nodes that are within the circumsphere of adjacent elements. These
can often be removed by swapping edges of these triangles.

Overlapping elements

refers to surface elements that occupy part of the same surface area, but do not have the same
nodes. This could be surface mesh that folds on to itself. This will also find elements that are at
an angle of up to 5 degrees from overlapping each other, as shown in Figure 415: Example of
Overlapping Element (p. 573).
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Figure 415: Example of Overlapping Element

Non-manifold vertices

refers to vertices whose adjacent elements outer edges do not form a closed loop. Usually indicates
elements that jump from one surface to another, forming a "tent like" structure. This would usually
pose no problem for mesh quality but will represent a barrier in the free domain that probably
should not be there. See the figure in Edit Mesh > Split Mesh (p. 634).

Unconnected vertices

refers to vertices that are not connected to any element. These are usually eliminated automatically
upon saving the mesh.

Display Mesh Quality

The Display Mesh Quality option runs a diagnostic check of individual element quality. Mesh
Quality can be displayed by a histogram. refer to the Quality Histogram section (p. 591).

Mesh types to check

allows you to select the mesh types to check with a selected Quality criterion. For large 3D
grids, you may want to disable the check for surface elements.

Elements to check

allows you to select the mesh elements to be checked.

• All

checks all elements.

• Active parts

checks all elements in active parts.

• Visible subsets

checks elements in visible subsets only.
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• Visible subsets and active parts

checks elements in visible subsets and active parts.

Quality type

specifies the Quality criterion selected from the drop-down menu.

Refresh Histogram

refreshes the histogram displayed.

The mesh quality criteria available are described in the following sections:

Quality

Aspect Ratio

Aspect Ratio (Fluent)

Custom Quality

Determinant

Distortion

Element Stretch

Equiangle Skewness

Ford

Hex. Face Aspect Ratio

Hex. Face Distortion

Max Angle

Min Angle

Max Dihedral Angle

Max Length

Max Ortho

Min Ortho

Max Orthogls

Max Ratio

Max Sector Volume

Min Sector Volume

Max Side

Min Side

Min Side (Quad Optimized)

Max Warp

Max Warpgls

Mesh Distribution

Mesh Expansion Factor

Mid Node
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Mid Node Angle

Opp Face Area Ratio

Opp Face Parallelism

Orientation

Orthogonal Quality

Prism Thickness

Quadratic Dev

Skew

Fluent Meshing Skew

Surface Area

Surface Dev

Taper

Tetra Special

Volume

Volume Change

Volume/Area/Length

Workbench Shape

X Size

Y Size

Z Size

Quality Metric Histogram

Quality

The criterion Quality is calculated differently for different element types:

• Tri

The quality is calculated as the aspect ratio of the tri element as described in Aspect Ra-
tio (p. 576).

• Tetra

The quality is calculated as the aspect ratio of the tetra element as described in Aspect Ra-
tio (p. 576).

• Quad

The quality is calculated as the Determinant, as described in Determinant (p. 580).

• Hexa

The quality is a weighted diagnostic between Determinant (between -1 and 1), Max Orthogls
(normalized between -1 and 1; if deviation from orthogonality is greater than 90 degrees, then
the normalized value will be smaller than 0) and Max Warpgls (normalized between 0 and 1;
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warpage of 0 degrees is 1, warpage of 180 degrees is 0). The minimum of the 3 normalized
diagnostics will be used.

• Pyramid

The quality is calculated as the determinant.

• Prism

The quality is calculated as the minimum of the Determinant and Warpage. Warpage is nor-
malized to a factor between 0 to 1, where 90 degrees is 0, and 0 degrees is 1.

Aspect Ratio

The criterion Aspect Ratio is calculated differently for different element types:

• Quad

The vectors for each of the 4 quad nodes span a parallelogram. The area of each parallelogram is
divided by the length of each component vector squared, to give 8 possible aspect ratios. The
minimum ratio is taken as the aspect ratio for the quad element.

Figure 416: Aspect Ratio for Quad Elements
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• Hexa

The aspect ratio is defined by the size of the minimum element edge divided by the size of the
maximum element edge. Quadratic hexahedras will also be considered.

• Tri

Ansys ICEM CFD calculates the ratio between the area of triangle and the maximum edge length
for each element. The values are scaled, so that an aspect ratio of 1 corresponds to a perfectly
regular element, while an aspect ratio of 0 indicates that the element has zero area.

Aspect Ratio = (area/max edge length)actual / (area/max edge length)ideal

Figure 417: Aspect Ratio of Tri Elements–Examples

• Tetra

Ansys ICEM CFD calculates the ratio between the volume of the element and the radius of its cir-
cumscribed sphere power three. The values are scaled, so that an aspect ratio of 1 corresponds to
a perfectly regular element, while an aspect ratio of 0 indicates that the element has zero volume.

Aspect Ratio = (volume/(circumscribed radius)3)actual / (volume/(circumscribed radius)3)ideal
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Figure 418: Aspect Ratio of Tetra Elements–Examples

Aspect Ratio (Fluent)

This is an alternative aspect ratio computation (as used in Ansys Fluent). In this case, it is computed
as the ratio of the maximum value to the minimum value of any of the following distances: the normal
distances between the cell centroid and face centroids computed as a dot product of the distance
vector and the face normal, and the distances between the cell centroid and nodes. For a unit cube
(see Figure 419: Calculating the Aspect Ratio for a Unit Cube (p. 579)), the maximum distance is 0.866,
and the minimum distance is 0.5, so the aspect ratio is 1.732. This type of definition can be applied
on any type of mesh, including polyhedral.
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Figure 419: Calculating the Aspect Ratio for a Unit Cube

Custom Quality

This option allows you to define your own quality metric as the combination of the following quality
criteria and element types: Determinant, Warp, Min Angle, and Max Angle.

You can specify the maximum and minimum quality levels of a histogram for quad and tri elements.
All values are adjusted to a scale of 0 to 1 when Recompute is pressed.

For example, if the Min Angle Quad is 30 degrees and the maximum is 45 degrees, then 30 degrees
will correspond to the minimum value in the custom quality and 45 degrees will correspond to the
maximum value.

Figure 420: Custom Quality
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Determinant

The Determinant, more properly defined as the relative determinant, is the ratio of the smallest de-
terminant of the Jacobian matrix divided by the largest determinant of the Jacobian matrix, where
each determinant is computed at each node of the element. The Determinant can be found for all
linear hexahedral, quadrahedral, and pyramidal elements. A Determinant value of 1 would indicate
a perfectly regular mesh element, 0 would indicate an element degenerate in one or more edges,
and negative values would indicate inverted elements.

Distortion

This is available only for hexa elements and is the measurement of the twisting of the element from
the ideal shape. For this the Jacobian determinants will be calculated at r,s,t=-1,0,1 of the natural
coordinate system of the element (27 node positions). The distortion is 27 times the minimum of all
absolute determinants divided by the sum of all 27 absolute determinants (0 if all Jacobian determin-
ants are 0).

Element Stretch

This option is available for surface and volume elements.

• For tris, this is calculated as the radius of the inscribed circle divided by the maximum edge
length and normalized by the value of an equilateral triangle with edge length 1.

• For quads and hexas, the calculated value is the minimum edge length divided by maximum
edge length normalized by the value for the idealized quad (cube) of length 1.

• For pentas and pyramids, this is calculated as the minimum of the element stretches of the
quad and triangle sides.

• For tetras, this is calculated as the radius of the inscribed sphere divided by the maximum
edge length normalized by the value of an equilateral tetra with edge length 1.

Equiangle Skewness

This quality parameter applies to tetra, hexa, quad, and tri elements.

Element equiangle skew = 1.0 – max ((Qmax – Qe) / (180 – Qe), (Qe – Qmin) / Qe),

where

Qmax = largest angle in the face or element

Qmin = smallest angle in the face or element

Qe = angle of an equiangular face or element (60 degrees for a triangle or 90 degrees for a square).

Ford

A hybrid quality parameter for 3 and 4 node element meshes based on weighted skewness warp,
and aspect ratio values. The possible range is from 0 to 32.
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Hex. Face Aspect Ratio

This quality parameter calculates the 3 averaged face areas of hexahedra elements, which is the average
of the areas of two opposite faces. The maximum of the six possible divisions of the averaged face
areas will be calculated and then inverted to normalize the result.

Hex. Face Distortion

This quality parameter calculates the product of the maximum edge size in the i direction multiplied
by maximum edge size in the j direction, multiplied by the same in the k direction, and then divides
this value by the volume of the hex element.

Max Angle

This calculates the maximum internal angle of the quad or tri faces of elements.

Min Angle

This calculates the minimum internal angle of the quad or tri faces of elements.

Max Dihedral Angle

This is the maximum angular space contained between planes which intersect. It is measured by the
angle made by any two lines at right angles to the two planes.

Max Length

Calculate the maximum length of the diagonals of quad faces, and the maximum side length of tri
faces. This works for all meshes and element types.

Max Ortho

This calculates the maximum deviation of the internal angles of the element from 90 degrees.

Min Ortho

This calculates the minimum deviation of any interior angles of the element from 90 degrees.

Max Orthogls

This calculates the maximum deviation of the internal angles of the elements from 90 degrees. For
elements other than hexas this diagnostic is equal to Max Ortho. For hexas this differs from Max Ortho
in the way that angles between 180 and 360 degrees are also considered (deviation up to 270 degrees).

Max Ratio

This calculates the maximum ratio of the lengths of any two edges that are adjacent to a vertex in
an element.
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Max Sector Volume

This option is available for volume elements. For each element node the sector volume will be calcu-
lated in the Gauss integration points of order 3 and the maximum of the calculated sector volumes
will be taken.

Min Sector Volume

This option is available for volume elements. For each element node the sector volume will be calcu-
lated in the Gauss integration points of order 3 and the minimum of the calculated sector volumes
will be taken.

Max Side

This calculates the maximum length of all the edges of quad or tri faces. This works for all meshes
and element types

Min Side

This calculates the minimum length of all the edges of quad or tri faces. This works for all meshes
and element types

Min Side (Quad Optimized)

This calculates the minimum length of all the element edges. For quad elements, the opposite edge
of the minimum element edge will also be considered. That is, if the length of the opposite edge is
smaller than 1.1 times the minimum element edge length, the value will be the opposite edge length,
else the value will be 1.1 times the minimum element edge length.

Max Warp

This calculates the maximum warp (in degrees) of all elements. This works only for structured volume
and surface meshes, linear hexahedral and linear quadrahedral elements. To determine warp of a
quadrilateral face, find the midpoints of all edges, which will be co-planar. Then, calculate the maximum
angle of any edge with the plane as defined, which is the warp of the face. The maximum warp of a
volume element or hexahedron is the maximum warp of its faces. For a 2D, planar mesh of QUAD_4
elements, the warp will be zero for all elements.

Max Warpgls

This measure applies to quad, prism and hexa elements (for quadratic elements the linear part will
be checked).

To determine the warp of a quadrilateral face, the angles between the triangles connected at the 2
diagonals of the quad will be calculated and the maximum will be used.

The maximum warp of a volume element (prism or hexa) is the maximum warp of its quad faces.

For a 2D planar mesh of QUAD_4 elements, the warp will be zero for all elements.
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Mesh Distribution

The mesh distribution for all elements intersected by the line defined by the Start Point and End
Point locations will be calculated and displayed in the Mesh Distribution window. Distribution in-
dicates the criterion selected. You can display the distribution for element volume (Volume), average
element edge length (Avg Edgelen), minimum element edge length (Min Edgelen), or maximum
element edge length (Max Edgelen). The distribution is displayed as a graph where the abscissa (x-
axis) indicates the distance of the element centroid (projected onto the line) from the Start Point
and the ordinate (y-axis) indicates the selected criterion (Volume, Avg Edgelen, Min Edgelen, or
Max Edgelen). This diagnostic is available for linear, tetra, pyramid, penta, and hexa elements.

Figure 421: Mesh Distribution

Figure 421: Mesh Distribution (p. 583) shows an example of the mesh distribution displayed. You can
use the left mouse button to zoom a portion of the plotted distribution.

Full range

resets the plot in the Mesh Distribution window to show the full range.

Load

allows you to load the mesh distribution data from a file.
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Save

allows you to save the mesh distribution data to a file.

Delete

allows you to select the plots to be removed from the Mesh Distribution window.

Done

closes the Mesh Distribution window.

X log

toggles the logarithmic scaling of the x-axis.

Y log

toggles the logarithmic scaling of the y-axis.

Symbols

allows the use of symbols to mark data.

Lines

allows the use of a line to indicate the distribution data.

X grid

toggles the display of grid lines along the x-axis.

Y grid

toggles the display of grid lines along the y-axis.

Mesh Expansion Factor

This option is available for volume elements. First, the node centered sector volume is calculated for
each node in the mesh. Then to calculate the expansion factor, the node centered volume is compared
to the volumes around the adjacent nodes to find the largest factor. For the element quality display,
for each element, the corresponding nodes will be checked and the maximum of all contributing
node mesh expansion factors will be used. If there is no node contributing to the element’s mesh
expansion factor, then the value will be 1.

Mid Node

The mid node criterion analyzes maximum deviation of mid node.

Mid Node Angle

This criterion is applicable only for Quadratic elements. It is the angle by which the quadratic mid
node is off from the linear edge.
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Figure 422: Definition of Mid Node Angle

Opp Face Area Ratio

This measure is applicable to hexahedral elements only. This is the measurement of the worst ratio
of the areas of the opposite faces of the hexahedral element. Ideally, this value should be 1.

Figure 423: Definition of Opposite Face Area Ratio

In the figure, let A1 = Area of Quad Face {ABDC}, and A2 = Area of Quad Face {EFHG}. If A1>A2, then
the Opposite Face Area Ratio of this pair of faces = A1/A2. If A1<A2, then the Opposite Face Area
Ratio = A2/A1. Similarly, the Opposite Face Area Ratio is found for each opposing pair of faces, and
the maximum of all three pairs is found as the measurement for this hexahedral element.

Opp Face Parallelism

This feature is also for hexahedral elements only. It is the measurement of the parallelism of the
hexahedral elements. If the opposite faces are ideally parallel, the value is 1.

Orientation

Direction of the face normal determined by the orientation of the nodes based on the right hand
rule. Face orientation should be into the volumetric domain.

Orthogonal Quality

The orthogonal quality for cells is determined using three sets of vectors. For each face, the face
normal vector (A i), the vector from the cell centroid to the centroid of the adjacent cell (c i), and the
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vector from the cell centroid to the centroid of the face (f i) are found. See Figure 424: Vectors Used

to Compute Orthogonal Quality for a Cell (p. 586).

Figure 424: Vectors Used to Compute Orthogonal Quality for a Cell

For each face, the cosines of the angle between A i and c i and between A i and f i are calculated.

The smallest calculated cosine value is the orthogonality of the cell. Finally, Orthogonal Quality de-
pends on cell type:

• For tetrahedral, prism, and pyramid cells, the Orthogonal Quality is the minimum of the ortho-
gonality and (1 - cell skewness).

• For hexahedral cells, the Orthogonal Quality is the same as the orthogonality.

The minimum value obtained from calculating these quantities for all the faces is defined as the or-
thogonal quality for the cell. The worst cells will have an orthogonal quality close to 0 while the best
cells will have an orthogonal quality close to 1.

Note:

Orthogonal quality for a cell is equivalent to Inverse Orthogonal Quality in Ansys Fluent
Meshing except that the scale is reversed:

Inverse Orthogonal Quality = 1 – Orthogonal Quality

Orthogonal quality values may not correspond exactly with the inverse orthogonal quality
values from Fluent Meshing due to minor tolerance differences in how the data is handled
internally.

For 2D surface mesh, a similar calculation is performed using only the edge normal vector (A i) and

the vector from the face centroid to the centroid of each edge (e i). See Figure 425: Vectors used to

Compute Orthogonal Quality for a Face (p. 587).

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.586

Edit Mesh



Figure 425: Vectors used to Compute Orthogonal Quality for a Face

Prism Thickness

This option is available only for linear and quadratic prism elements. This calculates the average of
the 3 heights at the triangle corners.

Quadratic Dev

This computes the deviation of quadratic nodes from the corresponding linear edge. Consider a triangle
made up of 3 nodes: the deviation is the ratio of the altitude (the shortest line connecting the midside
node to the base) with the base (the two linear nodes). A value of 0 means the midside node is on
the linear edge.

Skew

This calculates the maximum skewness of an element. The skewness is defined differently for volume
and surface elements. In all cases it is normalized so that 1 is ideal and 0 is the worst possible.

• For a hexahedral element, skewness is defined as the normalized worst angle between each
of the 6 face normals and the vector defined by the centroid of the hexahedron and the center
of the face.
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Figure 426: Skew for Hexahedra

• For tri elements, skewness is defined as the ratio between the area of the element and the
area of an equilateral triangle having the same circumcircle.

• For quad elements, the skew is calculated by first connecting the midpoints of each side with
the midpoint of the opposite side, and finding the angle α as shown in the Figure 427: Skew
for Quad Elements (p. 588) (the smaller of the two angles will be used so that α<90 degrees).
The result will be normalized by dividing α by 90 degrees.

Figure 427: Skew for Quad Elements

Fluent Meshing Skew

The Fluent Meshing skewness measure is computed as the normalized maximum deviation from the
ideal angle at face corners (60 degrees for a tri face or 90 degrees for a quad face) for surface elements,
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or the normalized maximum deviation from the ideal angle between face normals (for example, 90
degrees for a hexahedral element) for volume elements.

Note:

The Fluent Meshing skewness values are inverted compared to other quality metrics
in Ansys ICEM CFD. A value of 0 indicates the best quality element while a value of 1
indicates a degenerate element.

Surface Area

This calculates the surface areas of all elements. This works for all meshes and element types.

Surface Dev

This measures the deviation of mesh from the actual geometry.

Taper

For hexahedral elements, the Taper is the maximum ratio of the areas of opposite faces. For quad
elements, it is the maximum ratio of the lengths of opposite edges.

Tetra Special

This determines the ratio of the largest element edge to the smallest height for linear tetrahedral
elements.

Figure 428: Definition of Tetra Special

In the figure, let d = height normal to surface ABC to point D. The Tetra Special value = {Max (a, b,
c)}/d. The maximum value calculated from all the nodes is the Tetra Special value for the tetrahedral
element.
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Volume

This computes the volume of individual elements.

Note:

This diagnostic does not consider degenerate hex elements, and will assign a negative
value for them. The Volume/Area/Length check can be used for degenerate hex
elements instead.

Note:

The Volume and Volume/Area/Length criteria essentially use the same calculation
for most element types and orders (linear or quadratic), but the volume check is op-
timized for 8–noded (linear) hex elements. It is recommended that
Volume/Area/Length be used unless you want to check only the volume mesh, or
you have a linear hex mesh. In these cases, the Volume check would be faster.

Volume Change

This quality metric is calculated for a specific element by finding the maximum volume among all of
its neighbor elements divided by the volume of the element itself.

Volume/Area/Length

This quality parameter calculates the line length of line elements, the area of surface elements, and
the volume of volume elements, with evaluation at Gauss points (4th order). It is implemented for all
supported element types, including quadratic element types.

Note:

The Volume and Volume/Area/Length criteria essentially use the same calculation
for most element types and orders (linear or quadratic), but the volume check is op-
timized for 8–noded (linear) hex elements. It is recommended that
Volume/Area/Length be used unless you want to check only the volume mesh, or
you have a linear hex mesh. In these cases, the Volume check would be faster.

Workbench Shape

This option is applicable to all shell and volume elements. It provides a composite quality metric that
ranges between -1 and 1. The metric is based on the ratio of the volume to edge length for volume
elements and the ratio of area to edge length for shell elements. A value of 1 indicates a perfect cube
or square, while a value close to 0 indicates a bad element, and a negative value indicates an inverted
element.

X Size

This computes the length of the element profile in the X direction.
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Y Size

This computes the length of the element profile in the Y direction.

Z Size

This computes the length of the element profile in the Z direction.

Quality Metric Histogram

Mesh quality is displayed as a histogram where the abscissa (x-axis) displays the element quality on
a scale from 0 (worst) to 1 (best) and the ordinate (y-axis) displays the number of elements in each
quality range. The default is 20 bars or divisions between 0 and 1. So the first bar would display the
number of elements whose quality is between 0 and 0.05, and the next bar between 0.05 and 0.1.
The same histogram values are also tabulated in Messages window. The Status message line will
display the min and max values of the quality criterion.

Figure 429: Mesh Quality Histogram

By clicking any of the bars with the left mouse button, the information about the precise number of
values that fall into this interval and its boundaries are displayed in the message window. The color
contour bar will also appear in the display. Histogram bars that have been selected become a solid
color, and remain selected until clicked again. To display the elements within a selected (highlighted)
histogram bar, right-click the histogram window, and click Show (enabled by default). The elements
represented by that bar will be highlighted. If the Solid option is enabled, then the color of the ele-
ments will represent the corresponding range of quality as indicated by the color contour bar.

By right-clicking the histogram, the following options are available.

Replot

allows you to change the parameters of the histogram in the Replot window.

Figure 430: Replot Window

• Min / Max X value

sets the minimum and maximum values of the particular quality type selected for the X-axis.
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• Max Y height

sets the maximum number of blocks for the quality ranges. A value of 0 will set the display to
such that the histogram with the largest number of elements is fully visible. A smaller number
will give increased resolution for quality ranges with fewer elements.

• Num bars

sets the number of bars to use in the histogram display.

Reset

sets the maximum number on the Y-axis such that the histogram bar with the largest number of
elements is fully visible.

Refresh

recomputes the mesh quality and refreshes the histogram display.

Show

displays the elements within the selected (highlighted) histogram bars.

Solid

displays all selected elements in solid view and by color that corresponds to the quality range.
The color contour bar will display the range of quality by color.

Note:

This option slows down the display speed.

Color By Quality

when enabled (default), clicking on any histogram bar will display those elements colored according
to quality, as defined by the color bar which appear on the left side of the display window.

Highlight

applies to surface mesh only. Select one of the following options to highlight: selected elements
only, selected elements and one layer of attached surface elements, or selected elements and
two layers of attached surface elements.

Subset

puts the selected elements into a new subset.

Done

closes the histogram window.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.592

Edit Mesh



Smooth Mesh Globally

The Smooth Mesh Globally option allows you to automatically improve the quality of the mesh
elements. Different smoothing algorithms are available depending on which mesh type is loaded. Mesh
can be smoothed with respect to a particular quality criterion and with a specified number of iterations
to achieve a given quality level. A mesh containing tetras, pyramids, prisms and triangular and quad
surface elements can be smoothed. The element quality is displayed as described in Display Mesh
Quality (p. 573).

Note:

It is no longer necessary to load a geometry file in order to perform mesh smoothing. Surface
nodes will be constrained to the boundary represented by the original mesh. Fixed and edge
constraints are also kept, as represented by node and bar elements.

If the desired quality is not attained, simply re-smooth until no further progress is seen. Then
consider manual editing. Place the worst elements in a subset or select them from the histo-
gram in order to display them and make them active for editing.

If a multiblock mesh is loaded, see Smooth Multiblock Domains Globally  (p. 597) for smoothing options.

The following options are available for smoothing the mesh:

Quality

Smoothing iterations

specifies the number of iterative steps. Each iteration will apply smoothing to a percentage
of the elements below the specified quality. The more iterations, the smaller the percentage
of elements that is selected and incremented for each step. For example, if 5 iterations are
specified, the first iteration will smooth the worse 20% of elements, the second will smooth
40%, etc. Increasing the number of iterations is more robust, but less iterations means that
each iterative step is smoothing more elements each time.

Up to value

specifies the quality level up to which the smoother will attempt to smooth the mesh.

Criterion

specifies the quality criterion. The following criteria are available:

• Quality

• Aspect ratio

• Custom quality

• Determinant

• Min angle
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• Max orthogls

• Max warp

• Max warpgls

• Skew
Refer to Quality (p. 575) for details on the quality criteria.

Smooth Mesh Type

Smooth

If enabled for a particular element type, then this element will be smoothed in order to
produce a higher grid quality. The quality of these element types will be represented in
the quality histogram.

Freeze

If enabled for an element type, the nodes of this element type will be fixed during the
smoothing process. This element type will not be displayed in the histogram.

Float

If enabled for an element type, the smoother may move nodes of this element type freely
according to their geometric constraints (points, curves, and surfaces). Nodes of floating
elements are only moved if necessary to improve the quality of the adjacent smoothed
elements. In the case that the nodes are moved, the quality of the floating elements is
considered with the same priority and with the same quality criterion/method as the
smoothed elements. These floating elements are not included in the histogram.

Note:

There is a surface smoother and a volume smoother. If you smooth the
surface mesh, but float the adjacent volume mesh, you may find that the
surface smoother quality checks are not sufficient to maintain good quality
in the adjacent volume mesh. However, between volume mesh types or
when floating surface mesh, the quality of the floating elements will be
maintained.

Note:

When smoothing a subset, the subset is actively smoothed while all other
mesh is set to float.

Smooth Parts/Subsets

All Parts

allows you to smooth elements in all parts.
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Only active parts

allows you to smooth only the parts that are activated/enabled in the Display tree.

Only visible subsets

allows you to smooth only the visible subsets.

Active parts and visible subsets

allows you to smooth both the parts enabled in the Display tree and the visible subsets.

Refresh Histogram

recalculates and updates the histogram. This is useful when changing the Smooth Mesh Type
options and you want to simply check the quality of the elements prior to performing a
smoothing step.

Advanced Options

Laplace smoothing

Pure

solves the standard Laplace equation that calculates the average of all neighbor nodes
for any node and gives a more uniformly spaced mesh. This setting operates on mesh
types set to Smooth, smoothing surface mesh types first and then volume mesh types.

Note:

Laplace smoothing surface mesh before inflating prisms results in better
prism quality. Also, using the standard Laplace equation for prisms can
sometimes lead to a lower determinant quality. Therefore, it is recommended
that Laplace smoothing be applied prior to prism generation.

Edge length

uses a modified Laplacian scheme which tries to equalize the edge lengths around a
node. This option is useful in cases where the mesh size distribution is quite wide. The
smoother will try to increase the minimum edge length toward the average size to
improve mesh uniformity. Figure 431: Edge Length Based Laplace Smoothing (p. 596)
shows an example where the minimum edge length on the mesh increased after
smoothing using the Edge length criterion. The highlighted portion shows a set of
elements where the smoothing scheme was able to redistribute the edge lengths to
be more equal.

Note:

As this method tends to increase the minimum edge lengths in a model, it
can be very useful for explicit solvers whose time step is tied to the minimum
edge length.
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Figure 431: Edge Length Based Laplace Smoothing

Residual on Surfaces

when enabled, allows you to specify the residual for surfaces.

Residual in Volume

when enabled, allows you to specify the residual for the volume.

The residual represents the smoother "convergence" rate with respect to the initial state.
It is calculated as the ratio of average node movement at the current iteration to the average
node movement at the first iteration. You can specify the residuals for surface and volume
while smoothing. The residual at each iteration will be reported in the message window.
When the specified residual value is reached, the smoothing process will stop.

Note:

The acceptable range for residual values specified is 0–1.

Not just worst 1%

if enabled, it will evaluate all elements while smoothing. By default the smoother only
smoothes the worst 1% of each element type.

Allow node merging

if enabled, the smoother is allowed to merge nodes to improve the mesh.

Allow refinement

allows the smoother to automatically subdivide tetras to obtain further improvement. After
smoothing with Allow refinement enabled, it may be necessary to smooth further with
this option disabled. The goal of this option is to reduce the number of cells that are at-
tached to one vertex by refinement in problem regions.

Group bad hex regions

is used only in unstructured hexa smoothing. If enabled, then bad hex elements are grouped
into bad regions. The smoother will run on these bad regions one at a time. If disabled,
then the smoother will smooth all the groups at once.
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Ignore PrePoints

is used only for unstructured hexa smoothing. This option simply ignores the prescribed
points which hinder the quality of mesh.

Surface Fitting

is used only for unstructured hexa smoothing. It forces the smoother to follow B-spline
surfaces rather than the triangulation of the surfaces.

Prism Warpage Ratio

prisms are smoothed based on a balance between prism warpage and prism aspect ratio.
Numbers from 0.01 to 0.50 favor improving the prism aspect ratio, and from 0.50 to 0.99
favor improving prism warpage. The farther the value is from 0.5, the greater the effect.

Violate Geometry

allows the smoothing operation to yield a higher quality mesh by violating the constraints
of the geometry. Normally when a grid is smoothed, the nodes are restricted to the geometry
and can only be moved along the geometric entities to obtain a better mesh.

Note:

This option would be advantageous for situations such as a region where two
surfaces come together at an angle that makes good element quality difficult
to obtain (angles under 30 degrees). In this case, the mesh cannot both accurately
capture the geometry, and give good quality mesh. The geometry (the 30 degree
angle) can be sacrificed a small amount to improve the element quality if this
option is utilized. A large number of bad elements can be fixed in this way by
making a small sacrifice on the geometry.

Tolerance

is the distance measured in units of the model that nodes can be moved off the geometry,
if Violate Geometry is enabled.

Relative Tolerance

if enabled, this will make the specified Tolerance the factor of the minimum edge length
of the mesh instead of an absolute tolerance in units of the model.

Minimum Edge

if enabled, you can specify the minimum edge length allowed in the mesh after smoothing.

Smooth Multiblock Domains Globally

The Multiblock smoother is used to obtain smooth grid lines. It is specially optimized for blade

configurations. The mathematical basis is that an elliptical differential equation of the form ,
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where  is the "control function", will be solved. It can be proved that by using the elliptical operator

, smoothness of the mesh will be achieved. The control function  will be specified so that the
smoothed mesh will obtain certain characteristics, such as orthogonality and layer height of the first
layer.

The Multiblock smoother can also constrain nodes in one dimension and smooth nodes in the other
dimensions in order to improve mesh quality. This is useful in turbine blade analysis for the inlet and
outlet surfaces. While smoothing, the blade surfaces are frozen to maintain geometric location. Previously,
the inlet and outlet would be frozen, thereby freezing the ends of the periodic sides, and thereby lim-
iting the smoother. By constraining nodes in one dimension, the inlet and outlet are constrained axially,
maintaining their distance from the blade as well as their periodicity. However, the nodes can be
smoothed in the other dimensions, thereby allowing the smoother more flexibility.

For all other mesh types, the options for Smooth Mesh Globally  (p. 593) will be displayed.

The following parameters are available when a multiblock mesh is loaded:
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Relaxation Domain(s)

click the appropriate icon to select or deselect domain(s) to be smoothed.

Smoothing Direction

3D

smoothes the mesh in all directions.

I, J, or K

allows you to select the smoothing direction.
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Layer Options

This smoother works by smoothing planes and then interpolating the smoothing between the layers.
The model is reduced to a single block high and the layers are the mesh indices from one side to
the other along the smoothing direction. You need not smooth every plane. In models with very
little twist, selecting the first and last plane is sufficient. If a model (such as a compressor blade)
has more twist, it may be advantageous to smooth the first and last, as well as a few layers between.

Start Layer, End Layer

the first (usually 1) and last (usually the total number of layers) to be smoothed. These form the
ends of the smoothed volume and are usually setup automatically.

Increment

allows you to add smoothing planes between the first and the last planes. For instance, if you
have 26 planes, you could have an increment of 5, which would mean the 6th, 11th, 16th and
21st planes would also be smoothed. Use a smaller increment to include more planes and better
capture twist or other changes in the cross section. Setting the increment to 1 will smooth each
plane individually, and is usually not necessary.

Volume iterations

specifies the number of smoothing iterations between each actively smoothed layer. If this value
is greater than 0 then the layers between the smoothed planes will not only be interpolated
but additionally smoothed.

Planes

specifies the planes which need to be smoothed directly. If set, then the Start Layer, End Layer
and Increment setting will not be used. The plane numbers are separated by blanks (for example,
"1 5 10")

Select Options

Non-Relaxation Subfaces

freezes the selected subfaces.

Hold Cell Height Subfaces

orthogonality and first cell height will be obtained on all grid lines perpendicular to the selected
subfaces.

Fixed Edges

all edge nodes will be frozen for each selected edge.

Fixed Distribution Edges

the corresponding nodes can move but the original bunching will be retained for each selected
edge.
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Global Vertices

if any end vertices of a block edge have been selected, and a smoothing direction is selected,
then the Pre-Mesh will be smoothed globally in planes. It is recommended that all vertices be
selected as Global Vertices and that the real (not periodic) boundaries be frozen.

Layer Vertices

is intended to be used for Ogrid vertices. For neighbor nodes, the bisector will be calculated
placing the neighbor nodes on the bisector line in a distance specified as the First Layer Dis-
tance. If the First Layer Distance is smaller than 0.0, the selected vertices will not be used.
Vertices can be added or removed from the selection list, and the First Layer Distance can be
changed for the selected vertices.

Layer vertices are only used in Global edge smoothing. To access this option, a smoothing
direction must have been selected.

Clear all selections

resets all selections.

Advanced Options

The following advanced options are available:

Number of Iterations/Steps

Iterations in equation solver

An equation solver (SOR method) is used to solve the elliptic equation method. This value
specifies how many iterations should be done (default is 25).

Steps in global edge smoothing

specifies the number of smoothing steps in the global-edge smoothing method. In each
step, the Pre-Mesh will be smoothed globally and the output will be used as input in the
next step (default is 25).

Parameters

Projection limit

is used for node distribution whose first spacing from the surface is less than the geometry
tolerance. It is useful for near-wall layers. A value greater than 0.0 will define a distance
normal to the surface up to which the nodes will be interpolated. A single value of projection
limit is used at all locations on the model.

Relaxation factor

is a factor to stabilize the smoothing value. Reasonable values should be between 0.0 (ex-
clusive) and 1.0 (inclusive). Default value is 0.5.
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Residual factor

is used during global edge smoothing. Starting from the 2nd global edge step, the average
change compared to the previous step will be calculated by dividing this value by the value
calculated in the 2nd step. If this relative value gets lower than the specified residual factor,
a stop criterion has been reached. Default value is 0.05.

Surface fitting

constrains boundary nodes to the true geometry surfaces. With this option off, the boundary
nodes will be projected to the triangulation of the geometry surfaces.

Use projection

smoothing steps are performed allowing nodes to move away from constraints (curves,
surfaces), and then the nodes are finally projected back to the curve or surface. This option
is disabled by default.

Use orthogonal positioning

is used during global edge smoothing or plane smoothing. If Hold Cell Height has been
set on a subface, a special method will be used to calculate the control function values in
a way that the first layer nodes will be placed to hold the original or user defined (layer
vertices) cell height and to be orthogonal (bisector) to the boundary. This option is enabled
by default.

Use fractional positioning

is used during global edge smoothing or plane smoothing. If Use orthogonal positioning
has been set, the first layer nodes will not be moved in one step to the orthogonal position
but in a certain amount of steps (10). This is mainly to stabilize the orthogonal positioning
algorithm in highly clustered meshes. This option is disabled by default.

Methods

In the structured smoother, several elliptic relaxation methods are available both for the Volume
and Subfaces (subface boundaries). The default method is Sorenson - Laplace. In the case of
global edge smoothing, this parameter has no meaning.

Sorenson-Laplace

Sorenson methods attempt to maintain node distributions (bunching) near the surface
boundaries while improving orthogonality. This hybrid attempts to improve orthogonality
at the boundary while maintaining the first layer height from the boundary surface and
making a uniform node distribution in the interior

Sorenson-Thomas & Middlecoff

This method improves orthogonality at the boundary while maintaining the first layer height
from the boundary surface and holding the original clustering on the interior.
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Thomas & Middlecoff

This method generally improves the orthogonality of grid lines across boundaries while
holding the original clustering in the interior.

Laplace

This method attempts to give a uniform mesh size for all selected elements.

Interpolation

This uses an algebraic transfinite interpolation method with Soni interpolants to generally
improve internal angles.

Hilgenstock - Thomas & Middlecoff

Hilgenstock methods maintains orthogonality. This hybrid maintains orthogonality between
block boundaries (subfaces) to give a smooth transition across subfaces, while maintaining
the first layer height from the boundary surface.

Hilgenstock - Laplace

This attempts to improve orthogonality and uniform node distribution within the mesh.

Grid expansion rate

is the exponent for the exponential decay of Sorenson terms from the boundary to the interior
of a subface. Reducing this factor will cluster the elements closer to the boundary. Default values
are 3.5 for Subfaces and 4.6 for the Volume.

Multiblock Settings

Load Settings

allows you to load previously saved Multiblock Settings.

Save Settings

allows you to save the current Multiblock Settings in a file.

Run in sequence

allows you to load and run different Multiblock Settings files in sequence. Click Start se-
quence to begin running the sequence of files.

Distributed Smoothing

Distributed Smoothing

enables the use of distributed smoothing which allows you to smooth the mesh using
multiple processes executing on the same computer or different computers in a network.

Define Hosts

opens the Host Setup panel where you can specify the host settings.
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You need to do the following to specify the host settings:

1. Click New Host to open the Add Host panel where you can define the host machine.
Specify the name of the host and select the operating system type from the Type drop-
down list. Click Accept.

2. All defined hosts will be listed in the Available Hosts list. Select the host in the Avail-
able Hosts list and verify the relevant parameters.

a. Number Processors specifies the number of processors on the machine.

b. The Startup Command allows you to use either the remote shell client (rsh ) or
secure shell client (ssh ). Enable Password if you require a password to access
the machine. You may click the Check button to verify that the startup command
works correctly.

c. Verify that the ICEM_ACN Path and License File path are correct and specify the
Working Directory as appropriate.

d. Click Save Available to save the settings for the available hosts.

3. Select the host in the Available Hosts list and click Add -> to add the host to the As-
signed Hosts list. To remove a host from the Assigned Hosts list, select the host and
click <- Remove. You can also permanently delete previously defined hosts using the
Delete Host button.

4. Click Save Assigned to save the settings for the assigned hosts and close the Host
Setup panel.
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Number Processes

specifies the number of processes.

Connect Timeout

specifies a timeout for connecting to the host machine.

Verbose Print

enables the printing of detailed messages in the message window.

Smooth Hexahedral Mesh Orthogonal

The unstructured hexahedral smoother relaxes unstructured hexahedral meshes in order to obtain
smooth grid lines orthogonal to the boundary as well as smooth grid angles and transitions in the inner
volume. It first smoothes the surface mesh recognizing the topological boundary edges. If the number
of volume smoothing steps is greater than 0, after each surface smoothing step the inner volume will
be adjusted by performing 1 volume smoothing step. After the surface smoothing has been finished,
the inner volume will be smoothed (according to the number of volume steps set). It can also smooth
pure surface meshes.

The mathematical basis is that an elliptical differential equation of the form , where  is the

"control function", will be solved. It can be proved that by using the elliptical operator , smoothness
of the mesh will be achieved. The control function  will be specified so that the smoothed mesh will
obtain certain characteristics, such as orthogonality and layer height of the first layer.

The unstructured hexahedral smoother is available under Edit Mesh > Smooth Hexahedral Mesh Or-
thogonal (to smooth an existing mesh) and under Blocking > Pre-Mesh Smooth (to smooth the Hexa
pre-mesh). If you select Blocking > Pre-Mesh Smooth, the pre-mesh will be calculated (if it does not
exist), and then you can select the Orthogonality option for the Smooth Method for the unstructured
hexahedral smoother.

Note:

If you smooth the pre-mesh (Blocking), the smoother may move vertices and change edge
distributions undesirably. If you are outputting a structured mesh, you should save the
blocking first so you can return to the previous state if necessary. If you are outputting in
an unstructured mesh format, you should first convert to unstructured mesh and then use
the Edit Mesh → Smooth Hexahedral Mesh Orthogonal option.

Tips to improve smoothing success:

• Create the best possible starting condition by matching edge distributions.

• Create points (geometry) at the ends of the edges, and then associate the vertices (block) to them.
This may be used to contain an area of fine mesh along a wall, preventing it from being totally
smoothed out.

The following smoothing parameters are available:
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Number of iterations

On Surface

specifies the number of iterations the smoother uses to relax the surface mesh. The minimum
number of smoothing iterations to be completed for stability reasons is 10. The default number
of iterations on surface is also 10.

On Volume

specifies the number of iterations the smoother uses to additionally relax the volume mesh after
surface smoothing has been finished (minimum is 0). When the number specified is greater than
0, a volume smoothing step will be performed after each surface smoothing step to adjust the
volume mesh to the surface mesh. The default number of iterations on volume is 5.

Refresh Histogram

updates the quality measure histogram.

Smooth type

For both Surface and Volume, the Method drop-down lists contains the following three options:

• Orthogonality

The smoother will try to retain orthogonality and the height of the first layer. For surfaces, ortho-
gonality implies that the first layer grid lines will be orthogonal to the surface edges.

• Laplace

The smoother will try to equalize the mesh by setting the control function f to 0 in the elliptical
differential equation.

• Structured

The smoother offers two additional choices: Sorenson methods attempt to maintain node distri-
butions (bunching) near the surface boundaries while improving orthogonality. It could be one
of two types. Hilgenstock methods maintain orthogonality and first layer height, and may be
one of two types.

Selecting Structured causes a second drop-down list to appear. The following four options are
available:

– Sorenson/Laplace: This attempts to improve orthogonality at the boundary while maintaining
the first layer height from the boundary surface and making a uniform node distribution in the
interior.

– Sorenson/Thomas & Middlecoff: This method improves orthogonality at the boundary while
maintaining the first layer height from the boundary surface and holding the original clustering
on the interior.

– Hilgenstock/Laplace: This attempts to improve orthogonality and uniform node distribution
within the mesh.
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– The Hilgenstock/Thomas & Middlecoff method tries to maintain orthogonality at boundaries
while holding the first layer height. With Thomas & Middlecoff as the background control
function, the original clustering is intended to be maintained.

Note:

During smoothing, the volume mesh will be separated into an inner (Volume) part and
boundary (Surface) part which will be smoothed independently of each other. The
boundary (surface) elements will be smoothed first, then the inner volume will be adjusted
to the smoothed surface boundary, and finally the inner (volume) elements will be
smoothed. Hence, it is advisable to set the same Smooth type for both Surface and
Volume.

Freeze Options

• All Surface Boundaries

freezes all boundary node locations.

• Selected Parts

allows you to specify freeze options for selected parts. Select the part(s), then click Selected
part(s) Options. Specify the frozen surface boundary by enabling Surface boundary. Specify the
number of layers to be frozen with the surface boundary by disabling Surface boundary and
entering the number of layers n in the Layers field. The number of layers is set to 0 by default.
When Layers is greater than 0, then the surface boundaries including the first n layers from the
boundary will be frozen. For example, a value of 3 indicates that three layers of nodes away from
the surface will be frozen along with the surface boundary.

(B) Specifying number of layers(A) Enabling Surface boundary

Release Orthogonality / Initial Height Options

For certain situations, it may be helpful to release the orthogonality requirement from a certain
surface part or set the first layer distance (initial height of the first element off the wall) on certain
surfaces. These are mutually exclusive since orthogonality is required to set the first layer height.
Select the desired parts, and then click Selected part(s) Options. The default is to release orthogon-
ality for each part. You can set the initial height by disabling Release orthogonality and then set
the initial height by entering it in the Initial Height field.

Note:

You can set the Initial Height to -1 (default) in order to keep the starting initial height.
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(B) Specifying Initial Height(A) Enabling Release orthogon-
ality

Smooth along curves

allows you to specify which edges (projected onto curves) should be smoothed. The smoothing will
be carried out when faces are smoothed. You can specify none, all, or selected curves. The default
is all.

Note:

If the mesh distribution has a relatively large dynamic range of mesh sizes along a curve,
then selecting this option may be counter productive.

Advanced Options

The Choose Option drop-down list contains the following advanced smoothing options:

Grid Expansion

If a smoothing method other than Laplace is selected, then the grid expansion values will be
used to distribute the control function values into the inner volume. If the grid expansion rate
is greater than 0.0, the algorithm computes a pseudo-structured region in which the control
function values will be interpolated by an exponential decay (the grid expansion rate will then
control the negative exponent (e power -g) of the control function values). If it is 0.0 then a
Laplace interpolation of the control function values will be done. That is, for an inner node, the
control function value will be averaged by the control function values of its neighbor nodes.
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The default values are 0.0 for the surface mesh and for the inner volume. Reasonable values
other than 0.0 should be greater than 1.0.

Note:

It may be difficult to form the pseudo structured regions in some cases. If you have
such problems, set the grid expansion rate back to 0.

Note:

If the grid expansion rate is set to 0.0 and the smooth type is set to Orthogonality,
the first layer height and the orthogonality at the boundary are still achieved, but
the next layers tend towards Laplace approaching the middle of the mesh. In case
of a Navier- Stokes mesh you can see the effect near the boundary where the first
layer is orthogonal to the boundary but the next layers curve as they equalize (Laplace)
the distances of the layer nodes.

Treat unstruct nodes

determines the method of treating inner unstructured nodes. An unstructured node is a node
on which no ij (surface) or ijk (volume) directions can be defined. That is, a node which has
more or less than 4 (surface) or 6 (volume) neighbors is clearly an unstructured node.

Figure 432: Initial Mesh (p. 610) shows the mesh before smoothing. The highlighted node is an
unstructured node, while all other nodes are structured. Figure 433: Smoothed Mesh (p. 611)
shows the mesh after smoothing.

Figure 432: Initial Mesh
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Figure 433: Smoothed Mesh

• Bisector

Each structured neighbor node will be positioned in a bisector angle with respect to the un-
structured node and the two other neighbors. The grid line between the node and the un-
structured node will be in a bisector angle to the 2 grid lines between the unstructured node
and the corresponding neighbor node from left and right. The distance will be calculated in
a heuristic way. If the neighbor node is unstructured then it will be positioned using the
Laplace method.

• Laplace

Each neighbor node will be positioned using the Laplace method.

• Modified Laplace

Each structured neighbor node will be positioned using the Laplace method, but comparing
its distance to the unstructured node with the appropriate distances of the unstructured node
to its other neighbors (should not be greater than a certain ratio). If the neighbor node is
unstructured then it will be positioned using the Laplace method.

The hexahedral smoother works better on structured meshes because it can use structured el-
liptical smoother methods which are more powerful than the methods for the unstructured
parts for which it mainly uses Laplace.

Note:

For most models, the effect of the this setting may be negligible.
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Stabilization Factor

is used in the calculation of the new nodes and should be greater or equal to 1.0. A higher
factor will make the smoother more stable at the cost of orthogonality at the boundaries. If
there are problems with the smoother it is recommended that this value be increased to around
8.0. Default values are 1.0 on surfaces and 2.0 in the volume. Increasing this parameter may be
helpful on certain model configurations if the smoother corrupts the mesh, especially if it appears
due to overly orthogonal boundaries.

Use Orthogonal Distance

if enabled, then the original boundary distance of a first layer node will be calculated by project-
ing it to the boundary and measuring the distance to the projected point. Otherwise, the length
of the original grid line will be used. By default this option is disabled for both the surface and
volume.

In cases where there is a sharp angle between the grid lines from the first layer to the boundary,
if Use Orthogonal Distance has not been set, the calculated first layer distance may be consid-
erably greater than the distance of the first layer nodes to the boundary (because the length
of the grid line will be used). Hence, it may be advisable to set Use Orthogonal Distance in
the same way for both Surface and Volume. This would ensure that the first layer grid line
angles in the volume near the surface boundary would be similar to the nearby surface
boundary grid line angles.

Define Edges on Part Border Options

The border grid lines attached to the selected parts will be defined as edges. The main purpose
for defining these edges is that they separate the two sides of the surface mesh. If an edge is
topologically internal then orthogonality will not be established there.

Fix Orientations

If Volume is enabled, then before smoothing takes place, all volume elements will be checked
to see if the node order defines a right-handed element and will be fixed if necessary.

Note:

Enabling this option could result in additional calculation time.

Surface Fitting

constrains boundary nodes to the true geometry surfaces. When disabled, the original mesh
faces are used to determine the boundary constraints. This option is enabled by default.

Freeze Projected Nodes

When set, all nodes which are prescribed or projected to the geometry (curves or surfaces) will
not be allowed to move.
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Keep Periodic Geometry

when enabled, ensures that the mesh will stay on the geometry on periodic sides. Otherwise
the periodic nodes can move away from the geometry. Nevertheless periodicity is still guaranteed.
This option is enabled by default.

Active Parts Only

if enabled, only the active parts (parts that are turned on (activated) in the Parts branch of the
display tree, see the Parts (p. 213) section) will be smoothed. The geometry or mesh of the active
parts does not need to be displayed. When this option is disabled, the whole mesh will be
smoothed. The histogram displayed will also reflect the setting of the Active parts only option.
This option is disabled by default.

If you click Apply or OK the mesh smoothing will be started. If OK is selected, then the window will
be closed afterwards.

Repair Mesh

The Repair Mesh options can be used for manually editing parts of the mesh that are not of good
quality.

Figure 434: Repair Mesh Options

The following mesh repair options are available:

Build Mesh Topology

Remesh Elements

Remesh Bad Elements

Find/Close Holes in Mesh

Mesh From Edges

Stitch Edges

Smooth Surface Mesh

Flood Fill / Make Consistent

Associate Mesh With Geometry

Enforce Node, Remesh

Make/Remove Periodic

Mark Enclosed Elements
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Build Mesh Topology

Angle

Line elements (1D) will be created between shell elements (2D) attached at angles greater than
the specified angle. Node elements (0D) will be created between line elements (1D) attached at
angles greater than the specified angle.

Create bars between shell parts

automatically creates bar elements between different shell mesh parts, regardless of the angle
between them.

Selected elements

allows you to select particular elements for which to build mesh topology.

Remesh Elements

 Only one element type can be remeshed at a time. Select a particular surface mesh type from
the Mesh type  drop-down list and then manually select particular elements. The selected elements
are first deleted, and then the vacant area is remeshed. The element sizes are determined by the size
of the surrounding edges.

Note:

This option is designed for plane subsets of the surface mesh, and for selected volume
parts, but not for curved surfaces or entire volumes.

Tip:

To speed the mesh refinement, turn off visibility of Mesh > Subsets in the Display
Tree before applying the remesh.

Part

The remeshed elements will be added to the selected part.

Surface projection

allows you to project new nodes onto the nearest surface.

Ignore projection

if enabled, projections to curves and points will be ignored when remeshing. If a group of elements
that are being remeshed have internal nodes that are projected to curves or points, and if Ignore
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projection is disabled, the elements will not be able to be remeshed as the projections will be
lost.

Number of offset layers

specifies the total number of offset layers while remeshing the selected elements.

Offset height factor

The height of the first offset layer is this factor multiplied by the given element size. The height
of any successive layers will increase for concave edges, and decrease for convex edges.

Offset type

• Standard

Offsets will be created normal to the edges without special solutions for sections with small or
large angles, such as corners. The number of nodes on the offset front may not be identical as
the number of nodes on the initial boundary.

Figure 435: Standard Offset Example

• Simple

Offsets will be created normal to the edges without special solutions for sections with small or
large angles, such as corners. The number of nodes on the offset front is identical to the number
of nodes on the initial boundary.
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Figure 436: Simple Offset Example

• Forced Simple

This option is the same as Simple Offset, but without collision checking.

Figure 437: Forced Simple Offset Example

Remesh Bad Elements

The Remesh Bad Elements option has similar options to Remesh Elements (p. 614), with the
difference that only the bad quality elements from the selected elements will be deleted and remeshed.
It will not delete all selected elements.

Tip:

To speed the mesh refinement, turn off visibility of Mesh > Subsets in the Display Tree
before applying the remesh.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.616

Edit Mesh



Mesh type

specifies the mesh type.

Elements

specifies the elements to remesh.

Surface projection

allows you to project new nodes onto the nearest surface.

Ignore projection

if enabled, projections to curves and points will be ignored when remeshing. If a group of elements
that are being remeshed have internal nodes that are projected to curves or points, and if Ignore
projection is disabled, the elements will not be able to be remeshed as the projections will be
lost.

Note:

It is recommended that Ignore Projection be enabled when remeshing a controlled
region of mesh, and to disable it when remeshing bad elements for the entire
model.

Quality metric

specifies a quality metric.

Up to quality

specifies the desired quality level.

Max iterations

is the total number of iterations to remesh in order to get the desired quality level.

Find/Close Holes in Mesh

The Find/Close Holes option locates holes in the selected elements and remeshes them.

Tip:

To speed the mesh refinement, turn off visibility of Mesh > Subsets in the Display Tree
before applying the remesh.

Mesh Type

specifies the appropriate surface mesh element type.
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Elements

specifies the elements from which to look for holes.

Surface projection

allows you to project new nodes onto the nearest surface.

Part from geometry

when enabled, the Part for the new elements is inherited from the adjacent surface part. This is
calculated with a normal ray from the center of each new element to the nearest surface. When
this option is disabled, the Part for the new elements is inherited from the surrounding elements
based on the first element selected.

Mesh From Edges

The Mesh from Edges option allows you to close holes by selecting the edges that surround
it.

Mesh type

specifies the appropriate surface mesh elements available.

Edges

allows you to select the edges that surround the holes.

Surface Projection

allows you to project new nodes onto the nearest surface.

Single loop & complete edges

if enabled, it will try to complete a loop from the edges selected. If disabled, it will not mesh if
the selected edges do not form a complete loop.

Interpolation surface

interpolates the meshing area by a biquadratic approximation in order to generate a smooth
surface.

Keep volume consistent

if enabled, makes sure that the surface mesh and volume mesh are consistent with each other
after remeshing.

Note:

This only applies to tetra meshes.
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Stitch Edges

The Stitch Edges option allows you to close gaps within selected edges (usually single edges)
by merging opposing nodes, making the mesh on both sides conformal.

Edges

specifies the edges to be stitched.

Rel. Merge Tolerance

if two nodes are within this tolerance, they will be merged instead of stitched together. Specify
a factor (from 0 to 1) of the local element size. Typical values are 0.05 – 0.2. The purpose of this
tolerance is to avoid tiny element edges, not to limit the stitch area.

Merge End Nodes

when enabled, this option will merge end nodes when stitching the selected edges.

Smooth Surface Mesh

The Smooth Surface Mesh option is an automatic process for improving the quality of selected
surface mesh elements. A common mesh smoothing technique is Laplace Smoothing, which seeks
to reposition the nodes so that each internal node is at the centroid of the polygon formed by its
connected neighbors. This repositioning is usually done iteratively.

Elements

specifies the surface mesh elements to smooth.

Max Iterations

is the maximum number of iterations for smoothing the mesh.

Accuracy

is a relative tolerance for element quality (between 0 and 1) related to the local element size. The
default value is 0.025. If set to 0, then the given number of smoothing steps is done. Bigger values
improve the performance because smoothing stops when the accuracy has been reached.

Isoparametric

is an additional option for the surface smoother. The default value is 0, which is pure Laplacian
smoothing. You can increase this parameter up to 1 to produce an isoparametric mesh.

Surface projection

allows you to project new nodes onto the nearest surface.
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Smooth boundaries

smoothes the boundary nodes of the surface mesh selected, not just the internal nodes. It also
allows curve nodes to be improved.

Flood Fill / Make Consistent

Flood Fill

The Flood Fill process here is the same as what happens during the Octree meshing process.
Flood Fill uses Material points to mark volume elements and group them into volume parts. See
also the  Octree meshing approach in the Ansys ICEM CFD User's Manual.

For each material point in the model, a root volume element is defined (the volume element that
this material point sits in). From each root volume element, all the neighboring volume elements
will be added, and then their neighbors are added in a flood filling manner. This process stops
at the surface elements which define the closed boundary and selects all the volume elements
within the boundary. The selected volume elements are assigned to the part of the material point
within the volume.

Note:

If the flood fill process finds a second material point with a different part name within
the same process, leakage is detected. Flood fill will attempt to automatically close
holes, but if it cannot, the application will prompt you to close holes interactively. A
message will alert you to which material point entities are in conflict. In the interactive
process, you will be shown a jagged line representing the connection path between
the material points along the centroids of the volume elements and through the "hole"
if there is one. It will also highlight the single edges and bring up the mesh editing
option for mesh from edges so you can more easily select the edges and close the
hole. Then the flood fill will resume. In some cases, the problem may be that both
material points are in one volume or perhaps one is in the wall between two volumes;
in which case deleting or moving material points is the solution.
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Figure 438: Use of the Flood Fill Option

Note:

For situations where the mesh is not surface fitted, use the Mark Enclosed Elements
(p. 624) option instead of Flood Fill.

Make volume mesh consistent with surface mesh

makes tetra volume mesh consistent with tri surface mesh. Tetra elements near the surface are
modified to fit the surface mesh. The final volume mesh is connected node for node with the
surface mesh. You can use this command to replace a boundary or cut a surface mesh out of a
volume.

Figure 439: Original Volume and Surface Meshes (p. 622) shows a manifold with an inserted baffle.
The tetra volume mesh for the manifold and the tri surface mesh for the baffle is also shown.
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Figure 439: Original Volume and Surface Meshes

Figure 440: Combined Mesh (p. 622) shows the combined mesh, where the use of this option allows
you to combine the two meshes in different orientations.

Figure 440: Combined Mesh
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This option may be chosen for All elements, or Selected elements.

Note:

Most manual mesh editing commands, such as merge, split, etc. automatically keep
the volume consistent. Other commands, such as remesh from edges have an option
to "Keep volume consistent".

Associate Mesh With Geometry

The Associate Mesh with Geometry option will assign the closest part to the selected surface
mesh elements.

Enforce Node, Remesh

 If a node lies outside the mesh and is not the part of mesh (for example, a Weld node) the Enforce
Node, Remesh option will remesh nearby surface nodes so that the mesh respects the node location.

Tip:

To speed the mesh refinement, turn off visibility of Mesh > Subsets in the Display Tree
before applying the remesh.

Mesh type

specifies the mesh type.

Surface projection

allows you to project moved nodes onto the nearest surface.

Ignore projection

if enabled, projections to curves and points will be ignored when remeshing. If a group of elements
that are being remeshed have internal nodes that are projected to curves or points, and if Ignore
projection is disabled, the elements will not be able to be remeshed as the projections will be
lost.

Note:

It is recommended that Ignore projection be enabled when remeshing a controlled
region of mesh, and to disable it when remeshing bad elements for the entire
model.
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Keep volume consistent

if enabled, then the volume mesh also gets remeshed with the shell mesh, and the consistency
between the volume and surface mesh is maintained.

Note:

This option only applies to tetra meshes.

Selection Method

You have the option of selecting nodes or points. If selecting points, also specify the surface mesh
part name for the new node element.

Make/Remove Periodic

The Make/Remove Periodic option allows you to manipulate the periodicity of specific nodes.
You can check the existing periodicity through the mesh display options in the Model tree.

Note:

In order to make nodes periodic, periodicity must be defined in Mesh > Global Mesh
Parameters.

Make Periodic

allows you to select two nodes at a time to define periodic node pairs.

Note:

In order to make an axis vertex periodic with itself, select only that node, and you
will be asked to confirm that the selected node should be made periodic to itself.

Remove Periodic

removes the periodicity from the selected nodes. Select one node of each periodic node pair.

Mark Enclosed Elements

The Mark Enclosed Elements option uses Material Points within an enclosed volume of surfaces
to mark all the elements within that volume and assign them to the same Volume Part as the enclosed
Material Point. Only mesh in regions containing the selected Material Points will be affected.

Any elements within the enclosed space containing the Material Point are placed into the same
Volume Part. If the Material Point is outside of the selected surfaces, then all elements with centroids
outside of the enclosed surfaces are placed within the Volume Part. If there is an enclosed volume
that does not contain any material points, its elements are not affected.
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The end result is similar to that obtained using Flood Fill (p. 620), but the approach is less restricted
because the mesh does not need shells or faces aligned with the enclosing surfaces. For most situations,
Flood Fill is a more robust and faster method. For situations where the mesh is not surface fitted, this
option should be used in place Flood Fill.

In Figure 441: Example of the Mark Enclosed Elements Option (p. 625), note that the elements are
marked based on the location of the centroid of each element. Note also that the region between
the cylinders is an enclosed volume but has no Material Point, so its elements remain with the original
material.

Figure 441: Example of the Mark Enclosed Elements Option

Enclosed Surfaces

specifies the enclosed surfaces that form a volume.

Material Points / Bodies

specifies the Material Points.

Only volume elements

allows you to assign only volume elements within the enclosed surfaces to the part of the Mater-
ial Point. When this option is disabled, shell elements also within the enclosed surfaces will be
assigned to the part of the Material Point as well.

Note:

This option is enabled by default as most solvers prefer to keep volume elements and
shell elements in different parts.

An example is shown in Figure 442: Using the Only Volume Elements Option (p. 626). When the
Only volume elements option is enabled, the volume elements within the enclosed surfaces are
included in the Material Point Part. When the Only volume elements option is disabled, the
surface elements within the enclosed surfaces are also included in the Material Point Part.
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Figure 442: Using the Only Volume Elements Option

Original Mesh

Only volume elements Enabled

Only volume elements Disabled
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Merge Nodes

The Merge Nodes option allows you to merge two nodes together to improve mesh quality while
editing the mesh. Also, disconnected parts of mesh can be merged together.

Figure 443: Merge Nodes Options

The following options are available for merging nodes:

Merge Interactive

Merge Tolerance

Merge Meshes

Merge Interactive

The Merge Interactive option allows you to merge the selected nodes.

Nodes

specifies the nodes to be merged.

Figure 444: Selection of Nodes to be Merged (p. 627) shows two nodes to be merged.

Figure 444: Selection of Nodes to be Merged
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Propagate Merge

propagates the merged node through the mesh until propagation is stopped by a tri element or
a mesh boundary. Figure 445: Propagate Merge (p. 628) shows the use of the Propagate merge
option.

Figure 445: Propagate Merge

Merge to average

only the nodes selected will be merged. Element types will be changed if necessary to perform
the merge. Using the same example as Figure 444: Selection of Nodes to be Merged (p. 627), Fig-
ure 446: Merge to Average (p. 628) illustrates this operation.

Figure 446: Merge to Average

If the mesh is only surface mesh, you will be given the option to terminate or propagate the
merged nodes after selecting the nodes. After making the selection, that method will be used on
all following nodes merged until the function is exited by using the middle mouse button.
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Ignore projection

ignores restrictions based on node projection during merging. For instance, two point projected
nodes cannot be merged because they are each confined to their respective points. This option
ignores that restriction and allows the merge.

Tip:

To speed the mesh refinement, turn off visibility of Mesh > Subsets in the Display Tree
before applying the merge.

Merge Tolerance

The Merge Tolerance option allows you to merge nodes that are within a specified tolerance.

Nodes

specifies the nodes which are checked for proximity within the tolerance.

Tolerance

specifies the tolerance value. This function will attempt to merge pairs of selected nodes whose
proximity to each other is within the tolerance.

Ignore Projection

ignores restrictions based on node projection during merging. For instance, two point projected
nodes cannot be merged because they are each confined to their respective points. This option
ignores that restriction and allows the merge.

Only on Single Edges

allows you to easily select all the mesh, but will only perform node merging on the perimeter of
the surface mesh (single edges). Interior nodes, those on double or multiple edges, are not merged
with this option, even if their proximity is within the tolerance.

Note:

To color-code single edges yellow, right-click Shells > Diagnostics in the Display tree
and enable Single edges.

Tip:

To speed the mesh refinement, turn off visibility of Mesh > Subsets in the Display Tree
before applying the merge.
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Merge Meshes

The Merge Meshes option allows you to merge disconnected parts of the mesh if two or more
domains are loaded and the nodes do not match up at the interface between them. These domains
are usually created separately. The merging will match up the nodes so that one-to-one connectivity
is maintained throughout the entire merged domain. Tri elements at the interface of one domain
should be no larger than roughly 3 times the tri element size of the other domain. The larger elements
will be subdivided at the interface until they reach the size of the elements of the other domain.
Tetra/tetra and tetra/hexa merges can also be done. If a tetra mesh and hexa mesh are to be merged,
pyramids will be created at the interface.

Note:

The Merge Meshes option only works well when the quad elements at the interface are
close to equilateral.

The following methods are available for merging the mesh:

Merge volume meshes

is used to merge two different volume meshes (both meshes can be tetra or one can be tetra
and the other hexa).

Merge surface mesh parts

allows you to specify the surface mesh parts to be merged. Select the surface mesh parts
at the interface of the two separate domains. Only one part can be selected if the surface
elements of the two separate domains are in same part at the interface.

Frozen volume mesh parts

specifies the volume parts to remain fixed. The volume mesh part that is not frozen will
be modified. If one of the volume parts is hexa mesh, then that part will be frozen
whether it is selected as frozen or not.

Resolve refinements

is used to resolve couplings, which define the connectivity between elements which are not
connected node by node (hanging nodes). In order to accommodate solvers that cannot handle
couplings, this method can be used to resolve couplings using refinement and to make the mesh
more conformal.

Note:

Concave regions that have a coarsened interior will be filled with fine mesh. This results
in an interior refinement area with finer mesh sizes and coarse regions around it.
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Standard

is the same as Pure 3D Refinement, which resolves refinements into all three directions. But
this option has smarter handling of 2.5D (surface mesh that has been extruded to become
volume mesh) cases.

Allow unstable patterns

allows non-standard refinement patterns. This improves the situation of heavy propagation
of fine elements.

Pure 3D refinement

resolves refinements into all three directions. This may lead to heavy propagation of fine ele-
ments.

See Figure 447: Resolve Refinements Options-Example 1 (p. 631) and Figure 448: Resolve Refine-
ments Options-Example 2 (p. 632) for some examples of the different options.

Figure 447: Resolve Refinements Options-Example 1

Original Mesh

Standard and Pure 3D Refinement results in propagation of fine mesh in
concave regions.
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Allow Unstable Patterns

Figure 448: Resolve Refinements Options-Example 2

Original Mesh

Pure 3D Refinement
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Standard

Allow Unstable Patterns

Split Mesh

The Split Mesh option allows you to split mesh elements at an individual level. This is one type
of refinement of elements.
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Figure 449: Split Mesh Options

The different options available under this menu are as follows:

Split Nodes

Split Edges

Swap Edges

Split Tri Elements

Split Internal Wall

Y-Split Hexas at Vertex

Split Prisms

Split Nodes

The Split Nodes option allows you to split nodes for triangle mesh and move them. Both nodes
will have the same constraint (point, curve or surface) as the original node. You need to specify
whether the vertex is a manifold or non-manifold one.

Non-manifold vertices are those where the outer edges of their adjacent elements do not form a
closed loop. This usually indicates elements that jump from one surface to another, forming a "tent-
like" structure. This would usually pose no problem for mesh quality but will represent a barrier in
the free domain that probably should not be there.

Figure 450: Manifold and Non-Manifold Vertices

Manifold

For manifold vertices, select the node with the left mouse button and accept the selection with
the middle mouse button. Proceed to move the selected nodes with the left mouse button. New
triangles will be created that are attached to the new node.
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Non-manifold

For non-manifold vertices, select the node with the left mouse button. All surface elements con-
nected to that node will then be highlighted. Select the surface elements that will be attached
to the new node, and press the middle mouse key to accept. Then move the node with the left
mouse button. No new triangles will be created.

Figure 451: Split Node of Non-Manifold Vertex

Split Edges

The Split Edges option allows you to split selected edges into two, as well as the adjacent ele-
ments.

The following methods are available:

Selected

allows you to split the selected edges.

For this method, the following options also apply:

Propagate

The split edge operation will propagate through the mesh until the propagation is stopped
by a tri element or it exits to the ORFN region.

Project

projects the newly created nodes onto the geometry.

Split Ratio

determines the location of the split as a factor between 0 and 1 along the edge.

Note:

Only one of Propagate or Project may be selected if your mesh contains only 2D
elements.
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Double walls

A double wall element is a tetra element that has all four nodes on the surface (two triangle faces
on the surface). The fix is to split the edge spanning the volume so each tetra element has only
one face on the surface. See the example shown below.

Figure 452: Double Wall Element

Double Wall Element

Double Wall Element Split Into Two Elements
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Interior spanning

If a tetra element that is located in a gap of the geometry has its nodes on two different surfaces,
the analysis of that element may not yield sufficient results. This option splits the edges of all
elements located between the different surfaces and are not connected to a triangle element (all
edges that are not boundary edges). This will create an additional node on the edge, which will
provide another face for analysis and a more accurate result. See Figure 453: Gap with Spanning
Edges (p. 637) for an example.

Figure 453: Gap with Spanning Edges

Gap with Spanning Edges

Interior Spanning Edges Split
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All spanning

is the same as Interior spanning, except that all edges, including boundary edges, will be split.

Figure 454: All Spanning Edges Split

Swap Edges

The Swap Edges option swaps edges of two adjacent triangles. The original edge will be replaced
by an edge that connects the other two corners of the triangles, as shown in Figure 455: Swap Edges
Example (p. 638)

Figure 455: Swap Edges Example

Interactive Method

allows you to select the edge to be swapped.

Automatic Method

There are two options for the Automatic method:

• By Quality

This swaps edges to improve the mesh quality to the specified minimum quality with the spe-
cified number of iterations. The quality metric that is used is Triangle Aspect Ratio.

• By Deviation

This swaps edges to minimize surface deviation to the specified maximum deviation with the
specified number of iterations. Quality is taken into account while swapping, and edges may
be swapped to improve the quality, provided it does not make the deviation worse. Also the
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quality of the mesh may restrict some edges from being swapped even if the deviation would
be improved.

In Figure 456: Swap Edges by Deviation (p. 639), the highlighted edge could be swapped to
improve the deviation value. However, because the resulting triangles are of poor quality, the
edge will not be swapped by the automatic algorithm.

Figure 456: Swap Edges by Deviation

Edge to be Swapped

Swapped Edge Resulting in Bad Quality
Elements

Split Tri Elements

The Split Tri Elements option allows you to split selected tri elements into three triangles. The
split location is at the centroid of the element.

An example of Split Element is shown in Figure 457: Split Element Example (p. 639)

Figure 457: Split Element Example
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Split Internal Wall

The Split Internal Wall option creates pairs of coincident triangles and nodes on the internal
wall. Thus, the internal wall is logically treated as an actual wall with a "gap" in between it and the
outer wall. This option is applicable for Tetra mesh only.

Y-Split Hexas at Vertex

The Y-Split Hexas at Vertex option splits hexa elements at the vertex in a Y-Grid fashion. This
can be used to split degenerate unstructured hexas of pyramid or prism shape to improve the quality
as shown in the example below. Only elements connected at the vertex will be affected. This can be
used for surface mesh as well.

Figure 458: Y-Split Hexas at Vertex Example

Split Prisms

The Split Prisms option allows you to create a few prism layers and then split them. This
method is faster and can be more robust than growing the same total number of prism layers using
the Mesh Prism option.
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Selected Prism Surface Parts

specifies the selected prism surface parts. Clicking the icon  will open a window with a
list of prism surface parts. The prism layers on the selected surface parts will be split. If no
shell mesh part is selected, then all surface prism parts will be automatically selected.

Selected Prism Volume Parts

specifies the selected prism volume parts. Clicking the icon  will open a window with a
list of prism volume parts. If volume parts are selected, only the prism layers of the selected
surface parts that belong to these volumes will be split. If no volume parts are selected, the
prism layers for all the selected surface parts will be split regardless of the volume part.

Method

specifies the method for splitting prism layers.

Fix ratio

allows you to split a prism layer such that the specified Prism ratio is applied to its res-
ulting layers.

Fix initial height

allows you to split the first layer such that its first sub-layer is the specified Initial layer
height.

Number of layers

specifies the number of layers to result from each existing layer.

Split only specified layers

allows you to split only specific prism layers.

Layer numbers (0,1,2...)

specifies which prism layers are to be split. The first prism layer is 0, the second layer is 1,
etc.

Do not split attached pyramids

when enabled, the pyramidal elements that are attached to the prism layers will not be split.
This option is disabled by default.

Note:

Using this option will result in hanging nodes in the mesh because multiple prism
side faces will be covered by one pyramid's base face. Subsequent mesh checks
will find uncovered faces and surface orientation errors. Most solvers cannot accept
these hanging-nodes, others such as Ansys Fluent prefer pyramids this way because
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they will have better aspect ratios than if they were split thin along with the adja-
cent prisms.

Move Nodes

The Move Nodes options are used to move nodes using various methods. Nodes projected to a
prescribed point will not be able to be moved. Nodes that are projected to a curve will be constrained
to active curves. Nodes projected to a surface will be constrained to active surfaces. Internal volumetric
nodes can move along the plane defined by the screen. The different options for moving nodes are
shown below.

Figure 459: Move Nodes Options

Interactive

The Interactive option allows you to select the node with the left mouse button and move it
interactively.

Move Nodes Type

You can select Single to move single nodes, or Multiple, to move multiple nodes simultaneously.

Select

specifies the nodes to be moved.

Allow Inversion

if enabled, node movement will be allowed to invert or twist elements. If disabled, node movement
will be constrained so that elements cannot be twisted.

Project to

• All geometry

projects nodes to the nearest geometry entities.

• Active Parts
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project the nodes of active parts only. Active parts include those that are enabled in the
Model tree but not visible on the screen.

• None

nodes will not be projected.

Exact

The Exact option allows you to modify the coordinates of selected nodes. The nodes may be
moved individually or in relation to a reference location.

Multiple nodes can be selected and modified at the same time. Typically, this function is used to
modify a number of nodes to one specific coordinate, for example Y=0, to ensure a true symmetry
plane.

Method

Offset

allows you to select the coordinate direction and units of distance to offset the selected nodes.

Position

allows you to select the Reference location of the nodes to be moved and based on its pos-
ition, modify the X, Y, and Z (or R, Theta, and Z) directions of the selected nodes. The reference
location can either be an existing node, or a position on the screen.

Set

specifies the appropriate coordinate system and direction to move the nodes.

• Cartesian Coordinate System

You can select the direction to move the nodes: X, Y, or Z and enter the number of units of
distance.

• Cylindrical Coordinate System

You can select the direction to move the nodes: R, θ, or Z and enter the number of units of
distance.

Select Nodes

specifies the nodes selected. Select the nodes to be moved and click Apply. After selecting a
node, its location coordinates will be displayed in the message window.

Offset Mesh
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Elements

specifies the shell elements to be offset. Select the shell elements to offset in the normal direction.
The normal direction of the elements, both the selected elements and the elements connected
to those selected, must be consistent.

Distance

specifies the distance to offset the selected elements.

Note:

Offset will change the location of nodes, but will not change the number (or definition)
of selected elements. The new node location will be based on the normal direction of
all the elements connected to this node.

Align Nodes

Reference Direction

defines the reference direction. Select two nodes to indicate the reference direction.

Nodes

specifies the nodes to be aligned by the specified reference direction.

Redistribute Prism Edge

The Redistribute Prism Edge option allows you to redistribute prism layers to a specified constant
first layer thickness or a specified growth ratio spanning the local prism column thickness. This option
works with prism layers as well as a combination of prism and hexa inflation layers. A prism layer is
constrained by three parameters which calculate the fourth (see the Prism Meshing Parameters (p. 345)
section). Total Height is set during prism growth, and can be varying if you left the Initial Height
as zero. The number of layers can be set during the prism growth or adjusted with split prisms (see
the Split Prisms (p. 640) option). An initial Height Ratio is set in the Prism Meshing Parameters, but
can be adjusted by this Redistribute Prism Edge option. With Total Height and Number of Layers
now fixed, you can use this option to adjust the Initial Height or Height Ratio and force the calcu-
lation of the other.

Note:

The redistribution will not move nodes connected to pyramids, but will redistribute other
prisms in that layer, and above.
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Method

Fix ratio

allows you to specify a constant (fixed) growth ratio for redistributing the prisms. Note that
the redistribution is calculated for each column of prisms; if the prism total height varies, the
initial height will vary in order to maintain a fixed ratio.

Figure 460: Prism Redistributed by Ratio

Fix initial height

allows you to specify the desired initial height value of the prism layers in absolute units of
the model, not the reference size. Note that the redistribution is calculated for each column
of prisms, so specifying an initial height may result in varying ratios if the individual column
Total Height varies.
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Figure 461: Prism Redistributed by Initial Height

Redistribute locked prism elements

when enabled, allows you to redistribute prism elements which have been locked (refer to
Lock/Unlock Elements (p. 649) for details). When this option is disabled (default), the locked prism
elements will be ignored during the redistribute operation.

Locked prism elements, if any, will be reported in the message window, when the Redistribute
Prism Edge DEZ is opened. Locked elements can also be highlighted in the display by enabling
Mesh > Locked Elements in the Display Tree.

Use local parameters

allows the use of the initial height or growth ratio defined locally on curves, surfaces, or parts for
the prism mesh redistribution. If the Use local parameters option is enabled, and the local values
are either not set or set to zero, the default value for the initial height or growth ratio will be
used.

In Figure 462: Prism Redistributed with the Use local parameters Option (p. 647), the prism layer
is redistributed based on initial height. The Use local parameters option is used, and the prism
mesh redistribution accounts for the initial height set locally on the detail surface.
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Figure 462: Prism Redistributed with the Use local parameters Option

Before Redistribution

After Redistribution

Project Node to Surface

The Project Node to Surface option allows you to project nodes to surfaces. Select from the
following methods.

Nearest

Projects selected nodes to the nearest surfaces.

Direction

Projects selected nodes in a specified direction. If there is no surface in the specified direction,
the node will be projected to the nearest surface along the specified vector.
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Explicit

Specify the X, Y, and Z offsets to define the vector for the direction that the node is to be
projected.

Vector

Select two points to define the vector for the direction that the node is to be projected.

Always normal

If enabled, then the node will be projected only if the angle between the surface normal and the
defined vector is less than 5 degrees. If the angle is greater than 5 degrees, the node will not be
projected and a message will be displayed in the message window.

Project to

Specify whether to project nodes to All Parts, or to only Active Parts.

Note:

Active parts are determined by the Parts branch of the tree. Active status is not affected
by enabling and disabling entities or blanking specific entities. If you do not want
nodes to be projected to certain entities, you may need to place those entities into a
separate part and disable it (deactivate it) in the model tree.

Project Node to Curve

The Project Node to Curve option allows you to project the selected node to the nearest curve
or a specified curve. The movement of the node will then be restricted along the curve.

Nodes to Project

Select the nodes to be projected.

Project by Tolerance

If enabled, all of the selected nodes that are closer to the selected curves by the specified tolerance
are projected and moved to the curves. If disabled, the selected nodes will be projected and
moved to the nearest curve.

Tolerance

Specify the tolerance value.

Curve(s)

Select the curves that the nodes are to be projected to.

Select

Select the nodes from the display.
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Project Node to Point

The Project Node to Point option allows you to project a selected node to a particular point.

Nodes to Project

Select the nodes to project.

Projection Method

• Explicit

To project nodes to a specified point.

– Point

To project the node to a selected point.

– Self

To project the node to the point at the same location.

• By Tolerance

All of the selected nodes that are closer to the selected points by the specified tolerance are
projected and moved to the points.

Un-Project Nodes

The Un-Project Nodes option allows you to un-project a projected node. The node will then
be allowed unrestricted movement.

Select

Select the nodes from the display.

Lock/Unlock Elements

The Lock/Unlock Elements option allows you to lock or unlock elements. Locked elements will
prevent automatic operations such as mesh smoothing or coarsening from moving the nodes. Locked
elements can be highlighted by enabling Mesh > Locked Elements in the Display Tree.

Snap Project Nodes

The Snap Project Nodes option allows you to project nodes to their associated geometry. Select
from the following methods.
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Nearest

Projects selected nodes to the closest location on its associated geometry.

Direction

Projects selected nodes to their associated geometry along the specified direction.

Explicit

Specify the X, Y, and Z offsets to define the vector for the direction that the node is to be
projected.

Vector

Select two points to define the vector for the direction that the node is to be projected.

Always normal

If enabled, then the node will be moved only if the angle between the surface normal and the
defined vector is less than 5 degrees. If the angle is greater than 5 degrees, the node will not be
projected and a message will be displayed in the message window.

Project to

Specify whether to project nodes to All Parts, or to only Active Parts.

Note:

Active parts are determined by the Parts branch of the tree. Active status is not affected
by enabling and disabling entities or blanking specific entities. If you do not want
nodes to be projected to certain entities, you may need to place those entities into a
separate part and disable it (deactivate it) in the model tree.

Update Projection

The Update Projection option updates the projection of all nodes in the mesh. Nodes will be
projected to a surface, curve or point.

Project Nodes to Plane

The Project Nodes to Plane option allows you to project a node to a plane.

Note:

This option is similar to the Project Nodes to Surface option, except it does not require
a surface and offers less control over how the projection is done.
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Select

specifies the nodes selected for projection.

Plane Setup Method

specifies the method for defining the plane.

Point and Plane

defines the plane by a point and the normal. Select the point and specify the normal to the
plane.

Three Points

defines a plane passing through the three specified points.

Transform Mesh

The Transform Mesh option can be used for transforming a portion or all of the mesh. This is
useful when the mesh domain has symmetry. One section of the domain can be meshed and then rotated
or translated in order to cover the complete domain.

Figure 463: Mesh Transformation Tools Options

The different options are shown in Figure 463: Mesh Transformation Tools Options (p. 651). It is possible
to use more than one method at a time.

Translate

Rotate

Mirror

Scale

Translate and Rotate

Translate

The Translate option is used to move elements laterally without rotation.
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Select

specifies the elements for translation.

Copy

If enabled, the original mesh will be kept intact, and an exact copy of the mesh with duplicated
nodes and elements will be generated at the selected location.

Number of copies

specifies the number of copies to generate. If at least one copy is generated, than you have the
option to Merge nodes.

Increment Parts

To add the newly created copies of mesh to an existing part, click the Select Parts icon. Select
the part name from the window that opens up. If no part is selected, then the copies will be added
to a new part.

Merge nodes

automatically merges duplicated nodes when the mesh copies are adjacent to or overlapping
one another. This uses a merge nodes tolerance setting to control the merge. Selecting merge
nodes activates the options for setting the Tolerance Method and Deleting duplicate elements.

Tolerance Method

allows you to determine how the merge tolerance should be specified. The Automatic option is
recommended and will automatically calculate the tolerance as one tenth of the minimum edge
length of all selected elements. If the User defined option is chosen, then an absolute tolerance
can be set in the Tolerance field. The projection of the nodes are ignored during merging. There
is also some internal code to prevent collapsing edges between nodes within the tolerance.

Delete duplicate elements

deletes duplicated elements if after merging nodes the copies overlap or are adjacent.

Translation Method

• Explicit

Enter the offset distance in the X, Y, and Z directions to translate the selected elements.

• Vector

Define a vector by selecting two points. Elements will be moved in the direction of the defined
vector.
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Rotate

The Rotate option is used to rotate elements about a defined point. This is an extremely useful
tool while meshing a circular domain. Mesh only one section of the domain, and rotate it to generate
the complete domain.

Select

specifies the elements for rotation.

Copy

If enabled, the original mesh will be kept intact, and an exact copy of the mesh with duplicated
nodes and elements will be rotated as specified.

Number of copies

specifies the number of copies to generate. If at least 1 copy is generated, than you have the
option to Merge nodes.

Increment Parts

To add the newly created copies of mesh to an existing part, click the Select Parts icon. Select
the part name from the window that opens up. If no part is selected, then the copies will be added
to a new part.

Merge nodes

automatically merges duplicated nodes when the mesh copies are adjacent to or overlapping
one another. This uses a merge nodes tolerance setting to control the merge. Selecting merge
nodes activates the options for setting the Tolerance Method and Deleting duplicate elements.

Tolerance Method

allows you to determine how the merge tolerance should be specified. The Automatic option is
recommended and will automatically calculate the tolerance as one tenth of the minimum edge
length of all selected elements. If the User defined option is chosen, then an absolute tolerance
can be set in the Tolerance field. The projection of the nodes are ignored during merging. There
is also some internal code to prevent collapsing edges between nodes within the tolerance.

Delete duplicate elements

deletes duplicated elements if after merging nodes the copies overlap or are adjacent.

Rotation Axis

specifies the axis of rotation. Select the axis of rotation as one of the coordinate axes, or a vector
defined by two selected points.

Angle

Enter the angle of rotation.
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Center of Rotation

Define the point about which the elements will be rotated.

• Origin

The origin of the model's global coordinate system, (0 0 0).

• Centroid

The center of the bounding box of the selected elements.

• Selected

Any point selected from the display.

Mirror

The Mirror option relocates the mesh domain to its mirror image across a plane. A copy of the
selected mesh can also be made as a mirror reflection while the original mesh is kept intact.

Select

specifies the elements to be mirrored.

Copy

If enabled, the original mesh will be kept intact, and an exact copy of the mesh with duplicated
nodes and elements will be generated at the selected location. This will activate the option to
Merge nodes.

Increment Parts

To add the newly created copies of mesh to an existing part, click the Select Parts icon. Select
the part name from the window that opens up. If no part is selected, then the copies will be added
to a new part.

Merge nodes

automatically merges duplicated nodes when the mesh copies are adjacent to or overlapping
one another. This uses a merge nodes tolerance setting to control the merge. Selecting merge
nodes activates the options for the Tolerance Method and Delete duplicate elements.

Tolerance Method

allows you to determine how the merge tolerance should be specified. The Automatic option is
recommended and will automatically calculate the tolerance as one tenth of the minimum edge
length of all selected elements. If the User defined option is chosen, then an absolute tolerance
can be set in the Tolerance field. The projection of the nodes are ignored during merging. There
is also some internal code to prevent collapsing edges between nodes within the tolerance.
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Delete duplicate elements

deletes duplicated elements if after merging nodes the copies overlap or are adjacent.

Reflection Plane Axis (Normal)

specifies the axis or vector that defines the normal to the mirror plane. The vector may pass
through the plane.

Point of Reflection

Select the point about which the selected mesh elements are to be reflected.

• Origin

The origin of the model's global coordinate system, (0 0 0).

• Centroid

The center of the bounding box of the selected elements.

• Selected

Any point selected from the display.

Scale

The Scale option can be used to re-size the selected mesh domain by specifying factors in all
three coordinate directions.

Copy

If enabled, the original mesh will be kept intact, and an exact copy of the mesh with duplicated
nodes and elements will be resized as specified.

Increment Parts

To add the newly created copies of mesh to an existing part, click the Select Parts icon. Select
the part name from the window that opens up. If no part is selected, then the copies will be added
to a new part.

Scale Mesh Factors

Enter the scale factor for the three directions X, Y, and Z.

Center of Transformation

Select the base point for scaling.

• Origin

The origin of the model's global coordinate system, (0 0 0).

• Centroid
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The center of the bounding box of the selected elements.

• Selected

Any point selected from the display.

Translate and Rotate

The Translate and Rotate option allows you to translate and rotate the mesh simultaneously.
The reference location and target locations can be defined by 3 points, a curve or LCS and the mesh
is translated and rotated to match.

Copy

If enabled, a copy of the selected entities will be created in the new location.

IncrementParts

To add the newly created copies of entities to a new part, click the IncrementParts icon. A window
will open with the list of the parts of the selected entities. If a part is selected, the new entities
will be placed in a new part named [old_part_name]_0. For multiple copies, each copy will be
placed in a separate part, for example, MESH_1, MESH_2, MESH_3, etc.

Translate and Rotate Method

The three options for method are as follows:

3 points –> 3 points

Select six points in all. The first three points will be used as the reference for the entity to be
transformed. The second set of three points is used to define the transformation. The result
will match the first points of both sets, and the direction from the first to the second point,
and the plane defined by the third point.

Curve –> Curve

Select two curves. The first curve is used as a reference for the entity to be transformed. The
second curve is used to define the transformation. The result will match the beginning
(parameter = 0) of both curves, the direction from parameter 0 to 0.5, and the plane defined
by the end (parameter 1) of the curves. A curve used to define the transformation can be in-
cluded in the entities selected to be transformed.

LCS –> LCS

Select two local coordinate systems. Click Apply.

The result will match the origins and align the axes of the first LCS to the second LCS.

Convert Mesh Type

The Convert Mesh Type options are used to change one element type to another.
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Figure 464: Convert Mesh Type Options

The available options are shown in Figure 464: Convert Mesh Type Options (p. 657).

Tri to Quad

Quad to Tri

Tetra to Hexa

All Types to Tetra

Shell to Solid

Create Mid Side Nodes

Delete Mid Side Nodes

Tri to Quad

The Tri to Quad option allows you to convert a triangular surface mesh to quadrilateral surface
mesh. This is applicable for all visible surfaces.

Elements

specifies the triangular elements to be converted.

Surface Projection

contains options for projecting the newly created elements to the nearest entity of the geometry.

Quadrization

If this option is enabled, then the quadratic elements will be converted.

Note:

Quadrization can only be done on the entire mesh.

Mesh Improvement

improves mesh quality after conversion. Select from the following range:

• 0 = No improvement steps.

• 1 = Stop improvement if less than 20% of the total elements are free triangles. This is the default
value.
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• 2 = Stop improvement if less than 2% of the total elements are free triangles.

• 3 = Perform as many improvement steps as needed to complete the conversion.

Max Skewness

specifies the maximum allowable skewness for conversion.

Max Warpage

specifies the maximum allowable warpage for conversion.

Tip:

To speed the mesh refinement, turn off visibility of Mesh > Subsets in the Display Tree
before applying the conversion.

Quad to Tri

The Quad to Tri option divides each quad element into two triangles. The diagonal edge will
be placed so as to make the minimum internal angle as large as possible.

Method

• Shells Only

divides the quad elements only into triangle elements.

– Shells

specifies the shell elements to be converted.

• Through Hexas

splits the attached hexa elements into two prisms and propagates the split into the volume.
This will result in a column of hexas split into prisms.

– Split Face Nodes

splits the face nodes of quad element. Select diagonally opposite nodes of the quad
element.

Tip:

To speed the mesh refinement, turn off visibility of Mesh > Subsets in the Display Tree
before applying the conversion.
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Tetra to Hexa

The Tetra to Hexa option allows you to convert tetrahedral mesh to hexahedral mesh.

Method

• 1 tetra to 4 hexa

This option will subdivide selected tetra elements into four hexa elements by creating a node
at the center of the tetra, at the centroid of the tri faces of the tetra. The 4 hexa elements are
created by connecting these nodes.

Figure 465: Example of 1 Tetra to 4 Hexa

Project nodes

If disabled, the midface nodes that are created will be left linear and will not be pro-
jected. If enabled, the node will be projected in the manner determined by the Normal
to elements option.

Normal to elements

If this is enabled, the node will be projected normal to the triangle face. If the angle
between the normal direction and the projected point is greater than 5 degrees, then
the node will be left unprojected. If this option is disabled, the node will be projected
to the closest surface.

The Project nodes option will project new face nodes onto the geometry.

• 12 tetra to 1 hexa

Works on Octree generated mesh to convert groups of 12 tetras to 1 hexa element.

Note:

This only works on Octree generated mesh because that algorithm started with
Cartesian mesh which it converted to tetras with a 1 to 12 process.

The primary control is to specify the Min aspect ratio for the newly created hexa elements,
clumps of tetras that would produce a hexa of lower quality are not converted. Pyramids are
used to create a conformal interface between converted hexas and the surrounding tetra ele-
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ments. Uniform regions of Octree mesh convert most effectively. Octree size transition regions
cannot be converted; use density boxes to control where the size transitions happen (away
from critical regions). Also, reducing the number of transitions (more uniform sizing) can result
in a higher conversion rate. If the mesh against the surface is smoothed, it may not convert as
well. You can disable surface smoothing (Octree tetra global mesh parameter) if you want hexas
to the boundary. You can select either All tetra elements or elements from selected Volume
element parts for the conversion.

In Figure 466: Example for Conversion of 12 Tetra to 1 Hexa (p. 660), the Octree tetra mesh for
a disk drive (figure (A)) is converted to an Octree hexa hybrid mesh (figure (B)). This example
has a large number of transitions as well as prism elements. These transitions, smoothing, and
non Octree element types reduce the conversion rate. From the count of element types before
and after the conversion (TETRA_4 : 4220472 converted to TETRA_4 : 2004355 and HEXA_8 :
179262), note that the final number of elements is reduced by approximately half without
coarsening the mesh.

Figure 466: Example for Conversion of 12 Tetra to 1 Hexa

(B) Octree Hexa Hybrid Mesh for the Disk Drive
After Conversion

(A) Octree Tetra Mesh With Prisms for the Disk
Drive Before Conversion

Element types :Element types:

NODE : 150NODE : 150

LINE_2 : 11726LINE_2 : 11493

TETRA_4 : 2004355TETRA_4 : 4220472

HEXA_8 : 179262TRI_3 : 445817

TRI_3 : 434319PENTA_6 : 1788782
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PENTA_6 : 1748756QUAD_4 : 2898

QUAD_4 : 11786PYRA_5 : 11186

PYRA_5 : 176324

Note:

Only tetras are converted, not prisms. Also, prisms cannot grow into hexa elements,
so you need to maintain a layer of tetras near walls where you intend to grow prisms
or insert prism layers before using the 12 Tetra to 1 Hexa. conversion.

Aligning the Octree mesh with the principal model directions (such as along a pipe or wall)
can further increase the conversion rate and result in hybrid mesh that is better aligned with
the flow.

Note:

The Use active coordinate system option must be enabled when converting oriented
Octree tetra mesh to oriented hexa hybrid mesh.

Figure 467: LCS Oriented Octree Tetra Mesh Converted to LCS Oriented Hexa
Mesh

All Types to Tetra

The All Types to Tetra option converts all element types into tetra elements.

All to Tetra

Converts all elements into tetra elements. The selected elements do not have to be a specific
initial element type.
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Selected elements

If enabled, you can select which mesh elements to convert to tetra elements. Otherwise the
full mesh of all types of volume elements will be converted to tetra elements.

Make consistent

If enabled, then elements that are attached to mesh elements that are converted to tetra will
be automatically edited to keep the mesh consistent.

1 Prism to 3 Tetra

Subdivides each prism element into three tetra elements whose edges extend along the quad
faces of the former prism.

Figure 468: 1 Prism to 3 Tetra

Shell to Solid

The Shell to Solid option converts 2D elements into 3D elements.

Selected elements

If enabled, you can select which 2D elements are to be extruded into 3D elements.

Thickness

allows you to specify a thickness value of the 3D elements.

Square corners

If enabled, square corners will be formed. If elements at an L-bracked are being extruded, then
by default the corner will be rounded, as the node extrusions are given an absolute valued based
on thickness. This function will cause the node extrusions to be multiplied by a factor of the angle,
so that a sharp corner results. See Figure 469: Shell to Solid Conversion Without Sharp Corners
Option (p. 663) and Figure 470: Shell to Solid Conversion With Sharp Corners Option (p. 663).
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Figure 469: Shell to Solid Conversion Without Sharp Corners Option

Figure 470: Shell to Solid Conversion With Sharp Corners Option

Hexa at T-connections

If enabled, hexa elements will be formed at T-connections.

Create Mid Side Nodes

The Create Mid Side Nodes option allows you to create mid side nodes on all the elements of
the mesh, as shown in Figure 471: Create Mid Side Nodes Example (p. 664).
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Figure 471: Create Mid Side Nodes Example

Mid face node

If enabled, nodes will be created at the center of each face.

Create node on interface

This option is used when creating mid side nodes on the interface between selected elements
and the elements attached to them. If enabled, then the edges of the attached elements will also
become quadratic. If disabled, then the edges that are common to both the selected elements
and attached elements will remain linear.

Project to geometry

If enabled, the newly created nodes will be projected to the nearest geometry.

Calculate projection

When a quadratic node is created, it will be projected to all marked curves or surfaces of its linear
neighbors, and also the minimum projection will be calculated. The actual projection will be
compared to the minimum projection and checked to see if it is within the specified tolerance.
If not, the minimum projection will be used.

Check max

If any of the following three conditions is enabled, then the mid side node that exceeds the re-
quired condition(s) will not be projected. For the following max conditions refer to Figure 472: Check
Max Conditions (p. 665).
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Figure 472: Check Max Conditions

• Check deviation

The distance between the end nodes B1 and B2, multiplied with the value of the Midnode
max deviation results in R. Next, imagine a line through mid node D, and perpendicular to
line B1-B2. If the position of the projected node falls outside a distance R from the line, then
the node will be moved on the geometry so that it falls within this range. If this is not possible,
it will not be projected.

• Check angle

This refers to the angles (A1 and A2) between the positions of the element edge before and
after projection. If projecting a mid node would create an angle above the Midnode max angle,
then the mid node will not be projected.

• Check chord

The distance between the chord (B1-B2) and the projected mid node is restricted to the specified
Max deviation from chord, defined in terms of % of the chord length. If this distance is ex-
ceeded then the node will be moved on the line (which is defined by the projected mid node
and its projection to the chord) to the position of the maximum deviation.

Only selected elements

If enabled, you may select the elements to which the operation will be applied.

Tetra 10 elements

• Standard check

If enabled, each projected mid node will be checked for negative values on the determinants
at Gaussian integration points of all Tetra 10 elements to which the mid node belongs. If this
check fails for at least one element then the dimension of the mid node will be increased. That
is, if it was projected to curves it will now be projected to surfaces, and then this check will be
done again. Or if the mid node had been projected to surface, it will now be linearized.

• Strong check

If enabled, a stronger check with respect to the Tetra 10 elements of the mid node will be done.
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Automatic refinement

This is available only in the case of tetrahedral elements. For all elements a temporary mid node
will be created on each element edge (with projection) and it will be checked with respect to
some diagnostic criteria for the attached tetrahedrals. If any of the criteria is not fulfilled, the
element edge will be refined. In general it is not advisable to use this option.

Smooth refinement

If enabled, the mesh will be smoothed with 5 iterations to reach an aspect ratio of 0.25 for the
tetra elements.

Delete Mid Side Nodes

The Delete Mid Side Nodes option allows you to delete mid side nodes. Mid Side Nodes can
be deleted from the entire mesh or from selected elements/nodes in two different ways.

Elements or Nodes

Either elements or nodes can be selected.

Selected elements/nodes

If enabled, it allows you to delete mid side nodes from selected elements or to delete selected
quadratic nodes.

Convert Quadratic elements to multiple Linear elements

If disabled, this option will simply delete the midside/midface nodes without disturbing any other
nodes. If enabled, this option will refine the mesh in such a way that all midside/midface nodes
will become mesh nodes.

Keep interface node

This option is used when mid side nodes are deleted from selected elements that are attached
to other quadratic elements. If enabled, then the selected elements will become linear, but nodes
on the interface of the selected elements and the attached quadratic elements will remain.

Adjust Mesh Density

The Adjust Mesh Density options allow you to refine or coarsen the entire mesh or only at a
particular location.
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Figure 473: Adjust Mesh Density Options

The following options related to this feature are shown in Figure 473: Adjust Mesh Density Options (p. 667).

Refine All Mesh

Refine Selected Mesh

Coarsen All Mesh

Coarsen Selected Mesh

Refinement

Refines, or subdivides, elements. This applies only to triangular surface elements, quads, and tetra
elements. While refining triangular surface elements, if tetra elements are connected to the tri surface
elements, the tetra's edges connected to the tri's will be subdivided so that the mesh remains
conformal. Similarly, refining tetra elements will subdivide adjacent tetra or tri element edges so
that the mesh remains conformal.

Coarsening

Coarsens a tetrahedral or tetra/prism hybrid mesh. Elements in the mesh will be coarsened by col-
lapsing edges (merging nodes) and removing degenerate elements, but no operation will be per-
formed that would yield an element with an aspect ratio worse than what is specified. The degree
of coarsening (number of elements before vs. number of elements after) is automatically determined
and reported in the message window. Disconnected vertices are automatically deleted after
coarsening.

Refine All Mesh

The Refine All Mesh option refines all of the visible displayed elements. The different methods
are described below.

Pure refinement

Refines the mesh by splitting the edges and then performing swapping to improve element
quality.

Note:

In cases where adjacent tetra are connected by an edge only (not a face), the edge is
split, but then cannot be swapped to improve the quality. This may result in lower
element quality (see Figure 474: Refinement by Edge Splitting (p. 668)).
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Figure 474: Refinement by Edge Splitting

Steps

specifies the number of refinement steps to be completed.

Project Nodes

projects the new nodes of the subdivided elements on the geometry.

Note:

It is necessary to have a Tetin file loaded for the nodes to be projected.

On Surface Only

allows you to refine only the surface mesh. This option only splits edges on the surface and
then performs swapping to improve element quality.

Tip:

The On Surface Only option is useful when you need to refine only the surface
mesh. As the volume mesh is not refined, the quality problems seen in Figure 474: Re-
finement by Edge Splitting (p. 668) will be avoided.

By Mid Side Nodes Only

refines the mesh using mid-side nodes. This option produces a more uniform mesh (see Fig-
ure 475: Refinement by Mid Side Nodes Only (p. 669)).
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Figure 475: Refinement by Mid Side Nodes Only

Note:

The By Mid Side Nodes Only option can only be used globally, and not for local
refinement.

Surface deviation

For surface elements (triangles), this option subdivides the elements based on the surface deviation
computed. The surface deviation is the distance from the centroid of the element to the surface,
in the direction normal to the surface as illustrated in Figure 476: Surface Deviation (p. 669).

Figure 476: Surface Deviation

Max Surface Deviation

specifies the maximum allowable surface deviation. If the computed surface deviation is
greater than the defined value, the element will be subdivided.

Max Steps

is the number of refinement steps. The number of sub elements that are created is determined

by the formula, 4n , where n is the Max steps value. One step will break an element into 4
sub elements, 2 will yield 16 sub elements, etc.

On Surface Only

allows you to refine only the surface mesh.

Edge length

• Max edge length
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specifies the maximum edge length after refinement.

• Weak refinement

If enabled, the refinement will not be propagated strongly into the neighboring regions.

• Max steps

the number of refinement steps.

• Project nodes

projects the new nodes of the subdivided elements on the geometry.

Note:

It is necessary to have a Tetin file loaded for the nodes to be projected.

Refine Selected Mesh

The Refine Selected Mesh option refines selected elements from the mesh.

The methods for refining selected mesh are the same as described in Refine All Mesh (p. 667).

Tip:

To speed the mesh refinement, turn off visibility of Mesh > Subsets in the Display Tree
before applying the refinement.

Coarsen All Mesh

The Coarsen All Mesh coarsens all of the visible displayed elements.

Min aspect ratio

the minimum aspect ratio (the circumsphere ratio) allowed for the resulting coarsened elements.
The lower the minimum aspect ratio, the more elements in the mesh will be coarsened.

Max size

is the largest tetra size allowed by coarsening. Only elements below this size will be coarsened,
and only up to this size. The larger this value, the more the mesh will be coarsened.

Max surface deviation

For surface elements (triangles), this option coarsens the elements based on the distance from
the centroid of the element to the surface, in the direction normal to the surface. If this distance
is less than the defined Max Surface Deviation, the elements will be coarsened.
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Number of Iterations

is the number of smoothing iterations. Smoothing will be automatically performed after the
coarsening process if this number is nonzero.

Coarsen surface

If this is enabled, then surface triangular elements will also be coarsened. If disabled, only tetra
and prism volume elements are coarsened.

Maintain surface sizes

If this is enabled, it will attempt to coarsen up to the sizes prescribed on the geometry (points,
curves and surfaces). Local coarsening can be achieved this way by only changing tetra sizes on
specific entities. When tetra mesh is generated, the elements are divided to these sizes. So if no
tetra sizes are changed after generating the tetra mesh, then enabling this option will prevent
any coarsening from being performed.

Parts to freeze

specifies the parts which will not be coarsened. Nodes of these parts will remain fixed. If there is
only one volume part, and this part is frozen, no coarsening will be performed.

Coarsen Selected Mesh

The Coarsen Selected Mesh option coarsens selected elements from the mesh.

Note:

This feature works for quad and quad dominant mesh, but not all tri mesh. In order to
coarsen selected all tri or mostly tri mesh, freeze the parts that are not to be coarsened
and then use Coarsen All Mesh.

Elements

specifies the elements selected for coarsening.

Min aspect ratio

the minimum aspect ratio (the circumsphere ratio) allowed for the resulting coarsened elements.
The lower the minimum aspect ratio, the more elements in the mesh will be coarsened.

Max size

is the largest tetra size allowed by coarsening. Only elements below this size will be coarsened,
and only up to this size. The larger this value, the more the mesh will be coarsened.

Max surface deviation

For surface elements (triangles), this option coarsens the elements based on the distance from
the centroid of the element to the surface, in the direction normal to the surface. If this distance
is less than the defined Max Surface Deviation, the elements will be coarsened.
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Number of Iterations

is the number of smoothing iterations. Smoothing will be automatically performed after the
coarsening process if this number is nonzero.

Maintain surface sizes

If this is enabled, it will attempt to coarsen up to the sizes prescribed on the geometry (points,
curves and surfaces). Local coarsening can be achieved this way by only changing tetra sizes on
specific entities. When tetra mesh is generated, the elements are divided to these sizes. So if no
tetra sizes are changed after generating the tetra mesh, then enabling this option will prevent
any coarsening from being performed.

Renumber Mesh

The Renumber Mesh option renumbers all of the elements so that the cell numbering from min-
imum to maximum is along a defined direction. This is used to speed up the computation of the solution.

Figure 477: Renumber Mesh Options

The different options are shown in Figure 477: Renumber Mesh Options (p. 672).

User Defined

Optimize Bandwidth

User Defined

Renumber Elements

enables renumbering of the elements.

Starting element number

starts element numbering from the specified number.

Element number range

gives range of existing element numbers.
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Renumber Nodes

enables the renumbering of the nodes.

Starting node number

starts node numbering from the given node number.

Node number range

gives range of existing node numbers.

Method

• By Parts

renumbers elements and/or nodes one part at a time.

• All elements/nodes

renumbers all the elements and nodes.

• Selected Elements

renumbers only the selected elements.

• Selected nodes

renumbers only the selected nodes.

Direction

the global axes direction in which to renumber elements or nodes. For the X axis, the direction
is 1 0 0.

Skip 0-numbered Elements and Nodes

If enabled, the 0-numbered elements and nodes will be skipped for renumbering.

Optimize Bandwidth

The Optimize Bandwidth option renumbers nodes to minimize the bandwidth of the ele-
ment/node matrix.

Iterations

number of iterations to reorder node numbers.

Profile

minimizes the number of elements in the profile of the global system matrix. This option
supports solvers which eliminate operations on zeros outside the profile using a skyline
storage scheme.
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Bandwidth

minimizes the bandwidth of the global system matrix.

Assign Mesh Thickness

The Assign Mesh Thickness options available are shown in Figure 478: Adjust Mesh Thickness
Options (p. 674)

Figure 478: Adjust Mesh Thickness Options

Note:

Uniform shell thickness can also be applied under Properties > Define 2D Element proper-
ties, but that definition is stored in an attribute file and not in the mesh. Thickness applied
here becomes the default when setting up properties for 2D elements. Variable thickness
should always be applied here before defining 2D element properties.

Method

• Calculate

Mesh thickness will be assigned automatically to each node of the surface element from the
thickness information stored on the surface geometry at that location. This thickness can come
automatically from the midsurfacing process (including varying thickness) or be applied manually
with Repair Geometry → Adjust varying thickness.

The thickness is defined normal to the surface in both directions. The thickness can be viewed
from the display tree by right-clicking Mesh → Shells → Shell Thickness.

Calculate from solid

allows you to extract the thickness information of shell elements from the solid geometry
around the shells. This is used when the midsurface thickness information is not present on
the surfaces. To use this, load the original solid geometry. The shells mesh should be within
this geometry. Select the part of the solid to calculate the thickness. This method uses the
nearest point projection for thickness calculation. The average of the thickness in both direc-
tions is used for each node.
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Piercing

is an alternative method for calculating the thickness from a solid. It may be preferable for
surfaces with greater thickness where the nearest point method may not be appropriate.

Note:

The nearest point projection and piercing methods lead to similar results for surfaces
with small thickness.

• Remove

Removes the mesh thickness assigned to the nodes of the surface elements.

• Modify selected nodes

Individual nodes of surface element can be assigned a specified thickness.

Reorient Mesh

The Reorient Mesh option changes the direction of the normals of selected elements or all the
elements in a particular manner.

Figure 479: Reorient Mesh Options

The options for reorienting the mesh are shown in Figure 479: Reorient Mesh Options (p. 675).

Reorient Volume

Reorient Consistent

Reverse Direction

Reorient Direction

Reverse Line Element Direction

Change Element IJK

Reorient Volume

 Reorients the normals of the displayed elements to point into the volumetric domain (inwards)
or away from the domain (outwards). By default, all of the face normals will be reoriented to point
into the domain, unless there are orientation errors.

675
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Reorient Mesh



Outwards

If toggled ON, all the normals will be oriented in the outward direction.

Reorient Consistent

 Aligns all the normals of the displayed elements to have the same orientation (inwards or out-
wards) as the selected element. This works for all elements connected to the domain of the selected
surface element. Any mesh disconnected from this mesh will not be affected. This operation will work
across different parts.

Active parts

If toggled ON, only the elements in the parts that are turned ON in the Parts Display Tree
will be reoriented.

Reverse Direction

 Reverses the normals of the selected elements.

Elements

To select the elements from the display whose orientation is to be changed.

Filter by Screen Normal

This will reverse the normal of only those elements whose normal is in the opposite direction
with respect to the screen view factor.

Reorient Direction

 Changes the normal direction of the displayed elements according to a specified X Y Z vector.
Since a face normal can only point in two possible opposing directions, the normal will point in the
direction closest to that of the specified vector.

Reverse Line Element Direction

 Reverses the line element direction.

Change Element IJK

There are four different methods available to change the IJK indices of an element.

IJK –> KIJ

For the selected element(s), the indices will be changed from IJK to KIJ.
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Set Origin

For the selected element(s), the origin will be set at the specified node.

Align Element

Aligns all elements with reference to a selected element.

Set IJK

Allows you to set the current IJK indices of the selected element(s) to new IJK indices.

Set I

Select which of the current indices to mark as the new I index.

Set J

Select which of the current indices to mark as the new J index.

Set K

Select which of the current indices to mark as the new K index.

Delete Nodes

 Deletes the selected visible nodes from the display.

Delete Elements

 Deletes the selected elements from the display.

Edit Distributed Attribute

 Makes the element with a distributed attribute visible. For example, if a model has distributed
boundary conditions, this option allows you to view and edit the BC at an element or node basis.
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Properties
Figure 480: Properties Menu

After a model is meshed, you may define or edit material and element properties using the options in
the Properties menu. The options are as follows:

Load Material From File

Load Material From Library

Write Material File

Create Material Property

Create Material Property Table

Define Point Element Properties

Define 1D Element Properties

Define 2D Element Properties

Define 3D Element Properties

Note:

In this section, the terminology used is the same as Nastran terminology. The Nastran
manual may be a resource for terminology.

The following types of element properties can be defined. The elements are grouped by dimensionality.

• 0D (Point) element properties (MASS elements)

• 1D (Line) element properties

– Bars

– Rigid Beams

→ RBAR

→ RBE2

→ RBE3
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– Rod Connection

– Damper Connection

– Spring

– Viscous Damper

– Beam

– Gap

– Beam with Cross section

• 2D (Shell) element properties

– Shell

– Shear

– Layered Composite

• 3D (Solid) element properties

Load Material From File

 Existing material files can be loaded using the Load Material From File option, or using the File
> Parameters > Open Parameters option. In either case, a file browser will open for you to select a
material file (*.mat). Loaded material files will be listed in the Display tree, under Material Properties.

The following Nastran materials are supported:

• MAT1 (Linear isotropic material properties)

• MAT2 (Linear anisotropic material properties for two-dimensional elements)

• MAT8 (Orthotropic material properties for isoparametric shell elements)

• MAT9 (Anisotropic material properties for isoparametric solid elements)

• MATS1 (Stress-dependent properties for nonlinear materials)

• MATT1 (Temperature-dependent properties for MAT1 entry fields via TABLEMi entries)

• MATT2 (Temperature-dependent properties for MAT2 entry fields via TABLEMj entries)

• MATT9 (Temperature-dependent properties for MAT9 entry fields via TABLEMk entries)
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Load Material From Library

The Load Material From Library icon is located on the pull-down menu under the Load Material
From File icon. The following material files can be loaded from the Material Library:

• Steel

• Magnesium Alloy

• Copper Alloy

• Aluminum Alloy

• Polyethylene

• Stainless Steel

• Concrete

• Titanium Alloy

• Grey Cast Iron

The units for these materials are mm/C/MPa.

Write Material File

The Write Material File option allows you to save existing material property definitions to a ma-
terial file (*.mat).

Create Material Property

The Create Material Property option opens a DEZ where you define the Name, ID, and Type of
material.
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Figure 481: Define Material Property DEZ

Material Name

specifies the name of the material being defined.

Material ID

specifies the ID of the material (MID). Nastran property cards reference this ID.

Type

Each type has its own material properties DEZ, and is described in the subsequent sections.

The different material types are:

Isotropic

Shell Element Anisotropic

Solid Element Anisotropic

Shell Element Orthotropic

Isotropic Thermal Material

Anisotropic Thermal Material
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Isotropic

Each material property described below can be selected as Constant or Varying. For varying properties,
a material property table can be defined separately as described in Create Material Property
Table (p. 686).

Young’s Modulus (E)

Within the elastic limit, the ratio of direct stress to the strain produced is called the Young’s
modulus (E).

Shear Modulus (G)

Within the elastic limit, the ratio of shear stress to shear strain.

Typically, this field is left blank. Nastran will calculate the value of Shear Modulus internally, based
on the following formula:

E = 2*(1+NU)*G,

where NU is the value of Poisson’s ratio.

Poisson’s Ratio (NU)

The ratio of lateral strain to longitudinal strain.

Mass Density (RHO)

The density of a material is its weight per unit volume (in SI units). This value will be used to
automatically calculate the mass of all structural elements.

This value should be consistent with PARAM, WTMASS card value for Nastran runs.

Thermal Expansion Coefficient (A)

This coefficient (A) is used to calculate thermal strains when thermal loads exist on the structure.

Reference Temperature (TREF)

The reference temperature for the calculation of thermal loads or a temperature dependent
thermal expansion coefficient. Typically, it is defined at room temperature in degrees Kelvin.

Structural Element Damping Coefficient (GE)

This value is found by multiplying the critical damping ratio C/C0 by 2.0.

Stress Limits for Tension (ST)

This is an optional value, used only to compute margins of safety in certain elements and has no
effect on the computational procedures.

Stress Limits for Compression (SC)

This is an optional value, used only to compute margins of safety in certain elements and has no
effect on the computational procedures.

683
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Create Material Property



Stress Limits for Shear (SS)

This is an optional value, used only to compute margins of safety in certain elements and has no
effect on the computational procedures.

Material Coordinate System (MCSID)

This is used only for PARAM, CURV processing.

LS Dyna Material Type

This specifies the LS Dyna Materials type.

Shell Element Anisotropic

Anisotropic materials have different material properties in the horizontal and vertical directions.

The properties of anisotropic shell elements include the same material properties that are described
in the Isotropic (p. 683) Material Property section. Additional properties are described below:

Gij

Elements from the material property matrix for this material type as described in the Nastran
manual.

Thermal Expansion Coefficient Vectors (Ai)

These values are the thermal expansion coefficient vectors.

Solid Element Anisotropic

The properties of anisotropic solid elements include the same material properties described in the
previous two sections. The properties that are unique to this material type are described below:

Gij

Elements of the 6 x 6 symmetric material property matrix for this material type in the Nastran
material coordinate system.

Shell Element Orthotropic

Orthotropic materials have three mutually perpendicular planes of elastic symmetry.

Modulus of Elasticity – Longitudinal (E1)

Modulus of elasticity in the longitudinal direction. It also defined as the fiber direction or 1-direction.

Modulus of Elasticity – Lateral (E2)

Modulus of elasticity in lateral direction. It also defined as the matrix direction or 2-direction.
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Poisson’s Ratio (NU12)

The ratio of lateral strain to longitudinal strain.

G12

In-plane shear modulus.

G1Z

Transverse shear modulus in the 1-Z plane.

G2Z

Transverse shear modulus for shear in the 2-Z plane.

Mass Density (RHO)

The density of a material is its weight per unit volume (in SI units).

Thermal Expansion Coefficient (Ai)

Thermal expansion coefficient in the i direction. (Real)

Reference Temperature (TREF)

The reference temperature for the calculation of thermal loads or a temperature dependent
thermal expansion coefficient.

Xt and Xc

Allowable stresses or strains in tension and compression, respectively, in the longitudinal direction.
These values are required if a failure index is desired.

Yt and Yc

Allowable stresses or strains in tension and compression, respectively, in the lateral direction.
These values are required if a failure index is desired.

S

Allowable stress or strain for in-plane shear.

Structural Damping Coefficient (GE)

This value is found by multiplying the critical damping ratio C/C0 by 2.0.

F12

Interaction term in the tensor polynomial theory of Tsai-Wu. Required if the failure index by the
Tsai-Wu theory is desired and if the value of F12 is different from 0.0.
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STRN

For the maximum strain theory only. It indicates whether Xt, Xc, Yt, Yc and S are stress or strain
allowable. (Real = 1.0, strain allowable; blank for stress allowable)

Isotropic Thermal Material

Isotropic Thermal Material corresponds to MAT4 (Heat Transfer Material properties, Isotropic) in Nastran.
Using this option allows you to set one thermal conductivity for the model.

Anisotropic Thermal Material

Anisotropic Thermal Material corresponds to MAT5 (Thermal Material property definition) in Nastran.
Using this option allows you to set thermal conductivity for each plane.

Create Material Property Table

The Create Material Property Table option allows you to create a material property table for
defining varying material properties.

Figure 482: Define Material Property Table

Varying material properties can be defined with one of the following types of tables:

Enter the name and ID of the table, and select the table type. Click Edit Table to view the Table Editor,
as shown below.
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Figure 483: Material Properties Table Editor

The following options are available in the Table Editor window:

• Define and save material properties by filling in the table entries.

• Load material properties from a file in a space delimited x-y data format.

• Display the material properties graph as shown in Figure 484: Material Properties Curve (p. 687)

Figure 484: Material Properties Curve

Define Point Element Properties

The Define Point Element Properties option allows you to define point element properties. These
properties correspond to Nastran CONM2 element properties, which are mainly to define the mass
values.
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Figure 485: Define Point Element DEZ

By defining individual point masses as separate parts, they are conveniently grouped under the Display
Tree for easy manipulation.

Part

specifies the part for which the point properties will be assigned.

PID

This is grayed out by default.

Properties Type

The only type of point element property is Mass Point.

Mass Type

There are two options for Mass Types:
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• CONM1

The general form of defining a mass element.

• CONM2

A more specific means of defining a mass element.

Scalar Mass

specifies the value for the scalar mass (SI units).

Define 1D Element Properties

The Define 1D Element Properties option allows you to define line (curve) element properties.
Choose the Type of 1D element from the drop-down list. Each type has its own DEZ.

Figure 486: Define Line Element DEZ

The following sections describe the types of 1D (line) element that can be defined.

Bar Element Properties

Rigid Elements Properties

Rod Connection Properties

Mass Connection Properties

Damper Connection Properties

Spring Properties

689
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Define 1D Element Properties



Viscous Damper Element Properties

Beam Element Properties

Gap Element Properties

Beam With Cross Section

Bar Element Properties

The properties for elastic bar elements are as follows:

The X axis of the LCS follows the bar from end A to end B. The Y axis of the LCS is used to calculate
I2 (Iyy) and the Z axis for I1 (Izz).

The formulas that are referenced are available in Mechanics of Materials books or can be computed
by using section analysis programs.

Part

specifies the part name to which the defined property will be assigned.

Material

specifies the material name for the defined property.

PID

specifies the property ID. Nastran property cards reference this ID.

Type

Bar will be automatically selected.

Cross Section Area

the value of the cross sectional area of the geometry.

Moment of Inertia (I1)

the moment of inertia for the Z axis (Izz).

Moment of Inertia (I2)

the moment of inertia for the Y axis (Iyy).

Torsional Constant (J)

the torsional constant for the geometry. For a circular cross section, this value is the sum of Izz
and Iyy.

Normal X1, X2, X3

are the components of the orienting vector.
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LS-DYNA Beam formulation

Choose the LS-DYNA beam type.

Rigid Elements Properties

The three types of rigid elements are as follows:

Rigid Bar (RBAR)

Rigid Bar with Single Dependent Nodes (Nastran CBAR elements with associated PBAR cards).

Dependent DOF (CMA)

specifies the required degree of freedom for one end of the bar.

Dependent DOF (CMB)

specifies the required degree of freedom for the other end of the bar.

Independent DOF (CNA)

specifies the required Independent degree of freedom for one end of the bar.

Independent DOF (CNB)

specifies the required Independent degree of freedom for the other end of the bar.

Enter the required degree of freedom for one end of the bar.

Rigid Body (RBE2)

Rigid Body with Multiple Dependent Nodes (Nastran RBE2 elements).

Dependent DOF

specifies the required degree of freedom for one end of the bar.

Rigid Body (RBE3)

Rigid Body with Multiple Independent Nodes having weighted average of motion (Nastran RBE3
elements).

Dependent DOF

specifies the dependent degree of freedom.

Independent DOF

specifies the independent degree of freedom.

Weighting Factor

specifies the weighting factor. The default is 1.
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Rod Connection Properties

The properties for elastic rod connections are as follows:

Cross Sectional Area

the cross sectional area of the geometry.

Torsion Constant

the torsion constant of the element.

Torsion Coefficient

the coefficient that determines torsional stress.

Nonstructural Mass/Unit Length

nonstructural mass per unit length.

Mass Connection Properties

The properties for mass connections are as follows:

Scalar Mass

the value of scalar mass of the element.

Component C1 and C2

the component numbers.

Damper Connection Properties

This corresponds to the Nastran property card PDAMP.

Force/Unit Velocity

is the damping factor to be supplied.

Components C1 and C2

damping components.

LS-DYNA Material Type

Select either Type 66 or Type 74.

Spring Properties

A spring element may be defined by the properties of Stiffness, Damping Coefficient and Stress
Coefficient. This is associated with the Nastran PELAS card, which is used in conjunction with the
CELAS1 and CELAS3 element connectivity cards.
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Select LS-DYNA Material as either Type 66 or Type 74.

Note:

It is customary to define spring elements for each degree of freedom separately. For a six
degree of freedom bushing, you need to define 6 CELAS1 and 6 corresponding PELAS
cards. Also, spring elements should be defined by coincident nodes (zero length) so that
they don’t transfer unintended moments.

Viscous Damper Element Properties

Viscous damping element properties define the PVISC card needed for CVISC viscous damper elements.

Damping for Extension

the damping factor for extension.

Damping for Rotation

the damping factor for rotation.

LS-DYNA Material Type

Select either Type 66 or Type 74.

Beam Element Properties

The properties of a beam element are described below. This element may be used to model tapered
beams.

Cross Section Area

cross sectional area of the beam.

Moment of Inertia (I1)

area moment of inertia for bending in plane 1 about the neutral axis.

Moment of Inertia (I2)

area moment of inertia for bending in plane 2 about the neutral axis.

Moment of Inertia (I12)

This value should be 0.0

Torsional Constant (J)

is the torsional stiffness parameter.

Normal X1

the normal value for the X direction.
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Normal X2

the normal value for the Y direction.

Normal X3

the normal value for the Z direction.

LS-DYNA Beam formulation

specifies the LS-DYNA Beam formulation.

Gap Element Properties

The gap element properties are as follows:

Initial Gap (U0)

the initial gap opening.

Preload (F0)

is the preload.

Axial Stiffness of Closed Gap (KA)

axial stiffness for the closed gap.

Axial Stiffness of Open Gap (KB)

axial stiffness for the open gap.

Transverse Stiffness (KT)

transverse stiffness when the gap is closed. It is recommended that KT ≥ (0.1 * KA).

Coeff of Static Friction (MU1)

coefficient of static friction for the adaptive element or coefficient of friction in the y transverse
direction for the non adaptive gap element.

Coeff of Kinetic Friction (MU2)

coefficient of kinetic friction for the adaptive gap element or coefficient of friction in the z trans-
verse direction for the non adaptive gap element.

Max Allowable Penetration (TMAX)

maximum allowable penetration used in the adjustment of penalty values. The positive value
activates the penalty value adjustment.

Max Allowable Adjustment Ratio (MAR)

maximum allowable adjustment ratio for adaptive penalty values KA and KT.
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Fraction of TMAX Defining Lower Bound (TRMIN)

fraction of TMAX defining the lower bound for the allowable penetration. (Default = 0.001)

Normal X1

the normal value for the X direction.

Normal X2

the normal value for the Y direction.

Normal X3

the normal value for the Z direction.

Beam With Cross Section

The Beam with Cross Section element properties are as follows:

Cross Section Group (GROUP)

specifies the Group Name.

Cross Section Type (TYPE)

the various types of beams that can be used are I, T, L, H, BOX, BAR, ROD, TUBE, HAT, CHAN.

Nonstructural Mass Per Unit Length (NSM)

Specify this value.

Set Cross Section Dimensions

specifies the cross section dimension values in the table.

Note:

Every cross section type beam has its own Set Cross Section table.

Normal X1

the normal value for the X direction.

Normal X2

the normal value for the Y direction.

Normal X3

the normal value for the Z direction.
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Define 2D Element Properties

The Define 2D Element Properties option allows you to define shell (surface) element properties.
Choose the Type of 2D element from the drop-down list. Each type has its own DEZ.

Figure 487: Define Shell Element DEZ

The following sections describe the 2D (Shell) Elements that can be defined:

Shell Elements

Shear Elements

Layered Composite Elements

Select the part to which the defined property will be assigned, and the PID of the property. Nastran
property cards reference this ID.

Shell Elements

The properties for thin shells possessing membrane, bending, and transverse shear and coupling
properties (Nastran PSHELL cards) are as follows:

Material

specifies the material.
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Thickness

specifies the thickness of the geometry.

Transversal Shear Material

By default, this is the same material selected for the Material option. You can however select a
different material.

Coupling Membrane/Bending Material

By default, this is the same material selected for the Material option. You can however select a
different material.

Bending Moment of Inertia Ratio

bending moment of inertia of the element.

Bending Material

By default, this is the same material selected for the Material option. You can however select a
different material.

Transverse Shear Thickness Ratio

is the ratio of transverse shear thickness.

Nonstructural Mass/Unit Length

is the nonstructural mass per unit length.

Shear Elements

The properties for shear elements (Nastran PSHEAR cards for CSHEAR element types) are as follows:

Material

specifies the material.

Thickness

specifies the thickness of the geometry.

Nonstructural Mass/Unit Length

is the nonstructural mass per unit length.

Layered Composite Elements

The properties of layered composite elements (Nastran PCOMP card) are as follows:

Distance reference plane to bottom Surface (Z0)

is the distance from the reference plane to the bottom surface.
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Nonstructural Mass Per Unit Area (NSM)

is the nonstructural mass per unit area.

Allowable Shear Stress in Bonding (SB)

allowable interlaminar shear stress.

Failure Theory (FT)

The following Failure Theory options are available: HILL, HOFF, TSAI, STRN.

Reference Temperature (TREF)

is the reference temperature.

Damping Coefficient (GE)

the damping coefficient.

Laminate Options (LAM)

The following options are available:

• Blank

• SYM

• MEM

• BEND

Number of Layers

specifies the number of composite layers.

Define 3D Element Properties

 For 3D solids like HEXA, PENTA, and TETRA shaped elements, no special property is required except
for the identification of the Part name, Material, PID, and the Local Coordinate System (LCS).
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Figure 488: Define Volume Elements DEZ

Specify the coordinate system on which this property should have applied.
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Constraints
Figure 489: Constraints Menu

The Constraints menu contains options for defining constraints. The constraints may be defined either
on the geometry, or on the finite element model, or both. The methods to define constraints on the
model are described in the following sections:

Create Constraint / Displacement

Create Constraint Equation

Define Constrained Node Sets

Define Contact

Define Single Surface Contact

Define Initial Velocity

Define Planar Rigid Wall

Create Constraint / Displacement

 Constraints or displacements can be placed on different entity types in the geometry.

As soon as the constraint is created, it will be added to the Display Tree under Constraints. Constraints
are grouped by sets. Multiple sets can be created with different constraints.

701
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.



Figure 490: Create Constraint / Displacement Window

Name

The constraint name.

SPC Set

is the number given to the constraint set. This is common Nastran Terminology.

LCS

the coordinate system for the applied constraint or displacement.

SPC Type

specifies the SPC Type.
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Node Set ID

specifies the ID number of the Node Set.

Entity Type

the type of entity to which the constraint or displacement will be applied.

Directional Displacement

You can restrict the movement of the selected entities by disabling the fields. When enabled, you
can specify the specific value of the displacement.

Rotational Displacement

You can restrict the movement of the selected entities by disabling the fields. When enabled, you
can specify the specific value of the displacement.

Create Constraint / Displacement on Point

 In the example in Figure 491: Constraints on Points or Nodes (p. 703), a constraint is placed on
the center node of the model.

Figure 491: Constraints on Points or Nodes

Create Constraint / Displacement on Curve

 Constraints can also be applied on lines or edges of the parts to restrict its movement in desired
degrees of freedom, as shown in Figure 492: Constraints on Curves (p. 704).
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Figure 492: Constraints on Curves

Create Constraint / Displacement on Surface

 Constraints can also be placed on surfaces. In Figure 493: Constraints on Surfaces (p. 704), the
constraint is placed on the highlighted surface.

Figure 493: Constraints on Surfaces
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Create Constraint / Displacement on Subset

 Constraints can also be placed on subsets of parts. Select the subsets on which the constraint
should be applied.

Note:

The subset must already be created.

Create Constraint / Displacement on Part

 Constraints can also be placed on parts. Select the parts on which the constraint should be applied.

Create Constraint Equation

This option allows you to create a multipoint constraint equation of the form:

where Aj is a real number, and A1 is non-zero.

A mesh must be loaded in order to define a constraint equation.

Name

the name of the constraint equation.

MPC Set

the set identification number.

LCS

select the Coordinate System from the drop-down list.

Node Set ID

specifies the ID number of the Node Set.

The dependent and independent nodes, DOF, and coefficients can be specified.

Define Constrained Node Sets

 In order to define constrained node sets, a mesh must be loaded.

Note:

This option is available for the LS-DYNA, Ansys, and Autodyn solvers.
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The following parameters are specified:

Name

Enter the desired name for your set.

Node Set ID

Enter an identifier for your set.

Nodes

Click the Select node(s) icon and then choose the nodes to be constrained in the graphics window.

Type

Choose from Node set or Generalized weld using the drop-down list. The additional options are
dependent on your choice.

Define Contact

The contact option is supported for Ansys, Abaqus, and LS-DYNA solvers. Nastran does not support
contacts. If you need to model contact for Nastran it is recommended that connectors be used in place
of contacts. The options for contact vary by solver.

Contacts can be defined in a variety of ways as described in the following sections:

Automatic Detection

Manual Definition
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Automatic Detection

Contact Proximity Factor

defines the distance used to evaluate which mesh is within contact with mesh in other parts. For
each of the selected parts, mesh between the parts will be evaluated a contact region between
the parts will be created.

Note:

A mesh file must be loaded for this feature.

Parts

specifies the parts for which contact will be defined. By limiting the number of parts and modifying
the contact proximity factor, you can control the contact regions.

Note:

Often it is easiest to select all parts.

Create one contact group for all parts

if enabled, one contact group will be created for all the selected parts.

Static Coefficient of Friction

The static coefficient of friction (µ) between two surfaces is defined as the ratio of the tangential
force (F) required to produce sliding divided by the normal force between the surfaces (N):

µ = F /N

The static coefficient of friction is used in the contact definition to define the resistance of the
two parts under contact.

LS-DYNA Contact Options

The contact cards that are supported are listed in the figure below. For further details, refer to
the LS-DYNA manual.
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Figure 494: Define Contact Options

Automatic Contact Option

For further details, refer to the LS-DYNA manual.

Dynamic Coefficient of Friction

The dynamic coefficient of friction or kinetic friction is used to define the friction under contact
when the two parts are in motion relative to each other (in contrast to the static coefficient of
friction).

Manual Definition

 Contacts can also be manually defined for shell elements.

Name

the name of the contact, which will appear in the Display Tree.

Contact Surfaces

specifies the surfaces or shell elements that make up the contact region.

Target Surfaces

specifies the surfaces or shell elements that make up the target region.

The remaining parameters are the same as described in Automatic Detection (p. 707)
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Define Single Surface Contact

This option allows you to define a single surface contact.

Note:

This option is available only for the LS-DYNA solver.

Name

the name of the contact, which will appear in the Display Tree.

Contact Surfaces

specifies the surfaces or shell elements that make up the contact region.

Static Coefficient of Friction

The static coefficient of friction (μ) between two surfaces is defined as the ratio of the tangential
force (F) required to produce sliding divided by the normal force between the surfaces (N):

μ = F / N

The static coefficient of friction is used in the contact definition to define the resistance of the two
parts under contact.

Dynamic Coefficient of Friction

The dynamic coefficient of friction or kinetic friction is used to define the friction under contact
when the two parts are in motion relative to each other (in contrast to the static coefficient of friction).

LS-DYNA Contact Options

There are three types of contact options:

AUTOMATIC_SINGLE_SURFACE

SINGLE_SURFACE

ERODING_SINGLE_SURFACE

For further details, refer to the LS-DYNA manual.
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Define Initial Velocity

This option defines initial nodal point translational velocities using nodal sets. This may also be
used for sets in which some nodes have other velocities.

Note:

This option is available only for the LS-DYNA solver.

Name

the name of the velocity, which will appear in the Display Tree.

Points

Nodes/Points which are to have defined velocities.

Directional Velocity

specifies the X, Y and Z components of the Translational Velocity.

Rotational Velocity

specifies the X, Y and Z components of the Rotational Velocity.

Define Planar Rigid Wall

This option allows you to define planar rigid walls.

Note:

This option is available only for the LS-DYNA solver.

Name

the name of the rigid wall that will be updated in the Display Tree.

Points

Points/0D elements for which you want to define a rigid wall.

Offset

all nodes within this offset distance to the grid wall are included as secondary nodes for the rigid
wall.
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Head Coordinates

coordinates for the head of any outward normal vector, originating on the wall (tail) and terminating
in space (head).

Tail Coordinates

coordinates for the tail of any outward normal vector, originating on the wall (tail) and terminating
in space (head).

Interface Friction Data

• Type/Coulomb Coeff Value

– EQ 0.0, frictionless sliding after contact.

– EQ 1.0, no sliding after contact.

– 0.0 < FRIC < 1, Coulomb friction coefficient.

– EQ 2.0, node is welded after contact with frictionless sliding.

– EQ 3.0, node is welded after contact with no sliding.

• Critical Normal Velocity for Weld

Critical normal velocity at which the nodes are welded to the wall.
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Loads
External and internal loading can be applied in a variety of ways. These loads could be gravity (weight
of the structure) acting on the parts, pressure, forces or moments acting on a set of geometric or meshed
entities, velocities and accelerations, or temperature loading.

The Loads Menu options are described in the following sections.

Create Force

Place Pressure

Create Temperature Boundary Condition

Figure 495: Loads Menu

Create Force

 External forces or moments can be applied to different entities.
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Figure 496: Create Force Window

Name

Assign a name to the force.

Load Set

Loads are separated into different sets for different properties. Sets are labelled with integer values.

LCS

Select the local coordinate system.

Scale

The scale factor for the value of the force.

Node Set ID

specifies the ID number of the Node Set.

Entity Type

Select the entity type to which the forces or moments will be applied.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.714

Loads



Force Type

• Uniform

The force is uniformly distributed on all the nodes of the selected entities.

• Total

The force is distributed among all the nodes of the selected entities as per FEA concepts.

Forces

Enter the values of the forces and moments for the corresponding directions.

Note:

Applied forces will be represented by a blue arrow, and moments by a brown arrow. If
both are applied at any location then a brown arrow will represent both the force and
moment.

Create Force on Point

 External forces or moments can be applied to geometric points or nodes with this option.

Figure 497: Example of Externally Applied Forces

Create Force on Curve

 Forces or moments can also be applied on geometric lines or curves before meshing, as shown
in the example below. Force or moment values will be enforced on all the nodes created on the
specified curves after meshing.
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Figure 498: Example of Edge Loading

Create Force on Surface

 Forces or moments can also be applied on surfaces before meshing.

Create Force on Subset

 Forces or moments can be applied on subsets of entities with the same options as described
above.

Note:

The subset must already be created.

Create Force on Part

 Forces or moments can be applied on parts with the same options as described above.

Place Pressure

 Pressures can be defined to apply to surfaces, subsets, or parts. The metric unit of pressure is

N/mm2, and the pressure is applied to all elements on the entity once meshing is done.
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Figure 499: Place Pressure Window

Name

Assign a name to the pressure.

Load Set

Loads for different properties are grouped by sets. Sets are labelled by integer values.

Entity Type

Select the entities to which the pressure is to be applied.

Pressure Type

• Uniform Normal Pressure Load

Enter the magnitude of the pressure that will be uniformly applied.

• General Pressure Load

Enter the parameters to define the General Pressure Load.

Place Pressure on Surface

 Pressure can be applied to surfaces or shell elements. When writing out to an output file, the
pressure will be applied to the shell elements or the attached faces of the solid element, depending
on what solver is chosen and the type of pressure. The direction the pressure is applied is based on
the surface normals of the shell elements, or is applied into the volume for volume mesh. A circle
symbol will be displayed on a surface to indicate application of pressure, as shown in the figure below.
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Figure 500: Pressure on Surface Example

Place Pressure on Subset

 Pressures to a subset of geometric or mesh entities are defined with the same options. The
subset must already be created.

Place Pressure on Part

 Pressures to a subset of geometric or mesh entities are defined with the same options.

Create Temperature Boundary Condition

The metric unit of temperature used is °K (Kelvin scale).

Figure 501: Create Temperature Boundary Condition Window
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Name

Name of the Temperature Set.

Temperature Set

Set number for the defined Temperature.

Node Set ID

specifies the ID number of the Node Set.

Entity Type

Select the entities to which the temperature boundary condition is to be applied.

Temperature Type

This option applies to points only. The temperature load will be applied uniformly.

Temperature

The value of the temperature acting on the selected entities.

Temperature on Point

Temperatures can be applied to points. In the following example, thermal boundary conditions
are indicated by highlighted dots on the nodes.

Figure 502: Thermal Loading on Nodes

Temperature on Curve

Temperatures can be applied to curves. In the following example, thermal boundary conditions
are indicated by highlighted dots on the curves.
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Figure 503: Temperature on Curves Boundary Condition Example

Temperature on Surface

Temperatures can be applied to surfaces. In the following example, thermal boundary conditions
are indicated by highlighted dots on the surfaces.

Figure 504: Surface Temperature Boundary Condition Example

Temperature on Body

Temperatures can be applied to bodies as well. In the following example, thermal boundary
conditions are indicated by highlighted dots on the bodies.
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Figure 505: Body Temperature Boundary Condition Example

Temperature on Subset

Temperatures can be also be applied to subsets. The subset must already be created.

Temperature on Part

Temperatures can be also be applied to parts.
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FEA Solve Options
Figure 506: FEA Solve Options Menu

After setting up the different loading conditions on the geometry and mesh of a model, the FEA Solve
Options Menu enables you to select a solver and set specific options for your analysis. ICEM CFD supports
NASTRAN, Ansys, LS-DYNA, Abaqus, or Autodyn solvers for FEA analysis.

Note:

• The FEA Solve Options tab is enabled by the Mechanical Preprocessing option on the
Settings → Tools menu.

• The LS-DYNA deck does not handle units. You are responsible to use consistent units for
all data.

Since Autodyn uses LS-DYNA data, the same caveat applies.

• To export mesh in a format better suited to CFD analysis, use the Output Mesh tab.

For more information on the Output Solvers, see the Output Mesh (p. 759) chapter.

• Both FEA and CFD properties can be set for the same model.

The following sections will address the FEA Solve Options available. Each section is further split based
on Solver selection.

Setup Solver Parameters

Setup Analysis Type

Setup a Subcase

Write/View Input File

Submit Solver Run

Setup Solver Parameters

You can use your default Method as shown in the drop-down list, or select a different solver option.

The Setup Solver Parameters window has different options for different Solvers, as explained below.
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NASTRAN Setup Solver Parameters

Ansys Setup Solver Parameters

LS-DYNA Setup Solver Parameters

Note:

There are no additional parameters for Abaqus Solver or Autodyn Solver setup

NASTRAN Setup Solver Parameters

The different types of analysis that can be performed are: Linear Static Analysis, Modal Analysis and
Legacy analysis. Each analysis requires various parameters and inputs, which are explained in the fol-
lowing sections.

Eigenvalue Extraction (EIGR / EIGRL)

• Method ID (SID)

Set ID number (Unique integer > 0)

• V1, V2

For vibration analysis, the frequency range of interest.

• Number of Modes (ND)
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Number of frequencies desired.

Buckling Analysis (EIGB)

• Method ID (SID)

Set ID number (Unique integer > 0)

• SINV

Enhanced inverse power method.

• INV

Inverse power method.

• Lower / Upper Eigenvalues (L1, L2)

The Eigenvalue range of interest. Eigenvalues are the factors by which the pre-bucking state
of stress is multiplied to produce buckling in the shape defined by the corresponding Eigen-
vector.

• Desired Number of Positive / Negative Roots (NDP, NDN)

• NORM

Method for normalizing eigenvectors. The MAX option (default) normalizes eigenvectors to the
unit value of the largest component in the analysis set. The POINT option normalizes eigen-
vectors to the unit value of the component defined in the G and C fields, where G is the Grid
or scalar point ID, and C is the Component number. The value for NORM defaults to MAX if the
defined component is zero.

Nonlinear Static Analysis Control (NLPARM)

• Number of Increments (NINC)

0<Integer<1000, Default=10.

• Incremental Time Intervals (DT)

Incremental time interval for creep analysis. The unit of DT must be consistent with units used
for the CREEP entry that defines its characteristics.

• KMETHOD

The stiffness update strategy.

• Number of Iterations (KSTEP)

Number of iterations before the stiffness update for the ITER method. The stiffness matrix is
updated on convergence if KSTEP is less than the number of iterations that were required for
convergence with the current stiffness.

• Max Iterations (MAXITER)

725
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup Solver Parameters



The limit on the number of iterations for each load increment.

• CONV

Flags to select convergence criteria. U=Displacement error, P=Load equilibrium error, W=work
error and the error tolerances (EPSU, EPSP, and EPSW) define the convergence criteria.

• INTOUT

Intermediate output flag. Controls the output requests for displacements, element forces and
stresses, etc.

• Max Divergence (MAXDIV)

The limit on the probable divergence condition per iteration before the solution is assumed to
diverge. (Integer not equal to 0: Default=3)

• Manimum Number of Quasi-Newton (MAXQN)

Newton correction vectors to be saved in the database.

• Max Number of Line Search (MAXLS)

Maximum number of line searches allowed for each iteration.

• Fraction of Effective Stress (0.0–1.0) (FSTRESS)

Fraction of effective stress used to limit the sub-increment size in the material routines.

• Line Search Tolerance (0.01–0.9) (LSTOL)

Line search tolerance.

• Max Number of Bisections (MAXBIS)

Maximum number of bisections allowed for each load increment.

• Max Ratio (1.0–40.0) (MAXR)

Maximum ratio for the adjusted arc length increment relative to the initial value.

• Max Value of Incremental Rotation (RTOLB)

Maximum value of incremental rotation (in degrees) allowed per iteration to activate bisection.

Transient Time Step (TSTEP)

Defines the step intervals at which a solution will be generated, and the output in transient ana-
lysis.

• Number of Time Steps

Number of time steps of value DTi (integer greater than or equal to 1)
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Frequency (FREQ / FREQ1 / FREQ2)

• Frequency List (FREQ)

– Number of Frequencies

Defined number of frequencies.

• Frequency List (FREQ1)

The Frequency List (FREQ1) options define a set of frequencies to be used in the solution of
frequency response problems, specified by the First Frequency (F1), the Frequency Increment
(DF), and the Number of Frequency Increments (NDF) desired.

• Frequency List (FREQ2)

The Frequency List (FREQ2) options define a set of frequencies to be used in the solution of
frequency response problems, specified by the First Frequency (F1), the Frequency Increment
(DF), and the Number of Logarithmic Increments (NF).

Dynamic Load (DAREA / DELAY / DPHASE)

• Load Scale Factor (DAREA)

Defines scale (area) factors for static and dynamic loads. In dynamic analysis, DAREA is used in
conjunction with RLOADi and TLOAD entries.

– Pi

Grid, extra or scalar point identification number. (Integer >0)

– Ci

Component number (Integer 1 through 6 for grid point, blank or 0 for extra scalar point).

– Ai

Scale (area) factor.

• Dynamic Load Time Delay (DELAY)

– Pi

Grid, extra or scalar point identification number. (Integer >0)

– Ci

Component number (Integer 1 through 6 for grid point, blank or 0 for extra scalar point).

– Ti

Time delay for designated point Pi and component Ci.

• Dynamic Load Phase Lead (DPHASE)
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Defines the phase lead term theta in the equation of the dynamic loading function.

– Pi

Grid, extra or scalar point identification number. (Integer >0)

– Ci

Component number (Integer 1 through 6 for grid point, blank or 0 for extra scalar point).

– THi

Phase lead theta in degrees.

Dynamic Excitation (TLOAD/RLOAD)

• Transient Response (TLOAD1)

Defines a time dependent dynamic load or enforced motion, for use in transient response
analysis.

– DAREA

Identification number of DAREA set or a thermal load set that defines enforced acceleration
using large mass or SPC/SPCD data.

– DELAY

Identification number of delay entry set.

– EXCITATION TYPE

Defines the type of dynamic excitation.

– TABLEDi

Identification number of TABLEDi entry.

• Transient Response (TLOAD2)

Includes the same parameters as Transient Response (TLOAD1), in addition to the parameters:
Time Constants (T1, T2), Frequency (F), Phase Angle (P), Exponential Coef. (C), and Growth
Coef. (B).

• Frequency Response (RLOAD1)

Defines a frequency dependent dynamic excitation for use in frequency response problems.

• Frequency Response (RLOAD2)

Includes the same parameters as Frequency Response (RLOAD1).
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Dynamic Load Combination (DLOAD)

Defines a dynamic loading condition for frequency response or transient response problems as
a linear combination of load sets defined via RLOAD1 or RLOAD2 entries for frequency response,
or TLOAD1 or TLOAD2 entries for transient response.

• Global Scale Factor (S)

The Global Scale Factor.

• Number of loads

The number of Load Set ID numbers of RLOAD1, RLOAD2, TLOAD1, and TLOAD2.

Static Load Combination (LOAD)

Defines a static load as a linear combination of load sets.

• Global Scale Factor (S)

The Global Scale Factor.

• Number of loads

The number of Load Set ID numbers used to define the LOAD.

Single-Point Constraint Combination (SPCADD)

Defines a single-point constraint set as the combination of other defined single-point constraint
sets.

Multi-Point Constraint Combination (MCADD)

Defines a multipoint constraint set as combination of other multipoint constraint sets.

Default Grid Point Temperature (TEMPD)

Defines a temperature value for all grid points of the structural model that have not been given
a temperature on a TEMP entry.

Acceleration or Gravity Load (GRAV)

Defines acceleration vectors for gravity or other acceleration loading.

• LCS

Identify the local coordinate system.

• MB

Indicates whether the local coordinate system (LCS) is defined in the main Bulk Data Section
(MB = -1) or the partitioned superelement Bulk Data Section (MB = 0). Coordinate systems ref-
erenced in the main Bulk Data Section are defined relative to the assembly basic coordinate
system, which is fixed. This feature is useful when a superelement defined by a partitioned Bulk
Data section is rotated or mirrored.
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• Scale Factor

Scale factor of the acceleration vector.

• Vector Components

Acceleration vector components measured in the specified coordinate system.

Include File (INCLUDE)

Inserts an external file (*.dat, *.nas, *.bdf ) into the input file using an INCLUDE statement.

Ansys Setup Solver Parameters

Use the drop-down list to select the Method of Global motion that is to be specified, if any.

Acceleration or Gravity

• Parameter Name

The name of the load.

• Scale Factor

Scale factor of the acceleration vector.

• Direction

Specify the acceleration vector components.

Rotational Velocity

The X, Y, and Z components can be specified. Also, the Spin Softening Key can be decreased or
not modified.

Rotational Acceleration

The X, Y, and Z components can be specified.
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LS-DYNA Setup Solver Parameters

Base Acceleration or Gravity Load

Defines acceleration vectors for gravity or other loading.

Note:

Only one gravity vector can be defined for the LS-DYNA file.

• Parameter Name

The name of the load.

• Scale Factor

Scale factor of the acceleration vector.

• Direction

Specify the acceleration vector components.

Setup Analysis Type

This option allows you to setup the parameters for the different types of analysis.

The following sections describe the parameters that are specific to each analysis type.

NASTRAN Setup Analysis Type

Ansys Setup Analysis Type

LS-DYNA Setup Analysis Type

Abaqus Setup Analysis Type

Autodyn Setup Analysis Type
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NASTRAN Setup Analysis Type

Run Time (TIME)

The maximum allowable execution time in CPU minutes. By default, it is set to 99999. You can
increase this if necessary.
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Max Output Lines (MAXLINES)

The maximum number of output lines to the solver. In any run, if MAXLINES exceeds the set value
(99999  is the default), then the program will terminate.

Write Input Lines (ECHO)

Controls the Input file for the Nastran solver. The following options are available:

• NONE

Suppresses printing of the Bulk Data into the Nastran Input file.

• SORT

Writes the Bulk Data section in small field format as well as sorted alphabetically into the Nastran
input file.

• UNSORT

Writes the Bulk Data section exactly as it is input.

• BOTH

Write both the SORT and UNSORT formats.

• PUNCH

Punches the Bulk Data to an ASCII file.

Case Control Cards

Output Title (TITLE)

To specify a title that will appear on the first heading line of each output page.

Output SubTitle (SUBTITLE)

To specify a subtitle that will appear on the second heading line for each output page.

Output Label (LABEL)

To specify a label that will appear on the third heading line of each output page.

Linear Static Analysis (Sol 101)

Mass Multiplier (WTMASS)

This value will be multiplied to the structural mass matrix when the mass of the structure is
calculated.
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Rotation Stiffness Adjustment (K6ROT)

It specifies the stiffness to be added to the normal rotation for Shell and Tri elements. The default
is 0, but you can change its value between 1 to 100 to suppress singularities for geometric
nonlinear analysis.

Max Ratio (MAXRATIO)

The default value for the MAXRATIO is 1.0E7.

Coupled Mass (COUPMASS)

The default value is -1.

Constrain Singularities (AUTOSPC)

AUTOSPC specifies the action to take when singularities exist in the stiffness matrix. If enabled,
the singularities will be constrained automatically.

Grid Weights (GRDPNT)

This option will execute the grid point weight generator. It specifies the identification number
of the grid point to be used as a reference point.

Single Point Constraints (SPC)

Sets this value (positive integer) for the solution. It will set the same number of Single Point
Constraint in the input data form.

Load Set (LOAD)

Assigns an external static load set (positive integer) to the solution. It will set the same number
of Load Constraints in the input data form.

Temperature Set (TEMP)

Selects the temperature set to be used in either material property calculations or thermal
loading in heat transfer and structural analysis.

Output Requests

These output requests (Displacement, Stress, Strain, Element Strain Energy) can be set to ALL
or NONE.

Modal (Sol 103)

The Parameters and Output Requests data that is needed to perform Modal analysis is described
in Linear Static Analysis (Sol 101) (p. 733).

Buckling Analysis (Sol 105)

The Parameters and Output Requests data that is needed to perform Buckling analysis is described
in Linear Static Analysis (Sol 101) (p. 733).
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Nonlinear Static (Sol 106)

The Parameters and Output Requests data for performing Nonlinear Static analysis is described in
Linear Static Analysis (Sol 101) (p. 733).

Direct Frequency Response (Sol 109)

The Parameters and Output Requests data that is needed to perform this analysis is described in
Linear Static Analysis (Sol 101) (p. 733). The additional data needed is described below.

Parameters (PARAM)

• Structural Coefficient (G)

This value is equal to C/C0 multiplied by a factor of 2.

Case Control Cards

• Dynamic Load

Select a dynamic load to be applied in a transient or frequency response problem.

• Frequency

Select a frequency to be applied in a transient or frequency response problem.

Direct Transient Response (Sol 109)

The Parameters and Output Requests data that is needed to perform this analysis is described in
Linear Static Analysis (Sol 101) (p. 733). The additional data needed is described below.

Parameters (PARAM)

• Structural Coefficient (G)

This value is equal to C/C0 multiplied by a factor of 2.

• Structural Coefficient (W3)

The default value is 0.

Output Requests

• Velocity

Requests the form and type of velocity vector output.

Case Control Cards

• Dynamic Load

Select a dynamic load to be applied in a transient or frequency response problem.

• Frequency
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Select a frequency to be applied in a transient or frequency response problem.

Modal Frequency Response (Sol 111)

The Parameters and Output Requests data that is needed to perform this analysis is described in
Linear Static Analysis (Sol 101) (p. 733). The additional data needed is described below.

Output Requests

• Velocity

Requests the form and type of velocity vector output.

• Acceleration

Requests the acceleration output.

Case Control Cards

• Dynamic Load

Select a dynamic load to be applied in a transient or frequency response problem.

• Frequency

Select a frequency to be applied in a transient or frequency response problem.

• Structural Damping (SDAMPING)

Ansys Setup Analysis Type

Two different categories of analysis are supported for the Ansys solver: Structural and Thermal
Analysis. The following sections describe the parameters for each type of analysis.
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Structural Analysis

For Structural Static analysis, select the type of solver:

• Auto

– Number of Substeps

Number of substeps to be used for this load step (the time step size or frequency incre-
ment).

– Large Deformation Key

If Ignore is selected, than it will not include large deflection effects in a static or full
transient analysis. For the Include option, it will be incorporated in the analysis.

• Direct

Enter the Number of Substeps and select the Large Deformation Key option.

• PCG

This is a Pre-conditioned Conjugate Gradient iterative equation solver. It requires less disk
space and is faster for large models.

Enter the Number of Substeps and select the Large Deformation Key option.

– Tolerance

Solver tolerance value (defaults to 1.0e-8).

– Convergence multiplier

Multiplier user to control the maximum number of iterations performed during a conver-
gence calculation. The recommended range for the multiplier is 1.0 ≤ multiplier ≤ 3.0.

The Structural Modal Analysis, the following parameters can be defined for the Mode Extraction
Method.

Block Lanczos

This is a modal analysis method that is supported in the FEA functionality of Ansys ICEM CFD.

Number of Modes to Extract

Number of modes to extract for the analysis.

Beginning (Lower End) Frequency

Beginning or lower end of the range of frequency. It also represents the first shift point for the
eigenvalue iterations.

Ending (Upper End) Frequency

Ending or upper end of the range of frequency. The default value is 1.0E8.
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Mode Shape Normalization Key

If set to OFF, it normalizes the mode shape to the mass matrix. If set to ON , it normalizes the
mode shapes to unity instead of to the mass matrix.

Constraint Equation Processing Key

There are four options for different constraint equations to be used during analysis: Default,
Quick Lagrange, Accurate Lagrange, and Direct Elimination.

Element Calculation Key

Number of modes to expand and write for a modal analysis. If OFF is selected, then it will not
calculate element results and reaction forces. If ON  is selected, along with the nodal degree
of freedom, it also calculates element results and reaction forces.

Thermal

For Thermal Static analysis, select the type of solver:

• Auto

– Number of Substeps

Number of substeps to be used for this load step (the time step size or frequency incre-
ment).

– Large Deformation Key

If Ignore is selected, than it will not include large deflection effects in a static or full
transient analysis. For the Include option, it will be incorporated in the analysis.

• Direct

Enter the Number of Substeps and select the Large Deformation Key option.

• ICCG

The incomplete Cholesky Conjugate gradient (ICCG) algorithm is a commonly used iterative
method for solving large sparse systems of equations.

Enter the Number of Substeps and select the Large Deformation Key option.

– Tolerance

Solver tolerance value (defaults to 1.0e-8).
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LS-DYNA Setup Analysis Type

Title

Enter the title of the LS-DYNA solver run.

Density for Spring & Damper Elements

Define the density for the Spring and Damper elements.
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Abaqus Setup Analysis Type

For Abaqus, two Analysis Types are supported: Static and Natural Frequency Extraction.

For Static analysis, the Initial time increment, Time period of each step, Minimum and Maximum time
increments need to be specified.

The Natural Frequency Extraction procedure performs eigenvalue extraction to calculate natural fre-
quencies and the corresponding mode shape of a system. It includes the initial stress and load stiffness
effect, and is a linear perturbation procedure. The following parameters pertain to the Natural Fre-
quency Extraction type of analysis.

Eigensolver

There are two types of Eigensolvers, Lanczos and Subspace Iteration. Lanczos is faster when you
must extract a large number of eigen modes, such as for airframes, piping systems and building
skeletons. The subspace iteration method may be faster when only a few (less than 20) eigen
modes are needed.
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Number of Modes to Extract

Specify the number of modes to be extracted.

Beginning (minimum) and Ending (maximum) Frequency

Specify the beginning and ending frequencies.

Shift point

Specify the shift point.

Maximum iterations

Specify the maximum number of iterations.

Normalized By

Specify whether it is to be normalized by Mass Matrix or Large Displacement.

The following parameters pertain to both types of analysis.

Maximum increments

Specify the maximum number of increments.

Step amplitude

Specify whether to use Stepped or Ramped amplitude.

Include large displacement effect

Specify whether to include the effect of large displacement.

Autodyn Setup Analysis Type

Title

Enter the title of the Autodyn solver run.
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Density for Spring & Damper Elements

Define the density for the Spring and Damper elements.

Setup a Subcase

The Setup a Subcase DEZ allows you to create or modify subcases for analysis.

The details and choices for each Solver Method are described in the following sections.

NASTRAN Setup a Subcase

Ansys Setup a Subcase

Abaqus Setup a Subcase

Note:

Subcases are not supported for LS-DYNA or Autodyn.
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NASTRAN Setup a Subcase
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Active

Multiple subcases can be created, but only those toggled Active will be written out for the solution.
This allows for multiple solution types to be written from the same project without having to
delete or create subcases.

ID

Identification number for the subcase.

Subcase Output Label (LABEL)

The output label for the subcase.

Single Point Constraints (SPC)

Sets this value (positive integer) for the solution. It will set the same number of Single Point
Constraints in the input data form.

Load Set (LOAD)

Assigns an external static load set (positive integer) to the solution. It will set the same number
of Load Constraints in the input data form.

Temperature Set (TEMP)

Selects the temperature set to be used in either material property calculations or thermal loading
in heat transfer and structural analysis.

Real Eigenvalue Extraction Method (METHOD)

To create a subcase for Buckling Analysis, enter either the INV or SINV method.

Output Requests

These output requests (Displacement, Stress, Strain, Element Strain Energy, Velocity, Acceleration)
can be set to ALL or NONE.
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Ansys Setup a Subcase

Active

Multiple subcases can be created, but only those toggled Active will be written out for the solution.
This allows for multiple solution types to be written from the same project without having to
delete or create subcases.

Load step ID

Identification number for the load step.

Single Point Constraint Set

Assigns this set (positive integer) to the solution. It will also set the same number of Single Point
Constraints in the input data form.

Load Set

Assigns an external static load set (positive integer) to the solution. It will set the same number
of Load Constraints in the input data form.

Temperature Set

Selects the temperature set to be used in either material property calculations or thermal loading
in heat transfer and structural analysis.
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Abaqus Setup a Subcase

Active

Multiple subcases can be created, but only those toggled Active will be written out for the solution.
This allows for multiple solution types to be written from the same project without having to
delete or create subcases.

Load step ID

Identification number for the load step.

Single Point Constraint Set

Assigns this set (positive integer) to the solution. It will also set the same number of Single Point
Constraints in the input data form.

Load Set

Assigns an external static load set (positive integer) to the solution. It will set the same number
of Load Constraints in the input data form.

Temperature Set

Selects the temperature set to be used in either material property calculations or thermal loading
in heat transfer and structural analysis.

Write/View Input File

The Write/View Input File DEZ allows you to choose options for creating or editing the solver
input file.
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The details and choices for each Solver Method are described in the following sections.

NASTRAN Write/View Input File

Ansys Write/View Input File

LS-DYNA Write/View Input File

Abaqus Write/View Input File

Autodyn Write/View Input File

NASTRAN Write/View Input File

Nastran File

Specify the path and name for the nastran file (*.dat) that will be created after the Nastran run is
completed.

Volume, Shell, Bar Elements

The elements which are to be included in the input file. Select Defined to include only the defined
elements, All to include all available elements, or None, to not include any elements.

Thickness Distribution

Select from BC Defined, Distributed, or Averaged.

Large Field Format

If enabled, the Nastran input file will be written in Large Field Format. The default Small Format
contains 8 characters per field. The Large Field Format writes out the GRID data with 16 characters
per field, which is useful when more accurate GRID data is needed.
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Use Continuation Card

If enabled, the Nastran data will be output using continuation card. The default is OFF, but some
solvers that use Nastran input may still require continuation cards.

View Nastran File

If enabled, after the Nastran input file is written, it will open it in the default editor to be viewed.
You can edit this file before submitting it for the Nastran Run.

Ansys Write/View Input File

Ansys File

Select the Ansys Input file.

Attribute File

Select the Attribute file which contains information about all the parts and material properties.
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Parameter File

Select the Parameter file which contains the loading information.

There are two Edit Options: Basic and Advanced. Both options contain the following options.

Volume, Shell, Bar Elements

The elements which are to be included in the input file. Select Defined to include only the defined
elements, All to include all available elements, or None, to not include any elements.

Note:

If boundary conditions are defined for certain entities within the model, the Defined
elements should be selected for the appropriate element type. For example, if pressures
are defined on surface elements, and Shell Elements is set to None, then the pressures
applied to the surface elements will be ignored.

Thickness Distribution

Select from BC Defined, Distributed, or Averaged.

Advanced Edit option

The Advanced option enables the following buttons:

Create Attribute & Parameters Files

This option will generate the Parameter and Attribute files in the project directory. You can
edit the data of these files using the separate Edit Parameters and Edit Attributes buttons
provided.

With the help of these files, the translator will write an Ansys input file whenever Apply is
pressed.

Edit Parameters

opens a Solver Parameters window where you can set or modify many of the thermal or
structural analysis parameters.

Edit Attributes

opens a Part boundary conditions window where you can set or modify many of the loads
and boundary conditions. See Boundary Conditions (p. 769) for a description of the options
available.

View Ansys File

If this option is enabled, then after the Ansys input file is written, it will be opened in the default
editor. The file can be edited at this time, before it is run.
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LS-DYNA Write/View Input File

LS-DYNA File

Select the LS-DYNA input file. It is similar to the Nastran *.dat file.

Attribute File

Select the Attribute file which contains information about all the parts and material properties.

Parameter File

Select the Parameter file which contains the loading information.

There are two Edit Options: Basic and Advanced. Both options contain the following options.

Volume, Shell, Bar, Point Elements

The elements which are to be included in the input file. Select Defined to include only the defined
elements, All to include all available elements, or None, to not include the elements.
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Thickness Distribution

Select from BC Defined, Distributed, or Averaged.

Advanced Edit option

The Advanced option enables the following buttons:

Create Attribute & Parameters Files

This option will generate the Parameter and Attribute files in the project directory. You can
edit the data of these files using the separate Edit Parameters and Edit Attributes buttons
provided.

The Edit Parameters

Edit Parameters

opens a Solver Parameters window where you can set or modify many of the thermal or
structural analysis parameters.

Edit Attributes

opens a Part boundary conditions window where you can set or modify many of the loads
and boundary conditions. See Boundary Conditions (p. 769) for a description of the options
available.

View LS-DYNA File

If this option is enabled, then after the LS-DYNA input file is written, it will be opened in the default
editor. The file can be edited at this time, before it is run.
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Abaqus Write/View Input File

Abaqus File

Select the Abaqus input file. It is similar to the Nastran *.dat file.

Attribute File

Select the Attribute file which contains information about all the parts and material properties.

Parameter File

Select the Parameter file which contains the loading information.

There are two Edit Options: Basic and Advanced. Both options contain the following options.

Volume, Shell, Bar, Point Elements

The elements which are to be included in the input file. Select Defined to include only the defined
elements, All to include all available elements, or None, to not include any elements.
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Thickness Distribution

Select from BC Defined, Distributed, or Averaged.

Advanced Edit Options

The Advanced option enables the following buttons:

Create Attribute & Parameters Files

This option will generate the Parameter and Attribute files in the project directory. You can
edit the data of these files using the separate Edit Parameters and Edit Attributes buttons
provided.

Edit Parameters

opens a Solver Parameters window where you can set or modify many of the thermal or
structural analysis parameters.

Edit Attributes

opens a Part boundary conditions window where you can set or modify many of the loads
and boundary conditions. See Boundary Conditions (p. 769) for a description of the options
available.

View Abaqus File

If this option is enabled, then after the Abaqus input file is written, it will be opened in the default
editor. The file can be edited at this time, before it is run.

Autodyn Write/View Input File
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Autodyn Compatible File

Select the Autodyn Compatible File (*.k).

Volume, Shell, Bar Elements

The elements which are to be included in the input file. Select Defined to include only the defined
elements, All to include all available elements, or None, to not include the elements.

Thickness Distribution

Select from BC Defined, Distributed, or Averaged.

View Autodyn File

If this option is enabled, then after the Autodyn input file is written, it will be opened in the default
editor. The file can be edited at this time, before it is run.

Submit Solver Run

 Use this option to initiate the Solver Run.

The details and choices for each Solver Method are described in the following sections.

NASTRAN Submit Solver Run

Ansys Submit Solver Run

LS-DYNA Submit Solver Run

Note:

• Abaqus solver run has not been implemented.

• The Autodyn solver can be run in the Workbench environment.

NASTRAN Submit Solver Run
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Nastran File

Select the required Nastran input file (*.dat).

Runtime Options

The maximum time allowed for the Nastran run.

Ansys Submit Solver Run

Ansys Run Mode

There are two choices for the run mode, Interactive and Batch.

Graphics Device

For Interactive Mode, the GUI requires a terminal that supports graphics.

Input and Output File

If Batch Mode is selected, you need to specify the Input and Output files. The Input file contains
the Ansys commands submitted for batch execution. The Output file contains the text output by
the program. If the supplied file name already exists in the working directory, then it will be
overwritten when the batch job is started.
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Working Directory

The directory in which the Ansys run will be executed. Files that are written are created in this
directory.

Initial Jobname

The base file name used for all files generated by the Ansys run.

Total Workspace Memory (Mb)

The amount of memory requested for the Ansys run.

Total Database Memory (Mb)

The portion of total memory that the database will use.

Read start.ans at Start-up

To choose whether to read the start.ans file. Ansys users can include commands to be executed
at start-up in this file.

Select Ansys Product

Select from the list of Ansys products that are licensed and available.

LS-DYNA Submit Solver Run

Select LS-DYNA Executable

Select the LS-DYNA executable file.

LS-DYNA Input File

The LS-DYNA k file, written in the previous step as the input for the solver.
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Ansys LS-DYNA Options

If you want to use an Ansys license for running the LS-DYNA solver, select the applicable Ansys
license product.
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Output Mesh
Figure 507: Output Mesh Menu

Ansys ICEM CFD allows you to write output files to many different CFD file formats. The Output Mesh
tab allows you to choose between different solvers and file formats, and specify the related options
and settings before creating the output mesh file.

Select Solver

Boundary Conditions

Edit Parameters

Write Input

Select Solver

The Select Solver option opens the Solver Setup DEZ.

Figure 508: Solver Setup DEZ

You can use your default Output Solver as shown, or select a different solver option using the drop-
down list.

Ansys ICEM CFD allows you to write input files for any of the following Output Solvers:

Table 8: Supported Output Solvers

ADINAADH_NSACUSOLVEACTRANACRi

AcFluxAUTOCFDAnsys FluentAnsys CFXALPHA-FLOW

CEDREC-MOLDBAGGERAttilaAirflo3D

759
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.



CGNSCFX-4CFL3DCFDRC-DTFCFD++

CRSOLCOLISEUMCOBALTCMG_STARSCHAD

Concert3DCommon
Structural

ComcoCSPCRUNCH CFD

FASTEST-3DFANSCEXODUS-IIEMDatex

FastUFLEXFIELDVIEWFENSAPFENFLOSS

Fluent V4Flow-LogicFire_V8Fire_V7Fidap

ICATIBM-BemHPHDF (GE)GSMAC-DF

KIVA-3(V)iPLESIMPNSIDEASICU

MAGRECMACSLL-DYNA3DLAURAKIVA-4

NCCN3S-NaturMultiblock-infoMOUSEMAZe

P&W CommonNs3DNSU3DNPARCNOPO

POPINDAPMARCPHOENICSPARCPAB3D

Poly3DPlot3DPatranPRECISE (SI)PRECISE (Imperial)

RadTherm (.tdf )RTTRAVENRADIOSSPolyflow

SPLITFLOWSPECTRUM-CENTRICSCRYUSC/TetraSAUNA

STARSSTAR-CD 3.2.0STAR-CD
3.1.0/3.0.5

STAR-CCM+STAR-4

TLNS3D-mbTGridTAUSpecElemSTL

Trio-UTranairTeamTSARTNO

USMKV3VUSM3DUSAUH3DUGRID

WINDVectisVULCANVSAERO/USAEROVRML

ZENWIND-MASTER

Note:

• For Fluent V6, use Ansys Fluent.

• CFD++ may not be able to import part names longer than 12 characters. This is a
CFD++ limitation.

• To export mesh in a format better suited to structural analysis (Ansys, ABAQUS, NAS-
TRAN, LS-DYNA / Autodyn) use the FEA Solve Options tab.

For more information on the Common Structural Solvers, see the FEA Solve Op-
tions (p. 723) chapter.

• Both FEA and CFD properties can be set for the same model.

Tip:

More information about most of the Ansys ICEM CFD Output Interfaces is available from the
Help menu. Select the Output Interfaces option to open a browser window containing the
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Ansys ICEM CFD Output Interfaces information. Select the name of an interface in the Table
of Supported Solvers for more detail about that specific interface.

Important:

The output interfaces are separate executables that operate on project files that have been
saved to disk. This means you will need to save the project, particularly the mesh, part
boundary conditions, and/or properties files before sending output to the solver. If your
mesh is large and you are concerned about memory limitations and do not want the mesh
loaded twice into memory (the editor and the output interface), you can then unload the
mesh and proceed with the output based on the saved mesh file.

Some of the commonly used output interfaces are:

Ansys CFX

Ansys Fluent

CGNS

Polyflow

Ansys CFX

Ansys CFX
(CFX–5)

Solver

unstructured meshType of
mesh

3DDimension

This translator writes coordinates, connectivity and family information of an unstructured mesh file
in Ansys CFX (CFX-5.2) format.

Creating the Ansys CFX (CFX-5.2) Input File

The translator writes the Ansys CFX (CFX-5.2) input file using an unstructured mesh file and its
boundary condition file. To create the Ansys CFX (CFX-5.2) file, select the translator Ansys CFX in the

Output Solver list and click Apply. Select the Write input option in the Output tab. A window
will open to allow the specification of the files to be translated into the Ansys CFX format.
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Figure 509: Ansys CFX Options

Specify the following:

• the name of the boundary condition file

• the name of the Ansys CFX (CFX-5) file

• the scaling factor for the coordinates in the geometry file (optional)

• the coordinate system, global or local

• ASCII or binary output

• single or double precision

• the Ansys CFX (CFX-5) version: Pre-5.5 or 5.5 or later

The interface generates the Ansys CFX (CFX-5) file in the project directory.

Defining Boundary Conditions

There are no boundary conditions settings required for this translator. Note however that the family
information is exported to the Ansys CFX (CFX-5) file.

Ansys Fluent

Ansys FluentSolver

unstructured
mesh

Type of
mesh

2D and 3DDimension

The Ansys Fluent interface creates a Fluent or Fluent Meshing mesh file from an unstructured mesh,
with the following grid sections:

IndexSection
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0Comment

2Dimensions

10Nodes

12Cells

13Faces

18Periodic Shadow Faces

39Zone Section

The mesh file can be written in ASCII or binary format.

Note:

The Fluent output interfaces are separate executables that operate on project files that
have been saved to disk. This means you will need to save the project, particularly the
mesh, part boundary conditions, and/or properties files before sending output to the
solver. If your mesh is large and you are concerned about memory limitations and do not
want the mesh loaded twice into memory (the editor and the output interface), you can
then unload the mesh and proceed with the output based on the saved mesh file.

Creating the Ansys Fluent Input File

The translator writes the Ansys Fluent input file using an unstructured mesh file and its boundary
condition file. To create the Ansys Fluent file, select Ansys Fluent in the Output Solver list and click
Apply. After generating the mesh, boundary conditions can be defined. Supported boundary conditions
are:

fluid, porous, solidVolume

axis, fan, interior, mass-flow-inlet,
outflow, periodic, porous-jump,

Surface

pressure-inlet, pressure-far-field,
pressure-outlet, radiator, symmetry,
velocity-far-field, velocity-inlet, wall

Select the Write input option in the Output tab. A window will open to allow the specification
of the files to be translated into the Ansys Fluent format.
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Figure 510: Ansys Fluent Options

Specify the following:

• the grid dimension

• the scaling factor for the coordinates in the geometry file (optional)

• ASCII or binary output

• ignore couplings (yes or no)

• the name of the boundary condition file

• the name of the Ansys Fluent file

Creating the TGrid Input File

The translator writes the TGrid input file using an unstructured mesh file and its boundary condition
file.

Note:

TGrid is the same as Fluent Meshing and supports only surface mesh.

To create the TGrid file, select TGrid in the Output Solver list and click Apply. Select the Write
input option in the Output tab. A window will open to allow the specification of the files to be
translated into the TGrid file.
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Figure 511: TGrid Options

Specify the following:

• the grid dimension

• the name of the boundary condition file

• the name of the Fluent Meshing file

CGNS

CGNS Version 3.1 (ADF / HDF)Data
Format

unstructured or structured
mesh

Type of
mesh

2D and 3DDimension

The Ansys ICEM CFD - CGNS output interface creates a CGNS file in accordance with the SIDS. It uses
the CGNS mid-level-library endorsed by the CGNS Steering Committee to create the file. This interface
supports both structured and unstructured mesh translation.

Creating the CGNS File

The CGNS output interface can be invoked from the Ansys ICEM CFD main window. Select CGNS in

the Output Solver drop-down list and click Apply. Then select the Write input option in the
Output tab. A window will open to allow the specification of the files to be translated into the CGNS
format. An existing unstructured mesh file or a set of structured mesh files must first be selected.
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Figure 512: CGNS Options

In addition, the output interface requires the boundary conditions file, and for structured mesh input,
the topology file. It offers options for naming the CGNS file and to select the automatic creation of
boundary condition patches. You can set the Scaling factor for the coordinates in the CGNS file,
which can be used to transform the type of units by which the mesh is measured (for example, setting
the Scale factor to 1000 would change the scale from meters to millimeters). For unstructured mesh
input, you have the additional option to select whether the boundary condition patches are defined
using nodes or face elements. Default names for the Ansys ICEM CFD input files and the CGNS file
are given. These can be modified as necessary. The interface generates the CGNS file in the current
project directory.

Note:

When writing the CGNS file, the maximum number of elements in a part multiplied by the
number of nodes per element cannot exceed 2 billion.

• For linear Hexa meshes, the maximum number of elements in a part should not
exceed 250 million.

• For linear Tetra meshes, the maximum number of elements in a part should not
exceed 500 million.

To export meshes with parts comprising a large number of elements, ensure that larger
parts are split into smaller parts within these limits.

Connectivity

This translator supports 1-1 connectivity and periodic interfaces.

Defining Boundary Conditions (Optional)

After generating the mesh, and prior to running the translator, boundary conditions can be defined.

Select the Boundary conditions option in the Output tab. The Part boundary conditions
window appears, allowing you to set boundary conditions. Two boundary conditions types are available:
BCType and BCDataSet. Note however that BCDataSet in a subset of BCType in CGNS and therefore
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cannot be defined by itself. A boundary condition patch can either have a BCType alone, or a BCType
with one or more BCDataSets.

BCType

The boundary condition types (BCType) are defined in the SIDS. They identify the equations that
should be enforced at a given boundary. To define a boundary condition type, select a boundary
family (face in 3D, edge in 2D) and one of the BCType options in the provided list.

BCDataSet

Boundary condition data sets are used to define the BCTypeSimple, and one or more global
boundary condition data. When boundary condition data sets are specified, the boundary condition
type must be selected. This can be either Dirichlet or Neumann. Only uniform boundary condition
data are supported by the translator; the data given are applied to the entire boundary condition
patch. The list of variables corresponds to the standardized Data-Name Identifiers found in Annex
A of the SIDS. In general, BCTypeSimple is the same as BCType and no more than one BCDataSet
is required. In some particular cases however, the boundary condition type can be flow dependent.
In such case, BCTypeSimple differs from BCType. The SIDS defines these special cases as "compound
boundary conditions". For example, an inflow boundary where the flow goes from subsonic to super-
sonic would require a compound boundary condition. In such case, two BCDataSets would be added,
each with a different BCTypeSimple:

1. with BCTypeSimple = BCInflowSubsonic

2. with BCTypeSimple = BCInflowSupersonic

For more details on the use of compound boundary conditions, refer to the SIDS.

3D Elements Groups for Unstructured Grids

The CGNS standard does not provide a specific method for grouping elements. The translator offers
this feature by creating a DataArray_t node under Zone_t/DiscreteData_t. This DataArray_t node
is named PID and contains on array of integers for the pid of each element. Each element's PID is set
to its family ID number. The order in which the element's PIDs are listed follows the same order as
the global element numbering under Element_t.

Polyflow

The interface writes coordinate, connectivity and boundary condition information in the Patran-based
Polyflow format. The following Patran packets compose the input file created with this interface:

• Packet 25: Title Card

• Packet 26: Summary Data

• Packet 01: Node Data

• Packet 02: Element Data

• Packet 06: Distributed Loads

• Packet 07: Node Forces
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• Packet 99: End of Neutral File

Creating the Polyflow Input File

The translator writes the Polyflow Neutral File Version 2.4 using an unstructured domain file and its
boundary condition file. Select Polyflow in the Output Solver drop-down list and click Apply. Then

select the Write input option in the Output tab. A window will open to allow the specification
of the files to be translated into the Polyflow format. An existing unstructured mesh file must first be
selected.

Figure 513: Polyflow Options

Specify the following:

• the name of the boundary condition file (default is configuration/parts_mesh/mesh/boco)

• the name of the Polyflow input file (default is configuration/parts_mesh/transfer/configura-
tion.poly)

• the scaling factor for the coordinates in the geometry file (optional)

The interface generates the Polyflow file located in the Transfer Shell. You may open a shell window
in this directory by selecting the menu items "Utility" and "Transfer Shell".D

Defining Boundary Conditions for Polyflow

In MULCAD the boundary conditions are defined in the "Unspec. Bound. Cond." menu. In the DDN-
Mesher Interface, the "general bound. cond." menu is used. Refer to the General Remarks section for
more details. For P-CUBE, the NAME field and ID # icon are used to prescribed the Polyflow boundary
conditions. Three types of boundary conditions/properties are available for Polyflow: distributed loads,
nodes forces and PID numbers.

Distributed Loads:

MULCAD          DDN-Mesher      P-CUBE
------          ----------      ------
1.FLAG          1.string1       NAME field      Enter the word DISTR
2.NR            3.integer       ID # icon       Enter the load ID number
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The element numbers and their load ID are written out in Packet 6. The boundary condition
DISTR is only recognized on subfaces for a 3D model and on edges for a 2D model.

Node Forces:

MULCAD          DDN-Mesher      P-CUBE
------          ----------      ------
1.FLAG          1.string1       NAME field      Enter the word NODE
2.NR            3.integer       ID # icon       Enter the node ID number

The node numbers and their load ID are written out in Packet 7. The boundary condition NODE
is available on subfaces, edges and vertices for a 3D model and on edges and vertices for a 2D
model.

Element PID:

MULCAD          DDN-Mesher      P-CUBE
------          ----------      ------
1.FLAG          1.string1       NAME field      Enter the word PID
2.NR            3.integer       ID # icon       Enter the PID number

The element PID are written out in Packet 2. They must be defined on domains for a 3D model
and on subfaces for a 2D model. Their default value is 1.

Limitations

It is assumed for the moment that there is no need to define boundary conditions on interfaces since
Polyflow expects the load sets to be defined on the boundaries of the domain only.

Polyflow does not allow a mix of 2D and 3D elements in the same model. The type of elements re-
cognized by the Polyflow Translator are:

• in 2D:

– 3 or 6 points triangle

– 4 or 9 points quadrilateral

• in 3D:

– 4 or 10 points quadrilateral

– 8 or 27 points hexahedral

– 6 or 18 points wedge pentahedral

– 5 or 14 points pyramidal pentahedral

Boundary Conditions

The Boundary Conditions option will open a window to set up and review boundary conditions.
Selecting the "+" next to an item will bring down a further list of options and settings. Selecting a part
type (Volumes, Surface, Edges, etc.) will display the list of parts of that type in the model. Under each
part, the current boundary condition categories for that part are listed, along with the options to create
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a new boundary condition or paste a copy of one from a different part. The boundary condition categories
and types available are specific to the solver. If the Generic solver is selected, no categories will be listed,
and instead the boundary condition types will be listed immediately beneath each part. The defined
boundary conditions are marked with a check, and selecting it will display the detailed parameters on
the right side of the window. At the bottom of the parameters, there are options to Delete or Copy
the parameter values to another boundary condition. A part can contain more than one boundary
condition.

Figure 514: Part boundary conditions dialog box

The Part boundary conditions dialog box options are as follows:

Volumes

Parts that contain only material points (designated volume region definition) or volumetric elements.
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Surfaces

Parts that contain only surfaces or surface elements (tris or quads). The following types of surface
parts are defined:

• One-sided surfaces or surface elements, such as walls, inlets, and outlets.

• Two-sided parts contain zero thickness baffle surfaces or surface elements that have the same
volume on either side.

• Mixed / unknown parts contain baffles and wall boundaries.

Edges

Parts that contain only curves and/or bar elements.

Nodes

Parts that contain only prescribed points or node entities.

Mixed / unknown

Empty parts or parts that contain a mixture of the geometry or element types listed above.

Create new

This option is available for every boundary condition type, and it opens a window with the list of
available boundary condition types specific to the selected solver. Specific parameters for the type
can be selected and changed in the parameters list on the right side of the window.

Edit Parameters

The Edit Parameters option opens a window where the solver parameters for the selected solver
can be defined. The parameters are organized by type on the left side and the parameter values can
be entered in on the right side of the window. Parameter definitions can also be copied and pasted.

Write Input

The Write Input option will open a window where you can edit the parameters for the input file.
After editing the parameters, the application prompts you to save the project before the input file is
written.
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